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Preface 

About This Manual 
This manual provides reference information and instructional steps for performing daily tasks in your 
IDEXX Cornerstone* Practice Management System. This information is intended for use by all staff 
members who use the Cornerstone software at your practice. This manual provides information on: 

• Using basic Cornerstone features 

• Scheduling appointments and managing patient visits 

• Performing pet health management tasks 

• Performing daily inventory tasks 

• Using Cornerstone Imaging 

• Other tools and tasks 

How to Use This Manual 

This manual takes advantage of the searching and linking tools available within Adobe® Reader® PDF 
(Portable Document Format) files. Use the following tools to search and navigate within this manual: 

• Bookmarks panel – The Bookmarks panel acts as an always-visible linked Table of Contents, 
available on the left side of the document window. 

• Clickable TOC – This manual’s Contents section provides direct links to each page—just click the 
page/chapter/section text in the Contents listing to go to that page. 

• Find toolbar – Select Edit > Find in Adobe Reader and use the Find toolbar to do a quick search 
for a word or phrase in the current PDF. 

• Search window – Select Edit > Search in Adobe Reader and use the Search window to look for 
words in the current PDF or in multiple PDFs, or to use advanced search options. 

 

 

 

 

 

 

Click a bookmark 
in the Bookmarks 
panel to go directly 
to that section in 
the manual 

Select Edit>Find and use the 
Find toolbar to quickly find a 
word or phrase 

Click anywhere within the 
Contents listing to go 
directly to that page 

Select Edit>Search 
and use the Search 
window to set up 
search criteria or do 
an advanced search 
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Additional Resources 
The following resources are available for additional help with your Cornerstone software: 

Resource Recommended Use Location 

Cornerstone Administrator’s 
Manual 

Find reference information and 
procedural steps for setup and system 
configuration in Cornerstone 

• Icon installed on your desktop 

• Start > Programs > 
Cornerstone > Manuals 
Note: In Windows® 8, you can 
find the Cornerstone folder on 
the Apps screen. 

• idexx.com/cornerstoneresources  

Cornerstone Help System Find window-specific information and 
procedural steps for setting up your 
Cornerstone system and performing 
daily tasks 

• Press F1 on any Cornerstone 
window or dialog box 

• On the Cornerstone menu bar, 
select Help > Contents 

Cornerstone Tutorial Training 
Files & Print-Based Courses 

Work with the Cornerstone Tutorial 
Training Files data to complete 
exercises that mimic everyday tasks in 
your practice without jeopardizing the 
integrity of your real medical records 

• Start > Programs > 
Cornerstone > Training Files 

• Start > Programs > 
Cornerstone > Training Files – 
Print Based Courses 
Note: In Windows® 8, you can 
find the Cornerstone folder on 
the Apps screen. 

IDEXX Learning Center Access online courses, webinars, 
snippets, tutorials and podcasts 

• idexxlearningcenter.com 

 

Training File Details 
In the training files (including the Cornerstone Assistant training files), functionality is limited for some 
Cornerstone 8.3 features which ordinarily communicate with systems outside of Cornerstone: 

• Pet Health Network* Pro—You can see and use Pet Health Network Pro features like the share 
button and the IDEXX Message Center alerts for appointment requests; however, these actions 
won’t be reflected on pethealthnetworkpro.com or petly.com. 

• Inventory Ordering using IDEXX SmartOrder* with MWI® Veterinary Supply—Although you can’t 
use IDEXX SmartOrder, you can view the windows used for working with this feature. Also, Purchase 
Order 1000 in the training files shows an example of a purchase order created using IDEXX 
SmartOrder. 

• IDEXX Faxing Service—Although you can’t send faxes from the training files with the IDEXX Faxing 
Service, this feature is very close to the new email feature that is usable in the training files. Also, 
completed faxes are shown on the Communications Log in the training files. 

• Antech Diagnostics® Module—A training version of this module is not available in the training files. 
However, training is included when you purchase the Antech module or upgrade from the previous 
version of the module. 
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• Lifelearn® ClientEd™ Online—You can set up and synchronize Cornerstone with LifeLearn ClientEd 
Online documents only from your live Cornerstone database.  

 
• VetConnect* PLUS—You can view VetConnect PLUS information for the following patients: 

o Zeke—Patient ID 15329 (Feline) 
o Blake—Patient ID 3679K-1 (Canine) 
o Twister—Patient ID 120Q-1 (Canine) 

 
• Electronic signature capture for the integrated payment solution with XCharge®—In the training 

files, you can view XCharge features except the ability to capture electronic signatures. 

• Activation—You cannot activate or set up any of the above features from the training files; you can 
do that only from your live Cornerstone database. Also, in the configuration windows for a multi-
location single database environment, the training files do not allow you to apply primary settings to 
a secondary practice. 

Getting Help 
If you have a problem or question that you cannot find the answer to in the Cornerstone Help system or 
documentation, the following support options are available: 

• Visit our online support center at cornerstonehelp.com. 

• Email Cornerstone Support at cornerstone@idexx.com. 

• Call Cornerstone Support at 1-800-695-2877. 
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Chapter 1: Getting Started with Cornerstone* Software 

Introduction 
Your decision to use the IDEXX Cornerstone* Practice Management System shows your commitment to 
total practice information management. Cornerstone software can help you manage all of your practice’s 
needs for business, medical and educational information. 

Why Cornerstone? 

Cornerstone software offers you: 

• Simplicity – Cornerstone is easy to learn and easy to use. 

• Functionality – You can export information to other Windows-based programs. 

• Flexibility – You can choose to purchase additional Cornerstone modules based on your practice’s 
needs. 

• Networking capabilities – You can share the program and information with other users on your 
network. Additional licenses are required.  

• Multi-tasking – You can work in more than one software program at the same time. 

• Help – You can quickly look up information and get answers to questions using the Help system 
built into Cornerstone. 

• Support – You have the long-term support and stability of the industry leader. 

Starting the Cornerstone Database 
The Cornerstone software runs a number of IDEXX services in the background on your computer. 
Beginning with Cornerstone 8.3.6, you will notice some differences in the way the database and services 
are handled. For more information about the database and services in previous versions of Cornerstone 
8.3, see the latest release notes. 

• Cornerstone services are started and stopped in the IDEXX Database and Services window, which 
allows you to monitor the coordination of these services with each other and with your Cornerstone 
database. This window runs in the background. If you want to open the window to see which 
services are running, follow the instructions below. 

• The Cornerstone database runs as a service. This means that you no longer have to start the 
database. It starts automatically when you open Cornerstone. 

• You will NOT see a database icon in the system tray as you may have in previous versions of 
Cornerstone. 

To open the IDEXX Database and Services window: 

1. Double-click the Cornerstone Database Server  icon on your desktop. The IDEXX 
Database and Services window appears. 
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Services that are running display Running in green text. Services that are stopped display 
Stopped in red text. 

2. To start or stop all the services, click Start All or Stop All.  

A list of stopping or starting activities will appear in the window. The word Finished appears 
when the action is complete. 

Note: You can start and stop individual services. Click Open Windows Services, locate the 
service, and right-click to start or stop the service. We do not recommend that you do this as 
services are started and stopped automatically in the correct order. 

3. Close the window. 

  

Starting Cornerstone 
Depending on how you have customized your desktop, you can start Cornerstone in one of several 
ways. 

Before You Begin 

• Security must be set up for each staff member. See the Cornerstone Staff Security instructions you 
received separately when you purchased your Cornerstone software. 

• A Cornerstone Administrator should set up defaults, controls, and lists, and perform all other 
configuration tasks. For more information, see the Cornerstone Administrator’s Manual.  

Tip: IDEXX recommends setting your monitor display settings to 1024x768 or 1280x800 for optimal 
viewing of Cornerstone. 

To start Cornerstone: 

1. Do one of the following: 

• Double-click the Cornerstone  icon on your desktop.  

• Click the Start button on the taskbar, and then click All Programs > Cornerstone >  
 Cornerstone. 

Note: In Windows® 8, the Cornerstone folder is on the Apps screen. 

The Cornerstone Log In dialog box appears. 
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Log In dialog box 

2. In the User box, type your staff ID or select your name from the drop-down list. 

3. In the Password box, type your password. As you type your password, asterisks appear in place of 
the characters. 

4. Click OK or press ENTER. 

Note: You can log into Cornerstone using only your password, if this feature has been enabled. A staff 
member with Administrator rights can activate this Password log on option in Passwords defaults 
(select Controls > Defaults > Practice and Workstation, and then select Passwords from the menu 
on the left). For more information, see “Chapter 4: Setting Practice and Workstation Defaults” in the 
Cornerstone Administrator’s Manual. 

Logging Off and Changing Users 
You should log off Cornerstone when you are not at the computer. When you log off, this requires the 
next Cornerstone user to log on with their own password. 

IMPORTANT: Use care when changing users. When the database saves information, it records which 
user is logged on.  

To log off: 

 Do one of the following: 

• On the File menu, select Log Off. A Log Off verification message appears. Click Yes. 

• Press CTRL+L to automatically log off Cornerstone. (The Log In dialog box will automatically 
display for the next user to log in.) 

To change users: 

1. Make sure the previous user is logged off before you log in. 

2. Do one of the following: 

• On the File menu, select Password Entry.  

• Press CTRL+L. 

The Cornerstone Log In dialog box appears. 

3. Log in to Cornerstone as usual. 

Exiting Cornerstone 
Exit Cornerstone (and all Cornerstone modules) using the steps below. 

To exit Cornerstone: 

1. First, log off Cornerstone (File > Log Off). 

2. To exit Cornerstone, do one of the following: 
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• Click the Exit  toolbar button. 

• On the File menu, select Exit. 

• Click the Close  button in the upper-right corner of the Cornerstone application window. 

3. When you see the confirmation message, click OK. 

Shutting Down the Workstations 
Before you shut down your workstations, log off and exit Cornerstone. 

Shutting Down the Server 

Before You Begin 

• Log off and exit Cornerstone. 

• Close any other applications that are open. 

• Ensure that Cornerstone is closed on all workstations. 

• Verify that your daily backup procedures are being followed. 

To shut down the computer: 

Shut down the computer using the Windows® system. Do not use the power button to shut down. 

Note: If this is a Server operating system, you will need to select an option from the Option drop-down 
list and then click OK. If you select Other (Planned), you will need to type a comment in the Comment 
area before clicking OK. 

The Cornerstone Application Window 
The Cornerstone application window has many elements typical in Windows-based programs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tip: You can specify that a particular “Login page” (dialog box or window) opens automatically when 
you start Cornerstone. For more information, see “Default Login Page” on page 20. 

Title bar 

Menu bar 
Toolbar 

Status bar 
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Title Bar 

The Cornerstone title bar displays the Cornerstone icon and the Cornerstone program name.  

Menu Bar 

The menu bar across the top of the Cornerstone application window displays menus containing the 
commands available for use in Cornerstone. 

To access the menus using the mouse: 

 Click the menu name on the menu bar and then click the command you want to use. 

To access the menus using the keyboard: 

1. Press the ALT key to display the underlined keytip letters in the menu names. 

2. Press the letter underlined in the menu you want to use. 

3. Continue pressing letters until you press the letter of the command that you want to use. 

For example, to access File menu > Printer Assignment > End of Day, you would press the key 
sequence ALT, F, A, D. 

Note: You can also use the arrow keys to move up or down within the menu and then press ENTER to 
select the highlighted command. 

Toolbar 

The Cornerstone toolbar provides shortcut buttons that allow you to quickly access commonly used 
windows and menu options.  

In the initial Cornerstone setup, by default all toolbar buttons are visible on the main Cornerstone toolbar, 
but you have the option of removing buttons from the display in order to simplify the toolbar for your 
staff. You can designate which Cornerstone buttons are visible on the main Cornerstone toolbar across 
the practice (Controls > Defaults > Practice and Workstation, and then select Toolbar from the 
menu on the left) or for a specific staff member (Controls > Defaults > Staff, and then select the 
Toolbar tab). Some buttons display only if you have purchased the applicable Cornerstone module. 

Tip: In Cornerstone, hover the mouse pointer on a button to display a tooltip description of the button.  

 Patient Clipboard  Check-in/Out  Prescription Labels 

 Daily Planner  Vital Signs/Weight  Patient Visit List (PVL) 

 Whiteboard  Physical Exam/Patient Advisor  Invoice 

 Client  Medical Notes  Want List 

 Client Account  Image Explorer  CareCredit 

 Correspondence  Image Requests and Results  Delete 

 Patient  Imaging Dashboard  Help 

 Patient Reminders  Schedule for Today  Support Center 

 Patient File  Lab Requests and Results  IDEXX Message Center 

 Estimate  Reservation List  Exit 
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Status Bar 

The status bar is located at the bottom of the Cornerstone application window. The left side of the status 
bar displays prompts (based on the location of the cursor) for the type of information to be entered in a 
field or text box. The right side of the status bar displays the practice name, practice ID and user name 
of the currently logged in user. For those practices with the Multi-Location/Single Database option 
enabled, the practice name and ID are displayed for the practice you are currently logged into. 

Multiple Methods for Accessing Cornerstone Activities 
For many daily usage activities in Cornerstone, there are multiple methods you can use to access the 
applicable dialog box or window and perform the needed task. For example, to add a medical note for a 
patient, you could access the Start New Document window using any of the following methods: 

Method 1 With the patient’s record open on the Patient Clipboard*, in the Patient list area, right-click the 
patient’s name and select Medical Note. 

Method 2 With the patient’s record open on the Patient Clipboard, right-click anywhere within the Patient 
History area tabs and select Medical Note. 

Method 3 Click the Medical Notes  toolbar button. 

Method 4 On the Activities menu, select Medical Notes. 

For many activities, the fastest method is to start from the Patient Clipboard (which is why this method is 
used for most daily usage tasks covered in this manual). With the patient’s record open on the Patient 
Clipboard, you can right-click the patient’s name in the Patient list area and select from a comprehensive 
menu of activities. With this method, the client and patient information is entered for you when the 
desired dialog box or window opens, saving you steps and time. 

 

Right-click the 
patient’s name 
to access a 
menu of 
activities 
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Default Login Page 
The login page is a dialog box or window that displays automatically when a staff member logs into 
Cornerstone. The default login page is selected in Staff defaults (select Controls > Defaults > Staff, 
and then select the Miscellaneous tab). See “Chapter 5: Setting Staff Defaults” in the Cornerstone 
Administrator’s Manual for more information. 

Tip: Because the Patient Clipboard gives you easy access to common tasks using right-click menus, 
while keeping the client and patient general information available, many staff members may choose to 
set the Patient Clipboard as their default login page. See “Chapter 2: Using the Patient Clipboard” on 
page 26 for more information on the Patient Clipboard. 

Frequently Used Keyboard Shortcuts in Cornerstone 

To do this Press 

Launch the Cornerstone Help system. F1 

Use the Find tool to look up and select from a list. F2 

Display the Census List (patients currently checked into the practice). F3 

Move back through names on the Client List or Patient List. F7 

Move forward through names on the Client List or Patient List. F8 

Create a new item (for example, an estimate or invoice). CTRL+N 

Delete a highlighted field/line or blank record. CTRL+D 

Update a highlighted field. CTRL+U 

Log off Cornerstone. CTRL+L 

Start a new line when typing in a template data entry field. CTRL+ENTER 

Move to the next field. TAB 

Move to the previous field. SHIFT+TAB 

 

The Find Tool: F2 
The Find tool is a Cornerstone feature that is used frequently. Because it would be impossible to 
memorize IDs, Cornerstone includes this powerful and efficient tool to find: 

• Client, patient, staff member and invoice item IDs 

• Dates (a pop-up calendar is available from date fields in Cornerstone) 

• Departing instruction IDs 

• Diagnostic codes 

• Documents 

• Estimate and invoice numbers  

• Invoice item classifications and subclasses 

• Prescription instruction IDs  

• Revenue centers 

• Referral doctors and hospitals 

• Species and breeds 

Cornerstone User’s Manual                  20 



Chapter 1: Getting Started with Cornerstone* Software 

To open a search list: 

With the cursor in the applicable field, do one of the following: 

• Press F2. 

• Double-click in the field. 

The applicable search list appears. 

 
The Client List is one of several lists found in Cornerstone. 

To find an ID: 

When you first open the search list, the cursor is either in a name, description or number field, based on 
the selected Search by or Sort by option. You can change the search method by clicking the appropriate 
option. 

Tips for using the Find tool: 

• Begin typing in one of the information/search criteria fields (Name, ID, Phone, Microchip ID, etc.). 
Note that as you type, Cornerstone automatically scrolls to and highlights the list item that most 
closely matches the text you typed. 

• If you use the Find tool to search for a client or patient, the client or patient that you used most 
recently appears highlighted. You can simply begin typing a new name, description or number. 

• When searching the Invoice Item List by Description, you can select the Search for word check 
box to narrow the list to any item containing the text typed in the Description field.  

 
In this example, to find all items relating to "shampoo," select the Search for word check box.  
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To select an ID: 

 Do one of the following: 

• Double-click the ID. 

• Highlight the row using the arrow keys and press ENTER. 

• Highlight the row and click Select. 

The original dialog box appears displaying the ID number and all corresponding information. 

To use the F2 pop-up calendar: 

1. Press F2 in the Date field of any dialog box, and a pop-up calendar appears. 

 
F2 pop-up calendar 

2. Select the desired month and year. Click the right arrow button to advance one month. Click the left 
arrow button to move back one month. 

3. Select the desired date and click OK (or double-click the date) to enter the date in the Date field. 

The Recent Clients/Patients Feature: F7 and F8 
When you press F2 in a client or patient field, the last client (or patient) you entered in a Cornerstone 
dialog box appears. To use this client (or patient) again, press ENTER or click OK. 

You can also set up Cornerstone to remember the clients and patients you've used most recently. The 
F7 and F8 keys in the Client List and Patient List are programmed to move you backward and forward 
through the list of recently used clients (or patients). Using these options, you can quickly enter clients 
and patients in dialog boxes without searching through the complete Client List or Patient List. 

This search is specific to the workstation. For example, if you access Jane Smith on Workstation 1, Jane 
Smith will not be in the list of recent clients on Workstation 2. 

Note: To view the complete Client List or Patient List, begin typing the new name or ID in the applicable 
field. You can also clear the most recently used client (or patient) information by pressing the DELETE or 
BACKSPACE key, or by clicking the Clear button. 

Before You Begin 

• In Client defaults, enter the number of Recently accessed clients you want Cornerstone to 
remember. To access Client defaults, select Controls > Defaults > Practice and Workstation, 
and then select Client from the menu on the left. 

• In Patient defaults, enter the number of Recently accessed patients you want Cornerstone to 
remember. To access Patient defaults, select Controls > Defaults > Practice and Workstation, 
and then select Patient from the menu on the left. 

Note: Cornerstone can remember up to 99 recently used clients or patients. 
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To use the Recent Clients/Patients feature: 

Although the procedure below assumes you are looking for a client, you can use the same instructions 
to find a patient. 

1. With the cursor in an ID or Client Name field, press F2 or double-click in the field. The Client List 
appears. The client you most recently entered in a dialog box is selected (highlighted). 

2. Do one of the following: 

• Press F7 to see clients most recently used who appear before the highlighted client in the list. 

• Press F8 to see clients most recently used who appear after the highlighted client in the list. 

Assigning Printers in Cornerstone 
Within the IDEXX Cornerstone* Practice Management System, you can designate specific types of 
documents, such as reports or prescription labels, to print on specific printers. Assigning printers 
prevents you from having to change paper stock or printer settings every time you print. 

Documents that have not been assigned to a specific printer will print to the default printer selected in 
your Windows® operating system. 

Note: Network users must assign the default printer and specific document printers separately at each 
workstation.   

To select a default printer in Windows: 

Note: The procedure below may vary slightly depending on your version of Windows operating system. 

1. Do one of the following: 

• Click the Start button on the taskbar and select Devices and Printers or Printers and Faxes. 

• Click the Start button on the taskbar, select Control Panel, and then double-click Devices and 
Printers or Printers and Faxes.  

• In the Windows Search box, type Devices and Printers. 

• In the Settings charm, select Control Panel, and then select Devices and Printers. 

The printers listed are the printers available to you through your Windows settings. 

2. Right-click the printer to designate as the default printer and select Set As Default Printer.  

All print jobs that are not assigned to print to a specific printer in Cornerstone will print to this default 
printer. 

To assign a printer to print specific types of documents: 

Note: For invoices, we recommend that you print to your default printer rather than assigning a specific 
printer. 

1. On the File menu, select Printer Assignment and then select one of the following categories:  

• End of Day contains all of the EOD reports. 

• End of Month contains all of the EOM reports. 

• End of Year contains all of the EOY reports. 

• General Reports contains all other reports (such as Client and Patient reports) plus additional 
documents, including estimates, invoices, lab requests, Classic medical notes, prescription 
labels, standard rabies certificates, reminders and more.  
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• Correspondence contains all types of documents created using the Cornerstone Editor 
(correspondence documents, medical notes, forms, custom certificates, custom labels, 
PetDetect* collars, etc.) 

The Printer Assignment dialog box appears. 

 
Printer Assignment dialog box 

2. In the Printer drop-down list, select the desired printer. (The current list of items to be printed on that 
printer is already highlighted/shaded.) 

Note: Pay special attention to which printers you assign to print mailing labels, prescription labels 
and statements. Remember, files created in Microsoft® Word will use the default printer set up in 
your Windows® operating system. 

3. Select or deselect additional documents to be printed to the selected printer.  

• To select more than one nonconsecutive document, hold down the CTRL key while you are 
selecting documents.  

• To select a consecutive group of documents, click the first document, hold down the SHIFT key, 
and then click the last document in the group. The first and last documents and all documents 
between them are selected. 

• To select all documents in a particular category, click the Select All button.  

• To deselect all items in a particular category, click the Deselect All button. 

4. Click OK to save your changes. 
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Changing Print Options 
The Cornerstone Print Options dialog box allows you to change print options before printing a report 
from Cornerstone. 

 
Cornerstone Print Options dialog box 

To change print options: 

1. In the Copies text box, type the number of copies to print.  

2. In the Page range area, specify if you want to print all pages, only the current page, specific pages 
only and/or a range of pages.  

3. Select your Print option: All Pages in the Range, Odd, or Even pages. (To print a report double-
sided, print odd pages and then even pages.) 

4. Click OK to print. 

Note: We recommend that you do not change the default Print to file or Collate copies settings. Use 
Save As (from the report Filters dialog box) or Save (from the Reports Preview window) to save reports 
to a text file. 
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Overview 
The Cornerstone* Patient Clipboard* provides a central location from which to view or access 
information. Using the Patient Clipboard gives you easy access to common tasks (using right-click 
menus), while keeping the client and patient general information available. For this reason, many staff 
members may choose to set the Patient Clipboard as their default login page that displays automatically 
when Cornerstone is started (see “Default Login Page” on page 20).  

Note: If preferred, you can use the toolbar buttons or menu options to perform the same tasks that are 
available using the Patient Clipboard right-click menus.  

To open the Patient Clipboard: 

 Click the Patient Clipboard  toolbar button (or select Activities > Patient Clipboard). 

Areas on the Patient Clipboard 

The Patient Clipboard is divided into five areas, as shown below.  

 

 

Note: The Patient History area can be displayed in normal view (shown above), full size view, and with a 
preview pane view for previewing medical notes and correspondence documents from the Patient 
Clipboard. See “Viewing Options for the Patient History Area” on page 34 for more information. 

Client 
information 
area 

Patient 
History 
area 

Patient 
information 
area 

Patient 
list area 

Client  
area 
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Tips for using the Patient Clipboard: 

• In any of the Patient Clipboard areas, right-click to access a menu of options. 

• Multiple instances of Patient Clipboard windows can be used simultaneously. 

• To bring a Patient Clipboard window to the front of other Cornerstone windows, click the Window 
menu to view a list of all currently open windows. Select the one you want to view. 

Client/Client Information Areas 
With a client selected (using the Client ID field), client information can be viewed or accessed from two 
areas of the Patient Clipboard: 

• Client area 

• Client information area 

 

 
 

The Client Area 

The Client area displays a variety of information related to the client. This area shows the client’s name 
and ID number, classification, balance due, designated credit code, primary telephone number, and the 
number of both total and active patients owned by the client. 

Tip: When the credit code is red, it means there is an alert associated with the credit code. 

Client 
information 
area 

Client 
area 
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Many client-related tasks and windows can be easily accessed using the Client area right-click menu. 

 

To open the Client List from the Patient Clipboard: 

 In the Client ID field, press F2 or double-click in the field.  

See “Using the Client List” on page 39 for information on selecting a client using the Client List. 

To refresh the Patient Clipboard with the most recent data: 

 With a client displayed in the Patient Clipboard, right-click in the Client area and select Refresh. 

To clear the Patient Clipboard to help protect privacy: 

 With a client displayed in the Patient Clipboard, right-click in the Client area and select Clear. 

The Client Information Area 

The Client information area lets you view and access different types of client-related information using 
the Client information tabs. 

Tip: Tab display and order can be customized per staff member (select Controls > Defaults > Staff, 
and then select the Patient Clipboard tab). 

Client Information Tabs on the Patient Clipboard 

Tab Description 

 

The Client Information tab shows the client name and address, client status and classification,  
email address, and referral information. In addition, if using a Multi-Location/Single Database 
configuration, the client’s “home practice” is displayed. Right-click in the tab’s work area and 
select Update to change the client information. 

 

The Account Information tab shows the client’s account details, including the credit code, last 
payment and account balance. Select the Hide voided items check box to view only valid 
transactions. Right-click in the tab’s scrolling area to start an invoice or payment, make an 
adjustment, add an account comment, transfer a portion of the bill, write off (or reinstate) the 
account, or add a returned check to the account. To view details of a transaction, right-click on the 
line and select View. 

 

The Reminders tab shows the status of all reminders for the client’s animals. The patient name, 
description of the reminders’ status (overdue, current or no reminders) and the date the next 
reminder is due display on this tab. Right-click in the tab’s work area and select Update to change 
the reminder information. 

 

The Scheduled Appointments tab shows all appointments for the client, including the date, time, 
patient and room. Right-click in the tab’s work area and select New to add a new appointment or 
Update to update an existing appointment. 

 

The Reservations tab shows all boarding reservations for the client, including the arrival and 
departure dates, patient name and reservation, and cage types. Right-click in the tab’s work area 
and select New to add a new reservation or Update to update an existing reservation. 
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Tab Description 

 

The Estimates tab shows all estimates for the client, including the estimate ID, patient, date the 

estimate was created, date the estimate expires, and the amount. The signature  icon displays 
next to the estimate ID for all estimates that have been electronically signed. Right-click in the 
tab’s work area and select New to create a new estimate or Update to update an existing 
estimate. 

 

The Phones tab shows the client’s phone information, including the phone numbers and location 
descriptions. If notes exist for the phone number, the notes icon displays with black text lines on it 

. When the phone number line is highlighted, the notes display in the Notes area at the 
bottom of the tab. Right-click in the tab’s work area and click Update to add or change phone 
information. 

 

The Client Alerts tab shows all alert information for the client, including missing information alerts 
and any prompts or notes that are set up as alerts. If the alert notifies you of missing information 
(for example, a patient with no reminders), right-click on the alert and select Process to add the 
missing information to your records. (Note: The Client Alerts tab changes from yellow to red if 
there are alerts in a client’s record.) 

 

The Prompts and Notes tab shows answers to client prompts and note information for this client. 
Click the Prompts option to see the client prompts and answers. Click the Notes option to see 
any notes about this client. Right-click in the tab’s work area and click Update to add or change 
prompt answers or notes. 

 

The Secondary Names tab shows additional names on the client’s record. Right-click in the tab's 
scrolling area to add or update additional names on this record. Secondary names are useful if 
the pet belongs to two or more people with different last names, or if the practice wishes to search 
for the client record under more than one name. 
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Patient List/Patient Information Areas 
Patient information can be viewed or accessed from two areas of the Patient Clipboard: 

• Patient list area 

• Patient information area 

 

 

Tip: Click the Patient Search button to quickly display the Patient List to perform a patient search at any 
time. 

The Patient List Area 

The Patient list area displays a list of the patients owned by the client. Patients are listed whether they are 
active, inactive or deceased (inactive or deceased patients are grayed out). If more than two patients 
exist, click the green arrow  button and hover the cursor over the Patient list area to expand the list 
and display all patients at a glance. 

Patient 
information 
area 

Patient 
list area 

Patient 
Search 
button 
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Many patient-related tasks and windows can be easily accessed using the Patient list area right-click 
menu. 

 
 

The Patient Information Area 

The Patient information area lets you view and access different types of patient-related information using 
the Patient information tabs.  

Tip: Tab display and order can be customized per staff member (select Controls > Defaults > Staff, 
and then select the Patient Clipboard tab). 

Patient Information Tabs on the Patient Clipboard 

Tab Description 

 

The Patient Information tab shows the patient ID, name, status, class, sex, birth date, age, breed, 
color, weight, body score (if activated), markings, ward and cage. Right-click in the tab’s work 
area and select Update to change the patient information. If the patient has a picture, the picture 
will also display. Right-click the picture box and select options for adding, updating or deleting the 
picture. To access weight and vital signs information for the patient, click the Vital Signs/Weight 

 button. Note that the button displays in red/yellow  as an alert if at least one vital sign 
(other than weight and body score) has not been entered for the patient within the past 10 days. 

 

The Reminders tab shows the status of all reminders for the selected patient. The item ID, 
reminder description, reminder type, reminder due date, staff ID and reminder notes display on 
this tab. Reminders with a future date display in black. Overdue reminders display in red. 
Reminders that are due within the next 30 days display in yellow. If notes exist for the reminder, 
the notes icon displays with black text lines on it . Right-click in the tab’s work area and 
select Update to change the reminder information. 
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Tab Description 

 

The Tags/Microchip ID tab shows the microchip ID and registration information for the selected 
patient. It also lists rabies/vaccine tags that have been issued, including information on the tag 
number, date, expiration date, staff, and vaccine invoice item. If an existing tag is entered in the 
patient’s record, any comments are also displayed. Right-click within the tag listing area to access 
options for viewing/updating, voiding, reissuing, or adding an existing tag. 

 

The Appointments tab shows appointment information for the selected patient, including the 
date, time, reason for the appointment, and room. The tab also displays an “I” or “O” to the right 
of the appointment time to indicate that the patient is checked in (I) or checked out (O).Right-click 
in the tab’s work area and select New to add a new appointment or Update to update an existing 
appointment. 

 

The Reservations tab shows all boarding reservation information for the selected patient, 
including the arrival and departure date, reservation type, and cage type. Right-click in the tab’s 
work area and select New to add a new reservation or Update to update an existing reservation. 

 

The Check-in tab indicates if the patient is currently checked into the hospital. If the patient is 
checked in, the check-in date and time, staff ID, reason for visit and room display. Any check-in 
notes and/or alert notes also display. Right-click in the tab’s work area and select Update to 
update the check-in information. 

 

The Patient Visit List tab shows the patient’s items from the Patient Visit List, including item ID 
and description, quantity, amount and staff. A total of the items’ worth also displays. Click the 
Include recommended, Include accepted and Include performed check boxes to see at a 
glance the updated value of the items and services in the Patient Visit List. Right-click in the tab’s 
work area and select Update to update the Patient Visit List or select Print to display a preview of 
the Patient Visit List Report for this patient. 

 

The Estimates tab shows all estimates for the patient, including the estimate ID, patient, date the 

estimate was created, date the estimate expires, and the amount. The signature  icon displays 
next to the estimate ID for all estimates that have been electronically signed. Right-click in the 
tab’s work area and select New to create a new estimate, or right-click an existing estimate and 
select Update to view/update the estimate. 

 

The Patient Alerts tab shows all alert information for the patient, including missing-information 
alerts. If the alert notifies you of missing information (for example, a patient with no reminders), 
right-click on the alert and select Process to add the missing information to your records. (Note: 
The Patient Alerts tab changes from yellow to red if there are alerts in a patient’s record.) 

 

The Prompts and Notes tab shows answers to patient prompts and note information for this 
patient. Click the Prompts option to see the patient prompts and answers. Click the Notes option 
to see any notes about this patient. Right-click in the tab’s work area and select Update to add or 
change prompt answers or notes. 

 

The Owners tab shows the owner(s) information, including client ID, client name, and percentage 
of ownership. Right-click in the tab’s work area and select Update to change the owner 
information. 

 

The RDVMs tab shows the date the patient was referred to your practice, the referring doctor, and 
the referring hospital. The hospital and doctor phone numbers are also listed in the scroll area at 
the bottom of the tab. Right-click in the tab’s work area and select the applicable option to update 
the patient, doctor or hospital referral information. 
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The Patient History Area 
The Patient History area displays the medical history for the patient selected in the Patient list. From this 
area, you can view information such as a summary of the patient’s overall history, medical notes for the 
patient, a list of prescriptions, problems, laboratory results, diagnoses and vital signs/weight information.  

 
Note: The Patient History area on the Patient Clipboard can be displayed in normal view (as shown 
above), in full size view, and with an optional Preview pane. See “Viewing Options for the Patient History 
Area” on page 34 for more information. 

Patient History Tabs 

• Summary – Displays patient history information in summary view. 

• Text – Displays all lines of text in the patient history. 

• Problems – Displays medical problems noted in the patient’s history. 

• Dx  – Displays all diagnoses for this patient. You can also add or update diagnoses. 

• Rx – Displays all prescriptions for this patient. You can also renew, refill, correct and void 
prescriptions from this tab. 

• Medical Notes – Displays all medical notes for this patient. You can also update Draft or Tentative 
medical notes. 

• Lab – Displays all laboratory work for this patient. 

• Vital Signs – Displays all of the patient’s vital signs/weight history. View a graph of a vital sign by 
clicking the Graph  button displayed in the column header (available only for Numeric and 
Numeric List vital signs). You can also view any comments by hovering the cursor over any 
comment boxes  that may display next to a vital sign. 

Patient 
History 
area 
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Distinguishing Information Types in the Patient History Area 

The following Entry Type icons are used in the lines that appear in the Patient History area to help you 
quickly distinguish the information type at a glance.  

  Check in information   Medical notes 

  Finalized estimate signed by the client   Diagnoses 

  Items invoiced   Problems 

  Accepted item from the Patient Visit List   Physical exam/Patient Advisor* exam 

  Item declined to history   Prescription history 

  Recommended item from Patient Visit List   Laboratory results 

  Performed item from Patient Visit List   Patient images 

  Performed item   Departing instructions 

  Saved correspondence document   Call backs 

  Title only of a correspondence document   Vital signs/weight history information 

 

Viewing Options for the Patient History Area 

Do any of the following to customize your view of patient history information on the Patient Clipboard: 

• Click the Full Size View/Normal View button to toggle back and forth between a full size view and 
regular size view of the Patient History area.  

• Click the Preview button to change the Patient History area display to a split pane that includes the 
history tabs on the left and a history Preview pane on the right. The Preview pane provides a fully 
graphical display of any medical note, correspondence document or IDEXX Lab Report that is 
selected in the Summary, Text or Medical Notes or Lab tab.  

• When using the Preview pane, you can drag the vertical splitter bar to adjust the relative size of the 
history tabs panel to the size of the Preview pane. 

• To hide Whiteboard medical notes on the Summary, Text and Medical Notes tabs, select the Hide 
Whiteboard Notes check box (located in the bottom right corner of the Patient Clipboard). 

• To hide voided items (voided medical notes, voided vital signs sets, etc.), select the Hide voided 
items check box (located in the bottom right corner of the Patient Clipboard). 
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Finding Information in the Patient History Area 

• To search for a word in one of the tabs, click Find, enter all or part of the word and click Find. Click 
Find Next to search for other occurrences of the word. (Note: The Find button is not available on 
the Summary tab or the Vital Signs tab.) 

• To view patient history information for a specific date, click Go To Date. The pop-up calendar will 
display. Select the date and click OK. 

• To sort entries in a patient’s history display, click on the Date, Type or Staff column heading. For 
example, to sort by date, click on the Date heading. 

• To refresh a patient’s history with the newest information, in any of the Patient History area tabs, 
right-click on a column heading (Date, Staff, etc.) and select Refresh. The patient’s history is 
updated with any new items that may have been entered from other workstations. 

• To view a quick tooltip-style text pop-up for a line in patient history, using the mouse, hover the 
cursor over the history line. 

• To specify a start date for displaying information in patient history, in any of the Patient History area 
tabs, right-click on a column heading (Date, Staff, etc.) and select Set Start Date. The pop-up 
calendar will display. Select the earliest date of the patient’s history to display. 

• To navigate through a patient’s history using the keyboard, use the PAGE UP, PAGE DOWN, HOME, 
END and arrow keys. 

• Use the F7 and F8 keys as shortcuts to move to the next and previous lines of the same type. 

Preview 
pane 

Full Size View/ 
Normal View 
button 

Preview/Close Preview 
button 

Patient 
History 
tabs 

Splitter 
bar 
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Tip: To print the Patient History Report, click the Print History button located below the Patient History 
area.  

Filtering Information Displayed in the Patient History Area 

Depending on how extensively your practice uses Cornerstone features such as departing instructions 
and check-in notes, the history for some patients may contain more information than you can easily view 
or scroll through quickly. If this is the case, you can filter information to display only certain types of 
history lines in the Patient History area tabs. 

To filter the information displayed in the Patient History area: 

1. On the Patient History area Summary or Text tab, right-click on a column heading (Date, Staff, 
History) and select Filter. The Filter dialog box appears. 

 
Filter dialog box 

2. In the Filter box, select the type of information to display. Highlighted information types appear in 
patient history. 

3. Select the Set as default check box to save these selections (on this workstation only) for viewing 
the patient history. 

4. Click OK to apply your filter selections to the Patient History area tabs. 

Cornerstone User’s Manual                  36 



Chapter 2: Using the Patient Clipboard* 

The Patient File 
The Patient File window provides a cut-down version of the Patient Clipboard Patient History area 
information.  

To open the Patient File: 

1. Do one of the following: 

• Click the Patient File  toolbar button. 

• On the Activities menu, select Patient File. 

• On the Patient Information window, click the Patient File button. 

2. In the ID field, enter the patient ID by typing the ID or pressing F2 to search for and select the patient 
from the Patient List. The patient’s information, picture (if available) and owner information appear. If 
the patient has more than one owner, the owner with the highest percentage of ownership appears. 

Note: If the patient has more than one owner, you can view the A/R information for either client by 
selecting the owner from the drop-down list. 

 
Patient File window 

Finding and Viewing Information in the Patient File 

• View the entire medical record by clicking Text View. To return to the short view, click Summary. 

• When you are viewing the entire record, you can search the history by clicking Find. Click Find Next 
to search for other occurrences of the word.  

• To view patient history information for a specific date, click Go To Date. The pop-up calendar will 
display. Select the date and click OK. 

• To sort entries in a patient’s history display, click on the Date, Type or Staff column heading. For 
example, to sort by date, click on the Date heading. 
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• To refresh a patient’s history with the newest information, in any of the Patient History area tabs, 
right-click on a column heading (Date, Staff, etc.) and select Refresh. The patient’s history is 
updated with any new items that may have been entered from other workstations. 

• To view a quick tooltip-style text pop-up for a line in patient history, using the mouse, hover the 
cursor over the history line. 

• To specify a start date for displaying information in patient history, in any of the Patient History area 
tabs, right-click on a column heading (Date, Staff, etc.) and select Set Start Date. The pop-up 
calendar will display. Select the earliest date of the patient’s history to display. 

• To hide Whiteboard medical notes, select the Hide Whiteboard Notes check box. 

• To hide voided items (voided medical notes, voided vital signs sets, etc.), select the Hide voided 
items check box. 

• To navigate through a patient’s history using the keyboard, use the PAGE UP, PAGE DOWN, HOME, 
END and arrow keys. 

• Use the F7 and F8 keys to move to the next and previous lines of the same type. 

• To print the Patient History Report from the Patient File, click the Print History button. 
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Overview 
You can easily add or update a client’s information in the Client Information window. This information 
includes:  

• The client’s contact information (address and phone numbers) 

• Answers to client prompts 

• Notes about the client 

• Financial information 

• Referral information 

Tip: You can also set up patients from the Client Information window. (Adding a patient from Client 
Information automatically sets up the client as the patient’s owner.) 

Using the Client List 
The Client List is used to locate a client in Cornerstone. You can also view, update or delete a client’s 
information from the Client List.  

To open the Client List: 

 Click the Client  toolbar button (or select Lists > Client).  

The Client List window appears. 

 
Client List window 

Tip: You can also display the Client List in many Cornerstone windows by pressing F2 (or double-
clicking) in a Client ID field. 
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Tips for using the Client List: 

• When you open the Client List, the cursor is in the Name, Client ID, Phone, or Email Address field, 
based on the selected Sort by option. Change the search method by clicking a different option. 

• Begin a search by typing part of the name, ID, phone, or email address. As you type, the list 
includes only the items that match what you type. 

• Use the F7 and F8 keys to move forward or backward through the list of recently used clients. 

• Select the Include inactives check box to include inactive clients in your search. Inactive clients’ 
names will have an “(I)” next to the name. The next time the window is accessed on this workstation, 
the software will remember whether or not this box was selected. 

• Highlight the client’s name and click the Phone  button to the right of the phone number to 
display all of the client’s phone information, including work and cellular phone numbers. 

• Click the Clear button to start a new search. 

• Group Manager module only: Click the search Group Manager client list link to open the Group 
Manager Client/Patient Search window and search for a client record in another practice. 

To update a client’s information: 

1. On the Client List window, use fields in the Client information area to locate the client to update. 

2. Select the client and click Update (or double-click on the client). The Client Information window 
appears. 

3. Change the applicable information on the Information, Prompts/Notes, Referrals or A/R 
Information tabs. 

4. Click OK to save your changes. 

To delete a client: 

Note: You cannot delete clients with any account or patient information linked to them or any account 
activity in their records (unless you use Cornerstone purging).  

1. On the Client List window, use fields in the Client information area to locate the client to delete. 

2. Select the client and click Delete. A message appears asking you to confirm the decision.  

3. Click Yes. 

Adding or Updating Client Information 
In order to invoice a client, you must enter that client, the patient, and the client’s accounts receivable 
information into Cornerstone.  

Initial Client Setup 

If you do not have enough time to set up all of your clients and patients at once, we recommend that you 
set up clients and patients in this order: 

1. Clients and patients with appointments 

2. Clients and patients with reminders due now and in the near future 

3. Clients and patients as they come into the practice 

If you set up clients and patients in this order, you will be prepared for the clients you are most likely to 
see first. 
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Tip: To keep accounts as accurate as possible, set up clients with outstanding balances immediately, 
before using Cornerstone to invoice clients. 

Before You Begin 

• Set up the client classifications your practice uses (Controls > Classifications > Client tab). 

• Set up custom information prompts for clients (Controls > User Defined Prompts > Client tab). 

• Set Client defaults (Controls > Defaults > Practice and Workstation > select Client from the 
menu on the left). 

• Set Patient defaults if you also plan to set up patients now (Controls > Defaults > Practice and 
Workstation > select Patient from the menu on the left). 

To access the Client Information window for a new client: 

 Do one of the following: 

• On the Patient Clipboard, right-click in the Client area (top-left area) and select New. 

• Click the Client  toolbar button and then click New on the Client List window. 

• On the Lists menu, select Client and then click New on the Client List window. 

To access the Client Information window for an existing client: 

With the client’s record open on the Patient Clipboard, do one of the following: 

• In the Client area, right-click and select Update. 

• In the Client information area’s Client Information  tab, right-click and select Update (or double-
click anywhere within the tab). 

The Client Information window appears. 

 
Client Information window 

To add or update basic client information: 

1. Open the Client Information window. 
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2. For a new client, if the Auto assign option is selected in Client defaults, the Client ID is 
automatically generated by Cornerstone. Press TAB two times to accept the ID and continue to the 
Status field. 

 If your practice enters new client IDs manually, type an ID in the Client ID field and press TAB 
two times to continue to the Status field. 

3. On the Information tab, in the Status drop-down list, leave the status as Active. 

Note: If a client is marked as Inactive, an “(I)” appears next to the client’s name in the Client List. 
Reminders are not sent to clients marked as Inactive. 

4. Select a client Classification. (The classification set up in Client defaults is displayed.) 

Tip: You can set up certain classifications as alerts by selecting the Client alert check box when you 
set up the classification (in Controls > Classifications). Then in Alerts defaults (Controls > 
Defaults > Practice and Workstation > Alerts), select Classification in the Client alerts list.  

5. If the Show trainer and barn option is selected in Patient defaults (Controls > Defaults > Practice 
and Workstation > Patient), the Type field is displayed. Select a client type from the drop-down 
list. 

6. Enter the client’s name and address information. (The postal code set up in Client defaults 
(Controls > Defaults > Practice and Workstation > Client) is displayed. Postal codes set up in 
the default settings automatically populate the city.) 

Tip: In Alerts defaults, you can set up alerts to warn you if a client is missing name, address, phone, 
or email information. 

7. If you want to add another name to this client record, click the Secondary Names button and enter 
the name information. Secondary names are useful if the pet belongs to two or more people with 
different last names. This allows you to search for the client (and patient) record under more than 
one name.  

 Select the Print check box next to the secondary name to include the name on invoices and 
statements. 

8. Enter an E-mail address for the client, if applicable. Only one email address may be added per 
client record. If the Email address box is not completed, it is highlighted yellow. If the client does 
not want to provide the email address, select the Email declined check box. This turns off the 
highlight and turns off missing email alerts if you have them set up. The date you enter the 
declination is recorded. 

 If you want this client to receive reminders via email, select the E-mail reminders check box.  

9. In the Phones area, right-click to select from a menu of options for adding, updating or deleting a 
phone number. See “Setting Up and Updating Client Phone Numbers” in the next section for 
information on entering client phone information. 

Tip: Use the scroll bar on the right side of the Phones area to view additional phone numbers. 

10. In the Patients area, right-click to select from a menu of options for adding, updating or deleting a 
patient for this client. See “Chapter 4: Entering Patient Information” beginning on page 53 for 
information on entering patient information. 

11. Click OK to save your changes, or click another tab to continue entering information for this client. 

 The Client reports group includes many reports that allow you to view client information. See “Client 
Information Reports” on page 48 for information. 
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Setting Up and Updating Client Phone Numbers 
You can include as many phone numbers as needed in a client’s record.  

Tip: To access client phone numbers and any associated notes from the Patient Clipboard, click the 

Phones  tab in the Client information area. 

To add or update a client phone number: 

1. Open the Client Information window and click the Information tab.  

2. In the Phones area, right-click and select New (or double-click) to open the Phone Information 
dialog box. The area code set up in Client defaults is displayed. 

 
Phone Information dialog box 

3. Type the Phone number and Extension (if applicable). 

Note: If the phone number you enter for a new client is a duplicate of an existing phone number on 
another client’s record, an alert displays. Click Print to print a record of the client with the duplicate 
phone number or click Close to close the alert. To cancel and close the Phone Information dialog 
box without saving the phone number, click Cancel and click No when prompted to save changes. 

4. In the Location drop-down list, select the location associated with this phone number, such as 
home, work, cellular, etc. You can view the location from the Client Information window. 

5. In the Notes text box, type any notes associated with this phone number, such as times available. If 
you enter notes for a phone number, the notes  icon displays with black text lines on it in the 
phone number’s row on the Client Information window. 

6. If the client has more than one phone number and you want this phone number to be the primary 
number, select the Primary Phone Number check box. The primary phone number prints on 
reports and displays in windows that display only one phone number. 

7. Click OK to save your changes and return to the Information tab. 

8. Click OK to save your changes, or click another tab to continue entering information for this client. 

To delete a client phone number: 

1. On the Client Information window’s Information tab, in the Phones area, right-click on the phone 
number and select Delete. A message appears asking you to confirm the decision.  

2. Click Yes. 
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Answering Client Prompts and Adding Notes to Client Information 
You can use client prompts to gather the same information consistently from each client. You can also 
add a note to a client’s information. 

When you use prompts and notes, you can: 

• Create a prompt to be used as an alert. 

• Print several reports with the answers to client prompts listed. 

Tip: To access client prompt answers and notes from the Patient Clipboard, click the Prompts and 

Notes  tab in the Client information area. 

To answer client prompts or add a note to Client Information: 

1. Open the Client Information window and click the Prompts/Notes tab. 

2. In the Prompts/answers area, the client prompts that were set up in User Defined Prompts (in 
Controls > User Defined Prompts) are displayed. Type or select the answer to each prompt in the 
Answer column as applicable.  

 
Prompts/Notes tab on Client Information window 

3. In the Note text box, type any notes about this client. 

4. Click OK to save your changes, or click another tab to continue entering information for this client. 

 For a list of clients and their answers to prompts, print a Client Prompts Report.  

Tracking Client Referrals 
The Client Information window’s Referrals tab allows you to track who referred the client to the practice 
and any new customers referred to the practice by the client. Client referrals help you track your 
business sources. 

• You can identify who your best clients are and treat them accordingly. 

• You can identify which advertising media creates the most new clients so you get the most from 
your advertising budget. 

To record who referred a client: 

1. Open the Client Information window and click the Referrals tab. 
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Referrals tab on Client Information window 

2. In the Referred by area’s Client ID field, enter the ID of the client who referred this client by typing 
the ID or pressing F2 to search for and select the client from the Client List. (The information in the 
Has referred area is automatically updated as this client refers other clients.) 

3. Click OK to save your changes, or click another tab to continue entering information for this client. 

Tip: Set up advertising media as clients, and then link the media referral source to the client to track the 
effectiveness of your advertising. For example, set up clients with the last names Newspaper, Street Sign 
and Yellow Pages and mark those clients inactive so they will not display in the Client List. Now you can 
set up new clients as referred by one of the media “clients.” 

 For a list of clients who have referred other clients, the clients referred, and the year-to-date gross 
sales for each referred client, print a Referral Report.  

Setting Up Client Account Options (A/R Information) 
The Client Information window’s A/R Information tab allows you to specify how clients can settle their 
accounts and if they qualify for any discounts. 

Before You Begin 

• Set up the discounts you want to use in your practice (Controls > Discounts). 

• Set up your practice’s credit codes (Controls > Credit Codes). 

• Set up a default credit code in Client defaults (Controls > Defaults > Practice and Workstation > 
select Client from the menu on the left). 

To set up invoicing and billing options in the client’s A/R Information: 

1. Open the Client Information window and click the A/R Information tab. 
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A/R Information tab on Client Information window 

2. If this is a tax-exempt client, select the Tax exempt check box. 

3. Change the Credit code, if necessary. (If a default credit code has been set up in Client defaults, 
the Credit code field displays the default credit code that applies to most clients.)  

Note: If you designate a client as “Cash Only” and the client attempts to pay with a check, an alert 
appears at the time of payment (if the Credit Code client alert is selected in Alerts defaults). 

4. In the Monthly charges area, if monthly charges should be applied (when applicable) for this client, 
select the Finance charge and/or Billing charge check boxes. 

5. Select any Discounts to apply to this client (highlighted/shaded discounts are selected). The 
discounts will apply to invoice items that are also set up with this discount.  

6. Multi-Location/Single Database configuration only: In the Home practice drop-down list, select the 
home practice to be associated with this client and to be printed on the client’s monthly statement. 

Note: When using a Multi-Location/Single Database configuration, every client must have a home 
practice assigned. At the time when the Multi-Location/Single Database option is activated, the 
primary practice is automatically designated as the home practice for all clients. However, the clients 
can later be assigned to different practices using the Assign Clients to Practice tool. See “Chapter 3: 
Setting Up Lists and Information” in the Cornerstone Administrator’s Manual for more information. 

7. Click OK to save your changes, or click another tab to continue entering information for this client. 

 To see how accounts receivable information has been set up for clients, print a Client A/R 
Information Report.  

Merging Clients and Patients 
If you have clients with different last names who together are responsible for a patient, you may have set 
up two different accounts for the clients. If desired, you can merge these records into one record. 

To merge client (or patient) records: 

1. On the Tools menu, select Merge Clients/Patients.  

2. A message appears to remind you that merging should be performed during times of low system 
use. Click Yes to continue.  

The Merge Clients/Patients dialog box appears. 
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Merge Clients/Patients dialog box 

3. Under Merge Type, specify the type of record to merge—Client  or Patient  (click the icon to 
change the record type). The cursor automatically moves to the corresponding From field (Client ID 
or Patient ID). 

4. In the From table’s Client ID (or Patient ID) column, enter the ID of the first client/patient by typing 
the ID or pressing F2 to search for and select the client/patient from a list. Once the From 
client/patient is selected, the cursor moves to the To table. 

5. In the To table’s Client ID (or Patient ID) column, enter the ID of the second client/patient by typing 
the ID or pressing F2 to search for and select the client/patient from a list. 

6. Repeat steps 3–5 for any additional clients/patients to be merged. 

7. Click OK to merge the clients/patients.  

8. The status bar in the bottom-left corner of the dialog box shows the number of IDs merged 
successfully and the number of errors. If there were any errors, click Print to view a description of 
the error on the Merge Clients/Patients Report. 

9. If you want to clear the dialog box, click Reset. 

10. When you are finished, click Close. 

Setting Up New Client Accounts (for New Cornerstone Practices only) 
Use the following set of instructions only if you are setting up a new Cornerstone system and your 
existing client accounts have not been converted to Cornerstone accounts. In most cases, client 
account balances are automatically converted as part of the initial conversion process and do not need 
to be manually entered into Cornerstone. 

Before You Begin 

 Enter an adjustment comment in Account defaults (Controls > Defaults > Practice and 
Workstation > select Account from the menu on the left). For example, an initial adjustment 
comment might be “Client set up in system 00/00/00.” 
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To set up a new client’s account: 

1. Do one of the following: 

• On the Patient Clipboard, select the client and in the Client information area, click the Account 

Information  tab. Right-click within the transactions table and select Adjustment. 

• Click the Client Account  toolbar button, enter the Client ID and press TAB, and then click 
Adjust. 

• On the Activities menu, select Client Account. Enter the Client ID and press TAB, and then 
click Adjust. 

The Adjustment dialog box appears.  

 
Adjustment dialog box 

2. In the Comment box, enter the reason for the adjustment. (The adjustment comment from defaults 
displays automatically.) 

3. Type the amount this client owes in the corresponding boxes in the Adjusted column. 

Note: At the bottom of the Adjusted column: 

• Total due reflects what the client now owes your practice. 

• Adjustment reflects the total amount you are adjusting. 

4. Click OK to return to the Client Account window. The Accounts Receivable balances are updated. 

 To view a list of new clients, print the New Client Report. You can print this report for any time period 
processed—End of Day, End of Month or End of Year.  

Client Information Reports 
Cornerstone includes several reports related to client information.  

To access Client reports: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 

2. In the Reports list, click the plus sign to the left of Client to expand the list of client reports. 
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Client Reports  

Note: You can print or preview information for a range of clients (or other relevant filter). See “Chapter 5: 
Using Reports” beginning on page 81 for information. 

Client A/R Information 

Use the Client A/R Information Report to see how accounts receivable information has been set up for 
clients. 

 

 

Client Account History Report 

Use the Client Account History Report to see all transactions (including payments, adjustments, 
transfers, comments, returned checks and written off transactions) within a client’s account history, as 
well as the running balance.  

Note: If Multi-Location/Single Database is activated, the practice ID of the practice where the transaction 
took place appears at the end of each line in account history. 

To print the report for one client, when specifying a range on the Client Account History dialog box, enter 
the client’s ID in both the Starting value and Ending value fields. 

Cornerstone User’s Manual                  49 



Chapter 3: Entering Client Information 

To hide voided items, click the Hide voided items check box on the Client Account History dialog box. If 
you include voided items, note that both the original record and the record of the void will display. 

Note: This report contains all of the financial account data from the selected clients. If you have a large 
database, this report may take a long time to generate. Enter a range to narrow the report results. 

 

 

Client Discounts 

Use the Client Discounts report to check and update your discount strategy. 

 

 

Client Master Report 

Use the Client Master Report to generate a list of your clients, their addresses, email addresses and 
phone numbers. 

 

 

Client Prompts Report 

Use the Client Prompts Report to see answers to client prompts.  
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Client/Patient Master Report 

Use the Client/Patient Master Report to generate a list of clients and patients.  

 

 

Initial Client Setup Report 

Use the Initial Client Setup reports to review your Cornerstone system settings. 

 

 

Mailing Labels 

Use the Mailing Labels report to save client name and address information to a file. You can save the file 
in any of the following file formats: .txt, .xls, .csv, .slk, .wks, .wk1, .dif, .clp, .psr or .dbf.  

Note: For mailing labels, you can only choose Save As when saving a file. See “Saving a Report to a 
File” on page 90 for information.  

 

Merge Clients/Patients Report 

This report provides a list of clients who have merged their client records into one record. For example, if 
two clients marry and each has a record at your practice, they can choose to merge their records into 
one. 
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Referral Report  

Use the Referral Report to see how much income has been generated from different sources. The report 
shows you the effectiveness of different advertising media and provides a reference to send letters of 
appreciation to referring clients and clinics. 

 

 

Voided Invoices Report 

This report provides a list of voided invoices. You can choose to print a list of voids by Client ID, Staff ID 
or Void date. 
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Overview 
You can easily add or update a patient’s information in the Patient Information window. This information 
includes: 

• Name 

• Status (active, inactive or deceased) 

• Classification 

• Sex and birth date 

• Species and breed 

• Color, markings and registration number 

• Weight and body score (if activated) 

• Owner information 

• Microchip and registration information 

From Patient Information, you can also access: 

• A patient’s reminders and call backs 

• Prompt answers and/or notes about the patient 

• Referral information 

• Prescriptions 

• Diagnoses 

• Patient images 

Using the Patient List 
The Patient List is used to locate a patient in Cornerstone. You can also view, update or delete a 
patient’s information from the Patient List.  

To open the Patient List: 

 Click the Patient  toolbar button (or select Lists > Patient).  

The Patient List window appears.  
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Patient List window 

Tip: You can also display the Patient List in many Cornerstone windows by pressing F2 (or double-
clicking) in a Patient ID field. 

Tips for using the Patient List: 

• When you first open the Patient List, the cursor is either in the Name, ID, Vaccine tag or Microchip ID 
field, based on your selection in the Sort by area. Change the search method by clicking a different 
option. 

• Begin a search by typing part of the Name or ID. As you type, the list includes only the items that 
match what you type. 

• Use the F7 and F8 keys to move forward or backward through the list of recently used patients. 

• Click the Include inactives/deceased check box to include inactive patients in your search. Inactive 
patients’ names will have an "(I)" next to the name. The next time the window is accessed on this 
workstation, the software will remember whether this box was selected. 

• To accommodate herd vaccinations, when searching for a patient using the Vaccine tag field on the 
Patient List, you can enter any tag number that falls within the range of tags for the herd, and 
Cornerstone will locate the patient record for the herd. 

• Click the Clear button to start a new search. 

• Group Manager module only: Click the search Group Manager patient list link to open the Group 
Manager Client/Patient Search window and search for a patient record in another practice. 

• The primary owner of each patient appears in the Patient List. To view the owner’s primary phone 
number or to see other owners and their information, open the Patient Owner Information box by 
clicking the Client  button in the Patient List. You can then view all of a patient’s owners and 
owners' primary phone numbers. 
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Patient Owner Information box accessed from the Patient List 

Note: On the Patient Owner Information pop-up window, you can view the primary phone number for 
each owner. 

Adding or Updating Patient Information 
You can add or update a patient’s basic information from the Patient Information window’s Information 
tab. 

Before You Begin 

• If the new patient belongs to a new client, set up the client first. See “Adding or Updating Client” on 
page 40.  

• Set Patient defaults (Controls > Defaults > Practice and Workstation > select Patient from the 
menu on the left). 

To access the Patient Information window for a new patient: 

 Do one of the following: 

• On the Patient Clipboard, select the client, and then right-click in the Patient list area and select 
New. 

• Click the Patient  toolbar button and then click New on the Patient List window. 

• On the Lists menu, select Patient and then click New on the Patient List window. 

• Right-click and select New under Patients at the bottom of the Client Information window. 

To access the Patient Information window for an existing patient: 

With the patient’s record open on the Patient Clipboard, do one of the following: 

• In the Patient list area, right-click the patient’s name and select Update (or double-click the patient 
name). 

• In the Patient information area’s Patient Information  tab, right-click and select Update (or 
double-click anywhere within the tab). 
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To add or update basic patient information: 

1. Open the Patient Information window. 

2. For a new patient, if the Auto assign option is selected in Patient defaults, the patient ID is 
automatically generated by Cornerstone. Press TAB two times to accept the default ID and continue 
to the Name field. 

 If your practice enters new patient IDs manually, type a patient ID in the ID field and press TAB 
two times to continue to the Name field. 

 
Information tab (for a new patient) on the Patient Information window 

3. For a new patient, type the patient’s name in the Name field. 

4. In the Status drop-down list, leave the status as Active unless the patient is deceased or you do not 
want to send reminders about this patient. If the patient is deceased, change the status to 
Deceased and enter the date the patient died.  

5. If necessary, select the patient Class. (The class that has been set up in Patient defaults appears 
automatically.) 

6. Enter the patient’s Sex. 

7. Enter the patient’s Birth date by entering either the date (e.g., 12/1/2008) or the age of the animal 
(e.g., 1Y, 6 M and 4D).  

8. Select the Species and Breed from the drop-down lists. 

9. Select the patient’s Color from the drop-down list or type it in the box and enter any Markings. 
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10. The Weight / Body Score area options that display differ depending on whether you are adding a 
new patient or updating information for an existing patient: 

• For a new patient – Enter your Staff ID and the patient’s Weight in the fields provided. Optionally, 
you can also enter a Body Score if this vital sign has been activated for your practice.  

• For an existing patient – Click the Vital Signs/Weight  button to display the weight entry 
dialog box for the patient. Here you can enter a current weight and, if desired, click the add 
more Vital signs link to open the full Vital Signs entry and viewing window. See “Chapter 16: 
Recording Vital Signs/Weight Information” beginning on page 229 for information on entering 
vital signs. 

Note: The button displays in red/yellow  as an alert if at least one vital sign (other than weight 
and body score) has not been entered for the patient within the past 10 days. 

11. If the Show trainer and barn option has been enabled in Patient defaults, the Trainer and Barn 
fields display on the Information tab. Press F2 in either field to select a trainer or barn to designate 
for this patient. If applicable, select a Send Rmd check box if you want to send the patient’s 
reminders to the trainer or barn instead of to the owner. 

12. If you opened the Patient Information window from the Client Information window, the client appears 
in the Owners area. To set up the patient’s ownership, see “Setting Up Patient Ownership” in the 
next section.  

13. If applicable, enter the Microchip ID and Registration information for the patient. (If you have 
microchip IDs entered in patients’ records, you can search by microchip ID from the Patient List.) 

14. For a new patient, the Add Existing Rabies Tag button is available. Click this button to enter an 
existing tag into the system, if the patient was issued a tag elsewhere and you want to document the 
tag information in its record.  

Note: You can also enter an existing tag into the system from the Patient Clipboard—in the Patient 
information area, select the Tags/Microchip ID tab, and then right-click in the tab’s tag listing area 
and select Add Existing. 

15. Click OK to save your changes, or click another tab to continue entering information for this patient. 

 The Patient reports group includes many different reports that allow you to view patient information. 
See “Patient Information Reports” on page 73 for information.  

Setting Up Patient Ownership 
Each patient in Cornerstone must have an owner. Ownership information is kept in the Patient Owner 
Information window. This information includes: 

• The owner’s client ID 

• The client’s status (current or past owner) 

• The Send Reminders option 

• The dates the ownership began and ended 

• The percentage of the animal this client owns 

Note: You can link more than one client to a patient. 
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Before You Begin 

 If the new patient belongs to a new client, set up the client first. See “Adding or Updating Client” on 
page 40. 

To add patient owner information: 

1. On the Patient Information window, right-click in the Owners area and select New (or double-click in 
the Owners area). 

The Patient Owner Information dialog box appears. 

 
Patient Owner Information dialog box 

2. In the Client field, enter the client ID by either typing the ID or pressing F2 to search for and select 
the client from the Client List. 

 If you opened Patient Information from Client Information, the client information is entered. Press 
the TAB key to accept the ID. 

3. Verify the client’s status is Current. (Past owners do not receive reminders.) 

4. If you want this client to receive reminders, select the Send reminders check box. Owners with the 
Send reminders check box selected are considered Flagged Owners.  

5. The Ownership details area settings default to the current date and 100% ownership. Change the 
ownership details, if necessary. 

6. Click OK. 

7. If necessary, repeat steps 1–6 to add another owner. The total percentage of all ownership must 
equal 100%. 

Note: If a patient has more than one owner, select the Send reminders check box for the client(s) 
responsible for fulfilling reminders. 

8. On the Patient Information window, click OK to save your changes, or click another tab to continue 
entering information for this patient. 

Tip: You can select the Alerts default for Multiple Ownership to notify you when a patient has more 
than one owner. (On the Controls menu, select Defaults > Practice and Workstation, and then 
select Alerts in the navigation pane on the left.) 

To change ownership for an existing patient or to transfer from one client to another: 

1. Before changing ownership, make sure that all of the clients involved are already set up in 
Cornerstone. 
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2. From the Patient List, select the patient and click Update. 

3. In the Patient Information window’s Owners area, right-click on the owner to modify and select 
Update. The Patient Owner Information displays. 

4. If necessary, change the client’s status. 

5. If applicable, type the new Ownership percentage (the percentage of the patient this client now 
owns). The Date of ownership defaults to the current date. Change the date, if necessary. 

6. To delete an owner, press CTRL+D. 

7. Click OK. 

8. On the Patient Information window, click OK to save your changes, or click another tab to continue 
entering information for this patient. 

Adding Patient Letter Reminders (Postcards, Letters and Emails) 
Letter reminders are an important tool in the Cornerstone system. You should add reminders for each 
patient to prompt them to return for needed services in the future. 

You can enter reminders directly in a patient’s record from the Letters tab on the Patient Reminders 
window’s Letters tab. You can also enter reminders on an invoice. 

Before You Begin 

• Set up a reminder strategy for your practice. See “Chapter 14: Setting Up a Reminder System” in the 
Cornerstone Administrator’s Manual for information. 

• Link letter reminders to invoice items on the Reminders tab on the Invoice Item Information window. 
See “Chapter 10: Setting Up Your Invoice Items” in the Cornerstone Administrator’s Manual for 
information. 

To add patient letter reminders: 

1. With the patient’s record open on the Patient Clipboard, in the Patient list area, right-click the 
patient’s name and select Reminders.  

2. Click the Letters tab. 

 
Patient Reminders window Letters tab 
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Note: Overdue reminders display in red. Reminders that are due in the next 30 days display in 
yellow. 

3. To add a reminder for an item, in the Item ID column, enter the item by either typing the ID or 
pressing F2 to search for and select the item from the Invoice Item List. The Invoice Item Description 
appears. 

Note: You cannot add a reminder for a group item. 

4. Change the Date to the date the reminder is due. 

5. In the Staff ID field, enter the staff member who performs the service by either typing the ID or 
pressing F2 to search for and select the staff from the Staff List. The staff member's name appears. 

6. To delete an existing reminder, click the Item ID of the reminder you want to delete and press 
CTRL+D. 

7. To add a reminder note, click the Note button at the end of the item row. The Note dialog box 
appears. Reminder notes display on the Reminder Report and on the Daily Planner, but not on the 
printed reminders.  

8. Type the Note and click OK. The note text displays in the Reminder note area at the bottom of the 
Patient Reminders window. Reminders for which you’ve typed a note will show the Note button 
followed by ellipses (Note…). 

9. To print a list of patients with overdue reminders, click Print and then do one of the following: 

• To print reminders for all of the client’s patients, select Client All Patient > Reminder Letter 
Report. 

• To print reminders for only the selected patient, select Patient only > Reminder Letter Report.  

10. To print a health certificate (set in Patient defaults) listing current vaccinations for this patient, click 
Print and then select Health Certificate. The Start New Document window appears with the 
certificate template selected. Click OK to open the document in the Cornerstone Editor. Make any 
necessary changes or additions to the document, and then click Print. Click Close to close the 
Cornerstone Editor and then click Cancel to close the Start New Document window. 

11. On the Patient Reminders window, click OK to save your changes and close the window. 

Changing the Due Dates for Patient Reminders 

You can change the due date of a single reminder by clicking the arrows in the Date box or by using the 
pop-up calendar. However, to save time when changing the due dates for a block of reminders, use the 
Change Date feature. 

To change the due date for more than one reminder: 

1. On the Patient Reminders window, select the reminders to change the due date on by clicking the 
row number to the far left of each reminder. (The selected rows will be highlighted/shaded.) 

2. Click Change Date. The Change Date dialog box appears. 
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Change Date dialog box 

3. In the Date change area, specify if you want to enter a new date or simply increase the number of 
months. 

4. If you are changing the date, enter the new Date. 

5. If you are increasing the current date by a number of months, type the number of Months. 

6. Click OK to save your changes. 

Adding Patient Call Back Reminders 
Call back reminders provide you with an easy way to keep track of clients who need follow-up phone 
calls, such as a follow-up call after surgery or a call to report on a hospitalized animal. You can view call 
backs on the Reminder Recall Report or on the Daily Planner Call Backs tab.  

Note: You can change the date for one or more call back reminders. See the previous section for more 
information. 

Before You Begin 

• Link call back reminders to invoice items on the Reminders tab on the Invoice Item Information 
window. See “Chapter 10: Setting Up Your Invoice Items” in the Cornerstone Administrator’s Manual 
for information. 

• If you plan to work with laboratory call backs on the Daily Planner Diagnostics tab, you must first 
create a Lab Call Back invoice item (to use for creating or scheduling new call backs) and then 
specify this item ID in Daily Planner defaults. 

To add patient call back reminders: 

1. With the patient’s record open on the Patient Clipboard, in the Patient list area, right-click the 
patient’s name and select Reminders.  

2. Click the Call Backs tab. 
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Patient Reminders window Call Backs tab 

Note: Overdue reminders display in red. Reminders that are due in the next 30 days display in 
yellow. 

3. To add a reminder for an item, in the Item ID column, enter the item by either typing the ID or 
pressing F2 to search for and select the item from the Invoice Item List. The Invoice Item Description 
appears. 

Note: You cannot add a reminder for a group item. 

4. Change the Date to the date the reminder is due. 

5. In the Staff ID field, enter the staff member who performs the service by either typing the ID or 
pressing F2 to search for and select the staff from the Staff List. The staff member’s name appears. 

6. To delete an existing reminder, click the Item ID of the reminder you want to delete and press 
CTRL+D. 

7. To add a reminder note, click the Open or Pending button at the end of the item row. The Note 
dialog box appears. 

 
Note dialog box 

8. In the Staff ID field, type your staff ID and press TAB. 

9. From the Status drop-down list, select the status of the reminder call back (Open, Pending or 
Completed). Open call backs are deleted if an invoice item set to satisfy the reminder is added to 
the invoice. If you have added notes to the call back, but it is not complete, select Pending. 
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10. To enter a note, type your note in the text box or click Select Note and select a note from a list of 
commonly used call back notes.  

 
Call Back Notes dialog box 

11. Click OK to close the Note dialog box. The note text displays in the Reminder note area at the 
bottom of the Patient Reminders window. Reminders for which you’ve typed a note will show the 
note button followed by ellipses (Pending…). 

12. To print a list of patients who need to be called, click Print and then do one of the following: 

• To print call back reminders for all of the client’s patients, select Client All Patient > Reminder 
Recall Report. 

• To print call back reminders for only the selected patient, select Patient only > Reminder 
Recall Report. 

13. On the Patient Reminders window, click OK to save your changes and close the window.. 

To add a note to a call back in invoicing: 

1. When an invoice item with a call back reminder is entered on an invoice, a Call back Note dialog box 
appears.  

Note: If you do not want to enter call back notes during invoicing, you can turn off this option by 
clearing the Prompt for call back note check box in Invoice defaults. 

 
Enter Note dialog box in invoicing 

2. To enter a note, type your note in the text box or click Select Note and select a note from a list of 
commonly used call back notes. 

3. Click OK to exit the Enter Note dialog box and return to the invoice. 
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Viewing Call Backs on the Daily Planner 

To view call backs on the Daily Planner: 

1. On the toolbar, click the Daily Planner  button or from the Activities menu, select Daily 
Planner.  

2. On the Daily Planner window, select the staff member for whom you want to view call backs or 
select the View for all staff check box to view call backs for the entire staff. 

3. Click the Call Backs tab.  

4. Select the time period for which to view call backs. A list of clients and patients who need a call back 
during the selected time period appears.  

 
Call Backs tab on the Daily Planner 

Working with Laboratory Call Backs on the Diagnostics Tab 

The Daily Planner Diagnostics tab provides a single location for managing many of your laboratory-
related tasks in Cornerstone, including lab call backs. The Call Backs columns (Status, Date and Staff 
ID) allow you to keep track of lab call backs at a glance and access call back options with a single click. 

 
Diagnostics tab on the Daily Planner 
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In the Call Backs Status column, the status is indicated on the button. When updating the status, use 
the following definitions as your guide: 

• (blank) – A call back has not been performed or scheduled (created) for the laboratory result. 

• Open – A call back has been performed or scheduled (created), but the client has not yet been 
contacted. 

• Pending – A first call back has been initiated (e.g., called and left message) and notes have been 
added, but this call back has not yet been completed. 

• Completed – The client has been contacted, notes have been added, and no further call backs are 
needed. 

To record a first call back immediately for a listed laboratory result: 

1. Click the blank status button associated with the result and select Call now. The Call now dialog 
box appears. 

 
Call now dialog box 

Tip: All phone numbers for the client are provided near the top of the Call now dialog box, with the 
primary number at the top of the list. 

2. Enter the staff ID of the staff member who is making the call. 

3. Depending on whether the client was contacted, set the call back status to Open, Pending or 
Completed. 

4. To enter a note regarding the call status, type your note in the text box, or click Select Note and 
select a note from a list of commonly used call back notes. 

5. If you want to reassign this call back, select the Reassign this Call Back check box and enter the 
desired staff and date to be assigned for processing the call back at a later date. 

6. Click OK. 

To schedule a first call back for a listed laboratory result: 

1. Click the blank status button associated with the result and select Schedule a call back. The 
Schedule a call back dialog box appears. 
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Schedule a call back dialog box 

2. Enter the staff ID of the staff member you are scheduling to make the call. 

3. Set the date for the scheduled call back. 

4. To enter a note for this call back, type your note in the text box, or click Select Note and select a 
note from a list of commonly used call back notes. 

5. Click OK. 

To update an open or pending call back: 

1. Click the Open or Pending status button associated with the result. The Note for [lab call back item] 
dialog box appears. 

 
Note for [lab call back item] dialog box 

2. Enter the staff ID of the staff member who is making the call. 

3. Depending on whether the client was contacted, set the call back status to Open, Pending or 
Completed. 

4. To enter a note regarding the call status, type your note in the text box, or click Select Note and 
select a note from a list of commonly used call back notes. 

5. Click OK. 
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To view notes for a completed laboratory call back: 

 Click the Completed status button associated with the result. All associated call back notes display 
in a view-only dialog box. (Call back notes are also available in patient history, if needed for future 
reference.) 

Answering Patient Prompts and Adding a Patient Note 
Record customized information about a patient in the Prompts/Notes tab. The answers to patient and 
species prompts and patient notes appear on the Check-In Report and are useful when the patient 
visits. You can also select patient prompts to be used as alerts. 

Tip: To access patient prompt answers and notes from the Patient Clipboard, click the Prompts and 

Notes  tab in the Patient information area. 

To answer patient prompts and add a note to Patient Information: 

1. Open the Patient Information window and click the Prompts/Notes tab. 

2. In the Prompts/answers area, the patient prompts that were set up in User Defined Prompts (in 
Controls > User Defined Prompts) are displayed. Type or select the answer to each prompt in the 
Answer column as applicable. 

 
Prompts/Notes tab on Patient Information window 

3. In the Note text box, type any notes about this patient. 

4. Click OK to save your changes, or click another tab to continue entering information for this patient. 

  For a list of patients and their answers to prompts, print a Patient Prompts Report. 

Adding Referral Information for a Patient 
The Patient Information window’s Referrals tab allows you to document the referring doctor and hospital 
when a patient is referred to your practice. You can also view the referral history of the patient. For 
detailed information about Referral Relationship Management, see “Chapter 29: Using Referral 
Relationship Management” on page 403. 

Tip: To access a patient’s referral information from the Patient Clipboard, click the Referrals  tab in 
the Patient information area. 
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Before You Begin 

 Set up referring hospitals, referring doctor classifications and referring doctors. See “Chapter 23: 
Setting up Referral Relationship Management” in the Cornerstone Administrator’s Manual for more 
information. 

To add referral information for a patient: 

1. When a patient is referred to your practice, add a client record for the patient’s owner, if necessary, 
and add a new patient record for the referred patient. 

2. In the patient’s record, on the Patient Information window, click the Referrals tab.  

 
Referrals tab on Patient Information window 

3. In the Doctor field, select the referring doctor from the drop-down list. 

4. If this referring doctor is the primary referring doctor for this visit, select the Primary option.  

5. For each doctor (including the primary doctor) that you want to receive communications regarding 
this visit, select the This visit check box. 

6. In the Hospital field, select the referring hospital from the drop-down list. 

Note: If an incorrect referral doctor or referral hospital is accidentally added to a patient’s record, the 
invalid referral can be deleted by selecting the line and pressing CTRL+D. Once an invoice has 
been created for the patient after adding referral information, you cannot delete the referral 
information. 

7. Click OK to save your changes, or click another tab to continue entering information for this patient. 

Tip: When you are checking in a referral patient for a recheck, click the Recheck check box on the 
Patient Check-in/out window. This will help you track your referrals appropriately (new or recheck). 
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Adding a Pet Picture 
For each patient added to Cornerstone, you can add a picture to display in the Pet Picture box on many 
windows throughout Cornerstone. 

 

You can also set up Workstation defaults to print a pet picture on the Boarding Check-in Report, Check-
in Report, Estimate, Invoice, Prescription Label, Rabies Certificate and Reminders.   

Importing an Existing Picture 

You can create a pet picture image in another program and then import the image into the Cornerstone 
Pet Picture box. You can import image files in many different formats, including common formats such 
as bitmap, JPEG and TIFF. The image can be imported from a CD/DVD or from other locations on your 
hard drive or server. 

To import a pet picture image: 

1. Open the patient’s record in the Patient Clipboard, Patient Information window, Patient Visit List or 
Patient File. 

2. Right-click the Pet Picture box and select Capture > File.  

3. Browse to locate and select the file to import, and then click Open. The image appears in the Pet 
Picture box. (An imported picture replaces any existing image.) 

Capturing a New Patient Picture Image 

If you have a TWAIN-compliant image source (such as a scanner or a digital camera), you can capture a 
new image and place it in the Pet Picture box. 

Before You Begin 

 You must use a TWAIN-compliant image source to capture a pet picture image. 

To capture a new image with your TWAIN-compliant image source: 

1. Open the patient’s record in the Patient Clipboard, Patient Information window, Patient Visit List or 
Patient File. 

2. Right-click the Pet Picture box and select Capture > TWAIN. 

3. Choose your device from the Select Source dialog box. 

The software for the image device you use opens.  

4. Use the software as usual. Depending on your device software, the image may automatically be 
placed into Cornerstone, or you may have to manually choose to return to Cornerstone.   

Note: Cornerstone automatically resizes images to fit in the Pet Picture box. 

5. When the image appears in the Pet Picture box, click OK to save it. 

Editing a Pet’s Picture 

If necessary, you can crop, rotate, adjust contrast and brightness, and make other modifications to a 
pet’s picture. 
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To edit a pet picture: 

1. Open the patient’s record in the Patient Clipboard, Patient Information window, Patient Visit List or 
Patient File. 

2. Right-click the Pet Picture box and select Update. The image appears in the Image Manipulation 
window.  

3. From the Image Toolbox (shown below), select the image tool that you want to use to change the 
image’s appearance.  

4. To use a tool, click its button. When you are done using the tool, click the button again to deselect 
the tool. 

5. When you are finished, click the Close button in the Image Toolbox and then click Yes to save your 
changes. 

Image Toolbox 

 

 

 

 

 

 

 

 

 

 

 
 

Note: In the Image Toolbox, those buttons that do not apply to Pet Picture will be disabled.  

Zoom Options 

Zoom allows you to increase the detail of the image that can be viewed. When Zoom In and Zoom Out 
are chosen, Cornerstone automatically makes the adjustment. When Zoom Any is chosen, a box will 
display. Enter the Zoom percentage and click Apply. When Mouse Driven Zoom is selected, you can 
click on an area of the image, and that area will be enlarged. 

Fit to Window/Actual Size 

The Fit to Window button places the entire image in your window. The Actual Size button displays the 
image at 100% (as it will print). 

Magnifying Glass 

The Magnifying Glass button works like a magnifying glass. When this tool is selected, click on any 
area of the image to view the area in great detail. When you are finished using the magnifying glass 
feature, click the button again to turn off the option. 

Note: You will not be able to crop an image if you have the magnify tool selected. 

 

 

Zoom In 

Zoom Any 

Fit to Window 

Magnifying Glass 

Rotate 90 

Rotate 270 

Flip Horizontal 

Contrast and Brightness 

Invert 

Zoom Out 

Mouse Driven Zoom 

Actual Size 

Advanced Magnifying Glass 

Crop 

Undo All Changes 

Rotate 180 

Rotate Any 

Flip Vertical 

Contrast and Brightness Slider 

 

Save As 

 

Close 
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The Advanced Magnifying Glass Settings button displays a dialog box that allows you to change the 
settings of the magnifying glass tool. These settings are saved only until you close Cornerstone. 

• The Height and Width fields set the height and width (in pixels) of the magnifying glass. 

• The Zoom field determines the magnification of the tool. In the example below, the magnifying glass 
would magnify the image eight times larger than the original size. 

 
Magnify Advanced Settings dialog box 

Crop 

The Crop button allows you to cut out unnecessary parts of an image. To crop an image, click and drag 
a square selection box around the part of the image that you want to keep. The image will automatically 
be cropped. 

Note: You will not be able to crop an image if you have the magnify tool selected. 

Rotate 

Using the Rotate buttons, the image can be turned by 90, 180 or 270 degrees. If you select Rotate Any, 
you can enter the number of degrees you want to turn the image. Click the Clip check box if you want to 
keep the image the original size. (When you clip, you may lose part of the image.) Click Apply to apply 
your changes. 

 
Rotate Any dialog box 

Flip 

Using the Flip Horizontal button or the Flip Vertical button, the image can be flipped horizontally or 
vertically. 

Contrast/Brightness 

To change the contrast and brightness of an image, click the Contrast and Brightness button. Position 
the mouse in the image, click and drag up and down to adjust the brightness. Click and drag left and 
right to adjust the contrast.  

Sliding Scale for Contrast and Brightness 

To change the contrast and brightness of an image using a movable slider on a scale, click the 
Contrast and Brightness Slider button. 

Invert 

Click the Invert button to automatically invert the color in your image. 
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Undo All Changes 

The Undo All Changes button allows you to undo all changes you have made to the image during this 
editing session. 

Save As 

1. To save the image to a file, click the Save As button. 

2. Enter a name for the graphic and choose a file type. Supported formats include bitmap, JPEG, 
JPEG 2000 and TIFF. 

3. Click Save. 

Deleting a Pet’s Picture 

If you decide you no longer want to use a pet’s picture, you can delete it from the Pet Picture box. 

To delete a Pet Picture image: 

1. Open the patient’s record in the Patient Clipboard, Patient Information window, Patient Visit List or 
Patient File. 

2. Right-click the Pet Picture box and select Delete. A message appears asking you to confirm your 
decision. 

3. Click Yes. 
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Patient Information Reports 
Cornerstone includes several reports related to patient information.  

To access Patient reports: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 

2. In the Reports list, click the plus sign to the left of Patient to expand the list of patient reports. 

 
Patient Reports  

Note: You can print or preview information for a range of patients (or other relevant filter). See “Chapter 
5: Using Reports” beginning on page 81 for information. 

Legend of Patient History Codes 

A legend explaining the codes in a patient’s history is on the bottom of patient record reports. These 
codes include: 

B = Billing charge 

C = Medical note 

CB = Call back 

CK = Check-in 

D = Diagnosis 

DH = Declined to History 

E = Examination 

I = Departing Instruction 

L = Lab result 

M = Image case 

P = Prescription 

PA = PVL Accepted 

PB = Problem 

PR = PVL Recommended 

R = Correspondence 

T = Image 

TC = Tentative Medical note 

W = Weight 
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Animals Without Birthdates Report 

Use the Animals Without Birthdates Report to maintain your patient records.  

 

 

Animals Without Weight Report 

Use the Animals Without Weight Report to maintain your patient records.  

 

 

Birthday Report 

Use the Birthday Report to generate a list of patients and their birthdates. This report also includes 
clients’ addresses so practices can send “birthday” cards to pets. Choose the type of owner to include 
and the date range for the birthdates. 

 
Birthday Report Selection dialog box 
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Census Report 

Use the Census Report to track which patients have been checked into or out of your practice. 

 

 

Checked-In Census Report 

Use the Checked-in Census Report to track patients currently checked into your practice. Use this report 
to see a current status of checked-in patients and the rooms they have been assigned.  

 

 

Deceased Patient Report 

Use the Deceased Patient Report to list your deceased patients along with the owners’ names and 
addresses. The report can be saved to a file in a .csv or a .txt file format. This allows you to send 
sympathy letters or other correspondence to owners with deceased pets. 

 

 

Initial Patient Setup Report 

Use the Initial Patient Report - Species Prompt Report to see the species prompts currently set up in 
your Cornerstone system. Print the Initial Patient Setup Report before setting up species and breeds. 

 

 

Cornerstone User’s Manual                  75 



Chapter 4: Entering Patient Information 

Microchip ID Report 

The Microchip ID Report includes patients’ Microchip IDs and lists their owners, including owners’ 
addresses and telephone numbers. You can choose to print this report for active or inactive clients 
and/or patients. 

 

 

Patient By Name Report 

Use the Patient by Name Report to generate a list of clients and patients. Unlike the Client/Patient 
Master Report, you can print a range of patients (using Patient ID). 

 

 

Patient Diagnosis Report 

Use the Patient Diagnosis Report to contact clients whose animals have been diagnosed with a specific 
assessment to inform them of new medicines or treatments.  
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Patient History Report 

The Patient History Report is useful when you want to view a patient’s complete history with your 
practice. On the Patient History Report dialog box, you can choose the types of history to include in the 
report. 

 
Patient History Report dialog box 

Selecting/filtering information for the Patient History Report: 

• In the Range area, to view history for a particular patient, type the patient ID (or press F2 to search 
for and select the patient from the Patient List) in the Starting value and Ending value fields. To 
view history for patients within a particular date range, type the applicable dates (or press F2 to 
search for and select a date using the calendar) in the Starting value and Ending value fields. 

Note: If a range is not specified, Cornerstone will include medical history data for all patients. If you 
have a large database, this report may take a long time to generate.  

• In the History list, select the types of history information to include in the report (highlighted/shaded 
lines are selected). Click Select All to select all types of history information in the list, or click 
Deselect All to deselect all types. 

• Select the Show prices check box to include prices in the report. 

• Select the Hide voided items check box if you do not want to include voided items (e.g., voided 
medical notes, voided vital signs sets, etc.) in the report. 

• Select the Hide Whiteboard items check box if you do not want to include Whiteboard medical 
notes in the report.  

• Select the Print full page images check box if you want to include full page printouts of patient 
images in the report. 
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Patient Prompts Report 

The Patient Prompts Report is useful when you want to view answers to a specific prompt.  

 

 

Patient Visit List Report 

Use the Patient Visit List Report to print the Patient Visit List for a particular patient or patients. 
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Rabies Tag Report 

Use the Rabies Tag Report to print a list of patients who have received rabies vaccinations. This rabies-
specific report is useful for those practices that are required to submit rabies tag information to a state 
agency. 

 

 

Reminder Letter Report 

Use the Reminder Letter Report to print a list of patients with overdue reminders.  

Note: Equine practices can use the equine version of this report (in the Equine report group) to print a 
list of patients with overdue reminders by barn or by trainer. Note that to use the barn or trainer range, 
you must have the Show trainer and barn check box selected in Patient defaults. 

 

 

Reminder Recall Report 

Use the Reminder Recall Report to print a list of patients who should be called. This report can be sorted 
by client ID, client last name, invoice item description, invoice item ID, patient ID or reminder date. 

Note: Equine practices can use the equine version of this report (in the Equine report group) to print a 
list of patients, by barn or by trainer, who should be called. Note that to use the barn or trainer range, 
you must have the Show trainer and barn check box selected in Patient defaults. 
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Reminder Report 

Use the Reminder Report to print a list of patients with reminders. Only active animals are included by 
default. Inactive or deceased animals are included only if selected when the filter is run. This report is 
sorted by client ID, client last name, invoice item description, invoice item ID, patient ID or reminder date. 

Note: Equine practices can use the equine version of this report (in the Equine report group) to print a 
list of patients with reminders, by barn or by trainer. Note that to use the barn or trainer range, you must 
have the Show trainer and barn check box selected in Patient defaults. 

 

 

Tentative Medical Note Report 

Use the Tentative Medical Note Report to print a list of patients with templates or comments in their 
patient record that have been marked as tentative and still need to be finalized.  

 

 

Vaccine Tag Report 

Use the Vaccine Tag Report to print a list of all vaccination tags (including rabies) that have been issued 
by the practice.  
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Once you have your IDEXX Cornerstone* Practice Management System up and running, you can use 
Cornerstone data to analyze your practice and help you determine how to increase your profitability. The 
data you need is easy to collect with Cornerstone reports.  

About the Report Search Window 
The Report Search window (Reports > Find a Report) allows you to search, browse, view details and 
create a report—all from a single window. In addition, this window provides one-click access to view 
samples of each report, which allows you to easily verify the contents and layout of a report before 
creating it. 

 
Report Search window 
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The Reports List Area  

The Reports list displays all reports (or the results of a search) in a tree-style list, with all reports 
displayed according to group. Report groups are shown on the first level of the tree, furthest to the left. 
Reports (or in some cases, subgroups) are shown in the next expanded level.  

 

When browsing through the Reports list to locate 
a report, expand (and collapse) report groups as 
needed: 

• Click the plus sign [+] to open a report 
group and display the reports (or 
subgroups) within it. 

• Click the minus sign [-] to close the report 
group and hide the reports within it. 

• Click expand all or collapse all to quickly 
expand or collapse all report groups at 
once. 

 

The Reports list serves as both a search results display and a browse tree. If a search has not been run, 
all reports display in the Reports list by group, in alphabetical order (Appointment group, Boarding 
group, Client group, etc.). If you have performed a search, the resultant groups are ordered according to 
the search results ranking. For example, if the best match for a search on “PVL” is a report under the 
End of Day group, End of Day displays as the first group, and so on. 

Tip: At any time, you can click Reset to clear the search term and return the Reports list group order 
back to its original alphabetical listing. 

The Search Tool  

Many staff members may find that using the search 
tool on the Report Search window is the fastest way to 
locate a particular report. Simply type a keyword or 
phrase in the Search text box to filter reports to a 
subset of matching results. Cornerstone searches for 
your keyword in the report name, description, filters 
and fields, and then displays the ranked results in the 
Reports list.  

The search tool uses a standard search syntax, similar 
to common web-based search engines. It also has 
thesaurus-like intelligence built in, so common 
variations or abbreviations in Cornerstone will be 
included automatically. For example, a search on 
“dog” will automatically include “canine” in the search, 
and a search on “PVL” will automatically include 
“Patient Visit List” in the search. 

Search results are first sorted by the report groups 
that best match the search criteria. Then, each 
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matching report is listed within its expanded report group and sorted by closest to least-closest match. 

The 1st, 2nd, 3rd... icons indicate the top five reports that match your search criteria, with the top 
ranking report automatically selected in the tree. 

If your search generates a large number of matching reports (as often happens when searching on a 
commonly used keyword, such as “services”), Cornerstone lists only the best matches to save you time 
in locating the desired report. The #/# shown indicator shows the number of best-matching reports 
displayed, out of the total number of matching reports (e.g., 57/105 shown). If desired, you can click 
show all matches to display all matching reports. To return to the list of best matches only, click show 
best matches. 

Additional notes for searches: 

• If you know the name of a frequently used report, type all or part of the report name in the Search 
text box to quickly locate the report. 

• You can type up to 100 characters in the Search text box. 

• At any time, you can click Reset to clear the search term and return the Reports list group order 
back to its original alphabetical listing. 

Advanced search tips: 

• Phrase searches – Type words within quotation marks to search for multiple words in exact order. 
For example, “price change reason” gives different results than price change reason.  

• Boolean searches – The operators AND, OR and NOT are supported in uppercase, with grouping 
supported using parentheses. For example, you might search on (daily OR monthly) AND “sales 
tax” to find reports that include sales tax information—specifically daily or monthly reports. 

• Filtered searches – Place a plus sign (+) in front of an essential word that is required in the search. 
Place a minus sign (-) in front of a word to prohibit the term from the search and narrow the results. 
For example, -month +“deposit report” will filter out monthly reports from your search of deposit 
reports. 

 

Locked Reports 

The Cornerstone Security Setup feature allows an administrator to specify report access permissions for 
each staff member. By default, in the Reports list, locked reports for the logged-in staff member are 
designated by a small lock  icon displaying to the left of the report name. If you click on a locked 
report, the report’s details and sample display as usual, along with a note indicating that you do not 
have permission to run this report (the Create report button is disabled for locked reports). 

 

If you select the Hide locked reports check box, reports for which the staff member does not have 
access permissions (locked reports) are removed from the currently displayed Reports list. When 
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running a report search, this narrows the search results to display only those reports that are accessible 
by that staff member.  

Tip: If the Hide locked reports check box is selected, the number of hidden reports, if any, is displayed 
in parentheses (  ). 

The Report Details and Sample Area  

When you select a report in the Reports list, the Report Details area in the right pane displays report 
information and a segment of a report sample. This allows you to quickly verify the report contents and 
layout before electing to create the report. 

Note: Report details and a sample are not available for custom reports created by your practice using 
the Client and Patient Report Builder. 

For each report, you can view: 

• Report fields 

• Report description 

• Any calculations used in the report 

• Report sample segment  

• Full page sample preview 
(accessible by clicking + enlarge sample) 

 

 

 

 

 

 

 

 

Creating a Report 
Note: The steps below apply when creating a single report. To print multiple selected End of Period 
reports at once, select Reports > End of Period, and then select End of Day, End of Month or End of 
Year. See “Section 6 – End of Period Processing” in the Cornerstone Administrator’s Manual for 
information. 

To find and create a report: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 
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Report Search window 

2. Do one of the following to find the desired report: 

• In the Search text box, type a search keyword or phrase and click Search. The top five report 
matches are displayed in ranked order within their expanded report groups. The top ranking 
report is automatically selected in the tree. (See “The Search Tool” on page 82 for more 
information.) 

• In the Reports list, click a plus sign [+] to open a report group and display the reports (or 
subgroups) within it and browse through the reports. (See “The Reports List Area” on page 82 
for more information.) 

3. Click on a report in the Reports list to view the report details and a sample in the right-side pane. 

4. If desired, click +enlarge sample (located below the report sample image) to view a full-page 
preview of the sample report. 

5. To create a report, double-click the report name in the Reports list or highlight it and click Create 
report. (Note: For Inventory reports, click Create report and then click Run.) 

6. Depending on the type of report you are creating, different options are available: 

• For standard Cornerstone reports, a Filters dialog box appears. If applicable, set the sort order 
and specify a range to filter the information that displays on the report. See the “Filtering 
Information in Reports” section that follows for more information. 

• For Boarding reports, the Boarding Reports dialog box appears. Press F1 on this dialog box for 
help with setting the Boarding report options. 

• For Client and Patient reports, the Custom Client and Patient Reports dialog box appears. 
Click Update to change the highlighted report’s selection criteria, or click Run to create and 
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preview the report. See “Custom Client and Patient Report Builder” on page 91 for more 
information. 

• For Compliance reports, the Compliance Assessment Tool wizard appears. See “Chapter 26: 
Compliance Assessment Tool” in the Cornerstone Administrator’s Manual for information on 
generating Compliance reports. 

• For End of Day, End of Month and End of Year reports, select the period you want the report 
to reflect. For most reports, you can print information for more than one continuous period. To 
do this, click the earliest period and then press and hold the SHIFT key while you click the last 
period. All of the periods in between are highlighted. See “Section 6 – End of Period 
Processing” in the Cornerstone Administrator’s Manual for information on printing End of Period 
reports. 

Note: For End of Period reports, if a Filters dialog box is available for the report, it appears after 
clicking Preview, Print or Save As.  

• For Inventory reports, the Inventory Reports window appears. With the desired report 
highlighted in the list, click Run. If applicable, set the sort order and specify a range to filter the 
information that displays on the report. See “Inventory Reports” on page 329 for more 
information on Inventory reports. 

• For Performance Tracker reports, the Performance Tracker window appears. See “Chapter 27: 
Cornerstone Performance Tracker” in the Cornerstone Administrator’s Manual for information on 
generating Cornerstone performance tracker reports. 

• For Snapshot reports, the Snapshot Options dialog box appears. See “Viewing Report 
Snapshots” on page 95 for information on setting up and printing Cornerstone snapshot 
graphs. 

7. For standard Cornerstone reports, do one of the following: 

• Click Preview to view the report in the Reports Preview window. 

• Click Print to set print options and print the report. 

• Click Save As to specify a file name and type for saving the data to a file. 

Filtering Information in Reports 
There are several reasons why you may want to print a portion of a report (or filter report information): 

• You may not need all of the information contained within the report. (For example, you may want to 
print a report for invoice items with a specific class.) 

• You have a large database and your printer cannot print the entire report at one time. (You can print 
a portion of the report before printing another portion.) 

What Are Filters? 

Filters control the range of data included in a report. Different reports have different filter options (and 
some reports do not have filters). The filter options allow you to narrow the focus of a report. Narrowing 
the focus of a report is especially useful if you have a large database and are printing a report that 
contains a lot of information (like the Client Account Report, Patient History Report or Sales Information 
Reports). 

If the report you select has filters, the Filters dialog box automatically appears when you click Create 
report. 
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Here is an example of a Filters dialog box for the Rabies Tag Report: 

 

Using Filters 

The Sort order determines the order for displaying information in the report.  

The Range allows you to filter the information to narrow the amount of information that appears in the 
report. 

• In the Description box, you will find the filters available for this specific report.  

• Once you have selected the filter Description, type (or press F2 to select) the Starting Value and 
Ending Value. (For example, if you want to print a report listing information for a specific date, type 
the same date in both fields.) A few reports use filters that require a letter code. The table below 
shows these letter codes. 

Filter Letter Code  

Reminder Type C = Call 
L = Letter 

 

Invoice Item Type S = Service items   
 I = Inventory items 
G = Group items 

P = Pick items 
D = Dispensing items 

• You can select more than one filter for a report. If you use multiple filters, you must select And or Or 
at the end of a row before beginning a new row. 

Note: If you leave the filters blank, the report prints all of the available information. 

Using And/Or Statements 
You must use And/Or statements if you want to use multiple filters. And/Or statements tell Cornerstone 
to find information that meets the selected conditions. 

• If you select And, Cornerstone includes information that meets both criteria. 

• If you select Or, Cornerstone includes information that meets either of the criteria. 

For example, you could set the following filters for the Rabies Tag Report: 

Description Starting value Ending value And/Or 

Date Issued 01/01/09 12/31/09 AND 

Tag ID 500 1000  

 

In this scenario, you would generate a report of rabies tag information of only those rabies tags issued 
on January 1, 2009 through all of December 31, 2009 that have a tag number between 500 and 1000. 
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If you choose: 

Description Starting value Ending value And/Or 

Date Issued 01/01/09 12/31/09 OR 

Tag ID 500 1000  

 

In this scenario, you would generate a report of rabies tag information from all rabies tags issued on 
January 1, 2009 through all of December 31, 2009, as well as any rabies tags with an ID between 500 
and 1000 (issued on any date). 

Controlling How Information Appears in Reports 
The previous section discusses how you can narrow what information is included in a report. This 
section discusses how the information you have selected actually appears. 

The sort order determines the order that information appears in the report. If you sort by a name, 
Cornerstone starts at the beginning of the alphabet.  If you sort by a date, the earliest date appears first. 
If you sort by ID, however, you may see information that does not appear to be sorted “numerically.”  
This special case is discussed next.   

How Cornerstone Sorts IDs 

If you are sorting by ID or using ID as a filter, the Cornerstone system uses an alphanumeric sorting 
process (which lets you use alphanumeric IDs if you want). This means, however, that Cornerstone 
treats numbers like letters when it sorts based on IDs. (This is the same way a dictionary sorts entries.) 

When you look at a report, the IDs may not appear to be sorted “numerically.” The ID 10 appears after 1 
and before 2. If you want a “numerical” sort, you must set up your IDs starting at a large enough number 
that digits will not have to be added. For example, setting your client IDs to start at 1000 allows your 
practice 9999 IDs before another digit is required (10000). 

This is an example of the way Cornerstone sorts IDs: 

In the dictionary: In Cornerstone: 

b 1 

ba 10 

baa 100 

baab 1001 

baac 1002 

c 2 

 

Previewing Reports 
In Cornerstone, the Reports Preview window allows you to: 

• Quickly check data before proceeding with another procedure (such as using the Deposit Report to 
balance your cash drawer during the day). 

• View information for one client, invoice item or other Range option. 

• Check information before printing (to save paper). 

Note: You can preview only one report at a time. 
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To preview a report: 

1. Create the report.  

2. Depending on the type of report, set any applicable filters or select the applicable processing period 
(for End of Period reports). 

3. Click Preview. 

The report appears in the Reports Preview window.  

 
Reports Preview window 

Note: Inventory reports are displayed in a different preview window. See “Inventory Reports” on 
page 329 for more information. 

4. To maximize the window to view a larger area of the report, click the Maximize  button in the 
upper right corner of the Reports Preview window. To resize the window to view a larger area of the 
report, move the cursor to an edge of the window (the cursor changes to an arrow), and then click 
and drag the edge to resize the window. 

5. At this point you can click Print to print the report, click Save to save the report as a file for use with 
another program, or click Cancel to close the Reports Preview window. 

Printing Reports 
Often you will want to keep a hard copy of information, such as End of Period reports or a Reminder 
Recall report. 

Before You Begin 

 Assign the printer to print the report or assign the default printer. See “Assigning Printers in 
Cornerstone” on page 23.  

To print a report: 

1. Create the report. 

2. Depending on the type of report, set any applicable filters or select the applicable processing period 
(for End of Period reports). 

3. Click Print. 

Depending on the report you are printing, the Cornerstone Print Options dialog box may appear (not 
all reports offer print options).  
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Cornerstone Print Options dialog box 

Note: The report print options for Inventory reports appear in a different dialog box. See “Inventory 
Reports” on page 329 for more information. 

4. If necessary, on the Cornerstone Print Options dialog box, change the number of copies to print, set 
specific pages to print or select to print odd or even pages only (for double-sided printing). 

5. To change the printer selection for a single report, click the Printer button, select a printer from the 
list, and click OK. 

6. Click OK to print the report. 

The report prints on the printer assigned for the report or the default printer if no printer has been 
assigned. 

Saving a Report to a File 
If you want to be able to import Cornerstone data into another program (such as a spreadsheet or word 
processing program), you must save the report as a file. 

You can save the report in any of the following formats: .txt, .xls, .csv, .slk, .wks, .wk1, .dif, .clp, .psr or 
.dbf.  

To save a report as a file: 

1. Create the report. 

2. Depending on the type of report, set any applicable filters or select the applicable processing period 
(for End of Period reports). 

3. Click Save. 

The Save As dialog box appears. 
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Save As dialog box 

Note: The save options for Inventory reports appear in a different dialog box. See “Inventory 
Reports” on page 329 for more information. 

4. Select a location in the Save in drop-down list or the browsing area below it.  

5. In the File name text box, type a name for the file. 

6. In the Save as type drop-down list, select a format in which to save the file. By default, Cornerstone 
will save the report as a .txt file. 

7. Click Save. 

Saving a Report as a PDF File 
Using the Printer Selection dialog box to select the Cornerstone PDF printer, you can save a report in 
PDF format and use the document with other software or as an email attachment. 

To save a report as a PDF file: 

1. On the Cornerstone Print Options dialog box, click Printer. 

2. Select Cornerstone PDF and click OK. 

3. Click OK in the Cornerstone Print Options dialog box. The Save As dialog box appears. 

4. Select a location in the Save in text box or the browsing area below it, type a name in the File name 
text box, and click Save.  

Custom Client and Patient Report Builder 
You can create your own reports with the Custom Client and Patient Report Builder and narrow the 
scope of your report based on selected criteria (for example, client sales, postal codes and patients’ 
species). Name and save your custom report to use in the future. The report can be printed, saved as a 
file, or used to print mailing labels. 

To create a new report: 

1. On the Reports menu, select Client and Patient Report Builder. 

2. Click New. The New/Edit Custom Report window appears. 
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New/Edit Custom Report window 

3. In the Report name field, type a name for the report. Required. 

4. From the List results in order of drop-down list, select the order in which you want to display the 
results.  

5. In the Range field, enter a range if needed. 

6. To build a client report, click the Client Information tab (shown above) or to build a patient report, 
click the Patient Information tab,  

7. Enter the selection information you want to use to build your report. For specific report results, enter 
detailed criteria. See “Custom Report – Client Information Tab” on page 93 and “Custom Report – 
Patient Information Tab” on page 94.  

For example, to search for clients who spent between $400 and $500 this year, enter the dollar 
range in the Sales this year fields. To narrow the scope of the report, select clients who spent 
between $400 and $500 and live in a specific postal code area. 

8. Click Save to save your report criteria or click Cancel to exit without saving criteria. 

To print a custom report or print mailing labels based on a report: 

When you preview a custom report, you can print the report, print mailing labels based on the report or 
save the report as a file.  

Tip: The mailing label option uses Avery® 5160 labels. 

1. On the Reports menu, select Client and Patient Report Builder. A list of saved custom reports 
displays. 

2. From the list, select report and click Run. A preview of the report appears. 
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3. Choose one of the following options: 

• Click Print to print the report and click OK. 

• Click Labels, select the printer on which you want to print labels and click Print.  

• Click Save to save to a file. Type a file name, choose a file format (.txt, .csv, etc.) and click 
Save. 

To change report criteria: 

1. On the Reports menu, select Client and Patient Report Builder. 

2. Select the report you want to change and click Update. 

3. Make changes and click Save. 

To copy a report: 

To save time, you can copy an existing report and modify the criteria. Both the original report with the 
original criteria and copied report with modifications are saved and included in the Custom Reports list. 

1. On the Reports menu, select Client and Patient Report Builder. 

2. Select the report you want to modify and click Copy. 

3. Type a name for the modified report. 

4. From the List results in order of drop-down list, select the order you want to display the results in.  

5. In the Range field, enter a range if needed. 

6. Change the selection criteria on the existing report as needed.  

7. Click Save to save the copied report or click Cancel to exit without saving the report. 

Custom Report – Client Information Tab 

 
Client Information tab of the Client and Patient Report Builder 

Date record created: Includes client records based on the date the client record was created in the 
software.  
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Last invoice date: Includes client records based on the date that the last invoice was generated for 
a client. 

Number of patients: Includes client records based on the number of patients owned (in whole or in 
part) by a client. 

Sales this year: Includes client records based on how much they were charged for products and 
services year to date. 

Sales last year: Includes client records based on how much they were charged for products and 
services during the previous calendar year. 

Credit code: Includes client records based on the credit code on the client record. 

Postal code: Includes client records based on the postal code on the client record. One or more 
postal codes may be selected. 

Client balance: Includes client records based on the balance owed in a selected time period. Enter 
a dollar amount and choose whether you want to include clients with a balance greater than, less 
than or equal to the amount entered.  

Include inactive clients: Click this check box to include inactive client records in the report. If this 
box is not checked, only active client records will be included in the report.  

Client classification: Includes client records based on the client classifications on the client record. 
One or more classifications may be selected. 

Custom Report – Patient Information Tab 

 
Patient Information tab of the Client and Patient Report Builder 

Date record created: Includes records based on the date the patient’s record was created in the 
software. 

Last visit date: Includes records based on the date patient was last seen. 

Birth date range: Includes records based on patient birth dates. 
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Include inactive patients: Click this check box to include inactive patients in the report. If this box is 
not checked, only active patients will be included in the report. 

Include deceased patients: Click this check box to include deceased patients in the report. If this 
box is not checked, deceased patients will not be included in the report. 

Species: Includes records based on the species on the patient record. One or more species may 
be selected. 

Breed: Includes records based on the breed on the patient record. One or more breeds may be 
selected. 

Sex: Includes records based on the sex on the patient record. One or more sexes may be selected. 

Patient classification: Includes records based on the classification on the patient record. One or 
more classifications may be selected. 

Items included in patient history: Includes records based on whether an invoice item is found in 
the patient’s history. Press F2 to select from a list of items used at your practice. You can also enter 
a date range for the items. Click the Match all criteria check box if you entered more than one item 
and want to include only patients that have all of the items in their patient record. If this check box is 
not selected, patients who have at least one of the items listed, but not necessarily all of them, will 
be included in the report. 

Items not included in patient history: Includes records based on whether an invoice item is not 
found in the patient’s history. Press F2 to select from a list of items used at your practice. You can 
also enter a date range for the items. Click the Match all criteria check box if you entered more than 
one item and want to include only patients that have none of the items in their patient record. If this 
check box is not selected, any patient who has at least one of the items listed will not be included in 
the report. 

Viewing Report Snapshots 
A snapshot is a quick picture of your practice’s activity. To make a snapshot, Cornerstone takes data 
from End of Month processing periods and graphs the information. You see the results immediately! 

Using the Cornerstone snapshot feature, you can select the type of data to display and how you want 
the data displayed. 

Tip: You can view samples of snapshot graphs on the Report Search window (select Reports > Find a 
Report) by clicking on a report in the Snapshot report group. The report details and a sample display in 
the right-side pane. 

Before You Begin 

 An initial End of Month report must be processed before using Cornerstone’s snapshot feature for 
the first time. 

To view and print a snapshot graph: 

1. On the Reports menu, select Snapshot. The Snapshot window appears.  
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Snapshot window 

2. Cornerstone automatically displays the last graph viewed on this computer. You can change the 
way the graph appears by selecting a different option from the Type drop-down list. 

3. To view different data, click Options. The Snapshot Options dialog box appears. 

 
Snapshot Options dialog box 

4. Select the Group from which to gather data: Practice, Species or Staff. 

• If you select Species, you must enter a species ID. 

• If you select Staff, you must enter a staff member’s ID.  

5. Select the data to Graph. See “Available Snapshot Graphs” on page 97.  

6. Select the Period(s) from which to gather data. If you want to view data for more than one period, 
click the first period, press and hold the SHIFT key and click the last period. All of the periods in 
between are highlighted. 

Note: If you use multiple periods, they must be contiguous. 

Note: The periods and data are taken from EOM closings; select Current to see data from the 
current period.  

7. In the Type drop-down list, select the display type. See “Snapshot Graph” on page 98.  

8. Clear the Gridlines check box if you do not want to view gridlines in the graph. 
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9. Clear the Print in Color check box if you have a color printer, but do not want the graph to print in 
color. (You do not have to clear the Print in Color check box if you are using a single-color printer.) 

10. When the mouse pointer is over a graphical depiction of data, a floating pop-up box displays the 
EOM closing date and the actual numerical value represented. Clear the Display Details check box 
if you do not want the pop-up box to appear. 

11. Click OK. The snapshot appears.  

12. Click Print to print the graph to the default printer. 

13. Click Close to close the Snapshot window. 

Available Snapshot Graphs 

Practice 

Within the selected period(s): 

• Active, Inactive Clients for Practice shows the number of clients in your practice, broken down by 
active and inactive clients. 

• Average Net Invoice by Practice shows the average net invoice amount for all invoices (after taxes 
and discounts). 

• Current, 30 Day, 60 Day, 90 Day Breakdown for Practice shows all client’s A/R balances, broken 
down into Current, 30, 60 and 90 day balances. 

• Net Income for Practice shows the net income for your practice (after taxes and discounts). 

• Net Sales, Payments for Practice shows all sales and client payments made. 

• Number of Invoices by Practice shows the number of invoices processed. 

• Number of New Clients for Practice shows the number of new clients entered into Cornerstone. 

• Service/Inventory/Gross Sales for Practice shows the dollar amount of your practice’s service, 
inventory and gross sales. 

Species 

For the selected species and within the selected period(s): 

• Active, Inactive, Deceased Patients by Species shows the number of active, inactive and 
deceased patients. 

• Average Invoice by Species shows the average invoice amount. 

• Number of Invoices by Species shows the number of invoices processed. 

• Service/Inventory/Gross Sales for Species Dollar shows the amount of service, inventory and 
gross sales. 

Staff 

For the selected staff member and within the selected period(s): 

• Average Invoice by Staff shows the average invoice amount a specific staff member billed. 

• Number of Invoices by Staff shows the number of invoices posted. 

• Service/Inventory/Gross Sales by Staff shows the dollar amount of a staff member's service, 
inventory and gross sales. 
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• Total Sales for Staff shows the dollar amount of a specific staff member's gross sales (before taxes 
and discounts). 

Snapshot Graph Formats 

You can display a snapshot in any of the graph formats listed below. Regardless of the chosen format, 
the data will remain the same. 

Note: You can change the type of graph in the snapshot window by selecting a different type. 

There are three basic parts to a graph: the series, the categories and the values. 

• The series are the set of data points represented by color on the graph. Many graphs have multiple 
series: red, green and blue. The legend explains which data is represented by each color. 

• The categories are the divisions of data. Snapshot only uses EOM closing periods and the current 
period as categories. 

• The values are the numerical values of the data displayed. This may be an amount (in dollars) or a 
number (of patients). 

Note: If you print snapshots to compare different staff member or species data, make sure that the 
values and categories are equivalent before comparing the printed graphs. 

Bar and Column Graphs 

Bar and column graphs are typically used to display noncontiguous data. The only difference between 
bar and column graphs is their orientation; in bar graphs data values are plotted along the horizontal (X) 
axis and categories are plotted along the vertical (Y) axis. Column graphs display the data values along 
the Y axis and categories along the X axis.  

                                                                    

Line Graphs 

Line graphs are typically used to display continuous data. The values appear on the vertical (Y) axis and 
the categories (EOM closing periods) appear on the horizontal (X) axis. If a snapshot includes multiple 
line graphs, a legend that identifies what each line represents appears. 

 

                                                                     

 End o f  Mon th per iod  

C
a 
 t 
e 
g 
o 
r 
y 

Va lue  

Types of bar graphs:  
bar, stacked and 3D stacked. 
(A 3D bar is also available.) 

Types of column graphs:  
column, stacked and 3D stacked. 
(A 3D column is also available.) 

V 
a 
l 
u 
e 
s 

A line graph shows one set of 
data with each line. 
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This chapter includes information on scheduling appointments and other daily usage tasks in the 
Appointment Scheduler. For information on the steps required to set up the Appointment Scheduler in 
Cornerstone, see “Chapter 12: Setting Up the Appointment Scheduler” in the Cornerstone 
Administrator’s Manual. 

 

Overview 
The Appointment Scheduler is used to track patient appointments. Once you have completed the 
Appointment Scheduler setup tasks covered in the Cornerstone Administrator’s Manual, you can begin to 
use the Appointment Scheduler for daily scheduling tasks.  

This chapter covers the following tasks to help you get started using the Appointment Scheduler: 

• Accessing the Schedule for Today window 

• Viewing a selected staff member’s schedule 

• Scheduling and managing appointments 

• Maintaining and using the Tickler file 

• Viewing the weekly schedule 

• Finding available appointment times 

• Locating a patient’s appointment 

• Checking in a patient from the Appointment Scheduler 

• Blocking unavailable appointment times 

• Printing the daily schedule of appointments 

• Purging old appointments 

• Viewing and printing the various reports available for the Appointment Scheduler  

About the Schedule for Today Window 

Accessing the Schedule for Today 

The Schedule for Today window is the main Appointment Scheduler window used for scheduling and 
tracking patient appointments. 

To open the Schedule for Today window: 

 Do one of the following: 
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• On the Patient Clipboard, in the Client information or Patient information area, click the 

Scheduled Appointments  tab, and then right-click within the tab and select New or 
Update. 

• Click the Schedule for Today  toolbar button. 

• On the Activities menu, select Appointment Scheduler > Schedule for Today. 

• On the Invoice window, click the Make Appt button. 

The Schedule for Today window appears. 

 
Schedule for Today window 

When you open the Schedule for Today, you see the current schedule for the day. Each box represents 
one time unit (either 10 or 15 minutes, depending on how you have set up your practice hours). Notice 
that the rooms run along the top of the schedule and the times along the left side. Times allocated for 
lunch display in yellow. Other unavailable periods display in gray. 

Tip: The Schedule will update each time you double-click on an appointment time slot or click the 
Schedule button. 

Schedule for Today Display Options 

You can specify the information to display using the options available across the top and along the 
bottom of the Schedule for Today window. 

• Staff – Select a staff member to view their scheduled appointments for the day, along with the 
applicable client and patient. (All other appointments will appear without appointment information.) If 
a staff member’s hours are different from practice hours, the schedule will display their time in the 
Time column on the far left in black. Times allocated for lunch appear yellow, other unavailable 
periods appear gray.  
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Note: Only those staff members who have staff hours set up in the Staff Setup window (select 
Controls > Appointment Scheduler > Staff Setup) display in the Staff drop-down list. 

• Suite – Select a suite of rooms to display on the Schedule for Today. 

• Template – Display the template assigned to the specific day of the week. If necessary, select a 
different template from the drop-down list. 

• From/To – Select the timeframe to display on the Schedule for Today. 

• Display staff – Displays an “X“ to the right of an appointment to indicate that one or more staff 
members is scheduled at that time, for this column. Displays a “\” next to an appointment to indicate 
that no staff member is assigned to the column in that time slot, based on the staff time check 
boxes selected on the appointment. 

• Display check-in/check-out – Displays an “I” or “O” to the right of an appointment to indicate that 
the patient is checked in (I) or checked out (O). An empty box indicates the appointment has not 
been checked in or out. 

• Prev Day/Next Day – Displays the previous/next day’s schedule. 

• Go To – Displays a calendar that allows you to select a specific day and go to that day’s schedule. 

• Today – Displays the schedule for the current date. 

Right-Side Buttons 

Use the buttons along the right side and bottom of the schedule as you enter appointments. 

  Use: To: 

    Schedule an appointment in the selected time slot. 

   Update the selected appointment. 

   Check a patient into the hospital. 

   Move the selected appointment. 

   Block times (so appointments cannot be scheduled). 

   Delete the selected appointment. 

   Search for available appointment times. 

   Locate an existing appointment. 

   Open the Tickler File of deleted appointments. 

   Enter notes about the day’s schedule. 

   View details about the selected appointment. 
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   Print the schedule. 

   Open the weekly schedule. 

   Close the daily schedule. 

 

Right-Click Menus 

You can use right-click menus for quick, easy access to many scheduling tools. 

 If you right-click in an empty (unscheduled) time block, the following menu displays:  

 

 If you right-click in a scheduled time block, the following menu displays: 

 

Click to select the command to perform, or click outside of the menu to cancel. 

(X) Column 

The column on the far right of the daily schedule (after all the rooms) indicates several things about the 
daily schedule: 

• An X in the column shows that one or more staff members are scheduled at that time. If the 
background box is yellow, one or more staff members are double-booked for that time slot. If the 
background is red, one or more staff members are triple-booked for that time slot. 

• A \ indicates that no staff members are assigned to the appointment scheduled in that time slot. 

Viewing a Selected Staff Member’s Schedule 

To view a staff member’s schedule: 

1. Open the Schedule for Today window. 

2. At the top left corner of the schedule under the date, click the arrow next to All Staff. 

3. From the drop-down list, select the staff member whose schedule you want to display. (Only staff 
members who have hours set up appear on the list.) 

Note: If a staff member’s hours are different from practice hours, the schedule will display their time in 
the Time column on the far left in black text. Times allocated for lunch appear yellow, other unavailable 
periods appear gray. 
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Scheduling and Managing Appointments 
When an appointment is added to the schedule, appointment information is displayed in the schedule, 
as space allows. Longer appointments (using more time units) have room to display more information. 

Tip: When new appointments are made, if your practice uses boarding reservations, your IDEXX 
Cornerstone* Practice Management System can automatically check to see if any boarding reservations 
exist for the patient in the next 30 days. If reservations exist, an alert appears to notify your staff.  

To schedule an appointment: 

1. On the Schedule for Today window, if your practice has staff members with different hours, select 
the schedule for a specific staff member. 

2. Double-click in an available time slot in the schedule or select a time slot and click Schedule. 

The New Appointment dialog box appears.  

 
New Appointment dialog box 

3. In the Client ID field, enter the client ID by either typing the ID or pressing F2 to search for and 
select the client from the Client List. The selected client’s account information displays. 

4. In the Patient ID field, enter the patient ID by either typing the ID or pressing F2 to search for and 
select the patient from the Patient List. The selected patient’s reminders display. 

Tip: When you press F2 to select a client or patient, the client or patient used most recently is 
displayed. Press the DELETE or BACKSPACE key to view the complete Client or Patient List. 

5. In the Confirmed on field, enter the date the appointment was confirmed (or click the Confirm 
button to insert the current system date). If the appointment is confirmed, an asterisk (*) will appear 
on either side of the client’s name in the schedule. 

6. In the Primary drop-down list, select the primary reason for the patient’s visit. (Only reasons for visit 
set up in Appointment Scheduler appear.) If goals, staff member, time units, etc. are linked to the 
reason for visit, the applicable fields will be completed automatically, but can be changed for this 
appointment if necessary.  
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7. If desired, select a secondary reason from the Secondary drop-down list or type a different 
secondary reason in the field. (Note that a primary reason must first be specified in order to activate 
the secondary reason field.) 

8. In the Staff field, enter the staff ID by either typing the ID or pressing F2 to search for and select the 
staff from the Staff List. 

Note: You must enter a Staff ID. Deselect all of the Staff time check boxes if you do not actually want 
time scheduled for a staff member. 

9. In the Time units field, specify the number of time units needed for this appointment. 

10. If the practice overbooks appointments, indicate which time units the staff member must be with the 
patient for this appointment by checking each applicable time unit in the Staff time check boxes. The 
amount of time that a provider actually sees a patient may be shorter than the entire appointment 
time. 

If the staff member is scheduled at the same time in a different room, the following message will 
appear: “This staff member is booked for another appointment during this time. Do you wish to 
continue?” Click Yes to continue scheduling the appointment or No to exit. 

11. If applicable, enter a two-character Prefix to appear next to the client name on the first line of the 
scheduled appointment. Use a prefix to indicate preparation procedures (for example, T1 for Tray 
#1), insurance information, or to more specifically define appointment types. 

12. If staff goals are set for the selected staff member, the information will display in the Amount field. If 
necessary, adjust the amount or, if using the Appointment items list near the bottom of the window, 
add invoice items associated with the appointment here. The revenue in the Amount field will 
display the Appointment items total instead. 

Note: Charges will transfer to the Patient Visit List (PVL) when the patient is checked in. Once 
checked in, the items can only be removed from the PVL, not the appointment. 

13. View the patient’s reminder information in the Reminders list. You may want to recommend 
additional products or services to be added to the appointment based on any reminders that are 
due or overdue. 

14. In the Notes area, enter any notes specific to this appointment. Notes appear when holding the 
mouse over the appointment, when using the View button, on the Appointment Report and on the 
Check-in Report. 

15. In the Appointment items list, add any invoice items to be associated with the appointment: 

a. In the first available row, enter the item ID by either typing the ID and pressing TAB, or by 
pressing F2 to search for and select the item from the Invoice Item List. The item information 
displays.  

b. Enter the correct Quantity. 

c. To delete an appointment item, select the item and press CTRL+D. 

Tip: Use appointment items to indicate services that need to be performed during this appointment 
or items to invoice. The items listed here will appear on the Patient Visit List. 

16. Click the Transfer invoice items to patient visit list now check box to send the invoice items 
directly to the Patient Visit List (PVL) when you save the appointment information. 

Note: Use caution with this option—if the client changes his or her mind about an item, it must be 
deleted from the PVL and not the appointment. 
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17. Click OK to place the appointment on the schedule. 

To view appointment details: 

1. Select an appointment in the Schedule for Today window. 

2. Click View. The Appointment View dialog box displays detailed information about the appointment. 

 
Appointment View dialog box 

3. Click Close to return to the schedule. 

To confirm an appointment: 

1. On the Schedule for Today window, locate the appointment you want to confirm. 

2. Select the appointment time slot and click Update (or double-click the appointment time slot). 

3. Click Confirm. The current date will appear in the Confirmed On field. To change the date, click in 
the Confirmed On text box, and enter the correct date. When you enter a date in the Confirmed on 
text box, your staff ID is displayed after the date. If you are using Pet Health Network* Pro and a 
client confirms an appointment on their Petly.com page, “By PHN Pro” is displayed in place of a 
staff ID. 

4. To clear the Confirmed on box, click Unconfirm. 

5. Click OK. 

If an appointment is confirmed, an asterisk (*) appears on either side of the client’s name in the 
Schedule for Today. 

To update an appointment: 

1. On the Schedule for Today window, select the applicable appointment and click Update (or double-
click the appointment). The Edit Appointment dialog box appears. 

2. Make any necessary modifications or updates to the appointment information. 

3. Click OK to save your changes and return to the schedule. 

To move an appointment: 

1. On the Schedule for Today window, select the applicable appointment and click Move. 

2. Select the new time slot if moving the appointment to a different time on the same day.  

3. To move the appointment to a different day, click Go To. The Date Selection calendar will open.  
Select the new date and click OK, and then select the new time slot. 

4. The following message appears: “Would you like to move the appointment to [Date selected] at 
[Time selected]?” Click Yes.  

The appointment will be moved to the selected date and time. 
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Note: A warning message will not display if a moved appointment creates a double-booked 
appointment time for a staff member. You will need to check the X column for a yellow or red 
background in the new time slot (indicating multiple appointments scheduled for the same staff 
member). 

To copy and paste an appointment: 

1. On the Schedule for Today window, right-click on an existing appointment and select Copy (or 
press CTRL+C). 

2. Right-click in a different day/time slot and select Paste (or press CTRL+V). 

The pasted appointment will be identical to the copied appointment, except that the Confirmed on date 
will be reset to 00/00/00. 

Notes: 

• If any invoice items were included in the copied appointment, these items will be included in the new 
(pasted) appointment. 

• Copy/paste options are also available for “block” type appointments. 

To delete an appointment: 

1. On the Schedule for Today window, select the applicable appointment and click Delete. The Delete 
Appointment dialog box appears. 

Note: In order to delete a checked-in appointment, you must first check out the appointment. 

 
Delete Appointment dialog box 

2. Select the applicable option to specify if this appointment should be considered as Failed, 
Cancelled, or Neither. 

• Failed – Select if the client did not show up. 

• Cancelled – Select if the client called with enough advance notice. 

• Neither – Select if your practice does not want to track the number of deleted appointments or 
does not want to display this in the client’s alert. 

Note: Appointments classified as Failed or Cancelled will cause an alert to appear when the client is 
accessed in Cornerstone. To suppress these alerts, deselect the Cancelled Appointment and 
Failed Appointment client alerts in Alerts defaults (select Controls > Defaults > Practice and 
Workstation, and then select Alerts from the menu on the left). 
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3. If applicable, place a check mark in the Add this appointment to tickler file check box to store the 
appointment information in the Tickler File for future reference or to keep track of deleted 
appointments. See the “Maintaining the Tickler File” section that follows for more information. 

4. Click OK to save your changes and return to the schedule. 

Maintaining the Tickler File 
Clients are not always able to keep their scheduled appointments. It is possible to track these missed 
opportunities by adding the appointment to the Tickler File. A missed appointment is placed in the 
Tickler File if the Add this appointment to ticker file check box is selected when deleting an 
appointment. 

Use the Tickler File as a reminder to reschedule appointments for clients. If you reschedule an 
appointment for a client who is in the Tickler File, a prompt will pop up to ask if you want to use the 
information from the previous appointment. 

Tip: Assign a staff member to call these clients once a week about the missed appointments to offer to 
reschedule. 

To view Tickler File appointments: 

1. On the Schedule for Today window, click Tickler. The Tickler File dialog box displays a list of 
deleted appointments. 

 
Tickler File dialog box 

2. To permanently remove an appointment from the Tickler File, select the appointment and click 
Delete, and then click Yes to confirm your decision to delete the entry from the Tickler File. 

3. Click Close to return to the schedule. 

To reschedule an appointment listed in the Tickler File: 

1. On the Schedule for Today window, select a time slot and click Schedule. 

2. Search for and select the client the appointment is being scheduled for in the Client ID field. 

3. Search for and select the patient the appointment is being scheduled for in the Patient ID field. The 
following message will appear: “This patient is currently listed in the Tickler File. Would you like to 
use this patient’s appointment information?” 

4. Click Yes. The information from the previous appointment will be inserted in the appropriate fields. 

5. Continue to enter information as needed. 

6. Click OK. The appointment is removed from the Tickler File window. 

To print the information in the Tickler File: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 

2. In the Reports list, click the plus sign to the left of Appointment, and then select the Tickler Report. 

3. Click Create report. The Appointment – Tickler File Report dialog box appears. 
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4. Enter the sort order and range criteria, and then click Print or Preview. 

The Tickler File displays any deleted appointments that were selected to be added to the Tickler File. 

Finding Available Appointment Times 
You can search for available appointment slots based on the criteria entered in the Appointment Search 
window. Searches can be performed for specific appointment times based on the practice’s schedule 
templates. 

To find an available appointment time: 

1. On the Schedule for Today window, click Find. The Appointment Search dialog box appears. 

 
Appointment Search dialog box 

2. In the Search criteria area, specify information in the applicable fields: 

• In the Room list, deselect any room you do not want to use for this appointment. To select (or 
deselect) more than one room, press and hold the CTRL key while clicking on each room. 

• In the Reason for visit drop-down list, select the general reason for seeing the patient. (Note: 
Only reasons for visit set up with Appointment Scheduler information will appear in the 
Appointment Search.) 

• In the Staff field, select the Staff member to schedule. (Note: To view time slots for a selected 
staff member, the person must be set up with hours and goals.) 

• In the Units field, specify the number of time increments for which to schedule the appointment 
(either 10 or 15 minute increments). 
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3. In the Date/time range area, specify information in the applicable fields: 

• Select the date range to search in the Date from/To fields. Use the single arrow  to move a 

month at a time and the double-arrow  to move six months at a time. Click Today to search 
from the current system date to two weeks in the future. 

• Select the times to search from the Preferred time options, which include: 

o AM only – Search from the opening time through the last time increment before 12:00 PM. 
For example, if the practice is set up with 10-minute increments, the search will list 11:50 
AM as the last time slot to search. 

o PM only – Search from 12:00 pm through the practice’s closing time. 

o Specific range – Search based on the times entered in the Time from/To fields. 

4. In the Day of week area, select the check box for each day of the week to search. 

5. Click Search. The Results for Appointment Search dialog box will display a list of available 
appointment times based on criteria entered. 

Example: 

A client needs an appointment within the next two weeks on Wednesday or Thursday around noon to 
have her poodle groomed. The search criteria might look like this: 

 
Appointment Search example 

Locating a Client’s Appointment 

To locate a client’s appointment: 

1. On the Schedule for Today window, click Locate. The Locate Appointment dialog box appears. 

 
Locate Appointment dialog box 
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2. In the Client ID field, enter the client ID by either typing the ID or pressing F2 to search for and 
select the client from the Client List. All appointments scheduled for this client appear. 

3. Select an appointment and click Go To. The daily schedule for the selected appointment day 
opens. 

4. To view appointments scheduled for another patient, click Cancel to clear the information and enter 
another Client ID, or click Close to return to the Schedule for Today window. 

Checking in a Patient from the Appointment Scheduler 
When you use the Appointment Scheduler to check a patient into your hospital, the appointment 
information (including client, patient, reason for visit, staff and room) will display as defaults in the Patient 
Check-in/out window. If there is an appointment note, it will appear in the Additional Note field. 

To check in a patient from the Appointment Scheduler: 

1. On the Schedule for Today window, select the patient’s appointment. 

2. Highlight the appointment and click Check In. The Patient Check-in/out window will open with the 
appointment information displayed as defaults. 

3. Correct any information and continue to check the patient in as usual. 

For more information on checking in patients, see “Checking Patients into Your Practice” on page 120.  

Blocking Unavailable Appointment Times 
You can block time slots to prevent appointments from being scheduled during times when staff 
members are unavailable. 

An appointment time block can also be set up to be a recurring (repeating) time block. This feature 
saves time by allowing you to make regular adjustments to your schedule at one time. For example, if a 
provider will be unavailable every Thursday from 3:00 p.m. to 4:00 p.m. for the next eight weeks, you can 
block off this time on the Schedule for Today and set it up to be a recurring block for eight weeks. 

To block unavailable time slots: 

1. On the Schedule for Today window, select the time slot to block. If you want to block an extended 
period of time, select the first time slot in the period to block. 

2. Click Block. The Block Appointment dialog box appears. 
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Block Appointment dialog box 

3. In the Time Units field, enter the number of time units to block. The From and To fields will adjust 
accordingly. 

4. Select which room the blocked time affects from the For drop-down list, if applicable. 

5. In the Notes field, enter any notes about this blocked time. 

6. To set up a recurring block, do the following: 

a. Make sure that an individual room is selected in the For drop-down list. Recurring blocks can be 
set up for an individual room only, not for (All Rooms in Suite). 

b. Select the Recurring block check box. 

c. Indicate whether it is a Daily, Weekly or Monthly block by selecting the appropriate option. 

• Daily – Indicate how often the block should occur in terms of days by doing one of the 
following: 

o Choose the Every __ day(s) option and enter the days for which staff wants the block 
to recur. For example, if the block should be scheduled for every other day, type 2 in 
the field provided. 

o Choose the Every weekday option to have the block recur every day for one or more 
weeks. 

• Weekly – Indicate how often the block should occur in terms of weeks by doing the 
following: 

o In the Recur every __ week(s) on field, indicate the recurring block and then select the 
appropriate check box to specify which day of the week to start the recurrence. For 
example, to have a block recur once every two weeks on Friday, type 2 in the field and 
then select the Friday check box. 
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• Monthly – Indicate how often the block should recur in terms of months by doing the 
following: 

o Specify settings for the recurring block by selecting the week of the month, the day of 
the week, and the monthly frequency. For example, to have a reservation recur on 
Tuesdays during the last week every other month, you would specify: The last Tuesday 
of every 2 month(s). 

d. Select one of the following: 

• If there are a certain number of occurrences, select the End after option and enter the 
number of occurrences. 

• If the occurrences should end after a certain date, select the End by option and specify the 
date. 

Note: To change recurring block options (time, occurrence, etc.), you must delete the entire block 
and set up a new recurring block. 

7. Click OK to save your changes.  

To delete a block: 

1. Right-click on the block that you want to delete and from the pop-up list, select Delete. 

2. If you are deleting a nonrecurring block, a message appears to confirm the deletion. Click Yes. 

3. If you are deleting a recurring block, a Confirm Delete message appears. Do one of the following: 

• To delete only the selected occurrence, select Delete this one and click OK. 

• To delete all the occurrences of the block, select Delete all occurrences and click OK. 

Creating a Note for Staff 
Additional appointment information about the daily schedule can be stored using the Notes feature. 

Note: Do not confuse these daily schedule notes with notes about specific appointments that are 
entered in the New Appointment dialog box. See “Scheduling and Managing Appointments” beginning 
on page 104.  

Tip: Make a habit of checking the Notes button every time you open the schedule. If a note for the date 
exists, the button text will be bold, followed by ellipses ("…"). Click Notes to view the notes. Use the 
notes on the Schedule for Today window to enter anything that deviates from your normal scheduling 
procedure to communicate this information throughout your practice. (For example, if a doctor will be on 
vacation, you can enter a note to change the template to be used for scheduling on that day.) 

To enter a Daily Appointment Note: 

1. On the Schedule for Today, click Notes. The Appointment Notes dialog box opens and displays any 
schedule notes from the current date to the future. 

Cornerstone User’s Manual                  113 



Chapter 6: Using the Appointment Scheduler 

 
Appointment Notes dialog box 

2. Click New. 

3. In the Date field, type a new date or press F2 to select a date using the calendar. 

4. In the Note field, enter the note information.   

5. Click OK. 

To modify an Appointment Note: 

1. On the Schedule for Today, click Notes. The Appointment Notes dialog box opens and displays all 
schedule notes from the newest date to the oldest. 

2. In the Appointment Notes list, select the note to change and click Update (or double-click the note).   

3. Modify the date or note text. 

4. Click OK. 

To delete an Appointment Note: 

1. On the Schedule for Today, click Notes. The Appointment Notes dialog box opens and displays all 
schedule notes from the newest date to the oldest. 

2. Select the note to delete and click Delete. A message will appear asking you to confirm your 
decision. 

3. Click Yes. 

Printing the Daily Schedule of Appointments 
Appointment Scheduler lets you print the daily schedule or a detailed report of the appointments for the 
day. The printed schedule displays the same appointment information as the online schedule, but for all 
rooms. 

To print the Schedule for Today: 

1. Open the Schedule for Today to the date you want to print. 

2. Click Print. The printer selected in Printer Setup (on the File menu) prints the schedule. 

Note: For a detailed report, print the Appointment Report. For more information about this report, see 
“Appointment Report” on page 117.  

Viewing the Weekly Schedule 
The Schedule for Week window shows a condensed version of your daily schedule. You can schedule 
new appointments, but you cannot update scheduled appointment information from the Schedule for 
Week window. 
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To open the Schedule for Week window: 

 Do one of the following: 

• On the Schedule for Today window, click Weekly. 

• On the Activities menu, select Appointment Scheduler > Schedule for Week.  

The Schedule for Week window displays the schedule for the current week. 

 
Schedule for Week window 

Schedule for Week Display Options 

You can specify the information to display using the options available across the top of the Schedule for 
Week window. 

• Week – To select the week to display, do one of the following: 

o Use the single arrows to move the schedule forward or backward one week. 

o Use the double arrows to move the schedule forward or backward one month. 

o Press F2 to select a week using the calendar. 

• Show – Select the staff member schedule to display. You can display all staff or one staff member 
at a time. 

• Suite – Select the appointment suite to display. 

• Legend – Click the Legend button to display the letter and number code descriptions.  

 
Schedule for Week Legend 

To schedule a new appointment from the weekly schedule: 

 Double-click in an empty time slot (or select a time slot and click Schedule). 
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Purging Old Appointments 
Obsolete records can be deleted to help maintain adequate disk storage space on your computer. 
Removing old appointments also makes your searches faster. 

IMPORTANT: Before deleting any records, we strongly recommend making a backup of your database. 

To delete old appointment records: 

Note: Before purging any records, close all open windows must be closed. For network environments, 
we recommend shutting down Cornerstone and all other program modules on workstations and then 
performing purge activities from the server. 

1. On the Activities menu, select Appointment Scheduler > Appointment Purge. The Appointment 
Purge dialog box appears. 

 
Appointment Purge dialog box 

2. Select the Staff and Room records to search for from the drop-down lists. 

3. In the Dates to search area, use the From and To date fields to specify a date range of appointment 
records to purge. Press F2 in a date field to select a date using the calendar.  

4. In the Preferred time area, specify AM only, PM only, or a specific range (enter range in From and 
To). 

5. In the Day of week area, clear the check box for any day that you do not want included in the purge 
(days with checked boxes will be purged). 

6. Click OK. A message appears stating the number of appointments to be deleted. Confirm that you 
want these records deleted. 

7. Click OK to purge these records from the database. 

Appointment Scheduler Reports 
Use Appointment Scheduler reports to view detailed information for appointments scheduled or added 
to a Tickler File. Reports can also be used to view information about the setup of the Appointment 
Scheduler feature.  

Tip: If future appointments do not print, verify that the correct number of months is entered in the Invoice 
print area’s Number of months to print appointments for field in Invoice defaults. To view this field, on 
the Controls menu, select Defaults > Practice and Workstation, and then select Invoice in the 
navigation pane on the left.  

To access the Appointment Scheduler reports: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 
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2. In the Reports list, click the plus sign to the left of Appointment to expand the list of Appointment 
Scheduler reports. 

 
Appointment Reports 

Appointment Report 

Print the Appointment Report to see the complete details of your scheduled appointments. 

 

 

Appointment Report - Summary 

Print the Appointment Report - Summary to see a summary of the appointments scheduled for a 
particular day. 
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Practice and Staff Hours Report 

Print the Practice and Staff Hours Report to see the practice and staff member(s) schedules. 

 

 

Scheduled vs. Goal Report 

Print the Scheduled vs. Goal Report to see the staff revenue goals and the dollar amount scheduled for 
each room.  
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Tickler Report 

Print the Tickler Report to view deleted appointments that were added to the Tickler file. 

 

 

 

Cornerstone User’s Manual                  119 



Chapter 7: Patient Check-In and Check-Out 

Checking Patients into Your Practice 
You can check patients into your practice either as patients arrive (to maintain an accurate picture of 
your practice’s activity) or at the beginning of the day (to anticipate the day's events). 

When you check a patient into the practice, Cornerstone* software: 

• Adds the patient to the Census List 

• Gathers basic patient and client information, such as client ID, client name, patient name and 
patient ID 

• Gathers information for the Check-In Report (which Cornerstone prompts you to print after checking 
a patient in) 

Before You Begin 

• Set up your Check-in defaults (Controls > Defaults > Practice and Workstation > select Check-
in from the menu on the left). 

• Set up your Check-in Print Options defaults (Controls > Defaults > Practice and Workstation > , 
select Check-in > Check-in Print Options from the menu on the left). 

• Set up the reasons for visit that your practice uses (Controls > Reason for Visit). 

• Set up the rooms your practice uses (Lists > Room). 

• Set up a record for the patient in Cornerstone (Lists > Patient). 

To check a patient into your practice: 

1. Do one of the following: 

• On the Census List (F3), select Check-in. 

• On the Patient Clipboard, select the client, and then right-click on the patient’s name in the 
Patient list and select Check-In. 

• Click the Check-In/Out  toolbar button. 

• On the Activities menu, select Check-In/Out. 

The Patient Check-in/out window appears.  
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Patient Check-in/out window 

2. Depending on how you accessed the Patient Check-in/out window, the client and patient 
information may already be displayed. If not, enter the Client ID and press TAB, and then enter the 
patient ID and press TAB. 

Tip: At any time, you can click the Vital Signs/Weight  button to display the weight entry dialog 
box for the patient. Here you can enter a current weight and, if desired, click the add more Vital 
signs link to open the full Vital Signs entry and viewing window. Note that the button displays in 

red/yellow  as an alert if at least one vital sign (other than weight and body score) has not been 
entered for the patient within the past 10 days. 

3. Verify that the Staff ID is the staff member who will see this patient. If necessary, type the staff ID or 
press F2 to search for and select the staff from the Staff List. 

4. Under Reason for Visit, select a Primary reason for the patient’s visit. If desired, select a secondary 
reason from the Secondary drop-down list or type a different secondary reason in the field. (Note 
that a primary reason must first be specified in order to activate the secondary reason field.) 

5. Select the Room where the patient is located or will be assigned. 

6. If applicable, select a Ward and enter a Cage name. 

7. Select a Status. (The status may be set to <None> until the patient is Ready to go home.) 

8. If your practice uses patient referrals and this is a referral recheck visit, select the Referral Recheck 
check box to keep track of referral sales. (The sales amount from this visit will be included in new 
referrals’ totals, unless this option is selected.)  

9. Specify if this is an Inpatient or Outpatient check-in. 

Note: If Inpatient is selected, upon check-in the patient is automatically added to the Whiteboard as 
a hospitalized patient that is waiting for patient orders to be added. 

10. Type any Additional notes you want to print on the Check-In Report. 
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11. Enter any comments to display as an alert in the Alert notes box. These comments will display 
when the patient’s record is accessed and are not part of the patient’s permanent history. They will 
be deleted when the patient is checked out. 

12. In the Documents area, specify any documents to print upon check-in (in addition to the Check-In 
Report). In the Doc ID field, enter the document ID by either typing the ID or pressing F2 to search 
for and select a document from the Document Template List. 

13. In the Weight entry area, do the following: 

a. Verify the Date to associate with this weight entry (defaults to today’s date) and change if 
necessary. 

b. In the Weight field, enter the patient’s current weight. 

c. Verify the Unit of measure and, if necessary, select a different unit of measure from the drop-
down list. 

d. If the Body Score vital sign has been activated in your practice’s Vital Sign List (select Lists > 
Vital Signs/Weight), the Body score field is available. If the patient’s body score is known at 
this time, you can select the applicable value/description from the drop-down list. 

14. The Check-in Date and Time default to the current date and time. Change the date and time, if 
necessary. 

15. Click Check-in to check the patient into the practice.  

16. Depending on your Check-in Print Options default settings, a Check-In Report may print 
automatically or a message box may display, asking you to print a Check-In Report. Click Yes if you 
want to print the Check-In Report. 

 You can reprint a Check-In Report for a patient at any time. This report prints information based on 
your check-in defaults.  

To print a personalized travel sheet when you check in a patient: 

1. On the Patient Check-in/out window, enter all check-in information as usual, and then click the 
Travel Sheet button. The Travel Sheet Print dialog box appears. 

Note: You can access the Travel Sheet Print dialog box without checking in the patient by selecting 
Lists > Travel Sheets and clicking Print. 
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Travel Sheet Print dialog box 

2. From the Travel Sheet Description list, select the travel sheet(s) to personalize. 

3. If desired, in the Enter travel sheet heading field, enter a personalized heading for the travel sheet. 

4. In the Include client/patient heading box field, select Yes to include client and patient information, 
such as patient’s age, weight, sex, the reason for visit and client address, on the travel sheet. Select 
No if you do not want to include this information. 

5. If the client is not selected, in the Client field, enter the client ID by either typing the ID or pressing 
F2 to search for and select the client from the Client List. 

6. If the patient is not selected, in the Patient field, enter the patient ID by either typing the ID or 
pressing F2 to select the patient from a list of the client’s pets. 

7. In the Select types of items to print field, deselect any item type you do not want to include on the 
travel sheet. 

8. In the Include prices on travel sheet field, choose whether or not to print prices on the travel sheet. 

9. By default, travel sheets include blank lines so that staff can include notes and additional services 
on the travel sheet. If you do not want to include these lines select No in the Leave additional 
services and notes field. 

10. Specify the Number of copies to print. 

11. Click Preview if you want to view the travel sheet before printing. 

12.  Do one of the following: 

• Click Print to print the travel sheet to the assigned printer and exit. 

• Click Close to exit without printing. 
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Updating Check-In Information 
After a patient has been checked in, you may want to change the patient’s check-in information or 
update the room. You can update the check-in information and print an updated Check-In Report.  

To open the Patient Check-In/Out window: 

There are several ways to open the Patient Check-In/Out window: 

• From the Census List (F3), select the client/patient and click Check-In. 

• On the Patient Clipboard, select the client, and then right-click on the patient’s name in the Patient 
list and select Check-In. 

• Click the Check-In/Out  toolbar button. 

• On the Activities menu, select Check-In/Out. 

To update a patient’s check-in information: 

1. Open the Patient Check-In/Out window and locate the client and patient. 

2. Change the Reason for Visit, Staff ID, Room, Additional Notes, Check In Date/Time or Check 
Out Date/Time. 

3. Click Update. A message box appears asking you to print a Check-In Report. 

4. Click Yes if you want to print the Check-In Report. 

 You can reprint a Check-In Report for a patient at any time. This report prints information based on 
your check-in defaults.  

Checking Patients Out of Your Practice 
When you check a patient out of your practice, the patient is removed from the Census List. You can 
automatically check patients out when you post an invoice.  

To check a patient out of your practice: 

 Do one of the following: 

• On the Census List (F3), select the patient and click Check-out. 

• When you post an invoice for the patient, in the Post Invoice dialog box, click the Check-out 
patients check box. 

• On the Patient Check-In/Out window, with the checked-in patient’s information displayed, click 
Check-out. 

Next Appointment Reminders 
When you post an invoice, Cornerstone displays the next appointment reminder for each patient who is 
on the invoice. If there’s more than one reminder for a patient, Cornerstone displays the earliest one. If a 
reminder is overdue, it will still appear. 
For more information about setting up appointment reminders, see the Appointment Scheduler Defaults 
section of “Chapter 4: Setting Practice Workstation and Defaults” in the Cornerstone Administrator’s 
Manual. 
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These reminders include letter reminders that you can currently view in Cornerstone. If you set up the 
feature to only display reminders for certain invoice items, Cornerstone will display only those reminders.  

If you schedule an appointment using the reminder, that appointment will be printed on the invoice. 

Note: The Next Appointment Reminder dialog box displays reminders for all of the patients on the 
invoice, but the automatic scheduling feature takes you to the schedule for only the first patient listed. 

To schedule an appointment using the reminder: 

1. On the Next Appointment Reminder dialog box, select Yes. The Appointment Scheduler 
window appears and displays the schedule for the date the reminder is due. If the reminder 
is overdue, the schedule displays tomorrow’s schedule. 

2. Right-click the time you want and select Schedule to begin scheduling the appointment. 
The Schedule Appointment for the Following dialog box appears. 

3. Click Yes. The New Appointment window opens. 

4. Fill in appointment information, and click OK.  
Note: Be sure to check the Reminders list, since the patient may have reminders for 
several services that are due the same day. 

Check-In Reports 

Before You Begin 

• Check patients into your practice. 

• Select the types of information to print on the Check-In Report by setting your Check-in Print Options 
defaults (Controls > Defaults > Practice and Workstation > select Check-in > Check-in Print 
Options from the menu on the left). 
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Check-In Report 

The types of information included on the Check-In Report depend on the Information to print options you 
have selected for your Check-in Print Options defaults. See “Chapter 4: Setting Practice and Workstation 
Defaults” in the Cornerstone Administrator’s Manual for information on setting the Check-in Print Options 
defaults. 

 
Check-in Print Options defaults 

To print a Check-In Report at any time, follow the steps to update a patient’s check-in information. If you 
don’t need to update any of the information, click Update immediately. See “Updating Check-In 
Information” on page 124 for more information.  
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Overview 
The Patient Check-in, Check-out and Census List windows allow you to track the patients currently at 
your practice or expected to arrive. This helps you prepare and schedule your day. 

The Census List details all of the patients currently checked into your practice, as well as the staff 
member assigned to see them, the room they are located in and the reason for their visit.  

To open the Census List: 

 To open the Census List, press F3 anywhere in Cornerstone (or select Lists > Census).  

 
Census List 

 To track patients checked into (or out of) your practice, print the Census Report and Checked-in 
Census Report. See “Patient Information Reports” on page 73 for information. 

Viewing the Census List 

To view all of the patients currently checked into your practice, use the Census List. The Census List 
displays client and patient names and IDs, check-in dates and times, staff member IDs, where the 
patients are located (room) and why the patient is in the practice (reason for visit). In addition, the 
Census List displays how many patients have checked into and out of the practice for the day, how 
many patients are in the hospital and how many patients are scheduled for the day. An icon displays if 
the patient has invoice items on the Patient Visit List. 

To change the way information appears in the Census List: 

You can choose how information displays on the Census List. The Practice, View, Staff, Suite, Rooms 
and Sort by fields have drop-down lists that provide options for viewing Census information. For 
example, you can choose whether you want to include information for all staff members or for a single 
provider.  

• The Practice drop-down list is available for those practices with Multi-Location/Single Database 
enabled. Using the color-coded Practice drop-down list, select a practice to display Census List 
information only for that practice (an All Practices option is also available). By default, it preselects 
the currently logged in practice. 

Cornerstone User’s Manual                  127 



Chapter 8: Using the Census List 

• Using the View drop-down list, choose Scheduled Appointments to view patients with scheduled 
appointments. You can also choose Boarding & Grooming to view patients with boarding and 
grooming appointments (Boarding and Grooming module only) or Patients in Hospital to view all 
patients currently in your practice.  

• Using the Staff drop-down list, view patients assigned to any staff member (all staff) or to a specific 
staff member. 

• Using the Suite drop-down list, view patients in specific suites of your practice. The default suite will 
display for the logged-in staff member. 

• Using the Rooms drop-down list, view patients in all of your rooms or in one particular room. 

• Using the Sort By drop-down list, sort the information by Client Name, Date/Time, Patient Name, 
Room, Staff or Visit Type. 

• Use the scroll bar at the bottom of the dialog box to view additional information. 

Note: Periodically, click the Refresh button to access the most up-to-date Census information.  

To transfer client and patient information from the Census List to an invoice or estimate: 

From the Census List, you can select a client and patient to transfer to an invoice or estimate that 
requires a patient ID or client ID. Use this feature to quickly start an invoice, estimate, prescription label, 
Patient Visit List or other item. The instructions below use the invoice as an example. 

1. Open a new invoice or estimate and then press F3 to open the Census List. 

2. Select the client and patient to use in the invoice (or estimate) and click Select. Cornerstone 
transfers the client and patient information to the invoice. 

3. Continue invoicing as usual. 
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Overview 
The Patient Visit List (PVL) serves as a patient’s storage area in the IDEXX Cornerstone* Practice 
Management System. The Patient Visit List holds invoice items and other information that you may want 
to transfer later to an invoice or to the patient’s history.  

Through the Patient Visit List, you can: 

• Indicate items you have recommended to clients 

• Indicate accepted items 

• Transfer performed items to the invoice 

• Indicate recommended items that a client declines 

• Transfer declined items to the patient’s medical file 

• Add comments to each item 

• View items transferred from finalized estimates 

• Hold prescription items and transfer client/patient information from the prescription to the invoice 

About the Patient Visit List Window 
 

 

 

 

Patient 
information area 

PVL task 
and action 
buttons 

Item 
transfer 
options 

Blue comment 
line check box 

Owner 
information area 

Total of all line items on 
this PVL marked to 
transfer to the invoice 

Line item 
entry grid 

Item Source column 

Item Status column 
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Patient Information Area 

The Patient information area displays the patient’s ID, name, age, weight, and body score (if activated), 
breed and sex.  

To enter a current weight and/or add other vital sign entries as appropriate for the patient, click the Vital 

Signs/Weight  button. See “Chapter 16: Recording Vital Signs/Weight Information” beginning on 
page 229 for information on entering vital signs. 

Note: The button displays in red/yellow  as an alert if at least one vital sign (other than weight and 
body score) has not been entered for the patient within the past 10 days. 

Owner Information Area 

The Owner information area displays the primary owner along with the associated client balance and 
account information. If there is more than one owner, you can select a different owner from the Owner 
drop-down list, if needed. The default taxes and discounts applied to invoice items on the Patient Visit 
List are based on the selected owner. 

Item Source Column 

For items that Cornerstone transfers to the Patient Visit List from another source, the Item Source 
column displays an icon to indicate the transfer source. 

This icon: Indicates the item was transferred from: 

 
Appointment 

 
Boarding reservation (Boarding and Grooming module only) 

 Correspondence document 

 
Estimate 

 
Image request (IDEXX SmartLink Digital Imaging module only) 

 Laboratory request (Laboratory module only) 

 Medical note 

 Patient Advisor exam (Patient Advisor module only) 

 Prescription 

 
Whiteboard 

Tip: You can right-click an icon to display a Calculated Price box to view a breakdown of the item’s 
pricing. 
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Item Status Column 

Using the status buttons located to the immediate left of each item ID, staff members can indicate 
information they have communicated to the client (and the client’s response).  

This 
button: 

Indicates this item status: Description: 

 
Recommended Default status when an item or service is added to the PVL 

 
Accepted Client wants to purchase the item or service 

 
Performed Item is dispensed or the service is performed 

 
Declined Client does not want to purchase the item or service 

 
Declined to history 

Client does not want to purchase the item or service; information 
about the declined item is saved to the patient’s history 

Note: You can also right-click on an item’s status button and then select a new status from the menu.  

Automatic Status Changes 

• Estimate items – The Add invoice items to PVL setting in Estimate defaults determines if invoice 
items from a finalized estimate are transferred to the Patient Visit List (PVL). If the estimate invoice 
items are transferred to the PVL, their status is automatically changed to Accepted, and the date for 
the line item on the PVL is updated to the current date. 

• Checked-in appointment items – Invoice items are transferred from appointments to the PVL only 
when the patient is checked into the practice. When appointment items are transferred to the PVL, 
their status is automatically changed to Accepted.  

• Laboratory or boarding items – When laboratory or boarding invoice items are transferred to the 
PVL, their status is automatically changed to Performed. 

Line Item Entry Grid 

The Patient Visit List line item entry grid includes the following columns/fields:  

Column/Field Description 

Item ID Enter an invoice item ID by either typing the ID or pressing F2 (or double-
clicking) to search for and select the item from the Invoice Item List. To 
delete an item from the grid, click in the item’s Item ID field and press 
CTRL+D. 

If any duplicate items are entered in the grid, these line items display in 
dark red. In addition, if the Display duplicate items warning check box is 
selected in Invoice defaults, a “Duplicate items exist” message displays 
when the patient’s PVL is opened or when the items are transferred to an 
invoice. 

Description The invoice item’s Hospital description is displayed.  

Note: If the item was flagged as a Miscellaneous item on the Invoice Item 
Information window’s Info tab, you are allowed to make changes to the 
description when adding the item to the grid.  

Qty (Quantity) The quantity of the item; default quantity is 1.  
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Column/Field Description 

Amount The price of the item, based on the quantity specified.  

For invoice items transferred from an estimate, the Low price or High price 
may display, depending on the setting specified in the Transfer to patient 
visit list when finalized area in Estimate defaults. 

Disc (Discount) When you previously set up your invoice items, you had the option of 
linking certain discounts to individual invoice items on the Invoice Item 
Information window’s Tax/Disc tab. If you invoice a client who is set up to 
receive the discount associated with the item, Cornerstone automatically 
applies the discount, and the button in the Discount column displays Yes. 
To add or remove a discount on an invoice item, click the Yes or No 
button in its line item row. See “Applying Discounts to Specific Invoice 
Items” on page 187 for information on invoice item discounts. 

Tax When you previously set up your invoice items, you had the option of 
linking certain taxes to individual invoice items on the Invoice Item 
Information window’s Tax/Disc tab. If you invoice a client for one of these 
items, Cornerstone automatically applies the tax and the button in the Tax 
column displays Yes (except when the client has been marked as tax 
exempt). To add or remove a tax on an invoice item, click the Yes or No 
button in its line item row. See “Applying Taxes to Specific Invoice Items” 
on page 188 for information on invoice item taxes. 

Item notes  If you are not displaying blue comment lines on the PVL, the Item notes 
column is displayed. If there is a note for an item and the blue comment 
lines are hidden, you can click the item’s notes  icon to view the note. 
See “Displaying Blue Comment Lines on the Grid” on page 133 for 
information on blue comment line notes. 

Prescription  button 
Displays the Prescription Information dialog box, which allows you to 
create a prescription for the invoice item. See “Creating a Prescription” on 
page 294 for information on creating a prescription. 

Departing Instructions  

button 

Displays the Departing Instructions dialog box, which allows you to specify 
an item’s departing instructions to print on the invoice. See “Adding 
Departing Instructions” on page 189 for information.  

Staff The ID of the staff member to associate with this invoice item; defaults to 
the staff ID specified in Patient defaults or the staff associated with the 
item’s transfer source (lab request, medical note, etc.). To change the 
staff, either type the ID or press F2 to search for and select the staff from 
the Staff List. 

Ctr (Revenue Center) The ID of the revenue center to associate with this invoice item. If a default 
revenue center was specified on the Invoice Item Information window’s 
Info tab, that revenue center ID displays here. To change the revenue 
center, either type the ID or press F2 to search for and select a revenue 
center from the Revenue Center List. 

Date The date the invoice item is added to the PVL for the patient; defaults to 
the current date. To change the date, either type a different date or press 
F2 to select a date using the calendar. 
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Column/Field Description 

Verify Inventory Details  
If an inventory item is marked to track quantity on hand, lot numbers, 
expiration dates, and/or multiple locations, you may be asked to verify 
inventory details for this invoice item. For these types of inventory items, 
one of the following icons will appear in the column to indicate whether or 
not inventory details are missing:  

  Indicates more inventory information is required. 

  Indicates inventory information is complete; no action is required. 

Click the  icon and proceed to enter the inventory details and click the 
Verified check box to verify the details for each item as required. 

See “Verifying Inventory Details” on page 191 for more information. 

 

Displaying Blue Comment Lines on the Grid 

You have the option of displaying a blue comment line below each invoice item row on the PVL. The 
comment line is used to store comments or notes about an item. Comment line notes are not transferred 
to the invoice or to patient history, with the exception of items that have been declined to history. If an 
item is declined to history, the declined item information is saved in the patient’s history, along with any 
associated blue comment line notes for the item. 

The default for displaying or hiding the blue comment line when the PVL is opened is based on the 
Display blue comment line check box in the Patient visit list area in Invoice defaults. You can also 
change this setting at any time while viewing the PVL by selecting or clearing the Display blue 
comment line check box on the Patient Visit List, located in the bottom-left corner of the window. 

Tip: If there is a comment for an item and the comment lines are hidden, you can click the item’s notes 
 icon to view the comment. 

Options for Transferring Patient Visit List Items to the Invoice 

Three item transfer check boxes in the bottom-left corner of the Patient Visit List window indicate which 
types of items to transfer to the invoice: 

• If Include recommended is selected, items marked as Recommended  will transfer. 

• If Include accepted is selected, items marked as Accepted  will transfer. 

• If Include performed is selected, items marked as Performed  will transfer. 

Note: Defaults for these check boxes can be set in the Patient visit list area in Invoice defaults. 

As you select (or clear) an item transfer check box on the PVL, the adjacent total dollar amount changes 
to reflect the types of items you’ve included. This is the total dollar amount that will transfer to the 
invoice. 

To open the Patient Visit List from an invoice: 

If items exist on the Patient Visit List for a patient, when the patient is invoiced, one of the following will 
happen: 

• If the Display patient visit message option is selected in Invoice defaults, a message displays to 
ask if you want to select items from the list. Click Yes to open the Patient Visit List. 

• If the Display patient visit message option is not selected in Invoice defaults, the Patient Visit List 
automatically displays. 
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In addition, if items exist on the Patient Visit List for a patient, during invoicing you can click the Special 
button at any time and process the Patient Visit action to open the Patient Visit List for the patient. 

Patient Visit List Task and Action Buttons (Right Side of Window) 

Use the buttons along the right side of the Patient Visit List window to perform additional tasks and 
actions. 

Button Description 

   

Change the item status for all Recommended and/or Accepted invoice items on the 
PVL to Performed, indicating that you are ready to bill for these items. 

   
Sort the items on the PVL in ascending date order. 

   

Display the Departing Instructions dialog box to view or modify departing instructions 
linked to invoice items on this PVL. You can also add or update general instructions 
to associate with this PVL (vs. associating with a particular invoice item). 

   
Access the Pharmacy Formulary (Pharmacy Formulary module only). See “Using the 
Pharmacy Formulary” on page 197 for information. 

   
View and/or process any special actions linked to the invoice items on this PVL. See 
“Processing Special Actions” on page 192 for information. 

   
Select items to transfer from your practice’s travel sheet. See “Transferring Invoice 
Items from a Travel Sheet” on page 186 for information. 

   
Display the patient’s Patient Visit List Report in a preview window. From here you can 
click Print to print the report or click Save to save the report data to a file. 

   

Display the Client Invoice window for the current client and patient on the PVL. 
Depending on the item transfer options selected for this PVL, all applicable invoice 
items will transfer from the PVL to the invoice. 

Adding Recommended Items to the Patient Visit List 
Recommending items to clients is an important way to provide better pet health care and to generate 
revenue for your practice. By placing recommended items on the Patient Visit List (PVL) and tracking 
whether clients accept or decline the recommendation, this important information is available to the rest 
of the staff.  

Before You Begin 

• Set the Transfer to patient visit list when finalized options in Estimate defaults (Controls > Defaults 
> Practice and Workstation > select Estimate from the menu on the left). 

• Set the When inventory details need to be verified option for Performed PVL items and Saved 
Invoices in Inventory defaults (Controls > Defaults > Practice and Workstation > select 
Inventory from the menu on the left). 

• Set the Display patient visit message option and Patient visit list options in Invoice defaults 
(Controls > Defaults > Practice and Workstation > select Invoice from the menu on the left). 
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To add recommended items to the Patient Visit List: 

1. To open the Patient Visit List for a patient, do one of the following: 

• With the patient’s record open on the Patient Clipboard, in the Patient list area, right-click the 
patient’s name and select Patient Visit List. 

• Click the Patient Visit List  toolbar button. 

2. Depending on how you accessed the Patient Visit List, the patient may already be selected. If not, in 
the ID field, enter the patient ID by either typing the ID or pressing F2 to search for and select the 
patient from the Patient List.  

3. If necessary, select a different owner from the Owner drop-down list. 

4. In the next available Item ID field, enter an item ID by either typing the ID or pressing F2 to search 
for and select the item from the Invoice Item List. 

Tip: You can also click Travel Sheet to select items from a travel sheet. See “Transferring Invoice 
Items from a Travel Sheet” on page 186 for information. 

With the item ID entered, one or more dialog boxes may display, depending on the type of item 
entered and its associated special actions, if any.  

5. If necessary, change the Qty for the item.  

6. The item pricing is calculated automatically, based on the specified quantity, and is displayed in the 
Amount field. Change the price, if necessary. 

Note: You may not be allowed to change the item’s pricing, based on the Allow change setting for 
this item on the Invoice Item Information window’s Info tab. If changes are allowed, you may be 
required to select a price change reason. 

7. Complete the remaining fields for the line item as needed. See “Line Item Entry Grid” on page 131 
for more information. 

8. If necessary, change the status of the item to Accepted, Performed, Declined or Declined to 
history by clicking the status button to the immediate left of the item ID. See “Item Status Column” 
on page 131 for more information. 

Tip: To quickly change the item status for all Recommended and/or Accepted invoice items on the 
PVL to Performed, click Perform. 

9. To change the order that items appear on the PVL, click in the item’s Item ID field and move the 
item up or down using the arrow buttons in the bottom-right corner of the window. Items will be 
transferred to the invoice in this order. 

Tip: To quickly sort the items in ascending date order, click Sort by Date. 

10. To remove an item from the PVL, click in the item’s Item ID field and press CTRL+D. To delete an 
item that is part of a group, click in the item’s Qty field and press CTRL+D. 

11. As needed, perform additional tasks from the PVL using the buttons on the right side of the window. 
See “Patient Visit List Task and Action Buttons (Right Side of Window)” on page 134 for more 
information. 

12. When you are finished, click OK to save any changes and close the Patient Visit List. 

When the Patient Visit List is closed, any items marked as Declined are deleted, and any items 
marked as Declined to history are transferred to patient history. 
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 For a list of all items currently on the Patient Visit List for all patients, print the Patient Visit List By 
Date Report or the Patient Visit By Type Report (both in the End of Day report group).  

Viewing the Patient Visit List on the Daily Planner 
The Daily Planner’s Patient Visit List tab allows you to view invoice items on the Patient Visit List (PVL) 
associated with a specific staff member or for all staff. You can also organize the displayed PVL 
information in staff order or by item classification. Viewing the PVL information by item classification 
allows you to narrow the list of patients to those that have an invoice item associated with a selected 
classification. 

To access the Patient Visit List for a specific patient, right-click a patient in the list and select Update. To 
display the Patient Visit List Report for a specific patient, right-click a patient in the list and select Print. 

See “Chapter 14: Using the Daily Planner” beginning on page 134 for information on the Daily Planner. 
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This chapter covers the steps required to enter treatment orders and perform other daily usage tasks  
in the Electronic Whiteboard. For information on the steps required to set up the Electronic Whiteboard 
in Cornerstone, see “Chapter 13: Setting Up the Electronic Whiteboard” in the Cornerstone 
Administrator’s Manual. 

 

Overview 
The Electronic Whiteboard encompasses three windows that work in conjunction to provide you with a 
comprehensive solution for ordering, processing and tracking patient treatments within the hospital. 

• Patient Orders window – Used to schedule and manage treatment orders for a patient on the 
Whiteboard. 

• Whiteboard (main grid) window – Provides a centralized view of patients’ treatment schedules and 
statuses and acts as a key entry point to ordering and editing treatments. 

• Patient Treatments window – Allows you to view and complete treatment orders for a patient on 
the Whiteboard. 

This chapter covers the following tasks to help you get started entering treatment orders and performing 
other Whiteboard daily usage tasks: 

• Add a patient to the Whiteboard 

• Schedule patient orders 

• Delete, discontinue, or reinstate orders 

• View the Whiteboard on a second monitor 

• Set the sort order for viewing patients on the Whiteboard 

• Set filter options for viewing treatments on the Whiteboard 

• Change the date for viewing treatments on the Whiteboard 

• Working with patient alerts on the Whiteboard 

• Complete a treatment or multiple treatments simultaneously 

• Reverse a completed treatment 

• Remove a patient from the Whiteboard 

• Discharge a patient through invoicing 

• Work with Whiteboard reports 

Adding a Patient to the Whiteboard 
A patient must have a status of Inpatient to be added to the Whiteboard. You can update this status 
using the Patient Check-in/out window, Patient Clipboard, Census List or Whiteboard window. 

From the Patient Check-in/out window: 

1. Check in the patient as usual.  

2. Select the Inpatient option to automatically place the patient on the Whiteboard upon check-in. 
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Note: Once a patient is checked in as an Inpatient, you cannot change this option to Outpatient. 

From the Patient Clipboard: 

 Select the client, and then right-click on the patient’s name in the Patient list area and select 
Electronic Whiteboard > Patient Orders. The patient’s information displays in the Patient Orders 
window with the Inpatient status selected by default. 

From the Census List: 

1. Select the patient on the Census List and click Update to display the patient’s information in the 
Patient Check-in/out window.  

2. Select the Inpatient option and click the Check-in button, or, if the patient is already checked in, 
click the Update button. 

From the Whiteboard: 

1. In the Patients column, right-click and select Orders for New Patient.  

2. Within the Patient Orders window, enter the patient’s ID in the ID field by either typing the ID or 
pressing F2 to search for and select the patient from the Patient List. The Inpatient status is selected 
by default. 

About the Patient Orders Window 
The Patient Orders window is used to schedule and manage treatment orders for a specific patient on 
the Whiteboard.  

 
Patient Orders window 

To access the Patient Orders window, do one of the following: 

• From the Whiteboard, right-click a patient in the Patients column and select Patient Orders (or 
select Orders for New Patient for a patient who is not already on the Whiteboard). 
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• From the Patient Clipboard, in the Patient list area, right-click the patient’s name and select 
Electronic Whiteboard > Patient Orders. 

• From the Activities menu, select Electronic Whiteboard > Patient Orders. 

Patient Order Information Area (Top of Window) 

Column/Field Description 

Patient ID Indicates which patient’s orders are being scheduled. 

Depending on how you accessed the Patient Orders window, the patient 
may already be selected. If not, in the Patient ID field, enter the patient ID 
by either typing the ID or pressing F2 to search for and select the patient 
from the Patient List. 

With the patient ID specified, the patient’s name, client name, client ID, 
age, weight and body score (if activated), species, breed and sex 
information displays. 

Vital Signs/Weight  
button 

Allows you to access the Vital Signs window to update weight and/or other 
vital signs for the patient. 

Note: The button displays in red/yellow  as an alert if at least one vital 
sign (other than weight and body score) has not been entered for the 
patient within the past 10 days. 

Status Indicates the patient’s standing within the hospital. Options include: 

• Inpatient – patient is currently being treated. 

• Ready to go home – patient’s treatments are completed. 

• Discharged – client has been invoiced and the patient has been 
checked out of the hospital (or was manually removed from the 
Whiteboard). 

• Any custom status that has been set up for the hospital. 

Note: A custom status will be considered equal to the “Ready to go home” 
status in Cornerstone only if it contains one of the following keywords: 
Ready, Home, Pick, Release, or Discharge. 

Critical Select this check box if you want to flag a patient as critical and display the 

Critical  icon for the patient on all Electronic Whiteboard windows, the 
Check-in/out window and the Census List window.  

Patients flagged as critical display at the top of the Patients column on the 
Whiteboard, regardless of the selected sort order (with the exception of the 
Treatments for Hour sort orders, where critical patients display at the top 
only if they have treatments for that hour). 

Primary Reason for Visit The general type of problem or procedure requiring the patient to be 
hospitalized (e.g., Dental, Emergency, Surgery).  

Depending on the color assigned to this reason during setup (in Controls 
> Appointment Scheduler > Reason for Visit), a color-coded circle 
appears with the patient information on the Whiteboard and Patient 
Treatments window to indicate the reason for visit. 

Cornerstone User’s Manual                  139 



Chapter 10: Using the Electronic Whiteboard 

Column/Field Description 

Secondary Reason for Visit The Secondary reason for visit can be used to indicate the specific 
problem or procedure requiring the patient to be hospitalized (e.g., 
Extraction, Vomiting, Spay). If a secondary reason for visit is specified, it 
displays with the patient information on the Whiteboard and Patient 
Treatments windows. 

Note: A Primary reason must first be specified in order to activate the 
Secondary field. The secondary reason can then be selected from the 
predefined drop-down list, or staff can manually enter a different 
secondary reason. 

Admit date/time Indicates when the patient is admitted to the hospital. 

Discharge date Indicates when the patient is scheduled to leave the hospital. (Cornerstone 
adds three days to the Admit date and inserts this date by default.) 

Supervising Doctor The doctor who admits the patient and is the overriding decision maker for 
the case. 

Current Care Doctor The doctor who assumes care of the patient if there is a shift change or if 
the supervising doctor is unavailable. 

Cage Specific location where the patient will be located while hospitalized. 

Ward General location where the patient will be staying while hospitalized. 

 

Item Transfer Buttons (Right Side of Window) 

Column/Field Description 

PVL Used to access the Whiteboard Patient Visit List and transfer invoice items 
to the Patient Orders entry grid. See “Transferring Patient Order Items from 
the Whiteboard Patient Visit List” on page 145 for information. 

Travel Sheet Used to transfer invoice items from travel sheets to the Patient Orders entry 
grid. See “Transferring Invoice Items from a Travel Sheet” on page 186 for 
information. 

 

Patient Orders Entry Grid 

Column/Field Description 

Hide completed and 
discontinued treatments 

Select this check box if you want to display only uncompleted treatments 
for the patient. 

Alerts If Whiteboard alerts exist for the patient, you can view those alerts from the 
Patient Orders window.  

If there is more than one alert for the patient, a downward-pointing arrow 
displays to the right of the Alerts field to indicate there are more alerts to 
view. Rest the mouse pointer on the displayed alert to view the patient’s full 
alert list in a pop-up window. 

To open the Whiteboard Alerts dialog box to edit or add to the patient’s  
alert list, click the blue edit link (located to the right of the Alerts field). 
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Column/Field Description 

Left column for numbering 
patient treatment orders 

To specify the order in which treatments should display on the Whiteboard 
and Patient Treatments windows, renumber them as needed by changing 
the numbers in the left column. The order of treatments specified on the 
Patient Orders window is the order that will be used to display the 
treatment lines within the patient’s treatment block for each hour on the 
Whiteboard. 

To renumber a treatment order line, change the number in the left column 
as desired and then press TAB. 

Note: For group items, you cannot change the order of the individual items 
until after the patient orders have been saved by clicking OK on the Patient 
Orders window. You can then reopen the window and reorder the 
individual items as desired. 

Item ID Used to specify the treatments to order for this patient. 

Quantity The total number of the invoice item to be charged each time the treatment 
is completed (can be changed later, if necessary). 

Billing For this Patient Orders invoice item, indicates what will appear on the 
invoice and in patient history, and how often it will appear. Billing options 
include: 

1 line each time – The item appears on the invoice and in patient history 
each time the treatment is completed. 

1 line each day – Although a treatment is completed several times during 
the day, at the end of the day, only one line item appears on the invoice 
and in patient history, showing the total quantity and price. 

1 line each visit – Regardless of how many times a treatment is 
completed during the course of the hospital stay, only one line for the 
entire visit appears on the invoice and in patient history, showing the total 
quantity and price. 

For example, if a treatment is performed on January 22nd and 23rd, the 
item appears in history as being performed twice on the 23rd. 

No billing or inventory reduction – The treatment item is not placed on 
the invoice or in patient history, which means the invoice item is not pulled 
from inventory and the client is not charged. (If, however, the Save to 
history option is selected when the treatment is processed, a Whiteboard 
medical note will be added to the patient’s history for the item.) 

If the No billing.... option is selected for an item, the No Billing  icon 
displays in the blue line below the line item as a reminder to staff. This icon 
also appears on the Patient Treatments window for the order item. 

Note: It is possible to choose any of these billing options for a service 
item. However, for inventory items, only 1 line each time or No billing or 
inventory reduction can be selected. 

Category Used to indicate the type of care that applies to the treatment order item. 
Examples include Medication, Diagnostics, Daily Care, Treatments, and 
any custom category that has been set up for the hospital. 
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Column/Field Description 

Frequency How often the treatment should be performed. Many commonly used 
frequencies are provided, including: 

Continuous – Treatment is continued until the end of the specified 
duration occurs, the treatment is discontinued, or the patient is checked 
out. Continuous treatment time blocks display with a light blue background 
on the Whiteboard. 

Until Completed – Used when a time for completion cannot be assigned 
based on the type of action or treatment (e.g., staff needs to obtain a urine 
sample). When selected, Until Completed will display continuously on the 
Whiteboard until it is processed once. Then the treatment will be marked 
Completed at the time staff processes the order. 

One time – Treatment will be added for the start date and time indicated 
on the order. 

Every X hours – Treatment will be added for the start date and time listed 
on the order and for every number of hours indicated until the discharge 
date. 

Every X days – Treatment will be added for the start date and time listed 
on the order and for every number of days indicated until the discharge 
date. 

Note Used to indicate whether a Whiteboard medical note entry is required 
when the selected treatment is marked as Completed or Did not perform. 

Vital Signs Prompt  
Select this check box if you want staff to be prompted to record vitals for 
the patient every time this item is completed within the Patient Treatments 
window. 

PRN Select the PRN (pro re nata) check box to indicate that the treatment or 
task is to be completed as needed. 

Dose Now Indicates if the dose should start now, before the prescheduled time, or for 
frequencies such as SID, which is once a day, BID, which is twice a day, 
TID, which is three times a day or QID, which is four times a day. 

Start Date/Time When to start the patient treatment. 

Duration Days/Hrs The number of days and/or hours to continue the treatment or action. If a 
number is not entered, the treatment order remains on the Whiteboard until 
completed. 

Area Indicates where the treatment will be performed. This allows staff to narrow 
the list of treatments that display on the Whiteboard and Patient 
Treatments windows to a specific area. 

Staff Class Used to indicated which type of staff should perform the treatment. 

Blue line Use the blue line below each treatment item to enter any special 
instructions for the item. These instructions appear on the Patient 
Treatments window and are saved in the Whiteboard medical notes when 
the treatment is completed. 
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Scheduling Patient Orders 
The Electronic Whiteboard’s Patient Orders window allows you to add treatment orders for a patient. 

To schedule orders for a patient: 

1. Add the patient to the Whiteboard (see page 137) and access the Patient Orders window for the 
patient. 

2. If necessary, in the ID field, enter the ID for the patient by typing the ID and pressing TAB, or 
pressing F2 to search for and select the patient from the Patient List. 

3. If necessary, click the Vital Signs/Weight  button to record vitals for the patient within the Vital 
Signs window. 

4. In the Status field, select Inpatient. This status is used to check in and place the patient on the 
Whiteboard. 

5. If this is a critical care patient, select the Critical check box to flag a patient as critical and display 
the Critical  icon for the patient on all Electronic Whiteboard windows, the Check-in/out window 
and the Census List window.  

6. Under Reason for visit, click the Primary drop-down list and select a reason to indicate the general 
type of visit (e.g., Dental, Emergency, Surgery). If desired, in the Secondary field, select or type a 
secondary reason to provide more detail on the specific problem or procedure (e.g., Extraction, 
Vomiting, Spay). 

7. In the Admit date and time fields, specify when the patient will be admitted to the hospital by either 
typing the information or pressing F2 in the date field to select it from a calendar and then typing the 
time. (Cornerstone will insert the current system date and time by default.) 

8. In the Discharge field, enter the date the patient is scheduled to be discharged from the hospital. 

9. Under Doctor, in the Supervising field, enter the staff ID of the doctor who admits and is the 
overriding decision-maker for the case by either typing the ID or pressing F2 to search for and select 
the doctor from the Staff List. In the Current Care field, enter the staff ID of the doctor who assumes 
care of the patient if there is a shift change or because the supervising doctor is unavailable. 

Note: The supervising doctor and current care doctor can be the same. 

10. In the Cage field, type the name of the specific cage the patient will be staying in during 
hospitalization. 

11. From the Ward list, select the general area where the patient will be located. 

12. To display only uncompleted treatments for the patient on this window, select the Hide completed 
and discontinued treatments check box. This option is generally selected if the patient has existing 
orders. 
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13. If Whiteboard alerts exist for the patient, you can view and edit those alerts from the Patient Orders 
window: 

• If there is more than one alert for the patient, a downward-pointing arrow  displays to the right 
of the Alerts field to indicate there are more alerts to view. Rest the mouse pointer on the 
displayed alert to view the patient’s full alert list in a pop-up window. 

• To open the Whiteboard Alerts dialog box to edit or add to the patient’s alert list, click the blue 
edit link (located to the right of the Alerts field). 

14. To add the actual treatment orders for the patient, you have several options. You can transfer items 
from the Whiteboard Patient Visit List (see page 145), transfer items from travel sheets (see page 
186), and/or manually add items within the Patient Orders entry grid (see the following step).  

15. To manually add an invoice item, group code, or item from a pick list, do the following: 

a. In the Item ID field, type the invoice item ID and press TAB, or press F2 to search for and select 
the item from the Invoice Item List. 

Note: If there are Whiteboard defaults set up for this item on the Invoice Item Information 
window’s Whiteboard tab, those default values, change rules and editing permissions settings 
will be applied for this item’s Patient Orders entry grid fields. 

b. In the Quantity field, if known, type the total number of the invoice item to be charged each time 
the treatment is completed. This number can be changed when completing the treatment if 
necessary. 

c. In the Billing field, select the appropriate option for what and how many times a treatment item 
appears on the invoice and in patient history. If this is an inventory item, only 1 line each time or 
No billing or inventory reduction can be selected. When a patient order item is set to No 
billing..., the invoice item is not pulled from inventory, and the client is not charged. 

Note: If No billing... is selected, the No Billing  icon displays in the blue line below the line 
item as a reminder to staff. This icon also appears on the Patient Treatments window for the 
order item.  

d. In the Category field, select the type of care that applies to this invoice item. 

e. In the Frequency field, select how often the treatment should be performed.  

f. In the Note field, you have the option of choosing to require a medical note be entered when the 
selected treatment is marked as Completed or Did not perform. 

g. Select the Vital Signs Prompt  check box if vital signs need to be recorded when the 
treatment is completed for this item. 

h. Select the PRN (pro re nata) check box for items that are to be completed as needed. 

i. Select the Dose Now check box for items that should be administered starting immediately for 
frequencies such as SID for once a day, BID for twice a day, TID for three times a day, or QID 
for four times a day. 

j. In the Start Date and Time fields, modify the date and time to start the treatment, if necessary. 
You can specify an on-the-hour time (10 AM, 2 PM, etc.) or an incremental on-the-minute time 
(10:15 AM, 2:30 PM, etc.). 

Note: If you want to enter orders for a treatment needing to be completed every X minutes 
within a single hour—for example, a Glucose Curve test every 10 minutes—you would need to 
add a separate treatment order line for each occurrence. 
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k. In the Duration Days and Hrs fields, type the number of days and/or hours to continue the 
treatment, if necessary. If no duration is entered, the treatment orders remain on the Whiteboard 
until completed. 

l. In the Area field, select where the treatment will be performed. 

m. In the Staff Class field, select the type of staff member who should perform the treatment. 

n. Repeat steps a-m to schedule additional patient treatment orders, if necessary. 

16. If needed, type any special instructions for an item on the blue line below the white invoice item line. 
These instructions will appear within the Patient Treatments window below the item and in the 
finalized Whiteboard note.  

17. When you have finished entering patient orders, if desired you can rearrange the orders as needed 
by changing the numbers in the left column. To renumber a treatment order line, change the number 
in the left column as desired and then press TAB. (The order of treatments specified on the Patient 
Orders window is the order that will be used to display the treatment lines within the patient’s 
treatment block for each hour on the Whiteboard.)  

Note: For group items, you cannot change the order of the individual items until after the patient 
orders have been saved by clicking OK on the Patient Orders window. You can then reopen the 
window and reorder the individual items as desired. 

18. When the patient orders are complete, click OK. 

Note: You may return to the Patient Orders window later to add additional orders if needed. To 
access the patient orders from the Whiteboard, right-click on the patient in the Patients column and 
select Patient Orders.    

Transferring Patient Order Items from the Whiteboard Patient Visit List 
When you access the Patient Orders window for a patient, there may already be invoice items on the 
Patient Visit List that were transferred from other areas of Cornerstone. When scheduling patient 
treatment orders, you can easily transfer these items from the Whiteboard Patient Visit List. 

WARNING: Failure to transfer Whiteboard Patient Visit List items to patient orders can result in duplicate 
charges. 

To transfer items from the Whiteboard Patient Visit List: 

1. On the Patient Orders window, with all Patient order information area fields completed for the patient, 
click the PVL button. The Whiteboard Patient Visit List displays invoice items transferred from other 
areas of Cornerstone. 
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Whiteboard Patient Visit List 

2. Indicate which items to move to the Patient Orders window by either clicking the Ord check box next 
to each applicable item or clicking the Select all check box to choose all invoice items not marked 
as performed and any performed lab requests. 

Note: Any item marked as performed, with the exception of the performed lab requests, cannot be 
transferred. 

3. As needed, perform other Whiteboard Patient Visit List tasks or actions using the buttons on the 
right side of the window: 

• Perform – Change the item status for all Recommended and/or Accepted invoice items on the 
Whiteboard PVL to Performed, indicating that you are ready to bill for these items. 

• Sort by Date – Sort the items on the PVL in ascending date order. 

• Departing – Display the Departing Instructions dialog box to view or modify departing 
instructions linked to invoice items on this PVL. 

• Pharmacy – Access the Pharmacy Formulary (Pharmacy Formulary module only). 

• Special – View and/or process any special actions linked to the invoice items on this PVL. 

• Travel Sheet – Select items to transfer from your practice’s travel sheet. 

• Arrow buttons – Use the  or  arrow buttons to reorder the invoice items. 

4. Click the Order button to transfer the selected items and return to the Patient Orders window. 

Items transferred from the PVL to the patient’s orders are removed from the PVL. These items are 
rewritten to the PVL when they are marked Completed on the Whiteboard. 
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Deleting, Discontinuing, or Reinstating Treatment Orders 
You can delete, discontinue or reinstate orders listed within the Patient Orders window. 

To delete an order that has not been saved: 

Note: Items on the patient’s orders that have been saved cannot be deleted. 

1. Within the Patient Orders window, click the line item you want to delete. 

2. Press CTRL+D.  

To discontinue a treatment once the order has been saved: 

1. Within the Patient Orders window, right-click the line item and select Discontinue treatment. The 
line item is grayed out. 

2. Click OK to save the change and return to the previous window. 

When viewing the Whiteboard or Patient Treatments window, a gray Discontinue block will appear for an 
order that was discontinued. 

To reinstate a treatment that has been discontinued: 

1. Within the Patient Orders window, right-click the grayed out line item and select Restart treatment.  

2. A warning message appears to inform you that restarting this line will reinstate the line as if it was 
never discontinued and asks if you would like to continue restarting this line. Click the Yes button to 
confirm the treatment should be reinstated. 

3. Click OK to save the changes and return to the previous window. 

When viewing the Whiteboard or Patient Treatments window, a Scheduled block will appear for an order 
that was reinstated. 
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About the Whiteboard Window 
The Whiteboard (main grid) window provides a centralized view of patients’ treatment schedules and 
statuses and acts as a key entry point to ordering and editing treatments. 

 
Whiteboard (main grid) window 

To access the Whiteboard, do one of the following: 

• On the Cornerstone toolbar, click the Whiteboard  button. 

• From the Patient Clipboard, in the Patient list area, right-click the patient’s name and select 
Electronic Whiteboard > Whiteboard. 

• From the Activities menu, select Electronic Whiteboard > Whiteboard. 

Sort and Showing Areas (Top of Window) 

Column/Field Description 

Sort Allows you to sort the Patients column by Patient Name, Client Name, 
Reason for Visit, Check in Date/Time, Doctor, Status or Treatments for 
Hour. 

Date Allows you to change the date for treatments displaying in the time slot 
columns. If the date is yellow, it indicates the date displayed is different 
than the current system date. 

Go to Now button Resets the grid to the current hour and day. (The current hour column 
header displays in bold black text on a yellow background with “Now” 
appearing to the right of the hour.) 

Showing Displays all currently selected filters for Practice (Multi-Location/Single 
Database only), Ward/Loc, Area and Doctor. 
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Column/Field Description 

Edit button Opens the Whiteboard Filter dialog box where you can set filters to narrow 
the list of patients on the Whiteboard. 

Show All button Resets the filter criteria to display all patient treatments within the given 
timeframe. 

 

Patients Column (Left Side of Window) 

Column/Field Description 

Patient information blocks The Patients column displays information for patients staff are currently 
working with, those ready to go home and, depending on the practice 
default set, those discharged from the hospital. 

Each patient information block in the Patients column includes three lines 
of information that provides important at-a-glance information for staff 
monitoring patients on the Whiteboard. 

 

First line  

The color-coded patient name helps to identify the status of the patient or 
the status of the patient’s treatment orders: 

• Yellow     – Indicates the patient does not have any treatment orders 
assigned OR is on the Whiteboard past the expected discharge date. 

• Red     – Indicates the patient has overdue treatment orders. 

• Black     – Indicates the patient’s treatments are up to date. 

The first line of a patient’s block also includes a color-coded dot that 
indicates the primary reason for visit. The adjacent bold text that provides 
the secondary reason. If a secondary reason is not assigned, the primary 
reason text displays. 

Second line  

The second line of the patient block includes: 

• Client last name 

• Client ID 

• Critical  icon (if applicable) 

• Patient’s status within the hospital 

Third line  

The third line of the patient block includes: 

• Species 

• Weight 

• Current care doctor 
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Column/Field Description 

Patient block pop-up window To view additional patient information in a pop-up window, rest the mouse 
pointer on a patient block. The pop-up window displays patient order 
information pertaining to this visit and includes the pet’s picture (if one is 
included in the patient record). 

Right-click menu Right-click in a patient block to display a list of menu options: 

Patient Treatments – Allows you to access the Patient Treatment window 
and complete or mark a treatment as not performed for the selected 
patient. 

Patient Orders – Allows you to access the Patient Orders window and add 
or work with existing treatment orders for the patient. 

Patient Clipboard – Allows you to access the Patient Clipboard for the 
patient. 

Patient Visit List – Allows you to access the Patient Visit List and work with 
invoice items that will later be transferred to an invoice or the patient’s 
history. 

Patient Vital Signs – Allows you to access the Vital Signs window and 
record vitals for the patient. 

Remove from Whiteboard – Allows you to remove the patient from the 
Whiteboard without creating and posting an invoice. 

Orders for New Patient – Allows you to access the Patient Orders window 
and add orders for a patient that is not currently on the Whiteboard. 

Hide Discharged Patients – Select this option if you no longer want to 
view patients on the Whiteboard that have been discharged. 

View/Print Selected Day or View/Print Prior 24 Hours – Allow you to print 
a Patient Treatment Report. 

View/Print Selected Day – Allows you to print a list of patient treatments 
for a date or selected date range. 

View/Print Prior 24 Hours – Allows you to print a list of patient treatments 
from the previous day for patients still checked in. 

Refresh button Used to update the window to reflect the current information. 

 

Note: The number shown in parentheses at the top of the Patients column indicates the current number 
of patients on the Whiteboard (note that any currently selected filters may affect the number shown). 
Depending on the size and orientation of your monitor, there may be more patients on the Whiteboard 
than can be displayed vertically in this column at one time. This indication of the total number of patients 
serves as a reminder that you may need to use the right-side scroll bar to view additional patients at the 
bottom of the list. 

Whiteboard Grid Hour Columns 

Depending on the option set in Whiteboard defaults, the Whiteboard grid’s hour columns may display for 
the current day only or for the current day with 3 hours added for the previous and next days. 

If the current day with 3 hours… default is selected for the workstation, blue << Previous and  
Next >> links will display when you scroll horizontally to the outer limits of the 24 one-hour columns. 
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You can click the appropriate link to move the grid columns to change the date and display the hours for 
the previous day or next day. 

Tip: Click the Go to Now button to the right of the date field to quickly reset the grid to the current hour 
and day.  

Treatment Blocks (Displayed in Columns by Hour) 

Patient treatment blocks include detailed information on each treatment scheduled for the time block. 
The treatment lines listed within a block are ordered according to the numbering of the invoice items in 
the left-most column on the Patient Orders window. 

Color coding indicates the status of each treatment line: 

• Green     = Completed (a check mark  also displays next to any completed treatment lines) 

• Bright blue     = Scheduled 

• Light blue     = Continuous 

• Red    = Overdue 

• Gray     = Discontinued or Did not perform 

If a treatment’s Start Time was set up to use an incremental (on-the-minute) time (10:15 AM, 2:30 PM, 
etc.) on the Patient Orders window, the incremental time will display at the beginning of that individual 
treatment line within the block. For example, if a Glucose Curve is scheduled to be performed at 8:30 
AM, the patient’s treatment block in the 8 am column will display :30 Glucose Curve.  

Note: If an incremental time is specified, the treatment line turns red to indicate it is overdue on the 
Whiteboard when that specific time passes (not at the end of the hour, as with nonincremental treatment 
times). 

Alerts Column (Right Side of Window) 

The Alerts column on the Whiteboard window allows you to add, edit and view selected types of patient 
alerts. 

 

Depending on your setup, the Alerts column may display the following types of alerts (which are 
automatically added when a patient is initially placed on the Whiteboard): 

• Whiteboard Alert List alerts 

• Patient Prompt alerts 

• Patient Classification alerts 

• Alerts manually entered on the Check-in window 
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• Alerts manually entered on the Whiteboard 

Note: After a patient is added to the Whiteboard, changes to patient prompt, patient classification, or 
check-in alert information will not be reflected and will need to be manually updated on the Whiteboard.  

If more than three alerts exist for a patient, a downward-pointing arrow  displays in the block to indicate 
there are more alerts to view. Rest the mouse pointer on the alert block to view the patient’s full alert list 
in a pop-up window. 

You can click anywhere within a patient’s Alerts block to open the Whiteboard Alerts dialog box to edit or 
add to the patient’s Alerts list.  

Note: Alert text displays in red unless it is a Patient Prompt Alert that has been assigned a different color 
in Controls > User Defined Prompts. 

Viewing the Whiteboard on a Second Monitor 
You can run the Whiteboard on a standard workstation monitor and also display it simultaneously on a 
second monitor (connected to the same workstation) without having to dedicate a second computer. 
Ideally, the second monitor would be a larger flat-screen monitor turned vertically and mounted on a 
central wall in the practice for all staff to reference at a glance. 

To display the Whiteboard on a second monitor: 

1. On the menu bar, select Activities > Electronic Whiteboard > Whiteboard (second monitor). 
The Whiteboard displays on the main monitor. 

2. Drag the Whiteboard so it displays on the second monitor and click its Maximize button in the top 
right corner of the window. 

3. To view another Whiteboard on the main monitor for normal Cornerstone use, from the menu bar 
select Activities > Electronic Whiteboard > Whiteboard. The Whiteboard displays on the main 
monitor. 

When staff right-click and select an option on the second monitor’s Whiteboard, that window will open 
on the main monitor. 

Setting Filter Options for Viewing Treatments on the Whiteboard 
When viewing patients’ treatments on the Whiteboard, you have several options for selecting filters to 
narrow the list of patients displayed. 

Note: The Showing area at the top of the Whiteboard window displays all currently selected filters. 
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To set filters to narrow the list of patients displayed on the Whiteboard: 

1. Click the Edit button (upper-right corner of the Whiteboard window) to access the Whiteboard Filter 
dialog box and set the following filters as desired: 

• The Practice field (Multi-Location/Single Database configurations only) is used to narrow the list 
of patients to those currently checked in under a specific practice or all practices. 

• The Ward/Location field is used to narrow the list of patients to those residing in a specific area 
of the hospital before and after treatments are performed. 

• The Areas field is used to narrow the list of patients to the location where inpatient orders are 
scheduled to be performed. 

• The Doctor field is used to narrow the list of patients to the staff selected as the current care 
doctor within the Patient Orders window. 

2. Click OK. 

Note: To reset the criteria to display ALL patient orders within the given time frame, click the Show All 
button in the upper-right corner of the Whiteboard window (also available on the Whiteboard Filter dialog 
box). 

Setting the Sort Order for Viewing Patients on the Whiteboard 
When viewing patients’ treatments on the Whiteboard, you can sort the Patients column on the left side 
of the window by: 

• Patient Name 

• Client Name 

• Reason for Visit 

• Check in Date/Time 

• Doctor 

• Status 

• Treatments for Hour 

To change the Patients column sort order: 

 On the Whiteboard, select the desired sort order from the Sort drop-down list. 

Notes:  

• Patients flagged as critical display at the top of the Patients column on the Whiteboard regardless 
of the selected sort order (with the exception of the Treatments for Hour sort orders, where critical 
patients display at the top only if they have treatments for that hour). 

• The sort order defaults to Patient Name unless a different default sort option has been specified for 
the workstation in Workstation defaults. 

Tip: You can right-click in the Patients column and select Hide Discharged Patients if you no longer 
want to view patients on the Whiteboard that have been discharged. 

Changing the Date for Viewing Treatments on the Whiteboard 
The Whiteboard displays the times that patient treatments are due for the selected date. 
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The Whiteboard’s date field (to the right of the Sort drop-down list) indicates which day’s treatments 
display in the time slot columns. The date defaults to the current system date, but you have several 
options for quickly changing the displayed date. 

Note: If the date field is yellow, it indicates the date is different than the current system date. 

To change the date for viewing treatments on the Whiteboard, do any of the following: 

• To quickly reset the time slots grid to the current hour and day, click the Go to Now button. 

• To change the date using the date field, type a date or press F2 to search for and select a date from 
a calendar. 

• To move the date backward or forward one day at a time, click the previous  and next  buttons 
on either side of the date field. 

• If the current day with 3 hours for previous and next days default is selected for the workstation in 
Whiteboard defaults, blue << Previous and Next >> links display when you scroll horizontally to 
the outer limits of the 24 one-hour columns. Click the appropriate link to move the grid columns to 
change the date and to display the hours for the previous day or next day. 

Working with Patient Alerts on the Whiteboard 

Adding and Editing Whiteboard Alerts 

Using the Whiteboard Alerts dialog box, you can manually enter patient alerts to display on the 
Electronic Whiteboard windows. You can also change the order of the alerts, remove an alert, and edit a 
manually entered alert. 

To access the Whiteboard Alerts dialog box: 

• On the Whiteboard (main grid) window, click anywhere within a patient’s Alerts block. 

• On the Patient Orders window, click the blue edit link (located to the right of the Alerts field). 

To add a Whiteboard alert: 

If needed, you can manually enter patient alerts to display in a patient’s Alerts column on the 
Whiteboard. 

1. On the Whiteboard Alerts dialog box, type the alert in the text box and click Add. 

2. Click OK. 

To edit a manually entered Whiteboard alert: 

1. On the Whiteboard Alerts dialog box, select a manually entered alert in the patient’s Whiteboard 
alerts list and click Edit. 

2. Make changes to the text to display for the alert and click OK. 

3. Click OK. 

To reorder Whiteboard alerts: 

The Whiteboard has room to display only three alerts in each patient’s Alerts block, and the Patient 
Orders and Patient Treatments windows are limited to displaying only one alert. For this reason, you may 
want to change the order so that the most important alerts are at the top of the list and always visible. 

1. On the Whiteboard Alerts dialog box, select an alert in the patient’s Whiteboard alerts list and then 
click the  or  arrow button as needed to move it within the list. 

2. Click OK. 
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To remove a Whiteboard alert: 

1. On the Whiteboard Alerts dialog box, select an alert in the patient’s Whiteboard alerts list and then 
click Remove. 

2. Click OK. 

About the Patient Treatments Window 
The Patient Treatments window displays orders for a specific patient and allows you to mark each 
scheduled treatment as Completed or Did not perform. 

 
Patient Treatment windows 

To access the Patient Treatments window, do one of the following: 

• From the Whiteboard, right-click a patient in the Patients column and select Patient Treatments (or 
double-click within the patient’s information block or in one of their treatment blocks). 

• From the Patient Clipboard, in the Patient list area, right-click the patient’s name and select 
Electronic Whiteboard > Patient Treatments. 

• From the Activities menu, select Electronic Whiteboard > Patient Treatments. 
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Patient and Orders Information Area (Top of Window) 

Column/Field Description 

Patient information The area across the top of the Patient Treatments window displays general 
information about the patient and client, and information entered within the 
Patient Orders window. 

Vital Signs/Weight  
button 

Allows you to access the Vital Signs window to update weight and/or other 
vital signs for the patient. 

Reason for  Visit (Primary 
and Secondary) 

If applicable, both the primary and secondary reasons for visit are 
provided. A colored-coded dot indicates the primary reason for visit and 
the adjacent text provides the secondary reason. If a secondary reason is 
not assigned, the primary reason for visit text displays. 

Critical  icon 
If the patient has been flagged as critical on the Patient Orders window or 
during check-in, this icon displays to the right of the reason for visit. 

Admit date/time Indicates when the patient was admitted to the hospital. 

Discharge date Indicates when the patient is scheduled to leave the hospital. 

Status Indicates the patient’s standing within the hospital. 

Supervising Dr The doctor who admitted the patient and is the overriding decision maker 
for the case. 

Current Care Dr The doctor who assumes care of the patient if there is a shift change or if 
the supervising doctor is unavailable. 

Cage Specific location where the patient is located while hospitalized. 

Ward General location where the patient is staying while hospitalized. 

Alerts If Whiteboard alerts exist for the patient, you can view those alerts from the 
Patient Treatments window (display below the Cage and Ward 
information).  

If there is more than one alert for the patient, a downward-pointing arrow   
displays to the right of the Alerts area to indicate there are more alerts to 
view. Rest the mouse pointer on the displayed alert to view the patient’s full 
alert list in a pop-up window. 

 

Treatment Display Filters (Above the Treatments Grid) 

Column/Field Description 

Hide discontinued Removes any patient order marked as Discontinued from the list of 
treatments. 

Hide completed Removes a patient order from the list of treatments if all scheduled times 
for the treatment have been completed. 

Show only treatments for 
day 

Displays only the treatments for the date listed in the date field. 

Date filter Indicates the date for which treatments are to display. You can change 
which date to view by either typing the date, pressing F2 to search for and 
select the date from a calendar, or using the arrow keys to move the date 
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Column/Field Description 
backward or forward one day at a time. 

If this field is yellow, it indicates the date is different than the current system 
date. 

Areas filter Used to narrow the list of treatments to those assigned to be performed in 
a specific location. 

Staff Classifications filter Limits the treatments displayed to the specific staff classification assigned 
to a treatment at the time it is ordered. 

Show All button Resets the area and staff classification fields to display all. 

Show Vital Signs button Displays the patient’s vitals on the right side of the window. (Use the Hide 
Vital Signs button to close the vital signs viewing area.) 

• Use the previous  and next  buttons to scroll horizontally 
through the patient’s sets of vital signs, with the most current sets at 
the far right and the oldest to the far left.  

• View any comments by resting the cursor over any comment boxes 
 that display next to a vital sign.  

• Click the Refresh button to manually refresh the data in the vital signs 
area at any time. This information is also automatically updated based 
on the refresh rate set in Whiteboard defaults. 

 

Treatments Grid 

Column/Field Description 

Treatments column Displays a list of treatments for the patient, organized by category. Items 
listed at the top of the column in the brown Treatments for [current hour] 
block indicate treatments that are currently due. The items listed within the 
brown block on the left correlate with the brown color-coded time on the 
right. 

A green vertical line appearing to the left of a treatment indicates all 
scheduled treatments for the item have been completed. 

A red vertical line indicates that one or more instances of the treatment are 
overdue. 

Hour columns Indicate when patient treatments are due to be completed. 

Click a time (across the top of the Treatments grid) to bring all treatments 
due at that time to the top of the list. 

No Billing  icon If an order item’s Billing field was set to No billing or inventory reduction 
on the Patient Orders window, this icon displays as a reminder in the 
Treatments column. 

Treatments right-click menu Right-click in the treatments grid to display a list of menu options. 

Patient Orders – Allows you to access the Patient Orders window and add 
or work with existing treatment orders for the patient. 

Patient Clipboard – Allows you to access the Patient Clipboard for the 
patient. 
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Column/Field Description 
Patient Visit List – Allows you to access the Patient Visit List and work with 
invoice items that will later be transferred to an invoice or the patient’s 
history. 

Patient Vital Signs – Allows you to access the Vital Signs window and 
record vitals for the patient. 

Process Selected Treatments – This option is available when multiple 
treatments are selected on the list to display the completion area at the 
bottom of the window and indicate whether the treatments were 
Completed or Not Performed. 

View/Print Selected Day or View/Print Prior 24 Hours – Allow you to print 
a Patient Treatment Report. 

View/Print Selected Day – Allows you to print a list of patient treatments 
for a date or selected date range. 

View/Print Prior 24 Hours – Allows you to print a list of patient treatments 
from the previous day for patients still checked in. 

Refresh Used to update the information on the Patient Treatments window to 
display the most current information. 

 

Completing Scheduled Whiteboard Treatments 
When a Whiteboard treatment is performed, it should be marked as Completed on the Patient 
Treatments window. 

Completed treatment items are automatically placed on the Patient Visit List to be invoiced and saved in 
the patient’s history. 

To complete a treatment (or multiple treatments) on the Patient Treatments window: 

1. To select a single treatment to complete, double-click the treatment block. 

2. To select multiple treatments to complete at one time for a patient, select the treatments to process 
by doing one of the following:  

• To select random treatments on the list, press and hold the CTRL key and select each 
treatment. With the treatments selected, right-click in the patient treatments area and select 
Process Selected Treatments. 

• To choose a group of consecutive treatments on the list, select the first treatment, press and 
hold the SHIFT key, and select the last treatment. With the treatments selected, right-click in the 
patient treatments area and select Process Selected Treatments. 

Note: When multiple treatments are processed at one time, they must all be processed under the 
same staff member. 

A completion area displays at the bottom of the window. 

3. In the Staff ID field, enter the staff member responsible for the treatment by either typing the staff 
member’s ID and pressing TAB, or pressing F2 to search for and select the staff member from the 
Staff List. This staff member will be recorded with the treatment within the patient’s history. 
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4. Select one of the following options: 

• Select Completed if the treatment has been provided for the patient. The charge for a 
completed treatment item is placed on the Patient Visit List and in the patient’s history, unless it 
is a nonbillable item. 

• Select Did not perform if the treatment was not provided. Any treatment marked Did not 
perform that has a comment entered in the Medical note area will be saved to the patient’s 
history with the description DNP, the item’s description, and the words "Whiteboard Note." 

5. Indicate when the treatment was completed by selecting one of the following: 

• Select Display using scheduled time if the treatment was provided during the scheduled time. 

• Select Display using completed time if the treatment was provided at a time other than the 
scheduled time and staff would like to record the actual time it was completed. If this option is 
selected, type the date and time of completion in the fields provided. 

6. In the Medical note area, type any specific details regarding the treatment. This information, along 
with the providing staff member’s name, appears in patient history. If this is a nonbillable item and 
staff would like to include information about the treatment in medical history, either enter the 
information in the Medical note area or select the Save to history check box on the right if no notes 
are required. 

7. In the Items area, make changes to any listed invoice items as needed. These indicate the charge or 
charges that will apply to the treatment if completed.  

8. When all the information for this treatment order is filled in, click OK. 

9. If the order has the Vital Signs Prompt option selected, the Vital Signs window appears.  

a. Enter the patient’s vitals and click OK. A Staff Selection dialog box appears. 

b. Select the staff member entering the vital signs and click OK to save the information and return 
to the Vital Signs window. 

c. Click  in the upper-right corner to exit and return to the Patient Treatments window. 

10. If you selected multiple treatments to be completed, the next selected treatment order appears with 
the staff ID, time and status filled in. Make any necessary changes to the status, time of completion, 
medical notes and items, and then click OK. 

Once all treatment information has been filled in, the completion area closes. 

The treatments are marked as Completed or DNP (Did Not Perform), charges are transferred to the 
Patient Visit List and medical notes are recorded. 

Tip: To view or print a list of patients’ treatments that are scheduled, completed or not performed, 
generate a Whiteboard Patient Treatment Report 

Reversing a Completed Treatment 
Patient treatments that have been marked Completed or Did not perform can be reversed using the 
Undo feature on the Patient Treatments window. 

To reverse a completed treatment: 

1. On the Patient Treatments window, double-click the time slot for the Completed or Not performed 
treatment to undo. A completion area displays at the bottom of the window. 

2. Click the Undo button on the right. The Undo Treatment dialog box appears. 
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3. Within the Staff ID field, type the staff ID for the person making this entry and press TAB, or press F2 
to search for and select the person’s name from the Staff List. 

4. Within the History reason area, type the reason for reversing the treatment’s status. This reason will 
be appended to the original Whiteboard medical note. 

5. Click OK to process the change and return to the Patient Treatment window. 

The treatment is returned to its original status. 

Removing a Patient from the Whiteboard 
It is possible to remove a patient from the Whiteboard without creating and posting an invoice. 

Note: If this removal method is used, staff will still need to complete other applicable client/patient 
processing tasks, such as invoicing and check out. 

To manually remove a patient from the Whiteboard: 

1. On the Whiteboard (main grid) window, in the Patients column on the left, right-click the patient’s 
block and select Remove from Whiteboard. 

2. Do one of the following: 

• If the patient does not have any orders, proceed to step 3. 

• If the patient has orders, the Patient Orders window displays. Click the Remove from 
Whiteboard button. 

3. On the Remove Patient from Whiteboard dialog box, if applicable, select a hospital status for the 
patient in the New status drop-down list. 

4. Click OK.  

5. You are prompted to confirm the removal of the patient from the Whiteboard. Click Yes. 

The patient is marked as Discharged and may continue to be displayed on the Whiteboard, 
depending on the length of time set in Whiteboard defaults. 

6. If desired, right-click on the list of patients and select Hide Discharged Patients to hide these 
patients on the Whiteboard. 

Discharging a Whiteboard Patient Through Invoicing 
You can discharge a patient through the invoicing process, which automatically removes the patient 
from the Whiteboard. 

There are two steps to this process. The first is to change an inpatient’s status to Ready to go home. 
The second is to check out the patient through the invoicing process, which will change the patient’s 
status to Discharged. 

To discharge a patient through invoicing: 

1. Within the Whiteboard (main grid) window's Patients column, right-click in the patient’s block and 
select Patient Orders. The Patient Orders window displays information for the patient. 

2. From the Patient Orders window Status drop-down list, select Ready to go home. 

3. Click OK to save the change and return to the Whiteboard. 

The updated status displays in the patient’s block in the Patients column. 
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Note: You can also update the status starting from the Census List: Highlight the inpatient that is 
ready to go home, click the Update button to display the Patient Check-in/out window, select Ready 
to go home from the Status list, and click the Update button. 

4. Create and post an invoice for the client. 

5. Once processed, verify the Check-out patients option is selected within the Perform these tasks 
when posting area of the Post Invoice dialog box. 

Once the invoice is posted, the patient’s status will change to Discharged. 

Whiteboard Reports 
You can access information on patient orders and patient treatments using the Whiteboard Patient 
Orders Report and the Whiteboard Patient Treatment Report. 

Whiteboard Patient Orders Report 

The Patient Orders Report can be used to reference general information about treatment orders entered 
for patients that have been admitted as Inpatients within Cornerstone. 

Using the range criteria available for the report, you can generate a list of patient orders based on: 

• Selected date or date ranges 

• Patient ID 

• Attending (supervising) doctor ID 

• Current doctor ID 

• Changed staff ID (if the original orders have been changed, lists the staff who changed the orders) 

 

Note: The Patient Orders Report does not include treatment status (Completed, Scheduled, Did Not 
Perform). To see the treatment status, generate a Patient Treatment Report. 

To generate a Patient Orders Report: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 

2. In the Reports list, click the plus sign to the left of Patient, and then select Whiteboard Patient 
Orders Report. 

3. Click the Create report button. The Whiteboard Patient Orders Report dialog box appears. 
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4. In the Range area, enter any desired criteria to view select information on the report. If you do not 
enter criteria, the report will use the default range, which includes all patient orders for the current 
date. 

5. Do one of the following: 

• Click Preview to view the report in the Reports Preview window. 

• Click Print to set print options and print the report. 

• Click Save As to specify a file name and type for saving the data to a file. 

Whiteboard Patient Treatment Report 

The Patient Treatment report lists scheduled and overdue treatments for selected patients. This report 
includes blank fields for quantity, time, notes and staff initials. These fields can be filled in as staff 
provides treatments for patients. Later, using these lists as a reference, the treatments can be 
completed on the Whiteboard. 

 

 

There are several ways to access the Patient Treatment Report. 

To access the report from the Whiteboard (main grid) window: 

 In the Patients column on the left, right-click in a patient’s information block and select either 
View/Print Selected Day or View/Print Prior 24 Hours, depending on the time period you want to 
view. 

To access the report from the Patient Treatments window: 

 Right-click anywhere within the Treatments grid and select either View/Print Selected Day or 
View/Print Prior 24 Hours, depending on the time period you want to view. 

To access the report from the Cornerstone menu bar: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 

2. In the Reports list, click the plus sign to the left of Patient, and then select Whiteboard Patient 
Treatments Report. 

3. Click the Create report button.  
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To generate a Whiteboard Patient Treatment Report: 

1. Use one of the methods above to access the Patient Treatments report. The Whiteboard Reports 
criteria window appears for the appropriate date range and patient, if applicable. 

 
Whiteboard Reports window 

2. In the Sort drop-down list, select a sort order to indicate how to arrange the information on the 
report. 

3. If you are generating the report for more than one patient and you want to print the treatment orders 
on separate pages for each patient, select the Page break on patient check box. 

4. Depending on how you accessed the report, the Begin Patient ID and End Patient ID fields may 
already contain the ID of your selected patient. If desired, you can use these fields to specify a 
range of patients (press F2 in these fields to search for and select a patient from the Patient List), or 
you can leave these fields blank to print the report for all patients on the Whiteboard. 

5. If necessary, use the Begin Date and End Date fields to narrow the report to a specific date or date 
range. 

6. If necessary, use the Begin time and End time fields to narrow the report to a specific time frame. 

7. Within the following lists, select the desired criteria to narrow the information included in the report 
(press and hold CTRL to select random options; press and hold SHIFT to select a group of 
consecutive options): 

• Treatment Status – Used to narrow the report to a specific status of patient treatments. 

• Patient Status – Used to narrow the report to patients assigned a selected hospital status. 

• Current Doctor – Used to narrow the report to a specific doctor listed as the current care doctor 
within the patient orders. 

• Ward Location – Used to narrow the report to a ward or location within the practice where a 
patient may be assigned. 

• Area – Used to narrow the report to a specific area where treatments are processed. 
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• Staff Classification – Used to narrow the report to a specific type of staff. 

• Category – Used to narrow the report to a specific type of orders. 

8. Click Preview. The report will display patient treatments based on the criteria entered within the 
Whiteboard Reports criteria window. 

9. Do one of the following: 

• Click the Print button to print the report to a selected printer. 

• Click the Save button to save the data from the report to a file. 

• Click Cancel to exit the report and return to the Whiteboard Reports criteria window. 

10. On the Whiteboard Reports criteria window, click Close to exit and return to the previous window. 
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Overview 
Often a client (or potential client) contacts your practice for information on the estimated cost of a 
procedure before bringing a pet in. Using the Cornerstone* Estimate features, you can estimate the 
cost to the client.  

Using the Estimate features in Cornerstone, you can: 

• Place any invoice item (service, inventory, miscellaneous or group) on an estimate 

• Estimate prices for your current costs (low price) and anticipate cost increases (through the high 
price) 

• Apply transaction taxes and transaction discounts for each item 

• Optionally have clients electronically sign the estimate using a signature capture device or tablet PC 

• Specify how long Cornerstone stores unsigned estimates 

• Transfer invoice items from a finalized estimate to the Patient Visit List (PVL), where the items are 
held until transferred to an invoice 

Note: Because the estimate information is saved in the Patient Visit List (for the specific patient), you 
cannot create one estimate for multiple patients. 

Before You Begin 

• Set up Billing Messages (Controls > Billing Messages). 

• Set up Estimate Messages (Controls > Estimate Messages). 

• Set up Price Change Reasons (Controls > Price Change Reasons) and specify an Allow change 
setting for each invoice item on the Invoice Item Information window’s Info tab. 

• Set Estimate, Estimate Address and Messages defaults in Practice and Workstation Defaults 
(Controls > Defaults > Practice and Workstation). 

• (Optional) Specify if you want pet pictures to print on estimates in Workstation defaults (Controls > 
Defaults > Practice and Workstation > select Workstation from the menu on the left). 

• (Optional) Enter an Estimate markup for invoice items in the Info tab in Invoice Item Information 
(Lists > Invoice Item). 

• (Optional) Assign the printer where you want estimates to print (File > Printer Assignment > 
General Reports).  

Using Marginal Pricing on Estimates 
Cornerstone displays a low price and a high price (marginal pricing) for each item on the estimate. 
Marginal pricing helps you to provide accurate estimates, even if the price of an item increases between 
the time the estimate is created and the time the patient visits your practice for the service (the item). The 
use of marginal pricing on estimates is also a good idea when the price of a procedure can vary 
depending on what is found once the procedure is started. 
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Marginal pricing is calculated using the Estimate markup percentage specified for each invoice item on 
the Invoice Information window’s Information tab. Cornerstone uses this percentage to calculate the 
high price on the estimate.  

Applying Discounts to Specific Items on Estimates 
Discounts for specific items work the same way in an estimate as they do in an invoice. If a client is set 
up to receive a discount (and the invoice item is set up with the discount), Cornerstone automatically 
applies the discount to the item on the estimate. 

If Cornerstone is applying a discount to an item on the Estimate dialog box, the button in the Disc 
(Discount) column displays Yes. Click the Yes button to view the applied discounts. 

Note: Cornerstone applies transaction discounts (as explained above) only to the items you specify. The 
discount is not applied to the entire estimate. 

Before You Begin 

1. Set up the discounts you want to use in your practice (Controls > Discounts). 

2. Link discounts to individual invoice items on the Invoice Item Information window’s Tax/Disc tab. 

3. Set up clients to be eligible to receive applicable discounts on the Client Information window’s A/R 
Information tab. 

To apply or remove transaction discounts: 

1. While creating an estimate in the Estimate dialog box, enter the applicable Item ID.  

2. In the Disc column, click the Yes or No button in that item’s row. The Transaction Discount dialog 
box appears. The discounts currently being applied are highlighted.  

 
Transaction Discounts dialog box 

3. In the Discounts to Apply list, click to select or deselect a discount, highlighting all discounts you 
want to apply to the item.  

Note: If the client is not set up to receive the discount, a message appears to confirm that you want 
to apply the discount to this client. 

4. Click OK to save your changes. Cornerstone applies the highlighted discounts. 

Note: If an asterisk appears next to a discount, that discount has been modified (in the Controls menu) 
since it was used in this estimate. To use the updated discount: Click the modified discount (with the 
asterisk) and then re-click the discount to apply the updated percentage. Click OK. 

 To print a list of the discounts linked to clients, print a Client A/R Information Report. (See “Client 
A/R Information” on page 49.) 
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Applying Taxes to Specific Items on Estimates 
When you previously set up your invoice items, you had the option of linking certain taxes to individual 
invoice items. When you invoice a client, Cornerstone automatically applies the linked tax, and the 
button in the Tax column displays Yes. Click the Yes button to view the applied taxes. 

Note: Cornerstone applies transaction taxes (as explained above) only to the items you specify. The tax 
is not applied to the entire estimate. 

Before You Begin 

1. Set up the taxes you want to use in your practice (Controls > Taxes).  

2. Link taxes to invoice items on the Invoice Item Information window’s Tax/Disc tab. 

3. For tax exempt clients, select the Tax exempt check box on the Client Information window’s A/R 
Information tab. (Taxes are not applied if the invoiced client is marked as tax exempt.) 

To apply or remove transaction taxes: 

1. While creating an estimate in the Estimate dialog box, enter the applicable Item ID. 

2. In the Tax column, click the Yes or No button in that item’s row. The Transaction Taxes dialog box 
appears. The taxes currently being applied are highlighted.  

 
Transaction Taxes dialog box 

Note: If the client is set up as tax exempt, you cannot apply a tax. (A message will appear when you 
click the Tax button.)  

3. In the Taxes to Apply list, click to select or deselect a tax, highlighting all taxes you want to apply to 
the item. 

4. Click OK to save your changes. Cornerstone applies the highlighted taxes. 

Note: If an asterisk appears next to a tax, that tax has been modified (in the Controls menu) since it was 
used in this estimate. To use the updated tax: Click the modified tax (with the asterisk) and then click the 
tax again to apply the updated percentage. Click OK. 

 To print a list that shows clients' tax statuses, print a Client A/R Information Report. (See “Client A/R 
Information” on page 49.)  

Creating an Estimate 

To create an estimate: 

1. With the patient’s record open on the Patient Clipboard, in the Patient list area, right-click the 
patient’s name and select Estimate. The Estimate dialog box appears. 

Tip: For a potential client, use the “cash client” and “cash patient” used by your practice. 
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Estimate dialog box 

2. With the cursor in the Estimate # field, press TAB. (For new estimates, the Estimate # is assigned 
automatically by Cornerstone when the estimate is saved.)  

• If Cornerstone is currently saving an estimate for the client, the saved estimate displays. To 
create a new estimate, press CTRL+N in the Estimate # field. 

• If you press F2 in the Estimate # field, a list of any existing estimates will display. An “(F)” 

displays next to finalized estimates. The Signature  icon displays next to estimates that have 
been electronically signed and finalized. 

3. In the Description text box, enter the purpose for the estimate, if applicable. (The description 
displays on the Estimate List.)  

4. In the Item ID field, enter the ID of an invoice item by either typing the ID or pressing F2 to search for 
and select the item from the Invoice Item List.  

5. Press TAB. All applicable default information displays for the line item.  

Note: To remove an item from the estimate, click within or highlight the item ID and press CTRL+D. 

6. The Qty-Low and Qty-High default to 1 (unless the item is part of a group item). Change the low or 
high quantity, if applicable.  

Based on the specified quantities, the Low Price and High Price are automatically calculated as 
follows: 

• The Low Price is calculated as if you were entering the item on a current invoice: (Qty-low x 
current price for that quantity) + the dispensing fee, if applicable. The minimum price also 
applies. 

• The High Price is calculated based on the following formula: (Qty-high x high price) + 
dispensing fee. (The high price is the current price for that quantity marked up according to the 
Estimate markup percentage set on the Invoice Item Information window’s Info tab.) 

7. If necessary, change the price for the item. 
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Note: You may not be allowed to change the item’s pricing, based on the Allow change setting for 
this item (on the Invoice Item Information window’s Info tab). If changes are allowed, you may be 
required to select a price change reason. 

8. In the Staff field, type the staff ID or press F2 to search for and select the staff from the Staff List. 

9. In the Center field, type the revenue center ID or press F2 to search for and select the revenue 
center from the Revenue Center List. 

10. In the Disc (Discounts) field, click the Yes/No button if you want to add or remove transaction 
discounts for the item. See “Applying Discounts to Specific Items on Estimates” on page 166 for 
information. 

11. In the Tax field, click the Yes/No button if you want to add or remove taxes for the item. See 
“Applying Taxes to Specific Items on Estimates” on page 167 for information. 

12. In the Date field, the current date displays by default. Change the date associated with this invoice 
item, if necessary. 

13. If you want to transfer items to the estimate from a travel sheet, click Travel Sheet and select the 
desired items to transfer. 

14. When all desired items have been added to the estimate, click OK. The Save Estimate dialog box 
appears.  

 
Save Estimate dialog box 

15. In the Estimate footer area, the default estimate footer appears. If desired, select a different footer 
from the Message drop-down list. (Messages available in this drop-down list are set up in Controls 
> Billing Messages.) 

16. If you would like to change the estimate message (or messages) to print on this estimate, click the 
Messages button to open the Estimate Messages dialog box. Do the following: 

a. To remove a message, click in the ID field of the message you want to delete and press 
CTRL+D. 

b. To add a message, in the ID field, enter the ID of the estimate message by either typing the ID 
or pressing F2 to search for and select the message from the Estimate Message List. 

c. If needed, click the Note button to open the message text and make changes or add 
information. 
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d. Add additional messages as needed. 

e. If desired, click the arrow buttons at the bottom of the dialog box to change the order in which 
the messages will display on the estimate. 

f. If you want the messages selected here to print on a separate page and not on the actual 
estimate page, click the Print estimate messages on a separate page check box. 

g. Click OK to return to the Save Estimate dialog box. 

Note: For information on setting up messages, see "Chapter 2: Setting Up Cornerstone Controls” in 
the Cornerstone Administrator’s Manual. 

17. If you have set high and low price print option defaults and you want to change them for this 
estimate, click the Options button. The Estimate Options dialog box appears. 

 
Estimate Options dialog box 

18. Change the estimate options as needed, and click OK to return to the Save Estimate dialog box. 

19. In the Perform these tasks when saving area, you have several options for performing additional 
estimate tasks. Do one of the following: 

• To preview the estimate before performing additional tasks (save, print, etc.), select the Preview 
option and click OK. Proceed to the “Previewing an Estimate and Performing Other Tasks from 
the Print Preview Window” section below for information. 

Note: If the Use authorized signature option is selected in Estimate defaults, the 
Preview/Signature option displays in place of the standard Preview option. To use an 
electronic signature on the estimate, proceed to the “Using Electronic Signatures on Estimates” 
section on page 172. 

• To save the estimate and perform other estimate tasks without previewing, select the Save and 
continue option. Proceed to step 20. 

20. If you want to print the estimate after saving, select the Print estimate check box and specify the 
number of Copies to print. See “Printing an Estimate” on page 175 for more information. 

21. If you want to email the estimate after saving, select the E-Mail estimate check box. See “Emailing 
an Estimate” on page 176 for more information. 

22. In the Save estimate for… fields, specify the number of days to store the unsigned estimate (up to 
999 days), or enter an expiration date for the unsigned estimate. Estimates that have not been 
electronically signed by the client are deleted during End of Day processing after the specified 
number of days or on the specified date. 

Note: When setting the Save estimate for… fields, if you enter the number of days, Cornerstone 
immediately calculates and displays the corresponding expiration date after you press TAB or click 
outside of the field. If you specify the date, Cornerstone updates the corresponding number of days 
after you click OK (after the dialog box has closed). 
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23. If the client has accepted the estimate, select the Finalize estimate check box.  

Note: Depending on how you have set the Add invoice items to PVL setting in Estimate defaults, 
invoice items on the estimate may move to the Patient Visit List automatically upon finalizing the 
estimate.  

24. Click OK to save the estimate and perform any of the selected tasks. 

Previewing an Estimate and Performing Other Tasks from the Print Preview Window 
1. Create an estimate following the steps in the previous “Creating an Estimate” section. 

2. On the Save Estimate dialog box, ensure the Preview option is selected, and click OK. The estimate 
Print Preview window appears.  

 
Estimate Print Preview window 

Note: The tools available on the estimate Print Preview window vary depending on the type of PDF 
viewer installed on the workstation. 

3. In the Save unsigned estimate for… fields, specify the number of days to store the unsigned 
estimate (up to 999 days), or enter an expiration date for the unsigned estimate. Estimates that have 
not been electronically signed by the client are deleted during End of Day processing after the 
specified number of days or on the specified date.  

Note: When setting the Save unsigned estimate for… fields, if you enter the number of days, 
Cornerstone immediately calculates and displays the corresponding expiration date after you press 
TAB or click outside of the field. If you specify the date, Cornerstone updates the corresponding 
number of days after you click OK (after the window has closed). 

4. If the client has accepted the estimate, select the Finalize estimate check box.  
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Note: Depending on how you have set the Add invoice items to PVL setting in Estimate defaults, 
invoice items on the estimate may move to the Patient Visit List automatically upon finalizing the 
estimate.  

5. If you want to print the estimate at this time, click the Print button (bottom-left corner of the window) 
and specify the number of Copies to print. See “Printing an Estimate” on page 175 for more 
information. 

6. If you want to email the estimate at this time, click the Email button (bottom-left corner of the 
window). See “Emailing an Estimate” on page 176 for more information. 

7. When you have finished viewing the estimate and performing other tasks from the Print Preview 
window, click OK to close the window. 

Using Electronic Signatures on Estimates 
Cornerstone allows clients to view an on-screen estimate and electronically sign the estimate using a 
supported signature capture device or tablet PC. Signed estimates are automatically finalized and saved 
to patient history. 

Some benefits of electronically signed estimates: 

• Your practice can increase efficiency and save paper with the signature on the actual estimate—no 
need for scanning paper documents or creating additional correspondence documents. 

• With approval to perform services right on the estimate where the actual dollar amounts appear, you 
can better ensure compliance and move the process forward more quickly. 

• A signed estimate provides peace of mind to the client, with all services and costs agreed upon by 
the practice and client upfront. 

Tip: On the Patient Clipboard and estimate-related windows throughout Cornerstone, the Signature  
icon displays next to estimates that have been electronically signed. 

Before You Begin 

• Ensure that the Use authorized signature option has been selected in Estimate defaults. 
Optionally, if you plan to use witness signatures on estimates, select the Use witness signature 
option in Estimate defaults. To access Estimate defaults, select Controls > Defaults > Practice 
and Workstation, and then select Estimate from the menu on the left. 

• Ensure that a supported signature capture device (or tablet PC) is configured with Cornerstone and 
connected to the workstation. See “Chapter 1: Getting Started with Cornerstone Setup” in the 
Cornerstone Administrator’s Manual for information on setting up a signature capture device for use 
with Cornerstone. 

To finalize an estimate with an electronic signature: 

1. On a workstation with a connected signature capture device (or on a tablet PC), create an estimate 
following the steps in the previous “Creating an Estimate” section beginning on page 167. 

2. On the Save Estimate dialog box, ensure the Preview/Signature option is selected, and click OK. 
The estimate Print Preview window appears. 

3. Review the on-screen estimate with the client and then click Signature. 

4. Do one of the following: 

• If you are using a connected signature capture device, a signature box appears. Ask the client 
to sign on the signature pad, and then click OK to insert the signature in the document. 
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• If you are using a tablet PC, ask the client to sign directly on the estimate’s Authorized Signature 
line. 

5. If a witness signature is used in your practice (and has been enabled in Estimate defaults), ask the 
witness to sign on the signature pad or tablet PC. 

Once it has been signed, the estimate is automatically finalized and saved to patient history. The 

estimate displays with the Signature  icon and “FINALIZED - Signed” at the top of the Print 
Preview window. 

 
Print Preview window for a signed (and finalized) estimate 

Note: The tools available on this window vary depending on the type of PDF viewer installed on the 
workstation. 

6. To print the estimate, click the Printer  icon on the Print Preview window’s PDF viewer toolbar.  

7. To email the estimate, click the Email button located in the top-right corner of the window. See  
“Emailing an Estimate” on page 176 for more information. 

8. When you have finished viewing the estimate and performing other tasks from the Print Preview 
window, click OK to close the window. 
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Locating an Estimate 
You can reopen a saved estimate to add items or change items on the estimate. Estimates can be 
opened from the Patient Clipboard or from the Estimate dialog box. 

Note: You can open a finalized estimate for viewing, printing or emailing, but you cannot make changes 
to a finalized estimate. 

To open an existing estimate from the Patient Clipboard: 

1. Do one of the following: 

• To choose from a list of all estimates for a particular client, with the client’s record open on the 

Patient Clipboard, click the Estimates  tab in the Client information area. 

• To choose from a list of all estimates for a particular patient, with the patient’s record open on 

the Patient Clipboard, click the Estimates  tab in the Patient information area. 

 
Estimates tabs on the Patient Clipboard 

Note: An “(F)” indicates finalized estimates. A Signature  icon indicates estimates that have 
been finalized with an electronic signature. Signed estimates are also listed in the Patient History 
area Summary and Text tabs. 

2. Locate the desired estimate in the list and double-click the estimate line (or right-click the estimate 
and select Update). The Estimate dialog box appears with the selected estimate ID displayed in the 
Estimate # field. 

3. Press TAB to display the item information associated with this estimate. 

To open an existing estimate from the Estimate dialog box: 

1. Open the Estimate dialog box and provide the client and patient information, if necessary. 

2. In the Estimate # field, press F2 to search for an estimate on the Estimate List. 

 
Estimate List 
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Note: An “(F)” indicates finalized estimates. A Signature  icon indicates estimates that have 
been finalized with an electronic signature.  

3. Select the estimate to open. The Estimate dialog box reappears with the selected estimate ID 
displayed in the Estimate # field. 

4. Press TAB to display the item information associated with this estimate. 

Printing an Estimate 
You can print (or reprint) a saved or finalized estimate for a client at any time. The estimate printing 
options available depend on whether you are printing a saved estimate, a finalized estimate or a 
finalized estimate with an electronic signature. 

Tip: An estimate can also be printed during the process of creating/saving an estimate by selecting the 
Print estimate check box on the Save Estimate dialog box and then clicking OK. See “Creating an 
Estimate” on page 167 for information. 

Note: Departing instructions do not print on an estimate. 

To print a saved (not finalized) estimate: 

1. With the applicable estimate open in the Estimate dialog box, click the Print button. The Print 
Message dialog box appears.  

 
Print Message dialog box 

2. If necessary, select a different message to print at the bottom of the estimate, or edit the text of the 
message before printing. 

3. On the Print Message dialog box, do one of the following: 

• Click Preview to view the estimate in the Print Preview window, and then click the Print button 
(lower-left corner of the Print Preview window).  

• Click Print. 

The Cornerstone Print Options dialog box appears. 

4. The Printer field displays the default printer selected within Printer Assignments for estimates (select 
File > Printer Assignment > General Reports > Estimates). If you would like to print the estimate 
on a different printer, click the Printer button to access the Printer Selection dialog box and select 
the desired printer. 

5. In the Copies field, type the number of estimate copies to print. 

6. Click OK to print the estimate and return to the Estimate dialog box.  

7. Click Cancel to close the Estimate dialog box. 
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To print a finalized estimate (no electronic signature): 

1. With the applicable estimate open in the Estimate dialog box, click the Print button. The 
Cornerstone Print Options dialog box appears. 

2. The Printer field displays the default printer selected within Printer Assignments for estimates (select 
File > Printer Assignment > General Reports > Estimates). If you would like to print the estimate 
on a different printer, click the Printer button to access the Printer Selection dialog box and select 
the desired printer. 

3. In the Copies field, type the number of estimate copies to print. 

4. Click OK to print the estimate and return to the Estimate dialog box. 

5. Click Cancel to close the Estimate dialog box. 

To print a finalized estimate with an electronic signature: 

1. With the applicable signed estimate open in the Estimate dialog box, click the Print button. The 
estimate displays in the Print Preview window. 

2. Click the Printer  icon on the Print Preview window’s PDF viewer toolbar. The Print dialog box 
appears. 

3. The Name field displays the default Windows printer. If you would like to print the estimate on a 
different printer, select a different printer from the Name drop-down list. 

4. In the Copies field, type the number of estimate copies to print. 

5. Click OK to print the estimate and return to the Print Preview window. 

6. Click Close to close the Print Preview window, and then click Cancel to close the Estimate dialog 
box. 

Emailing an Estimate 
You can email a saved or finalized estimate to a client at any time. A PDF file of the estimate will 
automatically be created and attached to the email. 

Tip: An estimate can also be emailed to the client during the process of creating/saving an estimate by 
selecting the E-Mail estimate check box on the Save Estimate dialog box and then clicking OK. See 
“Creating an Estimate” on page 167 for information. 

Note: Emailing estimates requires Internet access, an email account, and properly configured email 
software (like Microsoft® Outlook® or Outlook® Express).  

To email an estimate: 

1. With the applicable estimate open in the Estimate dialog box, click the E-Mail button.  

Note: For estimates that have not yet been finalized, the Print Message dialog box appears. If 
necessary, select a different message to print at the bottom of the estimate, or edit the text of the 
message before emailing. Click E-Mail. 

The E-mail Information dialog box appears.  
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E-Mail Information dialog box 

2. In the Subject field, enter a subject line to be used on the email.  

3. If desired, enter information in the Note box. The estimate will be sent as an email attachment and 
any Note text will be included in the body of the email message. 

4. Specify who will receive the email by selecting the appropriate option from the drop-down lists 
attached to the Client, Referral doctor and/or Referral hospital fields: 

Note: The Client field will be available only if the client to whom you are sending the email has an 
email address listed in his/her client information. The Referral doctor and Referral hospital fields 
will be available only if the referral doctor and hospital are set up with an email address in 
Cornerstone and the Send info via field (in Doctor Information or Hospital Information) is set to E-
mail. In addition, the referral doctor and hospital must be selected for the applicable patient in the 
Patient Information window’s Referrals tab. 

• Don’t send – Choose this option if you do not want this person to receive this message. 

• To: – Choose this option if you want this message to be addressed directly to this person. 

• CC: – (stands for carbon copy) Choose this option if you want this message to be sent to 
someone else, but you want this person to receive a copy of the message. 

• BCC: – (stands for blind carbon copy) Choose this option if you want this message to be sent 
to someone else, but you want this person to receive a copy of the message confidentially. 

5. If you want to send the letter to others not included in the previous fields, enter the address in the E-
Mail Address field, and from the Type list, select the type of message to send (To, CC or BCC). 

6. Click OK to email the estimate. If the Choose Profile dialog box appears, click OK again. 

Finalizing an Estimate 
If an estimate is not finalized at the time it’s created, you can open the saved estimate and finalize it at a 
later time. 

Note: Electronically signed estimates are automatically finalized and saved to patient history. See Using 
Electronic Signatures on Estimates on page 172 for information on finalizing an estimate with an 
electronic signature. 
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To finalize a saved estimate: 

1. With the patient’s record open on the Patient Clipboard, click the Estimates  tab in the Patient 
information area. 

2. Locate the desired estimate in the list and double-click the estimate line (or right-click the estimate 
and select Update). The Estimate dialog box appears with the selected estimate ID displayed in the 
Estimate # field. 

3. Press TAB to display the item information associated with this estimate. 

4. Make any necessary changes to the estimate items, and then click Finalize. The Save Estimate 
dialog box appears. 

5. In the Perform these tasks when saving area, select the Save and continue option and ensure that 
the Finalize estimate check box is selected. 

6. Click OK. 

7. Depending on how your Estimate defaults have been set up, a message may ask if you want to 
transfer the items to the Patient Visit List. Click Yes or No. 

Deleting an Estimate 
You can manually delete an estimate that no longer applies to a patient. 

Note: You cannot delete a finalized estimate that has been electronically signed by the client. The 

Signature  icon displays next to estimates that have been electronically signed and finalized. 

To delete an estimate: 

1. With the patient’s record open on the Patient Clipboard, in the Patient list area, right-click the 
patient’s name and select Estimate. The Estimate dialog box appears. 

2. With the cursor in the Estimate # field, press F2. The Estimate List displays a record of each 
estimate created for the patient. 

3. Search for and select the estimate to delete, and then click Delete. You are prompted to confirm the 
deletion. Click Yes. 

The estimate no longer displays in the Estimate List and is removed from the patient’s history. 

4. Click Close to exit and return to the Estimate dialog box. 

5. Click Cancel to exit and return to the Patient Clipboard. 
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Overview 
When you invoice clients in the IDEXX Cornerstone* Practice Management System, many related 
activities automatically occur. After an invoice is processed and posted, Cornerstone updates the 
reminder information and the patient’s medical file, generates any departing instructions or special 
actions linked to the invoice items, and adds the invoice total to the practice sales totals for End of Day, 
End of Month and End of Year processing. 

Using the Client Invoice window options, you can perform all of the traditional accounting procedures 
you would expect to perform when invoicing. Cornerstone places financial information into the client’s 
account and adds references to the invoiced items and departing instructions in the patient’s medical 
history. 

About the Client Invoice Window 
 

 

 

 

Client Area 

The Client area displays the client ID, name, credit code information and last payment information.  

Invoice Area 

The Invoice area displays the invoice status (Open or Closed) and the invoice total. It also includes fields 
for the invoice number, type and staff member (Receptionist) generating the invoice. 

Client area Invoice area Accounts Receivable area 

Patient 
area 

Line item 
entry grid 

Invoice 
action 
buttons 

Invoice task buttons 
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Accounts Receivable Area 

The Accounts receivable area lists the client’s account balance information and A/R total. 

Patient Area 

The Patient area provides a list of patients owned by this client. 

Note: If there are more than 20 patients, only those patients who have invoice line items on the invoice 
(or on a Patient Visit List) will display. 

You can place more than one patient on the same owner’s invoice. After invoice items have been 
entered for the first patient, simply select the second patient in the list and proceed to enter this patient’s 
items in the line item entry grid (a new grid is displayed for each patient selected). On the printed 
invoice, a Patient Subtotal amount is listed for each patient. 

Line Item Entry Grid 

The invoice’s line item entry grid includes the following columns/fields: 

Column/Field Description 

Item ID Enter an invoice item ID by either typing the ID or pressing F2 to search for 
and select the item from the Invoice Item List. To delete an item from the 
grid, click in the item’s Item ID field and press CTRL+D. 

Item Description The invoice item’s Hospital description as it was previously defined 
during item setup on the Invoice Item Information window’s Info tab.  

Note: If a Client description was entered for this invoice item on the Info 
tab, that Client description will print on the invoice. The exception is if the 
invoice item was flagged as a Miscellaneous item on the Info tab. In this 
case, you are allowed to make changes to the description when adding 
the item on the grid. This description will print on the invoice, regardless of 
whether a Client description exists.  

Quantity The quantity of the item; default quantity is 1.  

Amount The price of the item, based on the quantity specified.  

Staff The ID of the staff member to associate with this invoice item; defaults to 
the staff ID specified in Invoice defaults. To change the staff, either type the 
ID or press F2 to search for and select the staff from the Staff List. 

Center (Revenue Center) The ID of the revenue center to associate with this invoice item. If a default 
revenue center was specified on the Invoice Item Information window’s 
Info tab, that revenue center ID displays here. To change the revenue 
center, either type the ID or press F2 to search for and select a revenue 
center from the Revenue Center List. 

Disc (Discount) When you previously set up your invoice items, you had the option of 
linking discounts to individual invoice items on the Invoice Item Information 
window’s Tax/Disc tab. If you invoice a client who is set up to receive the 
discount associated with an item, Cornerstone automatically applies the 
discount, and the button in the Discount column displays Yes. To add or 
remove a discount on an invoice item, click the Yes or No button in its line 
item row. See “Applying Discounts to Specific Invoice Items” on page 187 
for information on invoice item discounts. 
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Column/Field Description 

Tax When you previously set up your invoice items, you had the option of 
linking taxes to individual invoice items on the Invoice Item Information 
window’s Tax/Disc tab. If you invoice a client for one of these items, 
Cornerstone automatically applies the tax, and the button in the Tax 
column displays Yes (except when the client has been marked as tax 
exempt). To add or remove a tax on an invoice item, click the Yes or No 
button in its line item row. See “Applying Taxes to Specific Invoice Items” 
on page 188 for information on invoice item taxes. 

Date The date to associate with the item or service on the invoice; defaults to 
the system date. To change the date, either type a different date or press 
F2 to select a date using the calendar. 

Verify Inventory Details  
If an inventory item is marked to track quantity on hand, lot numbers, 
expiration dates, and/or multiple locations, you may be asked to verify 
inventory details for this invoice item. For these types of inventory items, 
one of the following icons will appear in the column to indicate whether or 
not inventory details are missing:  

  Indicates more inventory information is required. 

  Indicates inventory information is complete; no action is required. 

Click the  icon and proceed to enter the inventory details; click the 
Verified check box to verify the details for each item as required. 

See “Verifying Inventory Details” on page 191 for more information. 

 

Invoice Task Buttons (Bottom of Window) 

Use the buttons along the bottom of the Client Invoice window to perform additional tasks. 

Button Description 

   
Work with the patient’s laboratory requests and results (Laboratory module only). 

   
Display the Prescription Information dialog box, which allows you to create a 
prescription for a selected item on the invoice. See “Creating a Prescription” on page 
294 for information. 

   
Display the Special Actions dialog box to view and/or process any special actions 
linked to the items on this invoice (or to display the Patient Visit List if it contains items 
for this patient). See “Processing Special Actions” on page 192 for information. 

   
View or modify departing instructions linked to one or more items on this invoice or 
add an instruction to this invoice. See “Adding Departing Instructions” on page 189 
for information. 

   
Access the Pharmacy Formulary (Pharmacy Formulary module only). See “Using the 
Pharmacy Formulary” on page 197 for information. 

   
Display the Schedule for Today window to make an appointment for the patient. See 
“Scheduling and Managing Appointments” on page 104 for information. 

Cornerstone User’s Manual                  181 



Chapter 12: Invoicing 

Button Description 

   
Select items from your practice’s travel sheets. See “Transferring Invoice Items from a 
Travel Sheet” on page 186 for information. 

   
Copy items on an invoice to another patient or patients owned by the same client. 
See “Copying Invoice Items to Another Patient” on page 198 for information. 

 

Invoice Action Buttons (Right Side of Window) 

Use the buttons along the right side of the Client Invoice window to perform additional actions related to 
the invoice. 

Button Description 

   
Process the invoice and mark it as Closed. 

   
Save all information on the invoice without processing it (so it remains Open). 

   

   

Record a payment. You will not be allowed to select a future date. (The 
Prepay/Payment buttons change, depending on whether you are working with a new 
or posted invoice.) 

   
Manually enter a discount for the entire invoice. 

   
Display the Print Invoice dialog box, which allows you to change the message that 
prints at the bottom of the invoice, preview the invoice, or print the invoice. 

   
Void the invoice. See “Voiding an Invoice” on page 199 for information. 

   
Clear the Client Invoice window without saving information. 

 

Creating an Invoice 

Before You Begin 

• Set the Invoice defaults (Controls > Defaults > Practice and Workstation > select Invoice from 
the menu on the left). If you want patient reminders to print on invoices, make sure the Print patient 
reminders check box is selected. 

• Set the Invoice Address defaults (Controls > Defaults > Practice and Workstation > select 
Invoice > Invoice Address from the menu on the left).  

• Set the default invoice message in Messages defaults (Controls > Defaults > Practice and 
Workstation > select Messages from the menu on the left). 

• (Optional) Assign the printer where you want invoices to print (File > Printer Assignment > 
General Reports). 

• (Optional) Indicate the type of printer to use by setting the Invoice Print option in Workstation 
defaults (Controls > Defaults > Practice and Workstation > select Workstation from the menu 
on the left). 
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To create an invoice: 

1. To open the Client Invoice window, do one of the following: 

• On the Patient Clipboard, select the client, and then right-click on the patient’s name in the 
Patient list and select Invoice.  

• On the Patient Clipboard, select the client, and then right-click in the Client area and select 
Invoice. 

• Click the Invoice  toolbar button.  

• On the Patient Visit List (PVL), with invoice items entered for the patient, click the Invoice button 
on the right side of the window. 

The Client Invoice window appears. 

2. Depending on how you accessed the Client Invoice window, the client may already be selected in 
the Client area. If not, in the Client ID field, enter the client by either typing the ID and pressing TAB, 
or by pressing F2 to search for and select the client from the Client List.  

If this client has an open invoice (an invoice that has been saved but was not posted), the client’s 
oldest open invoice automatically appears. 

3. In the Invoice number field, do one of the following: 

• If this is a new invoice, press TAB to continue. Cornerstone will automatically assign the invoice 
number when you post or save the invoice. 

• If you are updating an open invoice automatically displayed by Cornerstone, press TAB to 
continue. 

• If you want to update a different open invoice or view a posted invoice for this client, press F2 to 
search for and select the invoice from the Invoice List. 

4. The Invoice type field displays the type selected in Invoice defaults (or the type saved with the open 
invoice). If necessary, select a different invoice type from the drop-down list. 

5. The Receptionist field displays the staff ID of the user currently logged in (or the staff ID that was 
saved with the open invoice). If necessary, enter a different staff ID by either typing the ID or 
pressing F2 to search for and select the staff from the Staff List.  

6. Depending on how you accessed the Client Invoice window, the patient may already be selected in 
the Patient area. If not, select the patient in the list (use the scroll bar if the patient is not visible). You 
can also specify the patient in the Patient ID field by either typing the ID or pressing F2 to search for 
and select the patient from the Patient List. 

The Client Invoice window is updated to reflect the information for the selected patient. 
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Client Invoice window with patient selected and items entered in grid 

7. If items exist on the Patient Visit List for this patient, either the PVL displays automatically or a 
prompt asks if you want to open the PVL (if the Display patient visit message option is selected in 
Invoice defaults). On the PVL, indicate the items to include in the transfer to the invoice, and then 
click Transfer. See “Chapter 9: Using the Patient Visit List” beginning on page 129 for information 
on the Patient Visit List. 

Tip: You can also click Travel Sheet to select items from a travel sheet. See “Transferring Invoice 
Items from a Travel Sheet” on page 186 for information. 

8. To add an invoice item, in the next available row’s Item ID field, enter an invoice item by either 
typing the ID or pressing F2 to search for and select the item from the Invoice Item List. 

With the item ID entered, one or more dialog boxes may display, depending on the type of item 
entered, if it has any associated special actions or call back reminders, etc. 

9. If necessary, change the value in the Quantity field.  

10. The item pricing is calculated automatically, based on the specified quantity and displayed in the 
Amount field. Change the price, if necessary. 

Note: You may not be allowed to change the item’s pricing, based on the Allow change setting for 
this item on the Invoice Item Information window’s Info tab. If changes are allowed, you may be 
required to select a price change reason. 

11. Complete the remaining fields for the line item as needed. See “Line Item Entry Grid” on page 180 
for more information. 

12. As needed, perform additional tasks using the buttons on the bottom of the window. See “Invoice 
Task Buttons (Bottom of Window)” on page 181 for information. 

13. If you want to add invoice items for another patient belonging to this client, repeat steps 6–11 as 
necessary to select the patient and add the invoice items. 
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14. To change the order that items appear on the invoice, click in the item’s Item ID field and move the 
item up or down using the arrow buttons in the bottom-left corner of the window. (Group items must 
be moved as a group.) 

15. To remove an item from the invoice, click in the item’s Item ID field and press CTRL+D. To delete 
an item that is part of a group, click in the item’s Quantity field and press CTRL+D. 

16. If applicable, perform additional actions related to the invoice using the buttons on the right side of 
the window. See “Invoice Action Buttons (Right Side of Window)” on page 182 for information. 

17. When you are finished creating the invoice, do one of the following: 

• Click Post to process the invoice and mark the invoice as Closed (no changes or additions can 
be made to the invoice once it has been posted/closed). See “Posting an Invoice” in the 
following section for more information. 

• Click Save to save all information without processing the invoice (information can be changed 
or added later). 

Posting an Invoice 

When an invoice is posted, the following automatically takes place: 

• All information for the invoice is saved, and the invoice is marked as Closed (no other changes, 
additions or transactions are allowed). 

• The invoice amount is applied to the client’s account balance. 

• Inventory quantity on hand is automatically updated for applicable items on the invoice. 

To post an invoice: 

1. Create an invoice using the steps in the previous “Creating an Invoice” section. 

2. After you have entered all invoice items and carried out any invoice-related tasks, click Post. The 
Post Invoice dialog box appears. 

Note: If there are any special actions that have not yet been processed for items on the invoice, the 
Special Action dialog box appears. Click Process to perform the highlighted special action or click 
Continue to continue posting the invoice. 

 
Post Invoice dialog box 
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3. In the Date field, verify the posting date for this invoice (defaults to the current system date). To 
change the date, either type a different date or press F2 to select a date using the calendar. 

4. In the Perform these tasks when posting area, select from the following tasks to perform upon 
clicking OK on this dialog box: 

• Apply payments – Open the Payment dialog box to apply the client’s payment for this invoice 
immediately. 

Note: If payment is not applied immediately, it can easily be applied at a later time from the 
Client Invoice window by pressing F2 in the Invoice number field to select and open the posted 
invoice, and then clicking Payment to display the Payment dialog box. 

• Print invoice – Print the specified number of copies of the invoice. If the Electronic Signature 
check box is selected in payment type/setup and an electronic signature capture device or 
tablet is detected, a drop-down list is available. From the drop-down list, select Full Invoice or 
Invoice Receipt. Note that a signature prints only on an invoice receipt. 

• Check-out patients – Check out the patient or patients included on the invoice. 

• Apply payments to invoice for productivity by provider – Assign the appropriate invoice 
payment percentages to the applicable provider(s) in your practice. (This option is selected by 
default if the Apply payment to specific invoices for A/R by provider option is selected in 
Invoice defaults.) 

• Print special action documents – This option is available if any items on the invoice are set up 
to initiate the Print Document special action with the When to Apply field set to Print after 
invoice posted. If so, the applicable document or documents are listed in the Special action 
document list area at the bottom of the dialog box. 

5. In the Invoice message area, select a message to print at the bottom of the invoice (defaults to the 
message set in Messages defaults) and make any necessary changes to the message in the text 
box. 

6. Click OK. Depending on the tasks selected in the Perform these tasks when posting area, the 
invoice may print and/or additional dialog boxes may display. 

Transferring Invoice Items from a Travel Sheet 
When adding invoice items to an estimate, Patient Visit List, Patient Orders or invoice, you can click the 
Travel Sheet button to select items to transfer from one or more travel sheets. 

To transfer invoice items from a travel sheet: 

1. With an estimate, Patient Visit List, Patient Orders or invoice open, click the Travel Sheet button. 
The Travel Sheet Item Selection dialog box appears.  
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Travel Sheet Item Selection dialog box 

2. Select the travel sheet you want to use.  

3. In the Classification area, narrow the list of invoice items by doing one of the following: 

• To view travel sheet items for all classifications, click <All Classifications>. 

• To view only those items in a specific classification, click the specific classification you want to 
view.  

• To selectively view items in more than one classification, press and hold the SHIFT key as you 
click the classifications. 

4. Under Travel Sheet, select the travel sheet from which you want to select items. 

5. To choose an item, click on it. The quantity will change to 1. Click again to increase the quantity. To 
reduce the quantity, right-click it. You can also type in the quantity if you have a large quantity or 
need to enter the quantity using decimals.  

Note: Positive quantities are indicated with green text. Negative quantities are indicated with red 
text. 

Tip: Items can be selected from multiple travel sheets. Click on another travel sheet to select from it.  

6. To view only the items that are selected for a patient, click the <View Selected Items> option, 
located at the top of the Travel Sheet area scroll list. 

7. To transfer selected items to the estimate, Patient Visit List, Patient Orders or invoice, click Transfer. 
The Enter Staff ID dialog box appears. Enter the staff ID and click OK. 

Applying Discounts to Specific Invoice Items 
When you previously set up your invoice items, you had the option of linking certain discounts to 
individual invoice items on the Invoice Item Information window’s Tax/Disc tab. If you invoice a client 
who is set up to receive the specified discount(s), Cornerstone automatically applies the discount, and 
the button in the Discount column displays Yes. Click the Yes button to view the applied discounts. 

Note: Cornerstone applies transaction discounts (also called line item discounts) only to the items you 
specify. The discount is not applied to the entire invoice. To apply a discount to the entire invoice, click 
the Discount button on the right side of the invoicing window. 
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Before You Begin 

1. Set up the discounts you want to use in your practice (Controls > Discounts). 

2. Link discounts to individual invoice items on the Invoice Item Information window’s Tax/Disc tab. 

3. Set up clients to be eligible to receive applicable discounts on the Client Information window’s A/R 
Information tab. 

To apply or remove transaction discounts: 

1. On an estimate, Patient Visit List, Patient Advisor* exam or invoice, add the applicable invoice item. 

2. In the Disc column, click the Yes or No button in that item’s row. (Or you can press TAB until the 
button is selected and then press the spacebar.) The Transaction Discounts dialog box displays. 
The discounts currently being applied are highlighted.  

 
Transaction Discounts dialog box 

3. To add or remove a discount to an invoice item, select the discount under Discounts to Apply. 
Cornerstone applies the highlighted discounts. 

Note: If the client is not set up to receive the discount, a message appears to confirm that you want 
to apply the discount for this client. 

4. Click OK to save your changes. 

Note: If an asterisk appears next to a discount, that discount has been modified (in the Controls menu) 
since it was used in this invoice. To use the updated discount: Click the modified discount (with the 
asterisk) and then re-click the discount to apply the updated percentage. Click OK. 

 To print a list of the discounts linked to clients, print a Client A/R Information Report. (See “Client 
Information Reports” on page 48.) 

 Transaction discounts also print on End of Day reports, such as the Itemized Audit Trail, and 
summary reports, such as the Daily Summary Report and the Invoice Register Report.  

Applying Taxes to Specific Invoice Items 
When you previously set up your invoice items, you had the option of linking certain taxes to individual 
invoice items on the Invoice Item Information window’s Tax/Disc tab. If you invoice a client for one of 
these items, Cornerstone automatically applies the transaction tax (unless the client is tax exempt) and 
the button in the Tax column displays Yes. Click the Yes button to view the applied taxes. 

Note: Cornerstone only applies transaction taxes (as explained above) only to the items you specify. The 
tax is not applied to the entire invoice. 
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Before You Begin 

1. Set up the taxes you want to use in your practice (Controls > Taxes). 

2. Link taxes to invoice items on the Invoice Item Information window’s Tax/Disc tab. 

3. For tax exempt clients, select the Tax exempt check box on the Client Information window’s A/R 
Information tab. (Taxes are not applied if the invoiced client is marked as tax exempt.) 

To apply or remove transaction taxes: 

1. On an estimate, Patient Visit List, Patient Advisor* exam or invoice, add the applicable invoice item. 

2. In the Tax column, click the Yes or No button in that item’s row. (Or you can press TAB until the 
button is selected and then press the spacebar.) The Transaction Taxes dialog box displays. The 
taxes currently being applied are highlighted.  

 
Transaction Taxes dialog box 

3. To add or remove a tax on an invoice item, select the tax under Taxes to Apply. Cornerstone applies 
the highlighted taxes. 

4. Click OK to save your changes. 

Note: If the client is set up as tax exempt, you cannot apply a tax. (A message appears when you click 
the Tax button.) 

Note: If an asterisk appears next to a tax, that tax has been modified (in the Controls menu) since it was 
used in this invoice. To use the updated tax: Click the modified tax (with the asterisk) and then click the 
tax again to apply the updated percentage. Click OK. 

 To print a list that shows clients’ tax status, print a Client A/R Information Report. (See “Client 
Information Reports” on page 48.) 

 Transaction taxes also print on End of Period reports, such as the End of Day Itemized Audit Trail, 
and summary reports, such as the Daily Summary Report, Daily Summary Tax Report and the Daily 
Audit Trail. To see a summary of sales tax activity, print the End of Month report Sales Tax Summary 
Income Reconciliation Report.  

Adding Departing Instructions 
Use departing instructions to give your clients specific details about the medicine that is being 
dispensed or special instructions for a procedure that has been performed. If you have linked departing 
instructions to invoice items, Cornerstone automatically prints the instructions on the invoice and saves 
them in the patient’s medical history. You can also: 

• Add a departing instruction to an invoice item, even if the invoice item has other linked departing 
instructions. 
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• Add an existing instruction or create a new instruction. 

• Change the text of a departing instruction. (The modified instruction is saved in the patient’s medical 
file, but the changes do not affect the practice’s Departing Instruction List.) 

Tip: You can set up a blank departing instruction and then use this instruction to type additional 
information or messages to the client. 

Before You Begin 

1. Set up the departing instructions you want to use in your practice (Lists > Departing Instructions). 
Print a Departing Instructions Report to see a list of departing instructions at your practice. 

2. Link departing instructions to invoice items on the Invoice Item Information window’s Instructions 
tab. Print the Invoice Item Information Report to see which invoice items currently have departing 
instructions linked. 

To add or update departing instructions: 

1. With an item or items added to the Patient Visit List, Patient Advisor* exam or invoice, do one of the 
following: 

• On the PVL, click the Departing Instructions  button for the applicable line item. The 

Departing Instructions dialog box appears. 

• On the Client Invoice window, click Departing. The Invoice Departing Instructions dialog box 
appears. 

 
Invoice Departing Instructions 

2. In the next available row’s ID field, enter the departing instruction ID by either typing the ID or 
pressing F2 to select the ID from the Departing Instruction List. The text of the selected departing 
instructions appears in the Instruction lines box.  

3. In the Staff ID field, specify the staff member recommending the departing instructions by either 
typing the staff ID or pressing F2 to select the staff from the Staff List. 

4. If needed, click the Note button to open the instruction text and make changes, add information, 
and/or check the spelling of the instructions. When finished, click OK. 
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5. To remove departing instructions from the invoice, click in the instruction’s ID field and press 
CTRL+D. (Deleting a departing instruction on the PVL or invoice does not delete the instruction from 
the practice’s Departing Instruction List.) 

6. Click OK to save your changes. 

Verifying Inventory Details 
If an inventory item is marked to track quantity on hand, lot numbers, expiration dates, and/or multiple 
locations, you may be asked to verify inventory details for this invoice item if it is added to a Patient Visit 
List, prescription, lab request, patient document, Patient Advisor* exam or invoice.  

For these types of inventory items, one of the following icons will appear in the Verify Inventory Details 

 column on the PVL/invoice/document (or next to the Quantity field for prescriptions) to indicate 
whether or not information is missing:  

  Indicates more inventory information is required. 

  Indicates inventory information is complete; no action is required. 

Depending on the default set in the When inventory details need to be verified area in Inventory defaults, 
this additional information may be required for the invoice item before you are allowed to continue. 
Options for the default setting include Not required, Warn if not verified, or Required. 

Note: The icon indicator also appears, if applicable, on the Vaccine Tag window. You can click the  
icon and verify inventory details from the Vaccine Tag window, if desired. However, you will not be 
required or warned about verifying the information until the performed item is saved on the PVL or 
invoice. 

To add required inventory information: 

1. For the applicable line item (on the PVL, prescription, invoice, etc.), click the  icon. The Inventory 
Details dialog box appears. 

 
Inventory Details dialog box 

2. For the inventory line item, type the required information in the provided fields or press F2 with the 
cursor in the Loc ID field to search for and select the information from the Inventory on Hand List. 

3. When all inventory details are complete, select the item’s Verified check box. 

4. Click OK. 

The icon now displays as , indicating that the required information is complete. 

Note: After the inventory detail information is complete and marked as Verified, quantity on hand is 
depleted for performed PVL items or items on a saved invoice. 
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Processing Special Actions 
A special action is an action Cornerstone will automatically perform when a specific item is added or 
posted during invoicing (or on the Patient Visit List). You can set up an invoice item to initiate a special 
action by selecting the action on the Invoice Item Information window’s Spec. Actions tab. For example, 
you could set up a vaccination invoice item to initiate the Vaccine Tag special action when the 
vaccination is invoiced. This special action would display the Vaccine Tag window, which allows you to 
enter information for the tag and print a rabies certificate.  

With the exception of the Vaccine Tag special action, all special actions you can perform during 
invoicing represent actions that can be performed elsewhere in Cornerstone, prior to invoicing: 

• Print special Feeding Guide instructions 

• Enter an image request (IDEXX SmartLink* Digital Imaging module only) 

• Enter a laboratory request (Laboratory module only) 

• Mark a patient as deceased 

• Create a prescription 

• Print a document 

• Change the sex of a patient 

• Enter a microchip ID 

• Enter weight/vital signs information 

The process of issuing a new rabies/vaccine tag and certificate can be performed only through invoicing 
using the Vaccine Tag special action. See “Issuing a Rabies/Vaccine Tag and Rabies Certificate” on 
page 193 for information on this process. 

Note: The When to apply setting on the item’s Spec. Actions tab determines when the special action is 
applied during invoicing or on the Patient Visit List. For the Mark as Deceased and Sex Modification 
special actions, the special action can be processed only on the invoice, not on the Patient Visit List. For 
more information about setting up special actions, see “Chapter 10: Setting Up Your Invoice Items” in 
the Cornerstone Administrator’s Manual. 

To process a special action: 

Depending on when the special action is applied and whether or not you choose to process it 
immediately, the Special button may be available for selection on the Client Invoice window or Patient 
Visit List. You can click the Special button at any time to display the Special Actions dialog box, which 
lists any applicable special actions.  

 
Special Actions dialog box 
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Note: The Special Actions dialog box automatically appears when you post an invoice if you haven’t 
performed all of the special actions that are linked to the items on the invoice. 

On the Special Actions dialog box, you can: 

• Click Process to perform the highlighted special action. When you perform a special action, a green 
check mark  appears next to the action. 

• Click Continue to continue posting or saving the invoice. 

• Click Close to return to the invoice. 

Issuing a Rabies/Vaccine Tag and Rabies Certificate 
When you process the Vaccine Tag special action, Cornerstone displays the Vaccine Tag window, which 
allows you to enter information for the tag and print a rabies certificate, if applicable. 

 
Vaccine Tag window 

Your vaccine/vaccination item setup determines if vaccine information displays by default in the fields on 
the Vaccine Tag window: 

• INVENTORY-based system – Items are set up as either vaccination SERVICE items that include a 
link to a vaccine INVENTORY item, or only an INVENTORY item is used. 

• SERVICE-based system – Items are set up as vaccination SERVICE items (with no link to an 
inventory item). 

See “Chapter 10: Setting Up Your Invoice Items” in the Cornerstone Administrator’s Manual for more 
information on setting up vaccine/vaccination invoice items. 

Note: You can assign a specific printer for printing your rabies certificates. See “Assigning Printers in 
Cornerstone” on page 23 for more information. 

Before You Begin: 

• Set Vaccine Tag defaults (Controls > Defaults > Practice and Workstation > select Vaccine Tag 
from the menu on the left). 
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• Set up applicable invoice items to initiate the Vaccine Tag special action (select Lists > Invoice 
Item, select the applicable invoice item and click Update > click the Spec. Actions tab). 

IMPORTANT: Vaccination invoice items must be set up to initiate the Vaccine Tag special action, which 
displays the Vaccine Tag window during invoicing (or on the Patient Visit List). This is the only way to 
issue a new rabies/vaccine tag and rabies certificate for a patient. 

To issue a rabies/vaccine tag and print a rabies certificate for a patient: 

1. On an invoice or Patient Visit List, add an invoice item that has been set up to initiate the Vaccine 
Tag special action.  

Note: Depending on the When to apply option selected for the special action during setup, the 
special action (and Special button) may be activated immediately after the item is added to the 
invoice/Patient Visit List, when the invoice is saved or posted, or when you click the Post button on 
the invoice (before the invoice is actually posted).  

2. If necessary, click the Special button located at the bottom of the Client Invoice window, select the 
Vaccine Tag special action, and click Process. 

When the special action is processed, the Vaccine Tag window appears.  

3. If you previously specified a Tag number prefix in Vaccine Tag defaults, that default prefix will 
display in a smaller text box to the left of the Tag number text box. If desired, you can change the 
prefix (up to five characters). 

4. In the Tag number text box, type the tag number or click the Increment Tag  button to use the 
next available tag number. This increments the tag number by one, based on the Last used tag 
number in Vaccine Tag defaults.  

5. Enter the vaccine Producer/Mfr. and Brand information in the text boxes provided. 

6. In the Type drop-down list, select the applicable vaccine type (Killed, MLV, etc.). 

7. In the Given field, verify the date this vaccine was administered and change the date if necessary. 

8. Enter or select the Manner of administration and Number of years information. 

9. In the Lot number and Drug expires fields, if applicable, enter or select the lot number and 
expiration date for the invoice item. (If lot numbers and expiration dates are tracked through 
Cornerstone Inventory, these settings are controlled by consumption.) 

10. In the Qty/Doses field, verify the quantity/number of doses of the vaccine given and change it if 
necessary. 

11. If the invoice item requires inventory details to be verified, click the red question mark  icon, enter 
or select the appropriate inventory details, and click the Verified check box for the item. See 
Verifying Inventory Details on page 191 for more information. 

12. If applicable, you can enter the location of injection (up to 25 characters) in the Location of 
injection text box. This information will display only when you view the tag information in 
Cornerstone; it will not print on the certificate. 

13. In the Performed by field, type the staff ID or press F2 to use the Staff List to choose a staff 
member, and then press TAB. The staff member’s license number displays if it has been specified 
on the Staff Information window’s Information tab. 

14. If you are issuing a tag that has been designated as a rabies tag, the Print certificate check box 
displays in the top-right corner of the window. Select this check box if you want Cornerstone to print 
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a rabies certificate when this tag is completed. (Or if your practice prints custom certificates, when 
this tag is completed, the certificate document opens for printing in the Cornerstone Editor.) 

15. Click OK.  

• If you have an INVENTORY-based system and you used the default vaccine information (or 
selected existing settings from the drop-down lists), no further options are available. If you 
selected the option to print a rabies certificate, the certificate prints (or opens for printing in the 
Cornerstone Editor). 

• If you have an INVENTORY-based system and you entered new vaccine information on the 
Vaccine Tag window, proceed to step 16. 

• If you have a SERVICE-based system, no further options are available. If you selected the option 
to print a rabies certificate, the certificate prints (or opens for printing in the Cornerstone Editor). 

16. If you entered a new lot number/expiration date combination, you are asked if you would like to add 
the combination for this inventory item. Click Yes to have Cornerstone add the combination for this 
item on the Invoice Item Information window’s Vaccine tab. 

 

17.  If you specified a new Manner of Administration/Years combination, you are asked if you would like 
to add the combination for this Inventory item. 

 

a. Select the Make this the default check box, if you want to use this combination as the species 
default for this Inventory item. 

b. Click Yes to have Cornerstone add the Manner of Administration/Years combination for this item 
on the Invoice Item Information window’s Vaccine tab. 

If you selected the option to print a rabies certificate, the certificate prints (or opens for printing in the 
Cornerstone Editor). 
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To update, void, or reissue a vaccine tag, use the right-click options on the Patient Clipboard, in the 
Patient information area’s Tags/Microchip ID tab. 

To enter an existing tag (if the patient was issued a tag elsewhere and you want to document it in the 
system), use the right-click Add Existing option on the Patient Clipboard, in the Patient information 
area’s Tags/Microchip ID tab. 

 For a list of rabies tags that have been issued by the practice, print the Rabies Tag Report.  

 For a list of all vaccination tags (including rabies) that have been issued by the practice, print the 
Vaccine Tag Report.  

Option to Complete the Tag Number at a Later Time 

When issuing a vaccine tag, if necessary you can leave the tag number blank and complete it later, prior 
to posting the invoice. For example, you might start to issue the tag from the Patient Visit List, and then 
wait to enter the tag number when the client is being invoiced in reception.  

When the client is invoiced, if the tag has not been completed (i.e., no tag number), the Tags to be 
Completed dialog box displays and lists any incomplete tags that exist in the client record. Select a tag 
and click Process to complete the tag information and continue with posting the invoice.  

 
Tags to be Completed dialog box 

Accessing Rabies/Vaccine Tag Options from the Patient Clipboard 

In the Patient information area on the Patient Clipboard, the Tags/Microchip ID tab includes tag options 
available via the right-click menu. 

 

These options include: 

• View/Update – A tag is updateable until the point when you post the invoice containing the 
associated invoice item that generated the Vaccine Tag special action. For those tags that are no 
longer updateable, you can view the tag information, but you cannot make changes. 

• Void – If necessary, you can void a tag; voided tags are listed in bold red text. 

Tip: Click the Hide voided tags check box if you do not want voided tags displayed on this tab. 

• Reissue – If a client loses a tag and needs proof of the vaccination, you can reissue the tag. When 
you reissue a tag, all information on the tag stays the same, except for the tag number. 
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• Add Existing – You may want to enter an existing tag into the system if the patient was issued a tag 
elsewhere and you want to document the tag information in their patient record. (You can also add 
an existing tag when setting up a new patient on the Patient Information window’s Information tab.) 

Using the Pharmacy Formulary 
If your practice has purchased the Pharmacy Formulary module and you have linked your invoice items, 
you can access the Pharmacy Formulary from the Patient Visit List or invoice. 

Before You Begin 

• Verify that your practice has purchased the Pharmacy Formulary module. 

• Link your invoice item IDs to drugs in the Pharmacy Formulary (Activities > Pharmacy Formulary 
> Pharmacy Invoice Item Link Setup). 

To use the Pharmacy Formulary on the Patient Visit List or invoice:  

1. On the Patient Visit List or invoice, add a prescription invoice item. 

2. With your cursor in the item’s row, click Pharmacy. A pop-up menu appears. 

3. Do one of the following: 

• Select Drug Interaction Matrix to check a drug against other drugs (drugs in the patient’s 
system or being prescribed for the patient) and produce a list of possible interaction results. 

• Select Dosage Calculator to calculate the dosage to prescribe for a patient based on the 
weight, species and available forms of the drug. 

• Select Antiparasitic Agent to use interactive antiparasitic agent charts for cats, cattle, dogs, 
horses, poultry, sheep, and swine. 

• Select Conversion Charts to access four conversion charts for your medical reference. 

Applying a Manual Discount to the Entire Invoice 
You can manually apply a discount to the entire invoice before you post the invoice. This discount is a 
percentage of the entire invoice. Do not confuse this manual discount with the transaction discount 
column on the invoice. (The discount column on the invoice allows you to apply discounts to specific 
invoice items.) 

To apply or remove a manual discount on an invoice: 

1. While creating an invoice in the Client Invoice window, enter all invoice items and carry out any 
special actions related to this invoice. 

2. Click Discount. The Manual Discount dialog box displays. The invoice’s total before discount is 
shown. 

3. Do one of the following: 

• To calculate the discount based on a percentage, select Percentage, type the percentage in 
the Discount percentage field, and then press TAB. The discount amount displays. 

• To calculate the discount by specifying a dollar amount, select Amount, type the discount dollar 
amount in the Amount field, and then press TAB. The discount percentage displays. 

Cornerstone adjusts the invoice’s total after discount. 
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Manual Discount dialog box 

4. Type a Description of the discount. 

5. Click OK. 

Copying Invoice Items to Another Patient 
If needed, you can copy items on an invoice to another patient or patients owned by the same client. For 
example, if a client brings in her two cats, you can enter all of the services for the first cat on an invoice 
and copy them to the invoice for the second cat, if applicable. This saves you from having to re-enter the 
services for the second cat. If all of the copied items do not apply to the second cat, you can manually 
delete them from the invoice. 

To copy invoice items to another patient owned by the same client: 

1. Start an invoice and add items as usual.  

2. When finished adding items for the patient, click the Copy To button (located at the bottom right of 
the Client Invoice window). A list of the client’s pets appears. 

 
Copy to Patient(s) dialog box 

3. To view the client’s pets of all species, click the Include all species check box.  

4. To view inactive pets belonging to the client, click the Include inactive patients check box. 

5. From the list, select the pet(s) to whom you want to copy services. 

6. If any group items were used on the first patient, we recommend that you click the Re-expand 
smart and nested groups check box when copying items to other patient(s). When this box is 
selected, you are prompted to answer any age-dependent or weight-dependent questions when the 
services are copied. 

7. When finished, click OK. 

Note: Only lines on the invoice for the first patient are copied. Lines on the Patient Visit List that have 
not been transferred or lines added to the invoice after the copy are not copied. 
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Voiding an Invoice 
If necessary, a staff member with appropriate security permissions can void an invoice in Cornerstone. 
When an invoice is voided, the invoice total is automatically credited to the client’s account, and their 
account balance is updated accordingly. 

To void an invoice: 

1. Open the invoice you wish to void by doing one of the following: 

• With the client selected on the Client Invoice window, press F2 in the Invoice number field to 
select the applicable closed invoice from the Invoice List. 

• With the client selected on the Patient Clipboard, in the Client information area, click the 

Account Information  tab, and then double-click the applicable closed invoice in the list of 
the client’s account transactions. 

2. With the applicable invoice displayed on the Client Invoice window, click the Void button. The Void 
Invoice dialog box appears. 

 
Void Invoice dialog box 

3. Select the Check to confirm the void check box to confirm that you want to void this invoice. 

4. To print the invoice (marked “Voided Invoice”) upon clicking OK, select the Print invoice check box 
and specify the number of copies to print. 

5. If desired, type the reason for the void and any applicable comments in the Comments text box. 

6. Click OK. 

7. If your practice uses cashier IDs, enter your cashier password. 

8. If a payment existed on the original invoice, a prompt appears to automatically reverse (void) the 
payment. Click Yes to reverse the payment.  

Note: If the payment was a credit/debit card payment, the Payment dialog box opens so you can 
immediately void the credit card transaction in Cornerstone. See “Voiding a Credit Card Payment 
Transaction in Cornerstone” on page 205 for information on this process. 

The transaction is saved as a line item in the client’s account with its own invoice number. The 
transaction information includes the date, the voided invoice number, the staff, and any comments. You 
may need to hover the cursor over the line item to view the comments. The invoice total also displays in 
the Credit column. The original invoice line item is marked as Voided, along with the date of the void. 

Note: Clear the Hide voided items check box to view voided invoices and voided payments in client 
account history. 
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Overview 
The Client Account is a record of all financial transactions between you and your clients. The Client 
Account shows:  

• Invoices (the invoice number and whether the invoice is open or closed) 

• Payments (method of payment) 

• Adjustments (who entered the adjustment and why) 

• Comments (any comment you want to keep in the client’s account history) 

• Transfers (amounts transferred to or from another client’s account) 

• Written off or reinstated amounts  

• Returned checks 

At the top of the Client Account, you will find the client’s credit code, last payment date and amount, the 
total dollar amount of all open invoices and the client’s account receivable balances.  

The IDEXX Cornerstone* Practice Management System uses information in the Client Account for 
several alerts, such as Balance Over 90 Days Old, No Payment in 60 Days and Returned Checks. 

Viewing Client Accounts 
You can quickly see a client’s account history in the Client Account window. 

To view a client’s account information: 

 Do one of the following: 

• On the Patient Clipboard, select the client, and then right-click in the Client area and select 
Client Account.  

• Click the Client Account  toolbar button. Enter the Client ID and press TAB. 

• On the Activities menu, select Client Account. Enter the Client ID and press TAB. 

The client’s account history displays in the Client Account window. An electronically signed credit 

card payment displays the signature  icon. 
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Client Account window 

Note: If the selected client has any open invoices, an alert box appears to tell you that open invoices 
exist. Click OK. 

You can perform a variety of actions using the buttons on the right side of the Client Account 
window. 

  Use: To: 

   
Open an invoice for the selected client. 

   
Record a client payment. 

   
Adjust a client account. 

   
Record a comment about the account. 

   
Transfer a portion of the client’s bill to another client’s account. 

   
Write off the client’s account. 

   
Record a returned check. 

   
View details on an invoice without retrieving the invoice. You can also view adjustments, 
comments and returned checks. 

   
Print the Client Account History Report. 
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Recording Payments on Accounts 
Use the Payment dialog box to record partial or full payments you receive from your clients. You can 
also record multiple payments (such as half the bill paid by cash, the other half by check). After you 
record a payment, it is posted to the client’s account, and Cornerstone asks if you’d like to print a 
receipt.  

Note: Payments do not close an invoice. 

Before You Begin 

 Set up your Account defaults (Controls > Defaults > Practice and Workstation > select Account 
in the navigation pane on the left). 

To record a client’s payment (for non-credit/debit card payments): 

Note: For information on payments using a credit or debit card, see “Processing Credit/Debit Card 
Transactions” on page 203. 

1. Do one of the following: 

• With the client’s account history displayed in the Client Account window, click Payment. 

• On the Patient Clipboard, select the client and in the Client information area, click the Account 

Information  tab. Right-click within the transactions table and select Payment. 

The Payment dialog box appears. 

 
Change given appears based on the Calculate change given setting in Account defaults. The Balance after payments 
shows the effect of the payment on the client’s account balance. 

2. If your practice uses cashier passwords, enter your Cashier password. 

3. Type the Amount of the payment. The default Payment Type appears.  

4. If the client is paying off the account, right-click in the Amount field and select Client balance. If the 
client is paying off the balance of the invoice, right-click and select Invoice balance. 

5. Select a different Payment type, if applicable. If the client was not set up for this type of payment, a 
message displays. If you have set up a payment type prompt, the prompt appears next to the 
payment type. 

6. If applicable, type the prompt answer in the Prompt field. 

7. The current date appears as the Deposit Date. Change the date, if necessary. 
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8. Change the amount of Change given. 

• If Calculate change given is selected in Account defaults, the amount of change to return to 
the customer (based on the client’s account balance) displays. 

• If Calculate change given is not selected in Account defaults, .00 appears in the Change 
given field, and the change appears as a credit to the client’s account. 

• If the client’s balance is zero or if the client has a credit on their account, Cornerstone assumes 
the payment is a deposit and the Change given field is not filled in. 

9. Click Post to record the client payment and update the client’s account balance. 

10. At the “Do you want to print?” prompt, select Yes to print a payment receipt or No to not print a 
receipt.  

 To print a list of payments you accepted during a day, print the End of Day report Daily Payment 
Register. (See “Chapter 20: End of Day Processing” in the Cornerstone Administrator’s Manual for 
information.) 

To reprint a Payment on Account receipt: 

You can reprint a payment made on account that does not apply to a specific invoice. (To reprint a 
payment for a specific invoice, view the invoice and reprint it.) 

1. Do one of the following: 

• On the Patient Clipboard, select the client and in the Client information area, click the Account 

Information  tab. Right-click the payment you want to reprint and select View. 

• With the client’s account history displayed in the Client Account window, highlight the payment 
you want to reprint and click View. Click Print. 

A preview of the payment appears. 

2. Click Print. 

Processing Credit/Debit Card Transactions 
IDEXX Cornerstone software offers a simple and secure solution for integrated credit card processing 
initiated from Cornerstone. Cornerstone works with a third-party payment processing provider to process 
credit and debit card transactions through an Internet connection. 

XCharge® Card Payment Processing Software 

XCharge® software, developed by Accelerated Payment Technologies™, provides third-party card 
payment processing for Cornerstone. XCharge is a secure and simple-to-use solution that processes 
both credit and debit card transactions in the United States and Canada. 

Note: Credit card numbers are not stored within Cornerstone—the XCharge software, which functions 
outside of Cornerstone, shields Cornerstone from this information. 

If You Need Help Processing Card Payments with XCharge 

 Once you have installed the XCharge software, you can access the XCharge User Manual by going 
to Start > Programs > XCharge > XCharge Help. You can also access the XCharge Help and 
manual from the Help menu within the XCharge software. 

If you cannot find the answer to your question in the Help or manual, you can contact Accelerated 
Payment Technologies Customer Care for technical support toll-free at 1-800-338-6614.  
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Before You Begin 

 Apply for an XCharge merchant account, install and set up the XCharge payment processing 
software, and set up the Credit Card Payment and Debit Card Payment payment types in 
Cornerstone (Controls > Payment Types). See “Chapter 2: Setting Up Cornerstone Controls” in 
the Cornerstone Administrator’s Manual for information on setting up credit and debit payment types. 

Initiating a Credit or Debit Card Payment from Cornerstone  

To initiate a credit or debit card payment from Cornerstone: 

Note:  The signature icon  is displayed on the Account Information tab on the Patient Clipboard* 
and on the Client Account window for any credit card payments that were electronically signed. 

1. On the Payment dialog box, if your practice is set up to use cashier IDs, enter your cashier 
password and press TAB. 

2. In the Amount field, type the amount or right-click to select Client balance or Invoice balance. 
Press TAB. 

3. In the Payment Type field, select Credit Card Payment or Debit Card Payment, and then press 
TAB. (Alternatively, you can click the Credit Card or Debit Card button.)  

4. Depending on the third-party payment processing provider you have set up, a Payments Login 
dialog box may appear. Enter your user name and password, and then click Login.  

Note: If you select the Remember me for this login option, the Payment Login dialog box will not 
display again as long as you are logged in on this workstation. If you log off Cornerstone and then 
log in again, you will need to provide the Payments Login information again in order to initiate a 
credit/debit card payment. 

The card payment processing window appears. 

5. The amount entered on the Payment dialog box automatically transfers to the Amount field on the 
payment processing window. If the Amount field is blank, type the amount of the purchase. 

6. If processing a debit card payment, enter the value in the Cash Back Amount field, if applicable. 

7. Swipe the card or manually enter the credit card number. 

Note: Debit card information must be entered using the card swipe and PIN pad. Manually entered 
values are not accepted for debit cards. 

8. Complete all required fields and process the transaction. 

9. If processing a debit card payment, ask the client to enter the PIN number on the PIN pad device 
when prompted. 
OR 
If processing a credit card transaction and using an electronic signature capture device, ask the 
client to sign. 

When the transaction has finished processing, the receipt prints. On the Payment dialog box in 
Cornerstone, the transaction information appears in the Payments area with the Status field 
indicating if the transaction was approved.  
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Note: The signature capture box displays differently in Cornerstone depending on whether you are 
using a signature capture device or a tablet PC. Also, Mobile Computing module users can capture 
signatures in the field and process a payment. 

10. Click Post to complete the transaction, and then click Yes when prompted to print a Cornerstone 
receipt. 

Upon successful completion of the transaction, the payment amount will be posted to the invoice 
and/or the client account. 

 For a list of daily credit/debit card transactions (payments, voids and refunds), print the Daily 
Payment Register – Credit/Debit Payment Transactions Report. 

Voiding a Credit Card Payment Transaction in Cornerstone 

A void transaction is used to reverse a credit card payment transaction. The transaction must be in the 
currently open batch (if the current day’s batch has already been closed, you will need to do a return), 
and only the full dollar amount of the original transaction can be voided—you cannot enter a partial void. 

Note: Debit card transactions cannot be voided. 

To void a credit card payment transaction in Cornerstone: 

1. With the client information displayed in the Client Account window, click on the payment transaction 
to be voided and click View. 

Note: If the payment was on an invoice, the invoice must be voided in Cornerstone first before you 
can void the payment. At the end of the invoice voiding process, a prompt appears to reverse the 
payment. Click Yes to continue. 

2. On the Payment dialog box, if your practice is set up to use cashier IDs, enter your cashier 
password and press TAB. 

3. Click anywhere within the transaction row to be voided, and then click Void (or press CTRL+D). A 
message appears to confirm the void/delete action. 

4. Click OK to close the message and void the selected transaction. 

Note: If the void transaction fails (typically because the transaction’s batch has already been 
closed), a Return window automatically appears so you can perform a return rather than a void for 
this transaction. On the Return window, complete all required fields and process the transaction. 

When the transaction has finished processing, a new negative dollar value line displays on the 
Payment dialog box, and the Status field shows the Void transaction. 

5. Click Post to complete the transaction.  

Upon successful completion of the transaction, the void amount is reflected on the invoice and the 
client account. 

Processing a Credit or Debit Return 

The process for issuing a credit or debit refund is similar to processing a credit or debit card payment, 
except to issue a refund you type a negative number in the Amount field on the Payment dialog box. 

To process a credit or debit return: 

1. In the Payment dialog box, if your practice is set up to use cashier IDs, enter your cashier password 
and press TAB. 

2. Type the return amount as a negative number (e.g., -13.50) in the Amount field and press TAB. 
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3. Select either Credit Card Payment or Debit Card Payment for the payment type, and press TAB. 
(Alternatively, you can click the Credit Card or Debit Card button.) The Return window appears. 

4. Complete all required fields and process the transaction. 

When the transaction has finished processing, a new transaction line is displayed on the Payment 
dialog box, and the Status field shows the Return transaction. 

5. Click Post to complete the transaction. 

Upon successful completion of the transaction, the Return amount will be posted to the invoice 
and/or the client account. 

Reprinting a Receipt for an XCharge Transaction 

Using the XCharge Transaction Lookup feature, you can print a copy of a receipt or a transaction detail 
report for a selected transaction. 

Note: Receipts can be printed for approved transactions only. 

To reprint an XCharge transaction receipt: 

1. In the XCharge software (Start > Programs > XCharge > XCharge), click the Lookup button. 

2. Use the available fields to specify a date range or batch number for the desired transaction, and 
then click the Search button. 

3. Select the desired transaction in the list, and then click the Receipt button. The receipt information 
displays in a receipt preview window. 

4. Click the printer icon on the toolbar to print a copy of the receipt. 

Closing the Daily Batch of XCharge Transactions 

When Cornerstone runs End of Day processing (either manual or unattended), it automatically sends a 
signal to the XCharge software to close the current day’s batch of credit/debit card transactions.  
XCharge immediately starts the batch closing (settlement) process and displays a message to inform 
you when the batch has been closed successfully.  

Manually Closing a Batch 

If necessary, you can manually close a batch of XCharge transactions at any time from the XCharge 
software. 

To manually close an XCharge batch: 

1. In the XCharge software (Start > Programs > XCharge > XCharge), click the Settlement button. 

2. Complete all fields on the Credit Card Settlement tab, and then click the Settle button. You are 
prompted to confirm the batch close action. Click Yes. 

XCharge displays a message to inform you when the batch has been closed successfully. 

For more information, see the XCharge User Manual or XCharge Help. 

If a Connection to XCharge Cannot Be Established 

In the event that a connection to XCharge cannot be established (i.e., if the Internet connection is not 
working) and you are unable to perform an online, real-time authorization, you will need to call for voice 
authorization and an approval code. Later, when the connection has been restored, you will need to add 
the credit card transaction to the batch after-the-fact using a “Force” transaction in the XCharge 
software. 
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A Force transaction is generally used to insert previously authorized, but not captured, transactions into 
a batch. Because the Force transaction type is not recorded automatically by Cornerstone, you will need 
to set up a special “Force Credit Transaction” payment type that will allow you to later record the 
transaction in Cornerstone.  

Note: Force transactions are available only for credit payments (not for debit payments). 

To set up a Force Credit Transaction payment type in Cornerstone (one-time setup): 

1. On the Controls menu, select Payment Types. 

2. Click New. 

3. In the Description field, type Force Credit Transaction (or similar identifying name for a Force 
credit card transaction). 

4. In the Prompt field, type Approval Code. The prompt appears when the payment type is selected 
on the Payment dialog box. 

Note: An Approval Code prompt is not required, but it is a good way of ensuring the transaction’s 
approval code is recorded in Cornerstone.  

5. Click OK and then click Close. 

6. Add the payment type to the applicable credit codes (Controls > Credit Codes) you have set up in 
Cornerstone. 

Step 1 – Call for voice authorization and approval code: 

1. On a credit card manual imprinter (old-style carbon copy device), make an imprint of the credit card 
and if applicable, record the 3–4 digit security code on the back side of the card. 

2. Before you call to obtain voice authorization, ensure you have the following information on hand: 

• Your merchant account number (merchant ID) 

• The credit card number and expiration date 

• The dollar amount 

3. Obtain a voice authorization approval code by calling one of the following numbers (depending on 
which processor you are using): 

• If Trans First is your processor, call 1-800-314-6888. 

• If Global is your processor, call 1-800-944-1111, option 1. 

Note: If you do not know your processor, contact Accelerated Payment Technologies Customer 
Care toll-free at 1-800-338-6614 for confirmation. 

4. Record the authorization approval code on the imprinted carbon copy paper with the card 
information. 

5. Ask the cardholder to sign the carbon copy paper, and provide the cardholder with a copy of the 
transaction information. 

Step 2 – Perform the transaction using the “Force” option in the XCharge software: 

When your connection has been restored, you will need to add the credit card transaction to the batch 
after-the-fact using a Force transaction in the XCharge software. 

1. Open the XCharge software (Start > Programs > XCharge > XCharge). 

2. In the list of Credit Card Transactions on the left, click Force (or press F6). The Credit Card – Force 
fields display in the pane on the right. 
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3. In the Amount field, enter the amount to process. 

4. Enter the credit card number and expiration date, or swipe the credit card if it’s available.  

Note: If you swipe the credit card, you automatically populate the Credit Card # and Expiration 
(MMYY) fields. 

5. In the Approval Code field, type the approval code obtained via voice authorization. 

6. Click Process (or press F12). When processing has finished, the receipt prints. 

Step 3 – Record the transaction in Cornerstone using the Force payment type: 

1. Return to the Payment dialog box in Cornerstone to enter the payment. 

2. In the Amount field, type the amount, or right-click and then select Client balance or Invoice 
balance. Press TAB. 

IMPORTANT: Make sure the amount entered or selected here matches the amount of the 
transaction you processed in the XCharge software. 

3. In the Payment Type field, select Force Credit Transaction (or the name used to create your Force 
payment type) and then press TAB.  

4. If an Approval Code prompt was set up for this payment type, in the Answer field, type the approval 
code for this transaction obtained via voice authorization.  

5. In the Deposit Date check box, verify the date and correct it, if necessary. 

6. Click Post to post the payment to the invoice and/or the client account. 

Step 4 – Account for Force transactions in your daily reporting: 

Because the Force transaction processed in XCharge is not initiated from Cornerstone (and therefore 
not recorded in Cornerstone), you will need to use the Daily Payment Register – By Payment Type report 
in Cornerstone as your log of transactions recorded under the Force Credit Transaction payment type. 

1. On the Reports menu, select Find a Report. 

2. In the Reports list on the left, click the plus sign [+] to the left of the End of Day report group, and 
then open the Daily Payment Registers subgroup. 

3. Double-click Sorted by –Payment Type to create the report. 

4. Select the applicable Daily period, and then click Preview or Print. 

5. Use the report preview or printout to look up the subtotal amount of all transactions processed 
under the Force Credit Transaction payment type. 

6. Add this amount to the credit transactions on your Daily Payment Register – Credit/Debit Payment 
Transactions Report within Cornerstone. Compare that amount to your XCharge daily reports to 
balance your End of Day.  

XCharge Reports 

The XCharge software provides a variety of reports that include detail and summary level information for 
all transaction types, as well as credit- and debit-specific detail. The transaction detail reporting allows 
for sorting by specific field names, and all reports can be displayed and/or printed by a date range. 

There are many useful reports available in the XCharge software. Two of the most commonly used 
reports include:  

Credit Card Totals Report – Provides the following processing detail by credit card type: transaction 
type, count, total amount, average amount and group. 
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Settlement Report – For each transaction within a batch, provides information on: transaction type, 
credit card number, expiration date, credit card type, approval code, date, settlement date, clerk, 
settlement clerk, register, settlement register, amount, settlement amount and settlement difference. 

To access reports in the XCharge software (basic steps): 

 In the XCharge software (Start > Programs > XCharge > XCharge), click the Reports button. 

For more information, see the XCharge User Manual or XCharge Help. 

Cornerstone Daily Payment Register – Credit/Debit Payment Transactions Report 

This Cornerstone report allows you to review your daily credit/debit card transactions (payments, voids 
and refunds). The report groups transactions according to payment card type and sorts them in 
ascending date/time order. 

Note: This report lists only those transactions performed using the Credit Card Payment and/or Debit 
Card Payment payment types, as these are the only payment types that allow card processing initiated 
from Cornerstone.  

To access this report in Cornerstone: 

1. On the Reports menu, select Find a Report. 

2. In the Reports list on the left, select End of Day > Daily Payment Registers > Sorted by – 
Credit/Debit Payment Transactions.  

Adjusting Client Accounts 
Use the Account Adjustments dialog box to adjust a client’s account or to set up a client’s account. Use 
adjustments sparingly and only to: 

• Set up a beginning balance 

• Modify a discount 

• Adjust a finance or billing charge 

Note: Do not use adjustments to correct invoicing or payment errors.  

To adjust a client’s account: 

1. Do one of the following: 

• On the Patient Clipboard, select the client and in the Client information area, click the Account 

Information  tab. Right-click within the transactions table and select Adjustment. 

• With the client’s account history displayed in the Client Account window, click Adjust.  

The Adjustment dialog box appears. 
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Adjustment dialog box 

2. In the Comment text box, type the reason for the adjustment. (The adjustment comment from 
defaults automatically displays.) 

3. Type the amount this client owes in the corresponding Adjusted boxes. (Do not type the amount you 
are adjusting.) 

• Total due at the bottom of the dialog box reflects what the client now owes your practice. 

• Adjustment reflects the total amount you are adjusting. 

4. Click OK. The Accounts Receivable balances are updated. 

Note: If you pay your providers based on collected accounts receivable, you will have to select the 
staff. 

 To print a list of adjustments, print the End of Month report Monthly Adjustment Summary by Client 
ID or Client Last Name. 

Adding Comments to Account History 
You can record various comments or information about a client’s account. These comments are dated 
and appear in the Client Account and Client Account History Report. 

To view a long comment in the Client Account, double-click the comment or position the mouse over the 
line. 

To add a comment to a client’s account: 

1. Do one of the following: 

• On the Patient Clipboard, select the client and in the Client information area, click the Account 

Information  tab. Right-click within the transactions table and select Comment. 

• With the client’s account history displayed in the Client Account window, click Comment.  

The Comments dialog box appears. 
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Comments dialog box 

2. Type the comment. 

3. Click OK. The comment appears in the Transaction Description column. 

Transferring Portions of Bills 
Sometimes you have to split a bill because the patient has more than one owner. You can transfer an 
amount of one client’s bill to another client. The transfer appears in both clients' account histories.  

Note: If the patient is owned by a partnership, use Split Billing instead. 

To transfer billing between client accounts: 

1. Do one of the following: 

• On the Patient Clipboard, select the client and in the Client information area, click the Account 

Information  tab. Right-click within the transactions table and select Transfer. 

• With the client’s account history displayed in the Client Account window, click Transfer. 

The Transfer Portion of Bill dialog box appears. 

 
Transfer Portion of Bill dialog box 

2. In the Transfer To area, enter the ID of the client to whom you are transferring a portion of the bill. 

3. Type the percentage or the total amount of the bill that is being transferred. Cornerstone calculates 
the corresponding amount (percent or total). 

Note: You cannot transfer a credit. 

4. Click OK to save your changes. 

Splitting Bills Between Partnerships 
Users of Split Billing will likely be equine or large animal practices. In most cases, all activity for patients 
at these practices is put on one invoice throughout the month. When the end-of-month process is run, 
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the invoices are marked as closed, and the totals are split between members of partnerships. Members 
are sent a monthly statement with a list of all services performed in the past month.  

Using the Split Billing Module 

Using the Split Billing module will not change your usual process.   

• You can start an invoice and leave the invoice open throughout the month, adding items as usual.  

• When your end-of-month is run, Cornerstone automatically closes all applicable invoices. (Make 
sure to select an Invoice Type that will be closed at the end of the month.)  

• After end-of-month is run, the balance that the partnership owes the practice will be zero. The total 
owed is now divided among each member according to the percentage assigned in the Partnership 
Information window.  

• Statements are generated for clients, including members of partnerships. 

To split a bill immediately: 

Occasionally, you may need to split a partnership bill before your next end-of-month process.  

1. Post the partnership invoice. 

2. On the Activities menu, select Split Partnership Invoices.  

3. Enter a range of partnership IDs or press F2 to select partnerships from the Client List.  

4. Highlight the invoice(s) to split and click OK. 

Looking at the Partnership Details 

Before End of Month (EOM) is run, any invoices display on the partnership account. After EOM 
processing, any invoices are closed, and there is no balance on the partnership account. The total is 
split and the amounts are divided among the individual member accounts based on the percentage set 
up in the partnership account.   

To see the original invoices under the partnership account, view voided invoices. Because the individual 
members will pay the balances, buttons related to payments (Payment, Transfer, Write Off and Rtn Chk) 
are not available from the partnership account. Cornerstone allows adjustments to be made to 
partnership accounts, but use care when making adjustments. 

Writing Off and Reinstating Accounts 
Writing off a client account marks the client inactive and sets all of the client’s accounts receivable 
balances to zero. The client alert Client Written Off warns you when you use this client. 

If you resume business with the client, reinstating the account is a simple process. The client alert Client 
Reinstated warns you that the client has been previously written off and then reinstated. The accounts 
receivable balances are set to the client’s previous balance. 

Before You Begin 

 Make sure that all invoices for that client are closed. 
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To write off an account: 

1. Do one of the following: 

• On the Patient Clipboard, select the client, and in the Client information area, click the Account 

Information  tab. Right-click within the transactions table and select Write Off. 

• With the client’s account history displayed in the Client Account window, click Write Off.  

The Write Off Account dialog box appears. 

 
Write Off Account dialog box 

2. In the Comment text box, document why you are writing off the account. The comment and the write 
off appear in the Transaction Description column in the Client Account. 

3. Click Write Off to save your changes. 

Note: Clients with accounts that have been written off will not receive statements. Inactive clients 
with an account balance will still receive statements. 

To reinstate a written off account: 

When reinstated, the client’s balance returns to the status it had prior to being written off. (The current 
balance returns to Current, the 30 day balance returns to 30 day, and so on.) The Reinstate button 
displays only on a client’s account that has been written off. 

1. Do one of the following: 

• On the Patient Clipboard, select the client and in the Client information area, click the Account 

Information  tab. Right-click within the transactions table and select Reinstate. 

• With the client’s account history displayed in the Client Account window, click Reinstate.   

The Reinstate Account dialog box appears. 

 
Reinstate Account dialog box 

2. In the Comment text box, document why you are reinstating the account. The comment appears in 
the Transaction Description column in the Client Account. 
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3. Click Reinstate to reinstate the client’s account, which adds the amount that was written off back to 
the account balance. 

 To print a list of clients whose balances have been written off, print the Account Write Off Report by 
Client ID or Client Last Name. (See “Chapter 22: End of Year Processing” in the Cornerstone 
Administrator’s Manual for information.) 

Recording Returned Checks 
You should record all checks that do not clear the bank. In Cornerstone, recording a bad check adds the 
amount of the check, plus any service charges, to the client’s accounts receivable balance. 

Before You Begin 

 Enter a service charge for returned checks in Account defaults (Controls > Defaults > Practice 
and Workstation > select Account from the menu on the left). 

To record a returned check: 

1. Do one of the following: 

• On the Patient Clipboard, select the client and in the Client information area, click the Account 

Information  tab. Right-click within the transactions table and select Rtn Chk. 

• With the client’s account history displayed in the Client Account window, click Returned Check.  

The Returned Check dialog box appears. 

 
Returned Check dialog box 

2. If your practice uses cashier passwords, enter your cashier password. 

3. If necessary, change the date in the Date text box. 

4. Type or select a check number in the Check # text box.  If you select the check number, 
Cornerstone automatically enters the amount of the check. 

5. If the amount is blank or incorrect, type value of the returned check in the Amount text box. 

6. If the service charge is incorrect, type the correct amount in the Service Charge text box. 

7. Select the Valid Returned Check check box if this returned check should be assigned to the client. 
This will cause an alert to display on the client’s record. (For example, if the returned check was a 
result of a bank error, you may not want the alert to display on the client record.) 

8. Click OK to save your changes. 
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Note: If you pay your providers based on collected accounts receivable, you will have to select the 
staff from whose totals the adjustment is made.  

 To print a list of returned checks, print the End of Month report Returned Check Summary. (See 
“Chapter 21: End of Month Processing” in the Cornerstone Administrator’s Manual for information.) 

Viewing Invoice Detail from Client Accounts 
Cornerstone allows you to view the invoice detail from client accounts. This timesaving feature prevents 
you from having to retrieve the invoice manually. For example, if a client calls about a bill, you can easily 
view the invoice to answer his or her questions. 

To view invoice detail: 

1. Do one of the following: 

• On the Patient Clipboard, select the client and in the Client information area, click the Account 

Information  tab. Right-click on an invoice and select View. 

• With the client’s account history displayed in the Client Account window, highlight the invoice 
line you want to view and click View. 

The invoice displays. Note that electronically signed invoices display the signature  icon. 

2. Click Cancel to return to the previous window. 
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Overview 
The Daily Planner is a one-stop window, designed for busy doctors and technicians who want to view 
information pertaining to the patients currently being seen at the practice. Only open patient cases 
display on the Daily Planner.  

From the Daily Planner, you can access: 

• Scheduled appointments and no-show appointments 

• Scheduled call backs 

• Open laboratory requests, recently received results and laboratory call backs 

• Checked-in patients 

• Tentative medical notes 

• Tentative correspondence 

• The Patient Visit List (PVL) 

• Open invoices 

• Open physical exams/Patient Advisor* exams 

Using the Daily Planner 

To use the Daily Planner: 

1. Do one of the following: 

• Click the Daily Planner  toolbar button. 

• On the Activities menu, select Daily Planner. 

The Daily Planner window appears.  

 
Daily Planner window 
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2. In the top-left Staff information area, the ID of the staff member logged in on this workstation 
displays. To change the staff member, enter a different staff ID or press F2 to search for an select a 
staff member from the Staff List. To view information for all practice staff, select the View for all staff 
check box. 

3. Choose from the following options: 

• Click the Appointments tab to view scheduled appointments and past due appointments for 
the specified staff member and date range. The appointment date/time, client ID and name, 
patient ID and name, appointment notes, appointment status, reason for visit, room and staff 
name display.  
Right-click on an appointment line to update appointment information, check a patient in, or 
open the Patient Clipboard for the patient associated with the appointment. 

• Click the Call Backs tab to view scheduled reminder call backs for the specified staff member 
and date range. The client ID and name, patient ID and name, staff name, date, phone, 
reminder item prompting the call back, and call back status display.  
Right-click on a reminder call back to update the call back information on the Patient Reminders 
window, delete a call back, add a note about the call back, change the due date of the call 
back, or open the Patient Clipboard for the patient associated with the call back. 
See “Viewing Call Backs on the Daily Planner” on page 64 for information on using the Call 
Backs tab. 

• Click the Diagnostics tab to manage laboratory requests and results for the specified staff 
member. You can view open laboratory requests and recently received results, post completed 
results, and resolve any orphan or not-requested results. For completed and posted laboratory 
results, you can generate a call back immediately or schedule a call back for a specific staff 
member and date.  
See “Working with Laboratory Call Backs on the Diagnostics Tab” on page 64 for information on 
using the Diagnostics tab. 

• Click the Checked-In tab to view patients that are currently checked in for the specified staff 
member. The client ID and name, patient ID and name, check-in date and time, reason for visit, 
room, and staff name display.  
Right-click a check-in record to update the check-in information, check out the patient, open the 
Patient Clipboard for the selected patient, or open the Physical Exam/Patient Advisor* exam 
window for the patient. 

• Click the Medical Notes tab to view non-finalized medical notes associated with the specified 
staff member. This allows staff to see which medical notes still need to be reviewed and marked 
as final. Medical notes flagged with an alert display with a bright red background.  
Right-click on a medical note line to update the medical note, finalize an enhanced medical note 
marked as Tentative, or open the Patient Clipboard for the patient associated with the medical 
note. 

• Click the Correspondence tab to view non-finalized correspondence documents associated 
with the specified staff member. This allows staff to see which documents still need to be 
reviewed and marked as final. The date, patient ID and name, client ID and name, document 
description, and staff ID and name display.  
Right-click on a document line to update the document, finalize a document marked as 
Tentative, or open the Patient Clipboard for the patient associated with the document. 
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• Click the Patient Visit List tab to view invoice items on the Patient Visit List. If a PVL contains an 
invoice item associated with the specified staff member, the patient and associated PVL 
information display on the tab. You can organize the PVL information in staff order (View by 
staff option) or you can narrow the list of patients to those that have an invoice item associated 
with a selected classification on the PVL (View by item classification option). You can also 
select the Display blue comment line option to show the blue comment line associated with 
each invoice item on a PVL. 
Right-click on a patient line to access the Patient Visit List and make modifications, open the 
Patient Clipboard for the patient, or display (and optionally print) the Patient Visit List Report for 
the patient. 

• Click the Invoices tab to view a list of open invoices. Invoices that have been saved but not 
posted display on the tab. The date, client ID and name, invoice ID, amount, invoice type and 
whether or not to close this invoice at end of month display.  
Right-click on an invoice line to update the invoice information on the Client Invoice window or to 
open the Patient Clipboard for the client associated with the invoice.  

• Click the Exams tab to view a list of open physical exams/Patient Advisor* exams (Patient 
Advisor module only) associated with the specified staff member. The admitted date, patient ID 
and name, client ID and name, staff ID, tech ID, and abnormals display. Right-click an exam line 
to update the exam information or open the Patient Clipboard for the patient associated with the 
exam. 

4. To organize the information that displays in a specific tab, left-click the appropriate column header. 

5. To display a list of available menu options for the selected tab, right-click on a line item within the 
tab. 

6. To update the Daily Planner to reflect current information, click the Refresh button or right-click 
within a tab and select Refresh from the list of menu options. 

7. When finished, click the Close button to exit the Daily Planner. 
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This chapter covers the daily tasks for using Physical Exam and printing a Pet Health Report Card from 
Cornerstone. For information on the steps required to set up Physical Exam and Pet Health Report Card, 
see “Chapter 15: Setting Up Physical Exam and Pet Health Report Card” in the Cornerstone 
Administrator’s Manual. 

 

Overview 
The Physical Exam feature allows you to: 

• Quickly and easily record body system observations and comments while the patient is being 
examined 

• Use one of several standard body system templates to record your observations 

• Print a Pet Health Report Card when the exam is complete 

• Store a record of the physical exam in the patient’s history 

On the Physical Exam window, the Observations tab’s right-click options allow you to easily select a 
status (Normal, Abnormal or Did Not Examine), add or remove a body system on the exam (Systems 
option), or add multiple lines of alternative observation text (Update option). 

 
Physical Exam window with right-click options 

Note: If you have installed the Patient Advisor* module, “Patient Advisor Exam” will display in place of 
“Physical Exam” in several areas throughout Cornerstone (Practice and Workstation defaults, right-click 
menu on the Patient Clipboard*, Activities menu, window title bars, etc.). See the Patient Advisor online 
Help for more information on setting up and using Patient Advisor.  

The Pet Health Report Card provides details of the physical exam and can be set up to print 
automatically when a physical exam is saved or posted. On the report card, each body system can be 
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marked as Normal, Abnormal or Not Examined. You can also print abnormal results in red and include a 
pet picture, if applicable. 

 
Sample Pet Health Report Card 

Before You Begin 

• Set default print options for the Pet Health Report Card (Controls > Defaults > Practice and 
Workstation > select Physical Exam from the menu on the left). 

• If desired, create or update observation text for body systems (Lists > Physical Exam > Physical 
Exam Setup).  

• If desired, add or change the Physical Exam system templates (Lists > Physical Exam > System 
Templates). 

Starting the Exam and Selecting a System Template 

To start the exam and select a system template: 

1. With the patient’s record open on the Patient Clipboard, in the Patient list area, right-click the 
patient’s name and select Physical Exam. (Alternatively, you can click the Physical Exam  
toolbar button and select a patient.) 

The Patient Exam List appears.  
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Patient Exam List 

2. Do one of the following: 

• If this is a new exam, click New. 

• If this is an open or closed exam for which you want to enter recheck information, click 
Recheck. You may want to perform a recheck if a patient returns to have bandages changed or 
additional x-rays taken, etc. 

Note: The recheck option creates a copy of the original exam record to which you can add your 
observations. This exam record is labeled as a recheck exam. Both the original and recheck 
exam are saved in patient history. 

• To modify information on an open exam, on the Patient Exam List, click the open exam that you 
want to modify and click Select. 

The Physical Exam window opens.  

 
Physical Exam window 

3. In the Admit field, press TAB to accept the current date or enter a different date.  

4. In the remaining text boxes in the Exam information area: 

a. Enter the release date, if known. 

b. Select the staff responsible for the physical exam and the technician, if applicable. 
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5. If necessary, click the Vital Signs/Weight  button in the top-left Patient information area to 
update the patient’s weight and other vital signs, if applicable. See “Creating a Vital Signs Set for a 
Patient” on page 233 for information on recording vital signs for a patient. 

Note: The button displays in red/yellow  as an alert if at least one vital sign (other than weight 
and body score) has not been entered for the patient within the past 10 days.  

6. Select the Observations tab to review the default physical exam System template. If the system 
template has been linked to a specific species, that template displays. If necessary, select a 
different system template from the drop-down list.  

Changing the Systems Included in the Physical Exam 
During a physical exam, if necessary you can add or remove body systems to be printed on the Pet 
Health Report Card. This updates the systems for the currently open exam only—the system template 
will not be changed. 

1. With a patient’s exam open in the Physical Exam window, right-click anywhere within the 
observations text and select Systems. The Exam Wizard - System Templates window appears. 

 
Exam Wizard - System Templates window 

2. In the list of systems, those systems with a check mark in the gray box to the left of the system name 
will print on the Pet Health Report Card. Click the gray boxes as needed to add or remove systems 
from the selection list. 

3. To change the status of a system, select Normal, Abnormal or Did Not Examine from the 
applicable drop-down list in the right column. 

4. To change the order of the systems, click on a system and then click the  or  arrow button to 
move it within the list. 

5. When you are finished, click Finish to save your changes for this physical exam. 

Modifying Observation Text on the Physical Exam 
The standard observations display based on the selected system template. During the physical exam, 
you can change the observation status and text to reflect the results of the exam.  
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To change the observation status: 

 Right-click on the observation and select the applicable status—Normal, Abnormal or Did not 
Examine. The observation text will change to the default text set up for that status. 

To change the observation text: 

1. To select a different set of preloaded observation text, highlight the existing text and press DELETE 
on the keyboard.  

2. Click the magnifying glass  icon to the right of the text box. The Observation List dialog box 
displays a list of alternative observation text options. 

 
Observation List dialog box 

3. Highlight the observation text to use and click Select. The selected observation text displays in the 
text box. 

4. To edit the observation text, position the cursor where you want to edit text and type or change the 
text as needed. 

To add multiple lines of observation text: 

1. With a patient’s exam open in the Physical Exam window, right-click anywhere within the 
observations text and select Update. The Exam Wizard - System window appears. 

2. Select the applicable system and status, and then click Search. The Observations List window 
appears. 

 
Observations List window 
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3. In the Observation text area, in the middle box listing the available observation text lines, highlight a 
text line to use and click Add. The text line displays in the bottom box containing all added lines of 
observation text. 

4. Repeat the previous step until all applicable text lines have been added, and then click OK. 

5. Click Finish to return to the Physical Exam window. 

Inserting Vital Signs Information Within an Observation 
If you previously set up certain Physical Exam body systems as “vital sign systems,” a Vital 
Signs/Weight  icon will display next to those systems on the exam Observations tab. You can click 
the Vital Signs/Weight icon and select vital signs to be included as text lines within the observation text 
that prints on the Pet Health Report Card. 

See “Chapter 15: Setting Up Physical Exam and Pet Health Report Card” in the Cornerstone 
Administrator’s Manual for information on setting up body systems as vital sign systems. 

 
Body system observation with Vital Signs/Weight icon 

To insert vital signs information within an observation: 

IMPORTANT: If you need to change the Normal/Abnormal/Did Not Examine status, change the status 
first, before selecting vital signs information to include in the observation. If you add vital signs 
information to the observation text and then change the Normal/Abnormal/Did Not Examine status, the 
observation text and vital signs information will be overwritten with the text for the newly selected status. 

1. For any system previously set up as a “vital signs system,” click to place your cursor in the desired 
position within the system’s observation text (where you want to insert the vital signs information), 
and then click the Vital Signs/Weight  icon located to the right of the observation text. 

The Vital Signs selection window appears. (See “About the Vital Signs Selection Window” on page 
236 for information.) 

Vital Signs/ 
Weight icon 

Vital signs 
information 
within the 
observation 
text 
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Vital Signs selection window 

2. If desired, add a new vital signs set and/or make changes to an existing set (if still within the allowed 
timeframe for editing). When finished with any additions or edits, click OK to save your changes and 
then enter or select the staff ID. 

3. In the Vital Signs column (left column), click the check box next to each vital sign to include in the 
observation text. To quickly select all vital signs for inclusion, click the select all signs check box. 

4. In the date/time/staff column headers, select the check box for each vital signs set to include. 
(Cornerstone automatically selects check boxes for the most recent five sets entered since the time 
of the patient’s last check in. If you add a new set in this window, it will include the new set in 
addition to the five most recent sets.)  

5. When you have finished selecting the vital signs to include in the observation text, click OK. 

The selected vital signs are added in the location of the cursor within the observation text box, along 
with the staff and date/time each vital signs set was created.  

Adding Exam Notes 
Use exam notes to save internal comments about the exam. Notes are saved in patient history with the 
exam but do not print on the exam. 

To add exam notes: 

1. With a patient’s exam open in the Physical Exam window, click the Note button. 

2. Type the note and click OK. 

The exam note can be modified on an open or new exam and viewed on a closed exam. 

Saving or Posting the Exam 
You can save or post the exam so it is included in the patient’s history. 

• If you Save an exam, you can return to it later to make changes. A saved exam is considered open. 

• If you Post an exam, the exam is saved in the patient’s medical history and is considered closed. 
After an exam is posted, it cannot be modified. 

To save or post an exam: 

1. With a patient’s exam open in the Physical Exam window, click Save to save the exam or Post to 
post the exam. The Physical Exam dialog box appears, displaying the Pet health report card – print 
information options. 
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Physical Exam – Pet Health Report Card print options 

2. To print the Pet Health Report Card at this time, select the Print check box and specify the number 
of copies to print. 

3. If necessary, change the footer message to print on the report card. 

4. Click Save or Post. 

Printing the Pet Health Report Card 
1. With a patient’s exam open in the Physical Exam window, click Print. The Physical Exam dialog box 

appears, displaying the Pet health report card – print information options. 

2. Select the Print check box and specify the number of copies to print. 

3. If necessary, change the footer message to print on the report card. 

4. Do one of the following: 

• To print the report card immediately without viewing it first, click Print. 

• To view the report card before printing, click Preview. From the preview window you can click 
Print to print the report card or click Save As to save the report card data to a file. 

Viewing Physical Exams in History 
Physical exams are stored in patient history and can be viewed anywhere you can view patient history, 
such as the Patient Clipboard. Look for the Physical Exam  icon.  

 
Physical Exam shown in patient history on the Patient Clipboard 
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Physical Exam Reports 

To access Physical Exam reports: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 

2. In the Reports list, click the plus sign to the left of Physical Exam to expand the list of Physical 
Exam reports. 

 
Physical Exam reports 

Note: If you have installed the Patient Advisor* module, the Patient Advisor report group will display in 
place of the Physical Exam group.  

Open Physical Exam Report 

The Open Physical Exam Report lists all patients with open exams in admission date order. You can use 
this report to review the open exams and determine if a recheck exam is necessary or if the exam should 
be posted.  

Reports for Managing Physical Exams 

Several additional Physical Exam reports help you manage your observation text and templates.  

• Observations Report  

• Physical Exam System Setup Report 

• System Template Setup Report  
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This chapter covers the daily usage tasks for Vital signs/Weight features in Cornerstone . For information 
on the steps required to set up the Vital Signs List for your practice, see “Chapter 16: Setting Up Vital 
Signs/Weight” in the Cornerstone Administrator’s Manual. 

 

Using the Vital Signs/Weight features in the Cornerstone* Practice Management System, you can view, 
add, edit and graph vital signs for a patient. You can also include vital signs information in medical notes 
and on Pet Health Report Cards created using Physical Exam/Patient Advisor* Exam. 

Accessing Vital Signs for a Patient 

One of the fastest ways to access vital signs for a patient is to click the Vital Signs/Weight  button 
that displays on many windows throughout Cornerstone (Patient Clipboard*, Cornerstone Editor, 
Physical Exam/Patient Advisor Exam, Whiteboard Patient Treatments and Patient Orders windows, 
Patient Visit List, etc.). 

Note: The button displays in red/yellow  as an alert if at least one vital sign (other than weight and 
body score) has not been entered for the patient within the past 10 days. 

Other ways to access vital signs for a patient: 

• On the Patient Clipboard, click the Vital Signs tab in the Patient History area. You can view vital 
signs directly on the tab and use the right-click menu to access other options (Add new, 
Update/View or Void). 

• On the Patient Clipboard, in the Patient list area, right-click the patient name and select Vital 
Signs/Weight. 

• Click the Vital Signs/Weight  toolbar button. 

• On the Activities menu, select Vital Signs/Weight. 

• Process an Update Vital Signs special action. 

When you access the Vital Signs/Weight feature using any of these methods, the weight entry dialog box 
appears. The weight entry dialog box allows you to enter the patient weight and, if desired, click the add 
more Vital signs link to open the full Vital Signs entry and viewing window. 

 

Note: If the Vital Signs/Weight feature is accessed from the Electronic Whiteboard, the Patient Orders 
window or the Patient Treatments window, Cornerstone displays the full Vital Signs entry and viewing 
window instead of the weight entry dialog box. 

Click to open the 
Vital Signs window 
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About the Vital Signs Window 
The Vital Signs window provides one central location to review historical vital signs for a patient, and 
allows you to more easily identify changes in a patient’s health through comparative trending and 
graphing.  

 

 

 
Vital Signs window 

The Vital Signs window includes the following fields and options:  

Field/Option Description 

‘Vital Signs’ column (static 
left column) 

Displays Weight and all other vital signs activated in Vital Sign Setup. 

‘Create new Vital Signs set’ 
column (right column) 

Allows you to add a new set of vital signs for a patient. See “The expanded 
‘Create new Vital Signs set’ column” on page 232 for more information. 

Hide voided records When selected, voided vital signs sets (columns) do not display on the 
Vital Signs window. 

Graph  button For Numeric and Numeric List vital signs, click this button to view the 
patient data in a graph and optionally print the graph. See “Graphing Vital 
Signs for a Patient” on page 235 for more information. 

Inactive (I) vital sign Inactive vital signs are listed on the Vital Signs window only if that patient 
has historic values for that vital sign. Inactive vital signs are marked with an 
"(I)" in the Vital Signs column. 

“?” link For Alphanumeric List and Numeric List vital signs, click this link to view 
the list values and their extended descriptions, if any exist. 

‘Vital Signs’ 
column 

Inactive 
vital sign 

Refresh 
button 

Hide voided 
records 

‘Create new Vital 
Signs set’ column 

“?” link 

Graph 
button 

Comments 
icon 

Red 
abnormal 
indicator 
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Field/Option Description 

Red abnormal indicator Abnormal vital sign entries – those marked as High (H), Low (L) or 
Abnormal (A) – display in bold red text. 

Comments  icon Displays when a comment is associated with the entry. Hover the cursor 
over the icon to view the comment text. 

Refresh button After vital signs have been saved for a patient (at this workstation or 
elsewhere in the practice), click this button to ensure you are viewing the 
most recent data for the patient. 

 

When working within the Vital Signs window, note the following: 

• A set of vital signs for a patient is a group of vital sign 
entries that belong to the same date/time/staff (provided in 
the column header). 

• A vital sign entry is an individual vital sign value—one cell 
within the vital signs set. 

 

 

 

Notes:  

• The Vital Signs window displays only active vital signs as assigned in Vital Sign Setup (select Lists 
> Vital Signs/Weight). Until you’ve completed the Vital Sign List setup, Weight is the only vital sign 
that will appear on the Vital Signs window. 

• For the Vital Signs display order, Weight is always on top (and if there is an active Body Score vital 
sign, it appears below Weight). The order of other vital signs can be specified during setup (select 
Lists > Vital Signs/Weight > click the Set Order button). 

• You can resize the Vital Signs window to optimize the display for your workstation, and the defined 
window size will be remembered on that workstation. (Note: Resizing capability is not available when 
accessing the window via the Patient Clipboard right-click menu.) 

Set of vital 
signs 

Vital sign 
entry 
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The expanded ‘Create new Vital Signs set’ column 

The Vital Signs window Create new Vital Signs set column makes it easy to quickly enter a set of vital 
signs for a patient. The fields available in this column mirror the Vital Sign List settings you configured for 
the practice during setup.  

 
Expanded ‘Create new Vital Signs set’ column on the Vital Signs window 

The Create new Vital Signs set column includes the following fields and options: 

Field/Option Description 

Date/Time cell This cell expands automatically when any other Create new… vital sign entry 
cell is selected. The Date and Time fields are required for each set of vital 
signs and default to the server date and time. Note that you cannot enter a 
date/time that is in the future or greater than 10 days old. 

Text entry box or drop-down 
selection list 

Depending on the vital sign type (Alphanumeric, Numeric List, etc.), the data 
entry/selection field may appear as a text box or a drop-down list. 

“?” link For Alphanumeric List and Numeric List vital signs, click this link to view the list 
values and their extended descriptions, if any exist. 

‘Normal’ drop-down list If the vital sign value is abnormal for this patient, alert staff by selecting High, 
Low or Abnormal from the drop-down list. A selection other than Normal will 
cause the value to display in bold red, along with an H, L, or A designation. 

Enter comment Type vital sign comments in the text box as needed (maximum of 30 
characters). The  icon displays for an entry if a comment is associated with 
it.  

None for species Displays in a cell if the species has not been associated with a list for that vital 
sign. (To add the species to a list: Select Lists > Vital Signs/Weight, double-
click the vital sign, select a list and then select the applicable species to 
associate with the list.) 

 

Date/Time 
cell 

Enter 
comment 

‘Normal’ 
drop-down list 

Text entry box 
or drop-down 
list 

None for 
species 

“?” link 
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Creating a Vital Signs Set for a Patient 
IMPORTANT: Make sure your practice’s Vital Sign List has been finalized before you begin entering vital 
signs for patients. For list-type vital signs, once a vital sign has been entered for a patient, you will no 
longer be able to make changes to the list values or the species associated with a list (although you can 
still add species to an existing list). See “Chapter 16: Setting Up Vital Signs/Weight” in the Cornerstone 
Administrator’s Manual for information on setting up your practice’s Vital Sign List. 

To add a set of vital signs for a patient: 

1. Open the Vital Signs window for the patient. (See “Accessing Vital Signs for a Patient” on page 229 
for information.) 

2. Expand the Create new Vital Signs set column (right column) by doing one of the following: 

• Double-click on any vital sign in the Create new… column. 

• Tab into the Create new… column. With the focus on the desired cell, press ENTER or 
SPACEBAR. 

• Right-click in the Create new… column and select Create a new set. 

Tip: To move through the Create new Vital Signs set column using the mouse, simply click in the 
desired cell/field. To move through the column using the keyboard, tab into a cell to place focus on 
it, and then press ENTER or SPACEBAR to expand the cell. Once expanded, press TAB to move 
from field to field within a cell. 

Note: If you have designated certain list values as defaults, these default values will be selected 
automatically when you click or tab into their associated fields. For this reason, you should review 
each field to ensure a default list value is not mistakenly selected for a patient. 

3. If necessary, you can change the date/time associated with this vital signs set (the Date and Time 
fields default to the server date and time): 

• In the Date field, enter a new date by typing the date or clicking the drop-down arrow to select 
the date from a calendar. Press TAB. 

• In the Time field, type a new time and press TAB. 

Note: The “editable” timeframe for making changes to a vital signs set is based on the server 
date/time when a vital signs set is created, which is not necessarily the date/time entered by the 
staff member. See “Vital Sign Editing Rules” on page 234 for more information. 

4. In the Create new… column entry cells, record vital signs as applicable for this patient.  

• If needed, click the “?” link to view detailed descriptions of available list values. 

• If this is an abnormal entry, use the Normal drop-down list to mark this vital sign as High, Low 
or Abnormal. 

• To add a comment about the entry (e.g., Panting, In pain, Scared, etc.), type in the enter 
comment text box (maximum 30 characters). 

Tip: For Alphanumeric entries (free-form text entry), note that only a small number of characters will 
display in the column when the vital signs set is viewed later in history, so it is best to type 
abbreviated text that’s meaningful at a glance.  

5. If desired, you can graph a Numeric or Numeric List vital sign by clicking its Graph  button. See 
“Graphing Vital Signs for a Patient” on page 235 for more information. 

6. When you are finished, click OK. A Staff Selection dialog box appears. 
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7. Enter the ID of the staff member entering vital signs for this patient by typing the ID or selecting the 
staff from the drop-down list. Click OK. The vital signs set is saved for the patient. 

8. After vital signs have been saved for a patient (at this workstation or elsewhere in the practice), you 
can click Refresh as needed to ensure you are viewing the most recent data for the patient. 

9. To exit the Vital Signs window, click the Close  button in the upper-right corner of the window. 

Vital Sign Editing Rules 
When editing an existing vital signs set, the key timeframes to remember are 24 hours and 10 days: 

• If the vital signs set was created within the last 24 hours, you are allowed to add values to blank vital 
signs and to edit existing entries (occupied cells) within the set.  

• If the vital signs set is older than 24 hours but created within the last 10 days, you may only add 
values to blank vital signs. No editing of existing entries is allowed. 

• If the vital signs set was created over 10 days ago, no entries or edits are allowed. (Note: If the vital 
signs set is invalid, it can be voided. See “Voiding a Vital Signs Set” on page 235 for information.) 

IMPORTANT: The “editable” timeframe is based on the server date/time when a vital signs set is 
created, which is not necessarily the date/time entered by the staff member.  

TASK 

Within 24 hours 
of initial vital 
signs set 
creation 

More than 24 
hours after initial 
vital signs set 
creation 

Within 10 days 
of initial vital 
signs set 
creation 

More than 10 
days after initial 
vital signs set 
creation 

Add a new vital sign entry (blank 
cell) within an existing set 

 
Yes Yes Yes Not allowed 

Edit a vital sign entry (occupied 
cell) within an existing set 

 
Yes Not allowed Not allowed Not allowed 

 

Notes: 

• Separate security permissions must be granted for each level of vital signs adding/editing. 

• You cannot add or edit entries for a vital sign if it is inactive. 

• In the most recent set of vital signs, blank entry cells that are still within the 24-hour adding/editing 
timeframe appear with a light yellow background. 

• If a patient already has a set of vital signs for today and you elect to create another set, Cornerstone 
verifies that you really want to create another set (versus edit the existing set). This is a common 
scenario if your practice work flow is to record the weight in reception (requiring you to create a set) 
and then record other vital signs later in the exam room. Note that after two sets have been added 
for a patient in one day, the verification message will not continue to appear for that patient. 

To expand an existing vital signs set for editing:  

 Do one of the following: 

• Double-click in the entry cell you want to add a value to or edit. 

• Tab into the entry cell you want to add a value to or edit, and then press ENTER or SPACEBAR. 

• Right-click in the vital signs set (column) and select Update. 
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Graphing Vital Signs for a Patient 
You can graph a patient’s historic and current vital sign data for one vital sign at a time for Numeric and 
Numeric List vital signs. Graphs can be printed and provided to clients as a helpful visual to show weight 
trends or other changes in their pet’s health over time. 

 
Vital signs graph 

The graph displays data from up to 10 of the most recent vital signs sets. The Numeric or Numeric List 
values display on the left axis. If applicable, associated descriptions are provided in a legend across the 
bottom. 

To graph a Numeric or Numeric List vital sign for a patient: 

1. Do one of the following: 

• With the patient’s information shown on the Vital Signs window, in the Vital Signs column (left 
column), click the Graph  button for the desired vital sign. 

• With the patient’s information shown on the Patient Clipboard Vital Signs tab, click the Graph 
 button in the desired vital sign’s column header. 

2. Click Back/Next to move through the patient’s vital sign history, showing up to 10 sets at a time. 

3. If you want to print the currently displayed graph, click Print, select your desired page setup 
settings, and then click OK. 

4. When you are finished, click Close. 

Voiding a Vital Signs Set 
If necessary, a staff member with appropriate security permissions can void a vital signs set. Voiding 
may be necessary, for example, if vital signs are accidentally entered for the wrong patient. 

Note: When you void a vital signs set, you void the entire set; you cannot void a specific entry or value. 
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To void a vital signs set: 

1. Do one of the following: 

• With the patient’s information shown on the Vital Signs window, right-click within the desired vital 
signs set and select Void. 

• With the patient’s information shown on the Patient Clipboard, right-click on the desired vital 
signs line in the Summary, Text or Vital Signs tab and select Void. 

2. On the Void Vital Sign Set window, enter the staff ID and reason for the void. 

3. Click OK. 

About the Vital Signs Selection Window 
The Vital Signs selection window allows you to select vital signs information to include in a patient 
document (medical note or correspondence) or on a Pet Health Report Card created using Physical 
Exam/Patient Advisor* Exam.  

 
Vital Signs selection window 

The Vital Signs selection window includes the following fields and options:  

Field/Option Description 

Select all signs check box When selected, all vital signs are selected for inclusion in the patient 
document or observation text. 

Select individual vital signs 
check boxes (on left side) 

Click the check box next to each vital sign to include in the patient 
document or observation text. 

Select vital signs sets  
check boxes (in column 
headers) 

Click the check box associated with each vital signs set to include in the 
patient document or observation text. 

For more information on including vital signs information in a patient document, see “Inserting Vital Signs 
Information” on page 254.  

For more information on including vital signs information on Pet Health Report Cards created using 
Physical Exam/Patient Advisor* Exam, see “Inserting Vital Signs Information Within an Observation” on 
page 225. 

Select all 
vital signs 

Select 
individual 
vital signs 

Select vital signs sets 
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This chapter covers daily usage tasks for adding a medical note to a patient record or printing a 
correspondence document. For information on the steps required to set up medical note templates and 
correspondence templates in Cornerstone, see “Chapter 17: Setting Up Medical Notes and 
Correspondence” in the Cornerstone Administrator’s Manual. 

 

Overview 
Starting with Cornerstone* version 8.0, both medical notes and correspondence documents are created 
in the Cornerstone Editor. The Cornerstone Editor is used both at the time of setup (when you create or 
update a document template) and at the time of use (when you add a medical note or correspondence 
document to a patient record). 

Note: The medical notes functionality available in Cornerstone version 7.6 and below is now referred to 
in Cornerstone as “Classic medical notes.” See “Chapter 18: Using Classic Medical Notes” beginning 
on page 282 for information. 

IMPORTANT: You must use the Classic medical note template for surgery/anesthesia logs. Enhanced 
medical notes do not support this feature at this time. See “Using Classic Medical Notes for 
Surgery/Anesthesia Logs” on page 285 for information on using this template.  

Before You Begin 

• Set Documents defaults (Controls > Defaults > Practice and Workstation > select Documents 
from the menu on the left). 

• Set up document template categories (Lists > Documents > Template Categories). 

• Set up the problem categories and problem list to be used in your practice (Controls >Problems > 
Categories or Controls > Problems > Problems List). 

• Set up the diagnostic codes to be used in your practice (Lists > Diagnostic Codes). 

• Set up medical note and correspondence document templates. For information on setting up the 
document templates, see “Chapter 17: Setting Up Medical Notes and Correspondence” in the 
Cornerstone Administrator’s Manual. 

• (Optional) Set up a signature capture device (Tools > Signature Capture Device). 
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The Cornerstone Editor – Medical Note/Correspondence Window 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cornerstone Editor – Medical Note/Correspondence window 

Note: When adding a text-only document (versus an enhanced format document), the menus, toolbar 
buttons and right-click menus available in the Cornerstone Editor are limited to those options that pertain 
to text-based data entry. Throughout this section, those features not available in text-only mode will be 
marked with an "(Enhanced documents only)" designation. 

Title Bar 

 

The Title Bar displays an at-a-glance summary of the client, patient and document information in this 
order:  
Client Last Name - Patient Name - (Patient ID) - Document Title - Species - Weight - Sex - Age – Breed 

Client Banner 

 

The Client Banner displays client name(s), phone number and account information. Simply double-click 
within the banner to update the client information.  

Patient Banner 

 

The Patient Banner provides at-a-glance access to patient information including name, ID, weight, body 
score (if activated), species, breed, age and sex. A pet picture is also displayed, if available. Simply 
double-click within the banner to update the patient information.  

To display the weight entry dialog box for the patient, click the Vital Signs/Weight  button. Here you 
can enter a current weight and, if desired, click the add more Vital signs link to open the full Vital Signs 
entry and viewing window. 

Status options Client Banner 

Document Banner 

Editor pane 

Invoice Items and 
Attachments pane 

Patient Banner 

Splitter Bar 

Full Size or 
Normal View 

Menu Bar 
Editor Toolbar 

Tool Bars 

Title Bar 
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Update Patient Weight 

The Ask for weight if the last entry is older than __ days field in Documents defaults determines 
whether staff are prompted to enter the patient’s weight upon starting or opening a medical note. 
Cornerstone will compare this default setting to the date of the most recent weight recorded for the 
patient in Cornerstone. If the date of the weight is older than the specified number of days, the weight 
appears in red in the Patient Banner, and the weight entry dialog box appears to allow the staff member 
to enter a current weight for the patient.  

 

Note: You can click the Vital Signs/Weight  button in the Patient Banner at any time to update the 

patient’s weight and other vital signs, if applicable. Note that the button displays in red/yellow  as an 
alert if at least one vital sign (other than weight and body score) has not been entered for the patient 
within the past 10 days. 

Document Banner 

 

The Document Banner displays the staff ID, staff name, template name, history description, document 
date, autofinalize option and alert option to highlight this document in history. 

Tip: Many of the properties that display in the Document Banner can be set as defaults in the Template 
Properties dialog box when you initially set up the document template. See “Chapter 17: Setting Up 
Medical Notes and Correspondence” in the Cornerstone Administrator’s Manual. 

Editor Menu Bar 

 

The Editor menu bar includes the File, Edit, View, Insert, Font, Paragraph, Table and Other menus. (The 
menu bar is located within the Cornerstone Editor window, separate from the main Cornerstone menus.) 

Note: The Paragraph and Table menus are available only in enhanced templates/documents (not text-
only templates/documents). 

Editor Toolbar 

The Editor toolbar buttons provide quick access to commonly used functions within the Cornerstone 
Editor. (The Editor toolbar is located within the Cornerstone Editor window, separate from the main 
Cornerstone toolbar.) 
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 Print preview  Copy  Table 

 Print  Paste  Spell check 

 Client signature†  Select all  Zoom 

 Undo  Search  Insert date and time 

 Redo  Bookmark  Lock/Unlock document 

 Cut  Picture   

† Available only at the time of use. 

Note: When using the Cornerstone Editor in text-only mode, the toolbar buttons available are limited to 

those options that pertain to text-based data entry. Text-only mode also offers a Color All Text  
button that allows you to apply a single color to all text in the template or document. 

Toolbars 

(Enhanced documents only) 

The tool bars include options for frequently used document elements, display settings, style settings and 
formatting tools. The Tool Bar display can be turned on/off using the View menu > Tool Bars option. 

 
Insert date/time, page number or number of pages, 
and show/hide nonprinting characters such as 
returns, tabs and spaces 

 
Specify the magnification level for viewing the current 
document 

 
Set the paragraph style, font, font size and effect of 
selected text (bold, italics, underline) 

 
Set the justification of the paragraph (align left, center, 
align right, justify) 

 
Format selected text as a numbered/bulleted list, 
increase/decrease the indent, and set the text color 

 

Status Options 

Using the drop-down list in the upper right corner of the Cornerstone Editor, you can set the status of 
medical notes and correspondence documents to Draft, Tentative or Final.  

Note: The status options are not available for Print Only documents or Correspondence – Title Only 
documents. 

• Draft – Draft status is intended for saving work in progress when you are interrupted by a phone call 
or an emergency and your notes are not verified, finished, or perhaps are not even correct at this 
point. A Draft status document will never autofinalize. Draft status saves any invoice items in their 
current state without sending anything to the Patient Visit List (PVL). When saving as Draft, the Apply 
to PVL check box is not selected by default, but can be selected if desired. 

Documents with a status of Draft are watermarked with large “DRAFT” text on each page when 
printed. The watermark does not appear within the Cornerstone Editor while working in the 
document (it is visible only on the printout). 
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• Tentative – With the Tentative status, the document is basically complete, but is still changeable if 
something else comes up (similar to tentative medical notes in previous versions). When saving as 
Tentative, the Apply to PVL check box is preselected and cannot be cleared. 

• Final – When a document is saved as Final, no further edits can be made to the document. If 
additional information becomes available after a document is finalized, the information must be 
added in an Addendum. When saving as Final, the Apply to PVL check box is preselected and 
cannot be cleared. 

Note: If you set a document’s status to Final and then click Save, the Cornerstone Editor saves the 
document and closes it automatically (no further editing is allowed after clicking Save). 

Full Size View/Normal View Button 

You can click the Full Size View button to increase the size of the Editor pane work area by “hiding” the 
properties banners (top of the window) and the Invoice Items and Attachments pane (bottom of the 
window). To bring these window elements back into view, click Normal View. 

Editor Pane 

The Editor pane is the document “page” where you fill in the template and add necessary text, pictures 
and other patient-specific data. You can add elements to the Editor pane area using the menu bar, 
Editor toolbar or right-click menu. 

Splitter Bar 

You can drag the adjustable Splitter Bar up or down to increase or decrease the visible area of the Editor 
pane and Invoice Items and Attachments pane. While adding a medical note or correspondence 
document, in most cases you want the Splitter Bar at a lower position, so that more editing space is 
available in the Editor pane. If you need to work in the Invoice Items tab, simply drag the Splitter Bar 
upward as needed to increase the working area of the Invoice Items tab while you are inserting or 
editing invoice items. 

Invoice Items and Attachments Pane – Invoice Items Tab 

The Invoice Items and Attachments pane is available at the bottom of the Cornerstone Editor window at 
the time of use, when adding a medical note or correspondence document. This pane includes an 
Invoice Items tab that works similarly to the Patient Visit List, and includes “invoice item audit” 
functionality that will search the Patient Visit List, and open invoice and patient orders to allow 
corrections in those places. 

 

Note: The Invoice Items and Attachments pane does not display for Print Only documents. 

You can easily add/change/remove invoice items using the Invoice Items tab. In the Cornerstone Editor, 
all invoice items are placed in the Invoice Items tab, and they are not included in the body text of the 
document. 

IMPORTANT: Invoice items cannot be placed on a document designated as a special action that prints 
after an invoice is posted. 
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To add invoice items to a document: 

1. To add an invoice item, double-click or press F2 in any blank Item ID row to open the Invoice Item 
list, allowing you to search for and select the desired item.  

A blank “Add Item” row always appears below the added item rows.  

2. Set the item status by clicking on the gray box to the left of each item row. Item status options at the 
time of document use include:  

  Blank – An item assigned a Blank status can be thought of as “sitting dormant” until you 
decide to utilize it, which means it will not be sent to the Patient Visit List. In some cases, you may 
want to add items to the template with a Blank status and let the staff member decide at the time of 
use whether to change the status. 

  Recommended – This item or service has been recommended for purchase by the client. 

  Accepted – The client has accepted the item (wants to purchase the service or item). 

  Performed – The item has been dispensed or the service has been performed. 

  Declined – The item has been declined by the client. 

  Declined to history – The item has been declined by the client and you want to add the 
declined information to medical history. 

Notes on adding invoice items to a document: 

• Items never leave the document regardless of the status, even after the document is finalized. If you 
do not want the unused invoice items to remain in the finalized medical note or correspondence 
document, you must use CTRL+D to delete these invoice item lines before finalizing. 

• For Group items and Pick items, if the status is set to Blank in the template, at the time of use (when 
adding a medical note) these do not expand/ask unless you change the status. If the status is set 
up as Recommended, Accepted or Performed in the template, the items will expand/ask right when 
you start the document. 

• The Cornerstone Editor’s print options allow you to specify whether or not to print the document’s 
invoice items, and if so, whether or not to include the Amount and Staff information for each item. In 
addition, you can specify whether to print declined or unapplied items. See “Printing a Document 
from the Cornerstone Editor” on page 262 for more information. 

Green Shaded Lines Indicate that Items have been Sent to the Patient Visit List 

If invoice items in a document are applied to the Patient Visit List, when the document is saved, these 
invoice item lines are displayed with green shading. This green shading allows you to identify at a glance 
which items have been sent to the PVL. See “Status Options” on page 240 for information on how items 
are applied to the PVL when saving a document. 

 
Invoice items already sent to the PVL display with green shading 
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Resolving Changes After Applying to PVL 

The Cornerstone Editor features an invoice item auditing capability that does a “sweep” of the PVL, open 
invoices and patient orders to allow corrections in those places. This invoice item audit is managed 
using the Changed Line Status column (right-most column) on the Invoice Items tab.  

 
Changed Line Status column on the Invoice Items tab 

The blank buttons in this column change state only if you make a change to an invoice item that was 
previously sent to the PVL (indicated by the item lines shaded in green). If a green line is changed in any 
way (including changing the status to/from Performed), a red  button appears in the Changed Line 
Status column to warn you that the item was changed after it was sent to the PVL. If an item appears in 
one or more additional places (PVL, invoice and patient orders), the Changed Line Status button for that 
item will change to warn you of this potential issue. 

To resolve the Changed Line Status warning: 

If the Changed Line Status for an item shows a red  button, click the button. An invoice item audit 
dialog box appears, and the red  button immediately changes to a yellow  button to indicate that 
the changed line status has been recognized (and may or may not be resolved). 

Note that if you need to make several changes to different item lines, you can make all the corrections to 
the PVL, for example, by clicking on one line. However, the other lines will remain with red buttons and 
you will be warned when you try to exit. 

 

If you do nothing with the Changed Line Status warnings and then later try to save the document, a 
message appears to remind you again that you have changed items on this document that also appear 
in other places. 

 

If you click Yes in response to the message, the document is not saved and you are given the 
opportunity to click on the Changed Line Status buttons and resolve any existing issues before saving. If 
you click No, the document is saved and the invoice item audit is not performed.  

Note: Regardless of whether you resolved item issues or not, when you save a document, the next time 
it is opened the Change Line Status buttons are cleared and appear blank. 

Cornerstone User’s Manual                  243 



Chapter 17: Using Medical Notes and Correspondence 

Deleting Items from the Invoice Items tab 

To delete an invoice item that has NOT been sent to the PVL: 

 Click on the item line and press CTRL+D.  

To delete an invoice item that has already been sent to the PVL: 

 Click on the item line and press CTRL+D. A message appears to warn you that this item has 
already been sent to the PVL and if you delete it from the document, you must still manually delete it 
from other locations. 

 

As an added reminder of the deleted item, the item is not cleared completely from the Invoice Items 
tab, but is instead displayed with strikethrough formatting applied so you can tell at a glance which 
items were removed from the items list. 

 
Deleted invoiced items that have already been sent to the PVL display with strikethrough formatting applied 

Invoice Items and Attachments Pane – Attachments Tab 

The Invoice Items and Attachments pane includes an Attachments tab that allows you to easily attach a 
file or web page link when adding a medical note or correspondence document in the Cornerstone 
Editor. 

 

Note: The Invoice Items and Attachments pane does not display for Print Only documents. 

Examples of file types that can be attached include Microsoft® Word documents (.doc), Microsoft® 
Excel® spreadsheet files (.xls), Adobe® Reader® documents (.pdf), and .wav audio files. 

To add an attachment to a document: 

1. With the document open in the Cornerstone Editor, click on the Attachments tab near the bottom of 
the window. 

2. To attach a file, right-click and select New File. 

3. To attach a web page address, right-click and select New URL. If you select New URL, your default 
web browser will open. Locate the web page you want to attach and copy the address. Return to 
Cornerstone and right-click on the Attachments tab again. Select Paste URL. 
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Tip: Attachments can be viewed in patient history. A paper clip indicates which medical notes or 
correspondence documents have attachments. (To view the attached files, you must have the software 
that created the files on your workstation. To view web pages, you must have access to the Internet.) 
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Document Use Tools 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Cornerstone Editor – Document Use Tools 

Note: When adding a text-only document (versus an enhanced format document), the menus, toolbar 
buttons and right-click menus available in the Cornerstone Editor are limited to those options that pertain 
to text-based data entry. Throughout this section, those features not available in text-only mode will be 
marked with an "(Enhanced documents only)" designation.  

Locking/Unlocking a Document 

The Lock/Unlock document  button allows staff to use the document as a simple tab-through form 
to quickly insert patient data in tab-ordered fields or accept default data with no additional text entry or 
document editing required. 

If you are adding a document based on a template that contains Text Input Fields or check boxes, you 
can use the document in “Locked mode” to easily tab from field to field to fill in the patient-specific data 
or accept the default data.  

Lock/Unlock Document 

Add Problem 

Add Diagnosis 

Pictures and 
Graphics 

Text Input 
Fields 

Check Boxes 

Add Vital Signs 
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The template may be preset to Locked mode when it is opened. If not, you can easily switch in and out 
of Locked mode by clicking the Lock/Unlock document button. You can tell whether or not a document 
is locked by looking at the state of the button: 

 Document is locked 

 Document is unlocked 

Answering Text Input Field Prompts 

If your document contains Text Input Fields (must be added in the template at the time of setup), you 
can set the document to Locked mode and then simply tab through the fields and “answer” them at the 
time the medical note or correspondence document is added for a patient.  

All Text Input Fields display with a light gray background so they are easily identified at a glance within 
the document. 

 
Text Input Fields within a medical note 

Tips for entering data in Text Input Fields: 

• The document must be in Locked mode in order to tab from field to field. (See the previous 
“Locking/Unlocking a Document” section.) 

• You must click within the first Text Input Field (distinguishable by its light gray background) before 
you can start tabbing through the document. 

• Note that some fields may be limited in the number of characters allowed (the maximum number of 
characters to accept in a field is set up in the template). 

• If the field already displays the correct answer, you can simply press TAB to accept the default data 
and move to the next field. 

• When tabbing through a locked form, to go back to a previous Text Input Field, press SHIFT+TAB. 

• To insert a new line within a Text Input Field, press SHIFT+ENTER. 

• If a form field answer is a choice between two or three possible answers, the template may have 
been set up with all possible answers as the Initial Data. In this case, you can simply leave the 
chosen answer and delete the unwanted text. 

Completing Check Boxes 

(Enhanced documents only) 

You can easily complete check boxes in a document—click once to place a check mark in the box, click 
again to clear the check mark. The document must be in Locked mode in order to tab from box to box. 
(See the “Locking/Unlocking a Document” section on page 246.) 
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Using Text and Paragraph Formatting Options 

(Enhanced documents only) 

Many text formatting and alignment options are available in the Cornerstone Editor’s Font and 
Paragraph menus. 

Create your text using standard text style and formatting options including bold, underline and italic. In 
addition, options are available for superscript, subscript, text background color and underline color.  

 

 

 
Font and Paragraph menu options in the Cornerstone Editor 

Adding Pictures and Graphics 

(Enhanced documents only) 

You can insert images and graphics as needed to add visual detail in a medical note or enhance a 
correspondence document. Supported image file types include BMP, JPEG, JPEG 2000 and TIFF. In 
most cases, we recommend using a compressed graphic file type like JPEG (vs. bitmap files which 
require more file space for saving). In addition, if you are bringing in standard photos from a digital 
camera, you may want to set your default photo size to a lower resolution (2-3 megapixels). 

Note: To include a DICOM® or RAW file, you will need to do this using an Imaging bookmark. 

After inserting an image, you can double-click on the image to edit it and make annotations using the 
Cornerstone Image Viewer tools. (See “The Image Viewer Toolbar” on page 363 for more information.) 

Note: You can copy and paste an image into a document using standard copy (CTRL+C) and paste 
(CTRL+V) commands. However, if you plan to edit the image or make annotations to an image later, 
you must insert the image using the Insert > Picture method. You will not be able to double-click on an 
image to open it for editing if the image was pasted into the editor. 

In addition to the standard Picture  option, a Picture and Description option is also available. The 
Picture and Description option allows you to insert a predefined two-cell table with a placeholder for the 
image in the cell on the left and a placeholder for the associated text in the cell on the right. This makes 
it easy to include description text about an image without having to worry about text wrapping issues or 
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formatting. This Picture and Description object can be predefined in the document as the template is set 
up or can be inserted at the time of use. 

 
Picture and Description object 

Note: When working within a Picture and Description table, the right-click options available are specific 
to table-related tasks. To insert elements or apply formatting within a cell, you must use the menus or 
toolbar buttons. 

To insert a picture: 

1. Right-click within the editor pane and select Insert > Picture. Alternatively, you can click the Picture 

 button on the editor toolbar. The Open dialog box appears. 

2. Select the desired image file and click Open. The image is inserted at the current cursor location. 

To insert a picture and description: 

1. Right-click within the editor pane and select Insert > Picture and Description. The Open dialog 
box appears. 

2. Select the desired image file and click Open. A two-cell table is inserted at the cursor location with 
the selected picture in the cell on the left. 

3. Select the placeholder text in the cell on the right and replace it with your description text that 
applies to the picture. 

To resize a picture: 

1. To quickly resize a picture while keeping the aspect ratio of the height and width the same, click on 
one of the four corner object handles (so the arrow cursor is diagonal). 

2. Drag to the desired size. 

To edit a picture or make annotations to a picture (available only at time of use): 

Note: Any edits or annotations you make to a picture within a document are associated only with that 
document and will not be reflected outside of the document (will not change the original picture saved in 
the patient record).  

1. Double-click on the inserted image (not a pasted image) that you want to edit. The image opens in 
the Image Viewer. 

2. Use the Image Viewer tools to make annotations and edit the image as desired. 

3. When finished, click .  

4. Click Yes to save changes. The Image Viewer closes and the edited image is displayed. 
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Inserting a Problem Description or Problem Details 

Problems can be inserted in two different formats within a document using the Problem description 
and Problem details options. 

• Problem description inserts the problem description text into the body of your text or paragraph. If 
multiple problem descriptions are selected, they display separated by commas (example shown 
below). In most cases, this is the format you would want to use within a document, inserting the 
problem text within the text of a predefined paragraph. 

Example: 

Abdominal Enlargement, Abdominal Pain 

• Problem details inserts a “detail block” table that includes all information associated with the 
problem (Description, Severity, State, Staff, Date, Modified Date). If multiple problem details are 
selected, they display as separate rows in the detail block (example shown below). This format is 
typically used for inserting at the end of a medical note, or for a document being sent to a referring 
doctor. 

Example: 

 

Note: Problem description is the only available format when adding a text-only document (versus an 
enhanced document). 

To insert Problem description text/Problem details text within an enhanced document: 

1. To access the Problems dialog box to specify the patient problems, do one of the following: 

• If the template you are using already includes an Add Problem Description or 
Add Problem Details link, click the link. 

• If you want to insert a new Problem Description or Problem Details in the document, place your 
cursor in the desired location, right-click and select Insert Problem Description (or Insert 
Problem Details). 

The Problems dialog box appears. Any problems that have previously been entered for this patient 
are displayed.  
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Problems dialog box 

Note: If you cancel out of the Problems dialog box, any previously displayed link will no longer appear. 
To access the Problems dialog box again without using a link, right-click and select Insert Problem 
Description or Insert Problem Details. 

2. To add a new problem: 

a. Under Problem, type the ID of the problem to add or press F2 to select from your practice’s 
problem list. 

b. Change the severity and state as needed. 

c. Enter your staff ID under Create Staff. 

3. With the Add to Document box selected for each problem you want to add to the document, click 
OK. 

The problem description/problem details are added to the document. If multiple problem 
descriptions are added, they display separated by commas. If multiple problem details are added, 
they display as separate rows in a detail block (similar to a table). 

To insert Problem description text within a text-only document: 

1. With the text-only document open in the Cornerstone Editor, place your cursor in the desired 
location, right-click and select Insert Problem Description. Alternatively, on the Insert menu, select 
Problem Description. 

The Problems dialog box appears. Any problems that have previously been entered for this patient 
are displayed.  

2. To add a new problem: 

a. Under Problem, type the ID of the problem to add or press F2 to select from your practice’s 
problem list. 

b. Change the severity and state as needed. 

c. Enter your staff ID under Create Staff. 

3. With the Add to Document box selected for each problem you want to add to the document, click 
OK. 

The problem description is added to the document. If multiple problem descriptions are added, they 
display separated by commas. 
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Inserting a Diagnosis Description or Diagnosis Details 

Diagnoses can be inserted in two different formats within a document using the Diagnosis description 
and Diagnosis details options. 

• Diagnosis description inserts the diagnosis description text as it is defined in Cornerstone. If 
multiple diagnosis descriptions are selected, they display separated by commas (example shown 
below). In most cases, this is the format you would want to add to a document. 

Example: 

Gastric Dilatation and Volvulus, Gastritis: Acute 

• Diagnosis details inserts a “detail block” table that includes all information associated with the 
diagnosis (Code, Diagnosis, Date, Status, Staff). If multiple diagnosis details are selected, they 
display as separate rows in a diagnosis details table (example shown below). This format is typically 
used for sending documents to a referring doctor. 

Example: 

 

Note: Diagnosis description is the only available format when adding a text-only document (versus an 
enhanced document). 

To insert Diagnosis description text/Diagnosis details within an enhanced document: 

1. To access the Patient Diagnosis dialog box to specify the patient diagnoses, do one of the 
following: 

• If the template you are using already includes an Add Diagnosis Description or 
Add Diagnosis Details link, click the link. 

• If you want to insert a new Diagnosis Description or Diagnosis Details entry in the document, 
place your cursor in the desired location, right-click and select Insert Diagnosis Description (or 
Insert Diagnosis Details). 

The Patient Diagnosis dialog box appears. Any diagnoses that have previously been entered for this 
patient are displayed.  
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Patient Diagnosis dialog box 

Note: If you cancel out of the Patient Diagnosis dialog box, any previously displayed link will no 
longer appear. To access the Patient Diagnosis dialog box again without using a link, right-click and 
select Insert Diagnosis Description or Insert Diagnosis Details. 

2. To add a new diagnosis: 

a. Under Code, type the diagnostic code or press F2 to select from your practice’s diagnostic 
codes list. 

b. Change the date and status as needed. 

c. Under Staff, type the staff ID of the person making the diagnosis. 

3. With the Add to Document box selected for each diagnosis you want to add to the document, click 
OK. 

The diagnosis description/diagnosis details are added to the document.  

To insert Diagnosis description text within a text-only document: 

1. With the text-only document open in the Cornerstone Editor, place your cursor in the desired 
location, right-click and select Insert Diagnosis Description. Alternatively, on the Insert menu, 
select Diagnosis Description. 

The Patient Diagnosis dialog box appears. Any diagnoses that have previously been entered for this 
patient are displayed.  

2. To add a new diagnosis: 

a. Under Code, type the diagnostic code or press F2 to select from your practice’s diagnostic 
codes list. 

b. Change the date and status as needed. 

c. Under Staff, type the staff ID of the person making the diagnosis. 

3. With the Add to Document box selected for each diagnosis you want to add to the document, click 
OK. 

The diagnosis description is added to the document. If multiple diagnosis descriptions are added, 
they display separated by commas. 
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Inserting Vital Signs Information 

(Enhanced documents only) 

You can insert a patient’s vital signs information in a simple table format anywhere within a patient 
document. For example: 

 

To insert a table of vital signs information in a document: 

1. Do one of the following: 

• If the template you are using already includes an Add vital signs link, click the link. 

• If you want to insert a new table of vital signs in the document, click to place your cursor in the 
desired location, and then right-click and select Insert Vital Signs. 

The Vital Signs selection window appears. (See “About the Vital Signs Selection Window” on page 
236 for information.) 

 
Vital Signs selection window 

2. If desired, add a new vital signs set and/or make changes to an existing set (if still within the allowed 
timeframe for editing). When finished with any additions or edits, click OK to save your changes and 
then enter or select the staff ID. 

3. In the Vital Signs column (left column), click the check box next to each vital sign to include in the 
document. To quickly select all vital signs for inclusion, click the select all signs check box. 

4. In the date/time/staff column headers, select the check box for each vital signs set to include in the 
document. (Cornerstone automatically selects check boxes for the most recent five sets entered 
since the time of the patient’s last check in. If you add a new set in this window, it will include the 
new set in addition to the five most recent sets.)  

5. When you have finished selecting the vital signs to include in the document, click OK. 
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The selected vital signs are added to the document in a table format, along with the date/time the 
vital signs set was created. For a standard page size in portrait orientation, five vital signs sets will fit 
across the page. Rows will be added to the bottom of the table if needed for additional sets. 

Inserting the Patient Weight 

(Enhanced documents only) 

You can easily insert the patient weight into the body of a document.  

To insert the patient weight within a document: 

1. When adding a medical note or correspondence document for a patient, right-click within the editor 
pane and select Insert > Patient Weight. Alternatively, on the Insert menu, select Patient Weight.  

The Weight entry box appears. 

 
Weight entry box 

2. Do one of the following: 

• If the weight shown in the Patient Banner is current, you can click Cancel to insert that weight 
into the text.  

• If you want to update the weight shown in the Patient Banner, enter the weight in the Weight 
entry dialog box and click OK. 

The weight and date of the weight are inserted at the current cursor location. 

Including a Client/Staff Signature 

(Enhanced documents only) 

In the Cornerstone Editor, using a supported signature capture device or tablet PC, you can include 
client or staff signatures in your documents using signature bookmarks. For information on bookmarks, 
see “Chapter 17: Setting Up Medical Notes and Correspondence” in the Cornerstone Administrator’s 
Manual. 

Note: In order to use electronic signatures in documents, you must first ensure that a supported 
signature capture device (or tablet PC) is configured with Cornerstone and connected to the workstation. 
See “Chapter 1: Getting Started with Cornerstone Setup” in the Cornerstone Administrator’s Manual for 
information on setting up a signature capture device for use with Cornerstone. 

Client Signatures 

If you are using a document that requires a client signature, when you are ready for the client to sign, 

click the Client signature  button or select File >Client Signature in the Cornerstone Editor.  

IMPORTANT: Cornerstone will finalize a document automatically if it is saved with a client signature.  

Note: As of Cornerstone version 8.0, signatures are not allowed in Print Only (formerly called Standard) 
documents or Correspondence (formerly called Referral) documents set to save the Title only. This 
ensures that you have a record of all signed documents for compliance and liability reasons. 
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To have a client sign a document using a signature capture device: 

1. With the applicable document open in the Cornerstone Editor, click the Client signature  
button. 

Note: The Client signature button is available on the Cornerstone Editor toolbar only if there is a 
client signature bookmark in the document. 

A "Please sign document" message box appears. 

2. Instruct the client to sign on the signature capture device. 

3. If necessary, you can click Clear to clear the signature from the box and redo the signature. 

4. After the client signs, click OK to insert the signature in the document. 

Staff Signatures 

For staff signatures, you can set up a Signature or Signature W/Pwd bookmark to prompt for the staff 
signature only or for the staff signature with a password associated with it. A signature (and signature 
password) can be predefined in Cornerstone for each staff member in Lists > Staff > Update > 
Signature tab.  

To include a staff member’s electronic signature in a document: 

1. Open the applicable document in the Cornerstone Editor. 

If a staff Signature or Signature W/Pwd bookmark is included in the document, the Staff Signature 
dialog box appears. 

2. In the Signature drop-down list, select the name of the staff member who will sign the document 
and enter the signature password, if required. The staff member’s signature will appear in the dialog 
box. 

3. If this is the signature you want, click OK and the signature will be inserted into the document. If this 
is not the signature you want, click Clear and select a different signature. 

Additional Cornerstone Editor Tools 

Several additional tools are available both at the time of use and at the time of setup: 

• Page setup and formatting tools 

• Tab stops 

• Bookmarks 

• Tables 

These tools are most often used at the time of setup when creating the document template. For 
information on these tools, see “Chapter 17: Setting Up Medical Notes and Correspondence” in the 
Cornerstone Administrator’s Manual. 

Cornerstone User’s Manual                  256 



Chapter 17: Using Medical Notes and Correspondence 

Keyboard Shortcuts for Use in the Cornerstone Editor 

Perform common tasks within the Cornerstone Editor 

To do this Press 

Move the focus to each command on the window, forward or 
backward, respectively. 

TAB or SHIFT+TAB 

Launch online Help. F1 

Run Spell Check. F7 

Jump to a specified line number. F10 

Undo the last action. CTRL+Z 

Redo the last action. CTRL+Y 

Find text. CTRL+F 

Replace text. CTRL + H 

 

Move around and select contents within the Editor pane 

To do this Press 

Select all. CTRL+A 

Select from the insertion point to the beginning of the line. SHIFT+HOME 

Select from the insertion point to the end of the line. SHIFT+END 

Select from the insertion point to the beginning of the document. SHIFT+PAGE UP 

Select from the insertion point to the end of the document. SHIFT+PAGE DOWN 

Move to the beginning of the line. HOME 

Move to the end of the line. END 

Move to the beginning of the document. CTRL+HOME 

Move to the end of the document. CTRL+END 

 

Perform common editing and formatting tasks within the Editor pane 

To do this Press 

Make letters bold. CTRL+B 

Make letters italic. CTRL+I 

Make letters underlined. CTRL+U 

Copy the selected text or object. CTRL+C 

Cut the selected text or object. CTRL+X 

Paste the selected text or object. CTRL+V 

Insert a line break. SHIFT+ENTER 

Insert a page break. CTRL+ENTER 

 

Perform common tasks within a table 

To do this Press 

Select the next cell’s contents in a table. TAB 

Select the preceding cell’s content in a table. SHIFT+TAB 

Insert tab characters within a cell in a table. CTRL+TAB 
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The Start New Document Window 
The Start New Document window allows you to select a document template and start a new medical 
note or correspondence document.  

The way you access the Start New Document window depends on whether you are adding a medical 
note or correspondence document. 

To open the Start New Document window: 

 If you are adding a medical note, do one of the following:  

• On the Patient Clipboard, right-click on a patient name in the Patient list area and select Medical 
Note or right-click anywhere within the Patient History area tabs and select Medical Note. 

• Click the Medical Notes  toolbar button. 

• On the Activities menu, select Medical Notes. 

 If you are adding correspondence, do one of the following:  

• On the Patient Clipboard, right-click on a patient name in the Patient list area and select 
Correspondence or right-click anywhere within the Patient History area tabs and select 
Correspondence. 

• Click Correspondence  toolbar button.  

• On the Activities menu, select Correspondence. 

 

 

 
Start New Document window 

• When adding a document for a single client-patient, the New client-patient document area allows 
you to quickly tab through and accept pre-populated client ID and patient ID fields. You can also 
double-click or press F2 in each field to select from a list. 

Merge from 
file 

Find Template 
options 

New client-patient 
document 

Template 
list 

Preview 
pane 
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• The Merge from file field allows you to specify the .csv file to use for merging Cornerstone data with 
your document. (You can select the New client-patient document option OR the Merge from file 
option, not both.) 

• The Find Template options allow you to quickly locate the desired template to use for adding a 
medical note or correspondence document. See the “Using the Find Template Options” section that 
follows for more information. 

• The Template list displays a table listing the Title, Category, Type and ID of all templates that match 
the specified search criteria.  

• The Preview pane displays a preview of the highlighted template. This helps you quickly distinguish 
one template from another if two templates have similar names. 

Tip: You can increase the size of the Preview pane area by dragging the bottom edge of the Start 
New Document window and increasing the size of the window. 

Using the Find Template Options 

The Start New Document window (and the Document Template List window) features a set of Find 
Template options that allow you to quickly locate a template.  

 
Find Template options 

• If you know the exact title of the template or if you know the document ID, type it in the Title or ID 
box to display a list of all templates that start with the same title text or that start with a matching 
document ID.  

• If you do not know the exact title but know one or more keywords included in the title, select the 
Search for word check box and type all or part of the word in the Title or ID box to locate all 
templates that include the word in their title.  

• Select the Include inactives check box to include inactive templates in your search. Inactive 
templates will be marked with an "(I)". 

• The Category drop-down list allows you to narrow your template search by listing only those 
templates in a selected category. (To keep them separate from enhanced medical notes, all Classic 
medical note templates are in the *Classic medical note category. This category cannot be changed 
or deleted.) 

• The Favorites drop-down list allows you to narrow your template search by selecting one of the 
following: 

o If you want to display those templates previously designated as favorites, select My Favorites 
or Practice Favorites. 

o If you want to display those templates used most often, select My Most Used or Practice Most 
Used. 

o If you use LifeLearn® documents, in the LifeLearn area you can search for a LifeLearn document 
by keyword, species, topic, and/or system.  
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Note: LifeLearn documents do not display templates because LifeLearn documents are 
Microsoft®  Word documents. 

• The check boxes on the right side of the Find Template area allow you to shorten the list of 
templates to search by listing only those templates that match the selected types (Medical Note, 
Medical Note text only, Correspondence, Correspondence text only, or Print Only). 

Adding a Medical Note or Correspondence Document 
To add a medical note or correspondence document to a patient record, you must first select a template 
to use for the document. The template opens in the Cornerstone Editor, where you can fill in the 
template fields and/or enter information, invoice items or other elements to complete the document for 
the patient.  

Tip: If you simply need to add a quick text-based note to the patient’s record, you may want to use the 
Quick Text method for adding a medical note. See “Adding a Quick Text Medical Note” on page 262. 

To add a medical note or correspondence document: 

1. Do one of the following: 

• For a medical note: On the Patient Clipboard, right-click on a patient name in the Patient list area 
and select Medical Note. 

• For a correspondence document: On the Patient Clipboard, right-click on a patient name in the 
Patient list area and select Correspondence. 

Note: See “The Start New Document Window” on page 258 for information on additional ways to 
access the Start New Document window. 

The Start New Document window appears.  

2. Depending on how you access the Start New Document window, the Client ID, Patient ID and Staff 
ID fields may already be completed for you. Complete these fields as necessary (press F2 or 
double-click to select an ID from a list), and press TAB to proceed to the next field.  

Note: The Patient List appears automatically if there is more than one patient associated with the 
selected client. Select the desired patient and click Select. 

Tip: To set the Staff ID to default to the staff member most likely to be entering medical notes and 
diagnostic codes, specify this Staff ID in the Staff ID for notes/Dx field in Patient defaults. 

3. Use the fields in the Find Template area to locate the desired template. See “Using the Find 
Template Options” on page 259 for information on the Find Template options. 

4. Click on a document template in the list to see a preview of the document in the preview area at the 
bottom of the window. 

5. Once you have located the desired template, select it and click OK (or double-click the template) to 
open it in the Cornerstone Editor. 

6. Depending on the setup for the selected template, you may be prompted to complete one or more 
of the following tasks upon opening: 

• If the patient weight is not considered current (based on the Ask for weight… setting in 
Documents defaults), the last entered weight appears in red. If you are adding a medical note, a 
weight entry dialog box appears automatically, allowing you to update the weight for this patient.  

• If there are any Question/Answer bookmarks included in the template, the associated pop-up 
boxes display. 
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• If there are any Pick items included in the template with a status other than Blank, you are 
prompted to pick the applicable items. 

• If there are any Group items included in the template with a status other than Blank, the Group 
will be applied and any associated pop-up boxes display. 

7. Check that the information displayed in the Client Banner and Patient Banner looks correct. If 
changes are necessary, double-click within the appropriate banner to update the information.  

8. In the Hx description field, if desired, modify the description of this document to appear in the 
patient’s history. (Note that if an Hx description is not entered at the time of use, and then only the 
template name is shown in history.) 

9. If you want this document to stand out in history (line displays in history as white text on a bright red 
background), select the Alert check box. 

10. If you want this document to be automatically finalized, click the Autofinalize in check box and enter 
the number of days after which this template will be marked as final. (Note: A document saved with 
Draft status will never autofinalize.) 

Tip: A default autofinalize setting can be specified in Documents defaults (select Controls > 
Defaults > Practice and Workstation, and then select Documents from the menu on the left). 

11. If you want to increase the size of the editor pane to see more of the current document on screen 
without scrolling, click the Full Size View button. This will temporarily hide the properties banners 
(top of the window) and the Invoice Items and Attachments pane (bottom of the window). To bring 
these window elements back into view, click Normal View. 

Tip: You can also use the Zoom (100%) drop-down list to select or enter a lower magnification level 
(like 75%) that allows you to increase the amount of the page you can see on screen. 

12. Depending on the type of template that this document is based on, there are several different 
options you may choose to enter information, pictures, invoice items, etc.: 

• If it is a tab-through form document that contains Text Input Fields, make sure the Lock feature 

is enabled (use the Lock/Unlock document  button on the toolbar) so you can tab through 
the entry fields.  

• Add text, pictures, invoice items and other elements using the desired Cornerstone Editor 
options. See “The Cornerstone Editor – Medical Note/Correspondence Window” on page 238 
and “Document Use Tools” on page 246 for information.  

13. When you are finished and ready to save the document, click the drop-down list in the upper-right 
corner of the window and select a status setting for the document (Draft, Tentative or Final). See 
“Status Options” on page 240 for more information. 

14. Do one of the following: 

• Click OK to save a Draft, Tentative or Final document and close the Cornerstone Editor. 

• Click Save to save the document and continue working on a Draft or Tentative document in the 
Cornerstone Editor (Final documents will save and close). 

• Click Cancel to cancel document changes and close a Draft, Tentative or Final document. 

Note: If the Hx description is blank when the text-only document is saved for the first time, if there is text 
in the first line of the document, that text will be used as the history description. 
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 Patient documents are included in the Patient History Report as well as the Check-In Report. (See 
“Patient History Report” on page 77 or “Check-In Report” on page 126.) 

Adding a Quick Text Medical Note 
The Medical Note Quick Text feature offers a simpler, faster option for adding text-based notes to a 
patient’s medical record (similar to the “None” Classic medical note template available in Cornerstone 
7.6 and earlier versions).  

For information on text-only medical note features and how they differ from enhanced medical notes, 
see “Chapter 17: Setting Up Medical Notes and Correspondence” in the Cornerstone Administrator’s 
Manual. 

Tip: You can get started immediately with no setup required by using the default Medical Note Quick 
Text template (the “Sample- Quick Text Blank” template). If you don’t want to use the blank default 
template, you can create your own text-only template (in Lists > Documents > Templates) and then 
assign your template as the “Medical Note Quick Text document” in Documents defaults. 

To add a Quick Text medical note for a patient: 

1. With the patient’s record open on the Patient Clipboard, right-click the patient’s name and select 
Medical Note Quick Text. 

2. Enter your staff ID by typing the ID, selecting the staff from drop-down list, or pressing F2 to select 
from the Staff List. 

3. Follow steps 6–14 in the previous section to create the medical note in the Cornerstone Editor (in 
text-only mode). 

Printing a Document from the Cornerstone Editor 
The Cornerstone Editor’s Print Options dialog box offers standard options for selecting the printer, print 
range, number of copies, etc. In addition, you can specify whether or not to print the document’s invoice 
items, header, document information and footer.  

 
Print Options dialog box 

Printing Invoice Items 

In the Invoice items area, the Print invoice items options allow you to specify whether or not to print the 
document’s invoice items. These options can be specified at the time of printing or you can predefine 
your preferences in the Documents defaults (select Controls > Defaults > Practice and Workstation, 
and then select Documents from the menu on the left). 
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Note: Only those items that have been sent to the Patient Visit List (and have not been subsequently 
deleted from the document) will print. 

 Print invoice items – When selected, prints items with a Patient Visit List status of Recommended, 
Accepted or Performed. Selecting this check box enables the three additional options below it: 

• Include declined and unapplied items – Also prints items with a PVL status of Declined, 
Declined to history, or Blank.  

• Include invoice item Amount – Also prints the Amount for each invoice item. 

• Include invoice item Staff – Also prints the Staff for each invoice item. 

Invoice items are printed in a table at the end of the document in the order in which they appear on 
the Invoice Items tab in the Cornerstone Editor. 

Example: 

 

Printing a Document’s Header, Document Information and Footer 

Note: When printing a text-only document, the Print header and Print footer options are not available 
on the Print Options dialog box. 

Special options allow you to customize each print job depending on the type of document and its 
intended use. For example, if a document includes practice contact information in the header but you 
want to print a special letter on pre-printed letterhead paper, you can turn off the header for printing by 
clearing the Print header check box. 

• Print header – When selected, the header prints on each page of the document. 

• Print document info – When selected, the document information is printed in a table at the end of 
the document (after the Invoice Items table, if one is printed). The document info includes the 
template name, history (Hx) description, staff, date last saved, and status. 

Example: 

 

• Print footer – When selected, the footer prints on each page of the document. 

To print a document from the Cornerstone Editor: 

1. With the document open in the Cornerstone Editor, click the Print button  in the toolbar, click  
Print on the right side of the window, or click File > Print. The Print Options dialog box appears.  

2. In the Printer drop-down list, select the printer to use for printing the current document. 

3. In the Print range area, specify if you want to print the Entire document, Current page, or specific 
Pages. 

4. If there are any invoice items attached to the document (appearing on the Invoice Items tab), the 
Invoice items area options are available. To print invoice items, select the Print invoice items check 
box and then select any additional “Include” options if applicable. 
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5. In the Options area, select the desired print options and specify the number of copies to print. 

6. Click OK to print the document. 

Automatically Printing a Linked Diagnosis Document from a Medical Note 
When adding a medical note for a patient, if you insert a diagnosis code that has been preconfigured to 
link to a particular document in Cornerstone (Lists > Diagnostic Codes > Diagnostic Code Setup), 
the Diagnosis Document dialog box appears. 

If you click Yes to print the linked diagnosis document, the Staff Selection dialog box appears.  

After entering the staff, one of the following will happen: 

• If the linked diagnosis document is a medical note or correspondence document, the document 
prints on the default printer. 

• If the linked diagnosis document is a LifeLearn® client handout, the document opens in Microsoft® 
Word. You can then print the document directly from Microsoft Word. See “Chapter 32: Using 
LifeLearn® ClientEd™ Online” on page 422 for more information. 

Sharing Documents from the Cornerstone Editor 
If your practice has an IDEXX Pet Health Network* Pro subscription, you can send documents to your 
clients using the Share button. For more information, see “Chapter 33: Using IDEXX Pet Health Network* 
Pro” on page 425. 

Emailing or Faxing Documents from the Cornerstone Editor 
You can send a medical note, correspondence document, or estimate to a client and/or referral 
veterinarian (RDVM) by email and/or fax directly from the Cornerstone Editor. The Communications 
window reflects communication preferences for any recipients set up in Cornerstone. When emailing a 
medical note, correspondence document, or estimate from the Cornerstone Editor, a PDF of the 
document is automatically created and attached to the email.  

To send a document from the Cornerstone Editor: 

1. With the document open in the Cornerstone Editor, click Email/Fax or select File > Send 
Document. The Communications window appears. 
Note: Communication preferences set up in Cornerstone for clients and RDVMs are reflected on this 
window. 

 
Communications window 
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2. In the Staff field, type the ID, press F2 to select the staff member, or select the staff member from 
the drop-down list. (The default setting is the last staff member to use the workstation.) 

3. If you want to send the document in PDF format by email, select the Email check box and do the 
following in the Communication Type and Recipients area: 

a. In the Subject text box, use the default subject line that displays or type in the text box to edit 
the subject line. 

b. If the client associated with this document has an email address set up in the Client Information 
window, you can quickly add the client to the email Recipients list by selecting the Add client 
check box. Cornerstone automatically lists the associated name and email address for the 
client. 

c. In the email Recipients list, double-click in the Type field and select one of the following for 
each recipient: 

• To: Select this email type for all primary recipients of the message. At least one recipient 
must be designated. 

• CC: CC is an abbreviation for “carbon copy.” If you select the CC type for a recipient, a 
copy of the message is sent to that recipient. All other recipients of that message can see 
that the person you designated as a CC has received a copy of the message. 

• BCC: BCC is an abbreviation for “blind carbon copy.” If you select the BCC type for a 
recipient, a copy of the message is sent to the recipient, but the recipient’s name is not 
visible to the other recipients of the message (including other BCC recipients). 

d. If you want to email the document to a recipient not currently set up with an email address in 
Cornerstone, in the next available blank row in the Recipients list, complete the Name and 
Email Address fields. You can change the email type by selecting To:, CC:, or BCC: from the 
Type drop-down list. 

e. To remove a listed recipient, in the email Recipients list, click the Remove icon in the 
applicable row. 

4. IDEXX Faxing Service only: If you want to send the document by fax, select the Fax check box and 
do the following in the Communication Type and Recipients area: 

a. If you want to include a fax cover sheet with the document, select the Include Cover Sheet 
check box. Any text entered in the Message text box is included on the cover sheet.  
Note: If you use a logo on your printed invoice, that logo is also applied to your fax cover sheet. 

b. If you want to fax the document to a recipient not currently set up with a fax number in 
Cornerstone, in the next available blank row in the Recipients list, complete the Name and Fax 
Number fields.  

c. To remove a listed recipient, in the fax Recipients list, click the Remove icon in the applicable 
row. 

5. You can enter text in the Message box. This text will be included in the body of the email or the fax 
cover sheet. 

6. The Attachments list automatically includes the document being sent in this email or fax 
transmission, as well as any files that are attached to the document. These appear on the 
Attachments tab. Most common file types are supported, including PDF, CSV, GIF, JPG, JPEG, 
XLS, DOC, TIF, TIFF, etc.  

Cornerstone User’s Manual                  265 



Chapter 17: Using Medical Notes and Correspondence 

Note: In the Attachments list, for both a medical note (the document currently open in the 
Cornerstone Editor) and correspondence documents, the Type is listed as Medical Note 
Attachment. 

To work with attachments, do any of the following: 

• To view an attachment in a separate preview window, click the View icon in the applicable row. 

• To remove an attachment so it is not included with the email or fax, click the Remove icon in the 
applicable row. 
Note: In the Cornerstone 8.3 software release, you cannot attach additional documents from 
Cornerstone or your computer to the email or fax from the Communications window. 

7. Click Send to send the document and any selected attachments to the specified recipients. 

Viewing Communications in the Patient Clipboard 
When you send email or fax communications from Cornerstone, a line for each communication type is 
generated in patient history and is viewable from the Patient Clipboard Summary and Text tabs. Email and 
fax communications also display on the Summary and Text tabs in the Patient File window. 

Note: If you do not want email and fax communication lines to display in patient history or on the Summary 
or Text tabs, right-click a column heading, select Filter, and deselect the Communications option. 

Preview Pane Display 

With a communication line selected on the Patient Clipboard Summary tab or Text tab, click Preview to 
view Recipients, Attachments, Subject, and Message information in the preview pane. 

Viewing the Communications Log 
All email and fax communications sent from Cornerstone are tracked in a Communications Log, which 
provides comprehensive details on the date sent, transaction status (sent/failed), recipient, destination 
(email address or fax number), patient, and so on.  

The Communications Log window allows you to: 

• View all outbound email and fax communications initiated from Cornerstone during a specified date 
range. 

• View the communication type (email or fax), client/patient, staff associated with the communication, 
the subject, and the date the email or fax was sent. 

• View all recipients of the communication and the status of the email or fax transmission. 

• Resend a failed transmission. 

• View the file name, type, and a preview for all attachments included in the email or fax. 

• Show only communications related to a specific communication by clicking Show Related Rows.  

• Mobile Computing module users can view the communication history type (communication) in the 
Patient Clipboard Summary tab. 

You can also: 

• Change the way the log is sorted by clicking on a column header; an arrow marks the column and 
indicates the sort order (ascending or descending). 

• Select the Only failed rows not successfully resent check box to display only failed emails and 
faxes that have not been successfully resent. 
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• Export the information shown in the log to a CSV file that can be opened in another software 
program. 

Note: Laboratory results and client-friendly reports that you share from IDEXX VetConnect* PLUS within 
Cornerstone can be viewed from the VetConnect PLUS communications log but are not viewable 
elsewhere within Cornerstone. 

Accessing the Communications Log 
• To view all practice communications, on the menu bar, select Activities > Communications Log. 

• To view all communications for a specific patient, click the view communication log link in the 
Patient Information area on the Patient Clipboard. 

• To view a specific communication and all communications related to it, double-click the 
communication line in the Summary or Text tab on the Patient Clipboard or click the 

Communication  button. 

Editing a Draft or Tentative Document (Unfinalized) 
You can edit a document that was saved as Draft or Tentative by doing one of the following: 

• From the Patient Clipboard – In the Patient History area, double-click on the document row or right-
click and select Update. 

• From the Daily Planner – Double-click on the document row or right-click and select Update. 

See “Status Options” on page 240 for information on the Draft, Tentative and Final status options. 

See the “Invoice Items and Attachments Pane – Invoice Items Tab” section beginning on page 241 for 
information on making changes to invoice items that have already been sent to the Patient Visit List. 

Manually Finalizing a Document 
You can manually finalize a medical note or correspondence document by doing one of the following: 

• From the Daily Planner – Right-click on a tentative document and select Finalize. (If it is a Draft 
document, it must be updated and saved as Tentative before it can be finalized using the right-click 
menu from the Daily Planner.) 

• From the Cornerstone Editor – When adding or updating a document in the Cornerstone Editor, 
you can finalize the document by selecting Final from the drop-down box in the top-right corner and 
then saving the document. 

Note: When adding a document in the Cornerstone Editor, if a client signature is included in the 
document, the document finalizes automatically when you save the document. 

Tip: You can copy (CTRL+C) text or notes from a finalized document and paste (CTRL+V) it into 
another document. Note, however, that images (including signatures) cannot be copied from a finalized 
document. 

Viewing Documents in Patient History 
With the exception of Print Only documents, all patient documents are recorded in medical history either 
by saving the whole document or the document title only. Each type of document can be distinguished 
by its icon that appears next to it in history. 

Document Type Recorded in Medical History Source Icon 

Print Only No (none) 
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Document Type Recorded in Medical History Source Icon 

Correspondence – Title Only Yes (title saved) 
 

Correspondence – Document Yes (document saved)  

Medical Note Yes (document saved)  
 

Additional tips for viewing documents in the Patient Clipboard – Patient History area: 

• The Patient History area can be displayed in normal view, full size view, and with a Preview pane 
view for previewing medical notes and correspondence documents from the Patient Clipboard. See 
“Viewing Options for the Patient History Area” on page 34 for more information. 

• For each document, the history line will show the Template Name, followed by the STATUS, followed 
by the Hx description (if any). For example, “Eye Exam - TENTATIVE – Eye exam w/corneal ulcer.”  

• If a document has been finalized, the status will show as either “FINAL [finalize date]” if manually 
finalized or “Closed [auto-finalize date]” if auto-finalized. 

• If the Alert check box was selected for the document, this line will stand out in history as white text 
on a bright red background. 

• For correspondence documents based on a template that has the Show past and future uses of 
this template on the Medical Notes tab, Daily Planner, Check-in Report, Patient History Report 
option selected, these documents appear in history with medical notes on the Medical Notes tab 
(correspondence documents can be distinguished from medical notes by their Correspondence  
icon). 

Viewing the Full Contents of Text-Only Medical Notes Inline in History 

Text-only medical notes allow full inline viewing of text-only document contents on the Patient Clipboard 
and Patient File windows. This means that you can quickly view any text-only medical note directly on 
the Text tab or Medical Notes tab without needing to open the document in a separate preview or 
editor window.  
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Note: The Patient Clipboard graphic above shows an example of how the Color All Text option can be 
used to apply a single color to all text in a text-only document in the editor and in patient history. 

Text-only medical note viewing options on the Patient Clipboard history tabs include: 

• Text tab – View the complete contents of the text-only medical note inline in history. 

• Medical Notes tab – View the complete contents of the text-only medical note inline in history. 

• Summary tab – View the text-only medical note’s Hx description inline in history or view the 
complete contents of the note in a pop-up window by resting the mouse cursor over the note’s 
history line. 

Adding an Addendum to a Finalized Document 
You can add an addendum to insert additional notes at the bottom of a finalized medical note or 
correspondence document. This adds an ADDENDUM section to the end of the document that includes 
the added text, plus the date, time and staff member who added the addendum. In addition, the line in 
patient history shows the date of the most recent addendum. 

Example: 

 

To add an addendum to a finalized document: 

1. Do one of the following: 

• On the Patient Clipboard, on the Summary tab or Medical Notes tab, right-click on the finalized 
document and select Addendum. 

• With a finalized document open in the Cornerstone Editor, click the Addendum button.  

The Addendum dialog box appears. 

 
Addendum dialog box 

2. Type the Staff ID and press TAB. 

3. Type the addendum text. 

4. If desired, click Spell Check to review the text for spelling errors. 

5. Click OK. 

The addendum is added to the document. 

In addition, “***ADDENDUM [addendum date]” is added to the document’s line in patient history. 
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Voiding a Document 
If necessary, a staff member with appropriate security permissions can void a medical note or 
correspondence document. Voiding may be necessary, for example, if a medical note is accidentally 
entered for the wrong patient. 

To void a document: 

1. With the patient’s record open on the Patient Clipboard, on the Summary, Text or Medical Notes 
tab, right-click on the document and select Update (or select View for a finalized document). 

2. With the document open in the Cornerstone Editor, click the Void button. 

3. A “Your changes will be lost. Do you want to proceed with the Void?” message appears. Click Yes. 

Note: Before voiding the document, the Cornerstone Editor does a “sweep” to check if any included 
invoice items were already sent to the Patient Visit List, open invoices or patient orders. If document 
items exist in other places, a message appears to verify if you would like to view item details before 
voiding. If you click Yes, the Void process is cancelled to allow you to resolve any item warnings 
before proceeding. (Click the item’s red  button to view details about the warning; you may need 
to manually edit or delete the items from the PVL, invoice or patient orders.) 

The Void dialog box appears. 

4. Type the staff ID and press TAB. 

5. In the text box, enter a reason for the void. 

6. Click OK.  

7. A message appears to verify you want to void the document. Click Yes. 

The document is voided and marked with a VOID watermark. The document is also marked as voided in 
the patient’s history. 

Tip: If desired, you can hide all voided documents in history on the Patient Clipboard to remove 
unnecessary clutter and save space. To do so, select the Hide voided items check box located in the 
bottom right corner of the Patient Clipboard. 

 To view a list of voided documents (medical notes and/or correspondence), print the Voided 
Documents report. 

Generating a Referral Letter 
After providing the needed care to a referral patient, use your practice’s referral letter template to 
generate a letter to the referring hospital and/or doctor and save the medical record in patient history. 

Note: The following instructions assume that the referral letter template has been set up as 
Correspondence – Document (saves the entire document in patient history). If you are using a 
template that was set up as Correspondence – Title Only (saves only the title in patient history), some 
of the options covered in this section (setting as Draft or Tentative, saving, etc.) will not be available. 

Before You Begin 

• Set up a document template for your referral letters. See “Chapter 17: Setting Up Medical Notes and 
Correspondence” in the Cornerstone Administrator’s Manual for information. 

If you plan to send the referral letter via email from the Cornerstone Editor, the referral doctor and 
hospital must be set up with an E-mail address and the Send info via field set to E-mail. In 
addition, the referral doctor and hospital must be selected for the applicable patient on the Patient 
Information window’s Referrals tab using the Primary and/or This visit options. For more 
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information about referral management, see “Chapter 29: Using Referral Relationship Management” 
on page 403. 

To generate a referral letter: 

1. Do one of the following:  

• On the Patient Clipboard, select the client and patient. Right-click on the patient’s name in the 
Patient list area and select Correspondence. 

• Click Correspondence  toolbar button.  

• On the Activities menu, select Correspondence. 

Note: Any applicable alerts may appear at this time. Review each alert and click OK to close the 
alert. 

The Start New Document window appears. Depending on how you access the Start New Document 
window, the Client ID/Patient ID fields may already be completed for you. 

2. Enter the Client ID, Patient ID and Staff ID as needed.  

3. Use the fields in the Find Template area to locate your referral letter template. 

4. Select the template in the document template list and click OK. 

The template opens in the Cornerstone Editor. 

Depending on the setup for the selected template, the following may appear upon opening: 

• If the patient weight is not considered current (based on the Ask for weight… setting in 
Documents defaults), the last entered weight appears in red. If you are adding a medical note, a 
weight entry dialog box appears automatically, allowing you to update the weight for this patient.  

• If there are any Question/Answer bookmarks included in the template, the associated pop-up 
boxes display. 

5. As necessary, provide the required information and close the pop-up boxes. The information will 
automatically populate the associated fields in the referral letter.  

6. In the Hx description field, if desired, modify the description of this document to appear in the 
patient’s history. (Note that if an Hx description is not entered, and then only the template name is 
shown to identify this document in history.) 

a. If you want to print the letter, click the Print button  on the toolbar, click Print on the right 
side of the window, or select Print from the Cornerstone Editor File menu. 

b. If you want to email or fax the letter, click Email/Fax or select Send Document from the 
Cornerstone Editor File menu. The Communications window appears. Note: Communication 
preferences set up in Cornerstone for clients and RDVMs are reflected on this window. For 
additional help with this window, press F1 in Cornerstone or see  
Example: If any RDVMs are associated with this patient in Cornerstone, the RDVM’s 
communication preferences set up in Cornerstone are reflected on this dialog box. If Dr. Smith 
is listed as an RDVM for this patient in Patient Information and Dr. Smith’s communication 
preference of receiving information via email has been set up in Cornerstone, the Email check 
box is automatically selected and the associated email address displays in the email 
Recipients list. If an RDVM is marked as the Primary for this patient, the To: email type is 
selected (unless the This visit check box on the Referrals tab of the Patient Information window 
is cleared). If another RDVM is marked as This visit for the patient, the CC: email type is 
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selected. If the RDVM does not have communication preferences set up in Cornerstone, they 
will not automatically appear in the list even if they are the primary RDVM or if the This visit 
check box is selected on the Referrals tab of the Patient Information window. 

c. Click Send to send the message, and then click OK when prompted to return to the 
Cornerstone Editor. 

7. When you are finished and ready to save the document, click the drop-down list in the upper-right 
corner of the window and select the appropriate option (Draft, Tentative or Final) for saving the 
document. (See “Status Options” on page 240 for information on the status options in the 
Cornerstone Editor.) 

8. When you are finished with the letter, do one of the following: 

• If you want to save the document and close the Cornerstone Editor, click OK. 

• If you want to save the document and remain in the Cornerstone Editor so that you can continue 
working in a Draft or Tentative document, click Save. 

The referral letter document is saved to the patient’s history. You can view this document by highlighting 
the line in history and double-clicking on it.  

Tip: You can view all open (non-final) referral letter documents on the system from the Correspondence 
tab on the Daily Planner. From there you can right-click on a document and select Update to review and 
make changes to a document or click Finalize to make the document part of the patient history. 

Merging Client/Patient Information with a Document (Merge from File) 
To personalize correspondence, you can merge Cornerstone client and/or patient information into a 
document before printing it. 

Creating a Data File to Merge with a Document 

You can save Cornerstone client or patient report information to a file for use with a Cornerstone 
correspondence document. When a reminder file of client and patient information is generated, the 
information is saved in a namelist.txt or namelist.csv file, allowing you to merge the information and print 
reminders in either Cornerstone (using the namelist.csv file) or Microsoft Word (using the namelist.txt 
file). 

To save client or patient report information to a file: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 

2. In the Reports list, click the plus sign to the left of the applicable report group, and then select the 
desired report. 

3. Click Create report. 

4. If applicable, enter a sort order and the range. 

5. Click Preview. 

6. When the report preview displays, click Save. 

7. Name the file and browse to select the desired location for the file.  

8. From the Save as type drop-down list, select Comma Separated (*.csv). if you plan to merge it 
with a correspondence document in Cornerstone, or select Text Format (*.TXT) if you plan to 
merge it with a Microsoft Word document. 

9. Click Save. 
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Merging a Data File with a Correspondence Document in Cornerstone 

Cornerstone provides the ability to merge a list of clients or patients with a correspondence document 
directly from Cornerstone.  

Note: Merge from file functionality is not available on mobile computers. 

Tip: Use the Mailing Labels report (in the Client report group) to create a client name list and save it in 
.csv format. Then merge the name list file with the Sample Mailing Labels (Avery 5160) document 
template in Cornerstone to easily create mailing labels for client promotions and marketing campaigns. 

To merge the file with a correspondence document: 

1. Do one of the following: 

• On the Patient Clipboard, right-click on a patient name in the Patient list area and select 
Correspondence, or right-click anywhere within the Patient History area tabs and select 
Correspondence. 

• Click Correspondence  toolbar button.  

• On the Activities menu, select Correspondence. 

The Start New Document window appears. 

2. Click the Merge from file option, and then click Browse to select the merge list (.csv) file that you 
created previously. You must select a .csv file (a comma-separated file). 

3. Click Open.  

4. On the Start New Document window, use the options in the Find Template area to locate the desired 
document. Select the document and click OK. 

5. A window displays, showing the bookmarks that are found in the selected document. Link the data 
from your file to the appropriate bookmark in the document by selecting the data from the File 
columns drop-down list. If the file was merged with this document before, Cornerstone will 
remember which file columns and bookmarks are linked. 

6. If your document is a Print Only document, skip to step 7. If the document is a Correspondence 
document, enter the document description, staff information and patient column information. This is 
used to store the document in each patient’s history. 

7. Click OK when you are ready to print a test page. 

8. Click Yes if the test page printed successfully, and you want to send the entire job to the printer, or 
click No if you want to adjust your printer settings and print another test page.  

Merging a Data File with a Microsoft Word Document 

You can create a Cornerstone data file of client and patient information and merge it with a document in 
Microsoft® Word.  

Note: Depending on the version of Microsoft Word you are using, the Word functions referenced in this 
section may vary slightly from your version of Word. Refer to the Microsoft Word online Help for 
instructions specific to your version. 

Before You Begin 

• Use Microsoft Word (not the Cornerstone Editor) to create the document to merge with the 
Cornerstone data file. 

Cornerstone User’s Manual                  273 



Chapter 17: Using Medical Notes and Correspondence 

• Insert Word merge fields (not bookmarks) in the document where you want the applicable 
Cornerstone data to be merged in the document. 

• When the Cornerstone data file is created in Cornerstone, save it in a .txt format. 

To merge the file with a Microsoft Word document: 

1. In Microsoft Word, open the document that you want to merge with the data file that was created in 
Cornerstone. 

Note: If merge fields have previously been included in the document, Word automatically opens the 
Data Source to which the previous merge codes apply. 

2. Depending on your version of Word, do one of the following: 

• In Word 2002 or 2003 – On the Tools menu, select Letters and Mailings, and then select Mail 
Merge Wizard. The Mail Merge Wizard appears. 

• In Word 2007 – Click the Mailings ribbon and then click Start Mail Merge > Step by Step Mail 
Merge Wizard. The Mail Merge Wizard appears.  

3. Follow the Mail Merge Wizard steps to set up your document. When you reach the Select recipients 
step, select Use an existing list, and browse to select the Cornerstone .txt data file that you 
created. 

4. Continue to follow the Mail Merge Wizard to merge the data file and print the document. 

Printing Sample Consent Forms 
A set of sample consent forms is included with your software. The consent forms, developed by James 
F. Wilson, DVM, JD and Charlotte A. Lacroix, DVM, JD, provide ways of formalizing agreements for 
treatment. Use of these “Wilson Documents” consent forms can minimize the oral confrontations with 
clients that most practitioners try to avoid. 

About the Forms 

Some of the forms included with your software are provided only as client consent forms. Others are 
provided to serve both as client consent forms and releases of liability. In many cases, specific, narrow 
wording has been used. This was done to establish a “client-friendly” approach, rather than a hostile 
one, to what might be viewed as a heavy-handed position by the practice. Practice owners and 
managers should be aware that changes in words or omissions of text might affect the enforceability of 
the consent or release form. This critical fact can be easily overlooked by attending veterinarians or 
office managers unfamiliar with the law. 

Because of these concerns and the fact that statutory and case law precedents vary from one state to 
another, a draft of any release or consent form should be reviewed by the practice’s legal counsel before 
it is put into use. 

These forms are provided with the understanding that they do not constitute the rendering of legal or 
other professional advice or services by IDEXX Computer Systems or Drs. Wilson or Lacroix. 

Consent Forms Characteristics 

Your electronic consent forms include the following: 

• Informational notes (when applicable). A note to inform the veterinarian on the intended use and/or 
legal implications of the form is included on some forms. The note appears in bold type at the 
bottom of the form. To alert the staff that a note is included, a special Question bookmark is 
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included in consent forms with notes. The Question bookmark automatically displays when the 
consent form is opened in the Cornerstone Editor. 

Tip: The note and the special Question bookmark should be deleted before the consent form is 
printed and given to the client.  

• Cornerstone bookmarks. For your convenience, Cornerstone bookmarks are also included in the 
consent forms. The bookmarks will automatically place practice, client, and patient information on 
the forms. 

Before You Begin 

• Before using the forms at your practice, select and print copies of the forms you want to use. Note 
any additions or changes that need to be made to reflect the fees, deposits, and policies at your 
practice. See “Chapter 17: Setting Up Medical Notes and Correspondence” in the Cornerstone 
Administrator’s Manual for information on editing document templates in the Cornerstone Editor.  

• (Optional) Set up a signature capture device (Tools > Signature Capture Device). 

• (Optional) Set up electronic signatures for staff members (Lists > Staff > Update > Signature 
tab). 

To use Wilson Document consent forms with Cornerstone software:  

1. Do one of the following:  

• On the Patient Clipboard, right-click on a patient name in the Patient list area and select 
Correspondence, or right-click anywhere within the Patient History area tabs and select 
Correspondence. 

• Click the Correspondence  toolbar button.  

• On the Activities menu, select Correspondence. 

The Start New Document window appears.  

 
Wilson Documents available on the Start New Document window 

2. Enter the Staff ID or press TAB to accept the default ID. 
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3. In the Category drop-down list, select the applicable “Wilson…” category to display only those 
document templates in the template list. 

4. Select the desired document template and click OK (or double-click on the document template). 

The document template opens in the Cornerstone Editor. 

5. If question bookmarks are embedded in the consent form, you will be prompted to enter 
information. Your answers will be inserted on the consent form. 

6. If applicable, have the client sign the document using a signature capture device.  

7. If applicable, have a staff member sign the document using a signature capture device.  

8. To print the form, click the Print  button or click File > Print. 

9. When finished with the form, do one of the following: 

• If you want to save the final form in patient history and close the Cornerstone Editor, select the 
Final status from the drop-down list in the upper-right corner and click OK. 

• If you printed a hard copy of the blank form without client/patient data and do not want to save it 
in patient history, click Cancel. 

Consent Forms List 

For your reference, the following is a list of the consent forms included with your software along with the 
corresponding document template names. 

Note: All consent form document template names begin with “Wilson” or “Lacroix.” For example, 
“Wilson Treatment Consent.” 

Tip: A list of the English documents and the corresponding Spanish document names is available in the 
Cornerstone online Help—search on the word “Spanish” in the Help’s Index or Search tab to locate the 
Help topic. 

General Consent Forms 

Consent Form for Treatment and/or Admission 

File name: Wilson Treatment Consent 
Client consents to treatment of pet, understands risks, and assumes financial responsibility, with 
payment required at time of discharge (used with client registration). 

Consent Form for Treatment and/or Admission (With Checklist) 

File name: Wilson Consent for Treatment/Admission 
Expanded version of above client’s consent to treatment, with a listing of elements needed for an 
informed consent. 

Emergency Service Estimate and Consent Form for Treatment 

File name: Wilson Emergency Service Estimate 
Consent form for emergency treatment, with acceptance of fee estimate within a 25% range and 
requirements to provide a deposit and contact the practice every 24 hours. 

Consent Form for Dental Care 

File name: Wilson Consent for Dental Care 
Consent form for and listing of various dental procedures and explanation of risks associated with 
anesthesia and extractions. 
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Consent Form for Cardiopulmonary Resuscitation 

File name: Wilson Cardiopulmonary Resuscitation 
Explanation of CPR with choices for various levels of treatment, including no CPR at all. 

 

 

Do Not Resuscitate Order 

File name: Wilson Do Not Resuscitate 
As opposed to providing options for CPR, this consent is a simple one prohibiting it. 

Consent Form for Extraordinary Care 

File name: Wilson Consent for Extraordinary Care 
Explanation of the serious nature of the illness and poor prognosis, combined with authorization of 
treatment and agreement to fees required for further treatment and CPR. 

Authorization for Anesthesia and/or Surgery 

File name: Wilson Authorize Anesthesia/Surgery 
Owners authorize anesthetic and surgical procedures; form incorporates the seven elements 
required for an informed consent in the document. 

Alternate Authorization for Anesthesia and/or Surgery 

File name: Wilson Authorize Anesthesia/Surgery2 
Owners authorize anesthetic and surgical procedures, with the seven elements required for an 
informed consent listed on the back page of the document. 

Consent Forms for Ambulatory Practices 

File name: Wilson Consents for Ambulatory Practices 
This file includes three consent forms for ambulatory practices: Consent Form for Routine Veterinary 
Care, Consent Form for Emergency Care, and Consent Form for Referral for Specialty Care. 

Declination of Preanesthetic Diagnostic Tests 

File name: Wilson Declining Preanesthetic Tests 
Clients who formally decline recommended preanesthetic blood profiles waive the practice’s liability 
for not performing such tests. 

Medical Power of Attorney 

File name: Lacroix Medical Power of Attorney 
This document enables owners to authorize someone else to make life or death decisions for their 
pet(s) if they become mentally incapable of doing so. 

Living Will Advance Instruction for Health Care of My Pet 

File name: Lacroix Living Will 
This consent form allows veterinarians to end life-support care for terminal patients. 

Consent Forms for Vaccination 

Consent Form for Vaccination Frequency 

File name: Wilson Choice/Consent to Vaccinations 
Educational materials in this document describe the risks and benefits associated with the changing 
protocols for the administration of vaccines every three years instead of annually. 
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Documentation of Rabies Vaccination 

File name: Wilson Rabies Vaccine Information Form 
Client declines rabies vaccination for the pet and acknowledges the consequences if the 
“unvaccinated” pet should bite a human or another animal. 

 

 

Consent Form for Rabies Vaccination of a Wolf-Dog Hybrid 

File name: Wilson Rabies Vaccination/Wolf-Hybrids 
Client acknowledges that rabies vaccination of a wolf-dog hybrid has no guarantee of efficacy. 

Consent Forms for Use of Veterinary Drugs 

Consent Form for Use of Drugs With Potential Adverse Effects 

File name: Wilson Drug w’ Potential Adverse Effect 
Some FDA-approved drugs such as Rimadyl®, phenobarbital, mitotane, and certain antibiotics or 
antifungal drugs pose infrequent but potentially fatal risks for patients. This consent informs clients 
of the risks, the need for follow-up evaluations, and their responsibilities in the event of 
complications. 

Consent Form for Cancer Therapy Using Investigational Methods and/or Extra-Label Drugs 

File name: Wilson Cancer Therapy/Investigative 
This document discusses complications from chemotherapeutic agents and the fact that most of 
these drugs have not been approved for use in the species to which they are being administered. 

Consent Form for Use of Psychotropic Drug(s) 

File name: Wilson Consent to Psychotropic Drugs 
This document explains the risks and side effects associated with the use of drugs in the treatment 
of pets with undesirable behaviors. 

Consent Form for Use of Pharmaceuticals in Special Species 

File name: Wilson Pharmaceuticals/Special Species 
This document discusses the fact that most of the drugs used in special species constitute an extra-
label use of the drugs being administered, that owners are aware of this, and that they accept it as a 
prerequisite to the treatment of special species. 

Consent Form for Extra-Label Use of Liquid Ivermectin 

File name: Wilson Consent of Purchase of Ivermectin 
Client acknowledges that use of liquid ivermectin for heartworm prevention is not FDA-approved, but 
elects to use this form of medication. 

Consent Forms for Use in Difficult Situations 

Consent Form for Release of Patient Against Doctor’s Recommendation 

File name: Wilson Release w/o Dr’s Recommendations 
Client requests release of hospitalized pet despite doctor’s recommendations for continued care; 
client accepts full financial and medical responsibility for such action. 
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Consent Form for Continuation of Treatment in Cases with Little or No Hope of Successful 
Treatment 

File name: Wilson Consent with Little or No Hope 
Owner elects to continue animal’s treatment despite a poor prognosis, but must pay in full for 
estimated costs of ongoing care. 

Proposed Letter of Compromise with Continuation of Services 

File name: Wilson Compromise w’ Continuing Service 
To be used when clients owe money and there is no evidence of professional negligence; letter 
submitted to client in an effort to present options to settle the account and continue service to the 
client. 

Proposed Letter of Compromise with Termination of Services 

File name: Wilson Compromise w’ Terminating Service 
To be used when clients owe money and there is no evidence of professional negligence; letter 
submitted to client in an effort to settle the account before terminating services. 

Termination of the Doctor/Client Relationship 

File name: Wilson Terminating Dr/Client Relations 
Informs client that the practice is unable to provide further veterinary care due to the client’s 
unacceptable attitude and/or behavior. 

Request for Release of Medical Records 

File name: Wilson Release of Medical Records 
Client requests medical records to be released to a new practice. 

Radiograph Release Form 

File name: Wilson Radiograph Release Form 
Pet owner takes custody of radiographs and accepts responsibility for returning them to the 
practice. 

Assumption of Risk and Responsibility for Pet Restraint by Owner in a Hospital Setting 

File name: Wilson Restraint by Owner 
Client releases the practice from liability if client insists on restraining the pet during exams or 
treatment procedures, against the recommendation of the doctor. 

Assumption of Risk and Responsibility for Animal Restraint by Owner in an Ambulatory Setting 

File name: Wilson Restraint w/o Ancillary Staff 
Client accepts responsibility for restraint of large and small animals when no staff assistance is 
readily available. 

Consent Form for Refill of Heartworm Medication Prescription Without a Blood Test 

File name: Wilson Heartworm without Blood Test 
If client declines heartworm-screening test with annual refill of heartworm medication, client waives 
the practice’s liability for adverse affects. 

Notice of Animal Cruelty 

File name: Wilson Animal Cruelty Form 
Warning to owners that any further evidence of animal cruelty will be reported to the local humane 
society. 
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Dangerous Animal Warning 

File name: Wilson Dangerous Animal Warning 
Owner acknowledges he has been informed that pet exhibits behavior that is potentially dangerous 
to humans or other animals. 

Consent Form for Euthanasia 

File name: Wilson Consent for Euthanasia 
In-depth euthanasia consent addressing the various ways practices must handle pets, depending 
on whether they may or may not have bitten people or animals. 

Agreement to Transfer Pet Ownership 

File name: Wilson Pet Transfer of Ownership 
Provides necessary information and consent for transfer of pets to the veterinary practice when 
owners are unable to pay for care and the practice offers to find new homes for such pets. 

Client Refusal to Authorize and/or Pay for Recommended Fecal Analyses and/or Parasiticides 

File name: Wilson Refusal for Canine/Feline Fecal 
Client refuses recommended fecal parasite analysis and/or treatment and releases the practice from 
liability. 

Consent Forms Related to Use of Pet for Educational Purposes 

Consent Form for Donation of Pet for Educational Purposes 

File name: Wilson Memorial Consent to Donate Pet 
Client releases possession and ownership of pet to the practice and allows it to be used for 
educational purposes. 

Consent Form for Donation of Pet Remains 

File name: Wilson Consent to Donate Pet Remains 
Client releases possession and ownership of pet’s remains and allows pet’s body to be used for 
educational purposes by the practice. 

Release of Information for Media or website Publication 

File name: Wilson Release of Information for Media 
Client allows information and images from patient to be released for use by the media or on 
websites. 

Other Consent Forms 

Consent Form for Participation in Wildlife Rehabilitation Program 

File name: Wilson Wildlife Rehabilitation Consent 
Explains risks to volunteer participating in raptor and wildlife rehabilitation programs and obtains 
informed consent to take responsibility for risks. 

Employment Testing Consent Form 

File name: Wilson Employment Testing Consent 
Informs job applicant that he/she is voluntarily testing for employment and not entitled to monetary 
compensation for time committed to such effort. 

Pet Sitting Consent Form 

File name: Wilson Pet Sitting Consent 
Pet-sitting agreement with preauthorization for essential veterinary care during the client’s absence. 
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Boarding Agreement for the Year and Pet Admission Agreement 

File name: Wilson Boarding Agreement for Year 
File name: Wilson Pet Admission Agreement 
Boarding agreement with statement of kennel policies, vaccination verification, diet preference, 
medication requirements, and preauthorization for essential veterinary care. 

Pet Adoption Agreement 

File name: Wilson Pet Adoption Agreement 
New pet owner acknowledges that there is no guarantee or warranty of the health and/or 
temperament of a pet adopted from this veterinary facility. 
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This chapter covers the steps required to add a Classic medical note to a patient record. For  
information on setting up a Classic medical note template in the Cornerstone* Practice Management 
System, see “Chapter 18: Setting Up Classic Medical Notes” in the Cornerstone Administrator’s Manual. 

 

Overview 
Classic medical notes are the “old style” of medical notes used in Cornerstone* 7.6 and prior versions. 
You can continue to use your Classic medical notes, or you can convert them to enhanced medical 
notes (see “Chapter 17: Setting Up Medical Notes and Correspondence” in the Cornerstone 
Administrator’s Manual for information). 

Classic medical notes are dated and stored in the patient’s medical history. After the information is 
finalized it cannot be changed, but an addendum can be added to a finalized Classic medical note. 

IMPORTANT: You must use Classic medical note templates for surgery/anesthesia logs. Enhanced 
medical notes do not support this feature at this time. See “Using Classic Medical Notes for 
Surgery/Anesthesia Logs” on page 285 for information on using these templates.  

Adding a Classic Medical Note for a Patient 
All Classic medical notes are started from the Start New Document window where you select an existing 
Classic medical note template to use and then insert the applicable data for the patient. 

Before You Begin 

 Set up Classic medical note templates for common types of information you enter (such as SOAP). 
See “Chapter 18: Setting Up Classic Medical Notes” in the Cornerstone Administrator’s Manual for 
information. 

To add a Classic medical note for a patient: 

1. Do one of the following: 

• On the Patient Clipboard, right-click on a patient name in the Patient list area and select Medical 
Note, or right-click anywhere within the Patient History area tabs and select Medical Note. 

• Click the Medical Notes  toolbar button. 

• On the Activities menu, select Medical Notes. 

The Start New Document window appears.  
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Classic medical note selected in the Start New Document window 

2. Depending on how you access the Start New Document window, the Client ID, Patient ID and Staff 
ID fields may already be completed for you. Complete these fields as necessary (press F2 or 
double-click to select an ID from a list), and press TAB to proceed to the next field.  

Note: The Patient List appears automatically if there is more than one patient associated with the 
selected client. Select the desired patient and click Select. 

3. In the Category drop-down list, select *Classic medical note. (To keep them separate from 
Enhanced medical notes, all Classic medical note templates are in the *Classic medical note 
category. This category cannot be changed.) 

4. Use additional fields in the Find Template area to locate the desired template. See “Using the Find 
Template Options” on page 259 for information. 

5. Click on a template in the list to see a preview of the Classic medical note in the preview area at the 
bottom of the window. 

6. Once you have located the desired template, select it and click OK (or double-click on the 
template). 

The template opens in the Classic Medical Notes window. 
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Classic Medical Notes window 

7. If there are preset data entry fields in the selected template, the Medical Note Information dialog box 
appears automatically upon opening the template. (To access this dialog box at any time while 
adding the Classic medical note, click the Data Entry button or press F6.) 

 
Medical Note Information dialog box 

8. Complete the medical note information fields as needed.  

• Use the TAB key, arrow keys or the mouse to move from field to field. 

• In Item ID fields, type the item ID. You can also press F2 or double-click in any Item ID field to 
choose an item from the Invoice Item List. 

Note: Invoice items that are added in Classic medical notes will transfer to the Patient Visit List 
(PVL). Items entered in an Invoice Item data entry field will appear in the note text. If you want to add 
items to the invoice while in a Classic medical note and you do not want them to appear in the text 
of the note, set the invoice item as a consult item. Items entered in a Consult Item data entry field 
will not appear in the text, but will display in the lower left area of the Classic Medical Note window. 

9. When finished, click OK to return to the Classic Medical Notes window. 
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10. If you want to mark the changes as final, choose one of the following options: 

• To manually finalize template information now, click the Final check box. 

• To automatically finalize template information at a later date, click the Auto finalize after check 
box and enter the number of days. 

Note: Templates with a status of Final cannot be altered.  

11. If your Classic medical note has invoice items or consult items on it and you did not finalize your 
template, you have the option of transferring your items to the Patient Visit List. Click OK to transfer 
items to the PVL, or choose No if you do not want to transfer items at this time. An asterisk * 
appears next to consult items that have already been transferred to the PVL. Changes to these items 
must be made in the PVL. 

12. To attach a file to the Classic medical note, in the Attachments box, right-click and select one of the 
following options: 

• Select New File to attach a new file to the medical note. Some file types that can be attached 
are Microsoft® Word documents (.doc), Microsoft® Excel® spreadsheet files (.xls), Adobe® 
Reader® documents (.pdf), and WAV audio files (.wav). 

• Select New URL to locate a web page address to attach to the medical note. Your default web 
browser opens. Locate the web page you want to attach and copy the address. Return to 
Cornerstone, right-click again in the Attachments box, and select Paste URL. 

Tip: Attachments can be viewed in patient history. A paper clip indicates which Classic medical 
notes have attachments. In the patient’s medical history, select the Classic medical note you want to 
view. The Classic Medical Notes window appears. In the Attachments box, double-click the 
document or web page you want to see. 

Note: To view the attached files in Cornerstone, you must have the software that created the files on 
your workstation. To view web pages, you must have access to the Internet. 

13. To review your fields for spelling errors, click Spell Check. 

14. When finished, click OK to close the Classic Medical Notes window. 

 Classic medical notes appear on the Patient History Report, as well as the Check-In Report. (See 
“Patient History Report” on page 77 or “Check-In Report” on page 126.) 

Using Classic Medical Notes for Surgery/Anesthesia Logs 
You must use Classic medical note templates for surgery/anesthesia logs. (Enhanced medical notes do 
not support this feature at this time.) 

Note: For Cornerstone 8.0 and prior versions, a Classic medical note must also be used to add a 
radiology (imaging) log for a patient. 

To add a Surgery/Anesthesia medical note for a patient: 

1. Do one of the following: 

• On the Patient Clipboard, right-click on a patient name in the Patient list area and select Medical 
Note, or right-click anywhere within the Patient History area tabs and select Medical Note. 

• Click the Medical Notes  toolbar button. 

• On the Activities menu, select Medical Notes. 

The Start New Document window appears. 
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2. In the Category drop-down list, select *Classic medical note. 

3. In the document template list, scroll to locate and then double-click on the Cornerstone Surgery 
Template. 

4. On the Medical Note Information dialog box, complete the fields as needed. 

5. Click OK. 

6. If you want to mark the changes as final, choose one of the following options: 

• To manually finalize template information now, click the Final check box. 

• To automatically finalize template information at a later date, click the Auto finalize after check 
box and enter the number of days. 

7. Click OK. 

8. Click Close. 

To preview or print the Surgery/Anesthesia Log: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 

2. In the Reports list, click the plus sign to the left of Practice, and then select the Surgery/Anesthesia 
Log. 

3. Click Create report. 

4. Specify any desired filters for the sort order and range.  

5. Click Preview to view the log in the Reports Preview window. 

6. Click Print. 

Adding an Addendum to a Finalized Classic Medical Note 
You can add an addendum to insert additional notes at the bottom of a finalized Classic medical note. 
This adds an ADDENDUM section to the end of the Classic medical note that includes the added text, 
plus the date, time and staff member who added the addendum. In addition, the line in patient history 
shows the date of the most recent addendum. 

To add an addendum to a finalized Classic medical note: 

1. Do one of the following: 

• On the Patient Clipboard, on the Summary tab or Medical Notes tab, right-click on the finalized 
note and select Addendum. 

• With a finalized Classic medical note open, click the Addendum button. 

The Addendum dialog box appears. 

 
Addendum dialog box 

2. Type the Staff ID and press TAB. 
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3. Type the addendum text and click OK. 

The addendum is added to the Classic medical note and “***ADDENDUM [addendum date]” is 
added to the Classic medical note line in patient history. 
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Documenting Medical Problems in a Patient’s Record 
A list of active, acute, chronic, resolved or verified incorrect problems can be added to the patient’s 
record. Once a problem is included in the patient’s record, it cannot be deleted, but can be designated 
as Verified Incorrect. 

Before You Begin 

• Set up problem categories (Controls > Problems > Problem Categories).  

• Set up a problem list (Controls > Problems > Problem List).  

To add a problem to a patient’s record: 

1. Do one of the following: 

• On the Patient Clipboard, select the client, and then right-click on the patient’s name in the 
Patient list area and select Problems from the pop-up menu.  

• On the Activities menu, select Problems.  

The Problems dialog box appears.  

 
Problems dialog box 

2. In the ID field, if the patient ID doesn’t display, type the patient ID or press F2 to use the Patient List 
to choose a patient. 

3. In the first available row’s Problem column, type the problem ID and press TAB or press F2 to use 
the Problem List to choose a problem. (To quickly locate the problem you want to add on the 
Problem List, click the Search for word check box and enter all or part of the problem description.) 

4. In the Severity column, select whether the problem is minor or major. 

5. In the State column, select one of the following options: Active, Acute, Chronic, Resolved, or Verified 
Incorrect. Problems marked as Active, Acute or Chronic display in red. Problems marked as 
Resolved or Verified Incorrect display in green. 
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6. In the Create Staff column, enter the ID of the staff member who is responsible for determining the 
problem. 

7. In the Create Date column, change the date if necessary. 

Note: The date in the Modified Date column cannot be changed. 

8. When finished adding problems, click OK. 

Tip: Problems can also be added to a patient’s record when adding the problem as part of a medical 
note or correspondence document. See “Inserting a Problem Description or Problem Details” on page 
250 for more information. 

Viewing a Patient’s Problem History 
Problems are saved in patients’ permanent medical history and can be viewed at any time from the 
Patient Clipboard Patient History area Summary, Text or Problems tabs. Look for the Problems  
icon. 

• Problems marked as Active, Acute or Chronic display in red.  

• Problems marked as Resolved or Verified Incorrect display in green.  

 
Problems shown in patient history on the Patient Clipboard 

Note: On the Patient History area Problems tab, any medical notes linked to the problem display in the 
bottom half of the tab. You can double-click on a medical note to view it. 

Adding and Updating Diagnoses 
Use diagnostic codes to enter tentative, ruled out and final diagnoses in a patient’s record. 

Before You Begin 

 Set up any additional diagnostic codes (Lists > Diagnostic Codes). Cornerstone contains the 
standard VPI® (Veterinary Pet Insurance) codes.  
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To enter a new diagnosis: 

1. Do one of the following to access the Patient Diagnosis dialog box: 

• On the Patient Clipboard, select the client, and then right-click on the patient’s name in the 
Patient list area and select Diagnosis from the pop-up menu.  

• Click the Patient Diagnosis  toolbar button. 

• On the Activities menu, select Diagnosis. 

The Patient Diagnosis dialog box appears. 

 
Patient Diagnosis dialog box 

2. In the ID field, if the patient ID doesn’t display, type the patient ID or press F2 to use the Patient List 
to choose a patient. 

3. In the first available row, enter the diagnostic Code. Press F2 to select a code from the Diagnostic 
Codes List. (You can also add a new code or update a diagnostic code from the list.) The diagnosis 
displays. 

4. If you use Patient Advisor* and want to include a reminder for the diagnosis, click the check box 

under the column with the feather symbol ( ). 

5. If necessary, change the Date to an earlier date (defaults to the current date). 

6. If necessary, update the Status to a Tentative, Ruled Out or Final diagnosis. 

7. Enter the Staff ID of the person making the diagnosis. (You may need to use the horizontal scrollbar 
at the bottom of the box to see the Staff Name.) 

IMPORTANT: Once you click OK, the diagnosis is added to patient’s medical history and cannot be 
changed or deleted. 

8. To update a tentative diagnosis, click the Status column drop-down list for the existing tentative 
diagnosis and select Final or Ruled Out. A message appears to confirm that you want to update 
the diagnosis. Click Yes. 

9. Click OK to save your changes. 

Note: Tentative diagnoses appear green in the Patient Diagnosis dialog box once saved.  
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Tip: A diagnosis can also be added to a patient’s record when adding the diagnosis as part of a medical 
note or correspondence document. See “Inserting a Diagnosis Description or Diagnosis Details” on page 
252 for more information. 

To update a diagnosis from the Patient Clipboard – Patient History area Dx tab: 

1. With the patient selected on the Patient Clipboard, click the Dx tab in the Patient History area.  

2. Right-click the tentative diagnosis and select Update. The Patient Diagnosis dialog box appears. 

 
Update Patient Diagnosis 

3. Change the Date and Staff ID, if needed.  

4. For the Select Diagnosis Status setting, select Final or Ruled Out, and click OK.  

5. A message appears to confirm that you want to update the diagnosis. Click Yes. 

 To view diagnoses for patients, print a Patient Diagnosis Report.  

 Patient diagnoses also appear on the Patient History Report, as well as the Check-In Report. (See 
“Patient History Report” on page 77 or “Check-In Report” on page 126.) 

Viewing a Patient’s Diagnosis History 
Diagnoses are saved in patients’ permanent medical history and can be viewed at any time from the 
Patient Clipboard Patient History area Summary, Text or Dx tabs. Look for the Diagnosis  icon.  

 
Diagnoses shown in patient history on the Patient Clipboard 
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Overview 
Using the prescription options in the Cornerstone* Practice Management System, you can easily create, 
refill, renew, correct, view and void a prescription. You can also print (or reprint) prescription labels and 
generate prescription reports. 

Before You Begin 

• Set Prescriptions defaults (Controls > Defaults > Practice and Workstation > select 
Prescriptions from the menu on the left). 

• Set up the prescription instructions your practice uses (Lists > Prescription Instructions).  

• Make sure the printer you use for prescription labels is assigned in Cornerstone. 

• (Optional) Specify if you want pet pictures to print on prescription labels in Workstation defaults 
(Controls > Defaults > Practice and Workstation > select Workstation from the menu on the 
left). 

Note: Pet pictures print very small on labels. The picture may take up space needed for text. 

Viewing a Patient’s Prescription History  

Viewing Prescription Information on the Patient Clipboard* – Patient History Tabs 

Prescriptions are saved in patients’ permanent medical history and can be viewed at any time from the 
Patient Clipboard Patient History area Summary, Text or Rx tabs.  

• Prescription information is immediately placed in the patient’s permanent medical history when you 
save the prescription. In patient history, the  icon indicates a prescription item. 

• If you want to verify that the prescription was invoiced, look for the prescription item with the billing 
code in patient history. In patient history, the  icon indicates an item has been billed. 
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Prescription items shown in patient history on the Patient Clipboard 

Viewing Prescription Information on the Prescription Labels Dialog Box 

The Prescription Labels dialog box can be used in place of the Patient Clipboard to view or enter 
prescription information. This dialog box shows the patient’s prescription history and allows you to sort 
the prescription history by Date or by Rx Number. 

To open the Prescription Labels dialog box: 

 Do one of the following: 

• Click the Prescription Labels  toolbar button. 

• On the Activities menu, select Prescription Labels. 

The Prescription Labels dialog box appears. 

 
Prescription Labels dialog box 

Cornerstone User’s Manual                  293 



Chapter 20: Working with Prescriptions 

From the Prescription Labels dialog box, you can: 

• Click New to create a new prescription. 

• Click View to look at a prescription’s information or print a prescription label. 

• Click Renew to create a new prescription based on a previous prescription. 

• Click Refill to refill an existing prescription. 

• Click Void to void a prescription. 

• Click Correct to correct a prescription. 

• Click Cancel to clear this patient’s prescription history from the dialog box and begin a new search.  

• Click Close (available when the prescription history is empty) to exit the Prescription Labels dialog 
box. 

Creating a Prescription 
You can enter prescription information into Cornerstone in one location and then use that information to 
print a prescription label, place the prescription information into the patient’s permanent medical history 
and place the prescription on the Patient Visit List (PVL), where it is saved to transfer to the invoice. 

Note: Prescription numbers are always generated automatically and cannot be changed. Cornerstone 
applies the prescription number when the prescription is saved. 

To create a new prescription: 

1. With the patient’s record open on the Patient Clipboard, in the Patient list area, right-click the 
patient’s name and select Prescribe.  

The Prescription Information dialog box appears. 

 
Prescription Information dialog box 

Note: You can also create a prescription label during invoicing by entering the prescription invoice 
item ID on an invoice line and clicking the Rx Label button. 

2. In the Item ID field, enter the ID of the invoice item being prescribed by either typing the ID or 
pressing F2 to search for and select the item from the Invoice Item List. 
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Note: If you have the Veterinary Pharmacy Reference™ module, an Interaction Warnings window 
may appear if any known interactions exist for the selected drug. 

3. In the Quantity field, type the amount being prescribed, based on the item’s selling unit of measure. 

4. If the selected invoice item requires inventory details to be verified, a red question mark  icon 
appears. Click the icon, and enter the inventory details and click the Verified check box to verify the 
details for each item.  

After entering inventory details and clicking OK, the red question mark icon changes to a green 

check mark  icon on the Prescription Information dialog box. You will not be allowed to post an 
invoice if a location, lot number, and/or expiration date has not been selected. (This applies only to 
those items you have selected to track quantity on hand, lot numbers, expiration dates, and/or 
multiple locations.) 

5. If applicable, in the Refills field, type the number of refills allowed for the prescription. If the 
prescription does not have a set number of refills and should be refilled only when needed, select 
Refill as needed. 

6. If necessary, in the Date provided field, type the date the prescription was provided. (Cornerstone 
displays the current system date by default.) 

7. If necessary, in the Expiration Date field, type the date the prescription expires.  

8. In the Prescribed by field, type the ID of the staff member who prescribed the item by either typing 
the ID or pressing F2 to search for and select the staff member from the Staff List. 

9. If the Filled by staff is required in your practice (set in Prescriptions defaults), in the Filled by field, 
type the ID of the staff member who filled the prescription by either typing the ID or pressing F2 to 
search for and select the staff member from the Staff List. 

10. In the Instruction ID field, if applicable, enter the ID of the prescription instructions to print on the 
bottom of the prescription label by either typing the ID or pressing F2 to search for and select the 
instructions from the Prescription Instructions List. The instructions that will print display in the 
Instructions text box. 

Note: If instructions are already linked to the invoice item, those instructions appear automatically. 

11. If necessary, change the prescription instruction text that will print on the label. 

Note: The box size and font size represents the actual size of the text that will print on the 
prescription label. If the text exceeds the size of the printed area allowed, the text displays in red as 
a warning that this text will not be included on the label. Adjust accordingly until no red text displays.  

Tip: If desired, you can print prescriptions using a smaller font by selecting the Small fonts check 
box in Prescriptions defaults. 

12. To review the instruction text for spelling errors, click Spell Check. 

13. If you do not want this prescription placed on the Patient Visit List (to be applied to an invoice), clear 
the Apply to invoice check box. 

Tip: Clear the Apply to invoice check box if the item has already been invoiced but the label needs 
to be printed or reprinted. 

14. If the Apply to invoice check box is selected, the Price field displays the current price of the item 
based on the quantity listed on the prescription. If necessary, change the price.  
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15. If using revenue centers, in the Revenue Center field, enter the revenue center to which this 
prescription is assigned by either typing the Revenue ID or pressing F2 to search for and select the 
revenue center from the Revenue Center List. 

16. Click OK to save the prescription and place it in the patient’s medical history. If Apply to Invoice 
was selected, Cornerstone also places the prescription on the Patient Visit List.  

Note: If the same prescription item already exists on the Patient Visit List, a message appears 
asking whether to override or add the prescription. Click Override to replace the prescription on the 
Patient Visit List with the current prescription. Click Add to include the prescription along with the 
already existing prescription item. 

17. On the Cornerstone Print Options dialog box, click OK to print a prescription label or click Cancel to 
exit without printing. (See “Printing Prescription Labels” on page 298 for more information.)  

Refilling a Prescription 
You can easily refill a patient’s prescription if there are refills available. 

Note: The selected prescription must have refills available in order to refill the prescription. 

To refill a prescription: 

1. With the patient’s record open on the Patient Clipboard, in the Patient History area, click the 
Summary, Text or Rx tab. 

2. Highlight the most recent prescription of the item to refill, and then right-click and select Refill. The 
Prescription Information – Refill dialog box appears for the selected prescription. 

 
Prescription Information – Refill dialog box 

3. The Quantity field displays the original amount prescribed for the patient. If necessary, type a new 
amount of the item dispensed for this refill of the prescription. 

Note: The entered quantity cannot exceed the remaining quantity listed in the Remaining Qty field, 
which displays the remaining quantity available for refilling this prescription out of the total quantity 
originally prescribed. 

4. Depending on how the prescription was originally set up, either the Refills field or the Refill as 
needed option will be available. If necessary, adjust the number of refills for this prescription. 
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5. Complete the remaining prescription information fields as needed. (See “Creating a Prescription” on 
page 294 for information on prescription information fields.) 

6. When finished, click OK to save the prescription and place it in the patient’s medical history. If Apply 
to invoice was selected, Cornerstone also places the prescription on the Patient Visit List. 

7. On the Cornerstone Print Options dialog box, click OK to print a prescription label or click Cancel to 
exit without printing. (See “Printing Prescription Labels” on page 298 for more information.) 

 For a list of prescriptions with refills remaining, print a Prescription Refill Log Report.  

Renewing a Prescription 
You can create a new prescription based on a previous prescription’s information by renewing it. 

To renew a prescription: 

1. With the patient’s record open on the Patient Clipboard, in the Patient History area, click the 
Summary, Text or Rx tab. 

2. Highlight the most recent prescription of the item to renew, and then right-click and select Renew. 
The Prescription Information – Renew dialog box appears for the selected prescription. 

3. Enter prescription information (quantity, refills, expiration date, etc.). (See “Creating a Prescription” 
on page 294 for information on prescription information fields.) 

4. When finished, click OK to save the prescription and place it in the patient’s medical history. If Apply 
to invoice was selected, Cornerstone also places the prescription on the Patient Visit List. 

5. On the Cornerstone Print Options dialog box, click OK to print a prescription label or click Cancel to 
exit without printing. (See “Printing Prescription Labels” on page 298 for more information.) 

Correcting a Prescription 
If wrong information was entered for a prescription, you can easily correct it. The old prescription 
appears as a voided prescription in the patient’s history. 

To correct a prescription: 

1. With the patient’s record open on the Patient Clipboard, in the Patient History area, click the 
Summary, Text or Rx tab. 

2. Highlight the prescription to correct, and then right-click and select Correct. The Prescription 
Information - Renew dialog box appears for the selected prescription. 

3. Make any necessary corrections to the prescription information fields. (See “Creating a Prescription” 
on page 294 for information on prescription information fields.) 

4. When finished, click OK to save the prescription and place it in the patient’s medical history. If Apply 
to invoice was selected, Cornerstone also places the prescription on the Patient Visit List. 

5. On the Cornerstone Print Options dialog box, click OK to print a prescription label or click Cancel to 
exit without printing. (See “Printing Prescription Labels” on page 298 for more information.) 

Voiding a Prescription 
To cancel a prescription, you can void it. If you then want to refill or renew the prescription, you must use 
a previous prescription for that item or create a new prescription. 

Note: It is only possible to void the most recent action on a prescription. You cannot void a prescription 
until any refilled prescriptions have been voided.  
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To void a prescription: 

1. With the patient’s record open on the Patient Clipboard, in the Patient History area, click the 
Summary, Text or Rx tab. 

2. Highlight the prescription to void, and then right-click and select Void. 

3. A message appears asking if you would like to void the selected prescription. Click Yes to confirm 
the void. 

If the Hide voided items option is selected on the Patient Clipboard, the voided prescription is hidden in 
the Patient History area. 

Printing Prescription Labels 
Although Cornerstone automatically prompts you to print a prescription label when you create, refill or 
renew a prescription, you can print (or reprint) a prescription label at any time. 

To print or reprint a prescription label: 

1. With the patient’s record open on the Patient Clipboard, in the Patient History area, click the 
Summary, Text or Rx tab. 

2. Highlight the applicable prescription, and then right-click and select View. The Prescription 
Information - View dialog box appears. 

3. Click the Preview button if you would like to preview the prescription label in a Print Preview window 
before printing the label or saving the data from the label to a file. 

4. Click the Print button to print the prescription label directly to a selected printer. The Cornerstone 
Print Options dialog box appears. 

5. The Printer field displays the default printer selected within Printer Assignments for prescription 
labels (select File > Printer Assignment > General Reports > Prescription Labels). If you would 
like to print the label on a different printer, click the Printer button to access the Printer Selection 
dialog box and select the desired printer. 

6. In the Copies field, type the number of label copies to print. 

7. Click OK to print the label. 

Prescription Reports 
Cornerstone includes several reports related to prescription labels.  

To access Prescription reports: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 

2. In the Reports list, click the plus sign to the left of Prescription to expand the list of prescription 
reports. 
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Prescription reports 

Tip: You can also view prescriptions in a patient’s medical history by printing the Patient History 
Report. When creating the report, under History, make sure Prescriptions is selected. (On the report, 
history entries of type P are prescriptions.) 

Prescription History Report 

Use the Prescription History Report to see which items have been prescribed for which patients and by 
whom. This report can be sorted by client ID or last name, invoice item description or prescription date. 

 

 

Prescription Instructions Report 

Use the Prescription Instructions Report to see the instruction IDs currently set up in Cornerstone. This 
report can be sorted by prescription instruction or prescription ID. 
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Prescription Refill Log 

The Prescription Refill Log Report contains the same information as the Prescription History Report, but 
only for prescriptions with refills remaining. This report can be sorted by client last name or invoice item 
description. 
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This chapter covers getting started with daily usage tasks in Cornerstone Inventory. For information on 
items and inventory setup, see “Chapter 7: Getting Started with Cornerstone Inventory Setup” in the 
Cornerstone Administrator’s Manual. 

 

Overview 
One of the main purposes of Cornerstone* Inventory is to help you track your inventory so you can 
manage your practice’s cash flow more efficiently. In order to track your inventory correctly, you will want 
to be able to quickly see information about inventory items. 

This chapter covers the following tasks to help you get started using Cornerstone Inventory: 

• Accessing Cornerstone Inventory 

• Determining if you are using a single location or multiple location inventory system (different work 
flows and associated documentation and training are used with each type of inventory system) 

• Working with Cornerstone Inventory windows 

• Searching for inventory items 

• Accounting for internal stock usage 

Before You Begin 

• Security access to inventory features should be set up prior to using Cornerstone Inventory. For 
more information, see the Cornerstone Staff Security instructions you received separately when you 
purchased the Cornerstone software. 

• Before using Cornerstone Inventory, you first need to add your inventory items and set up the 
inventory system to meet the needs of your practice. See “Chapter 10: Setting Up Your Invoice 
Items” in the Cornerstone Administrator’s Manual for more information setting up Cornerstone 
Inventory. 

• The inventory windows require that Windows® Internet Explorer® 7 or later be installed on each 
workstation. It does not have to be used as the default Internet browser. 

Accessing Cornerstone Inventory 

To access Cornerstone Inventory features: 

 Select the Cornerstone Inventory feature from the Inventory menu on the Cornerstone menu bar.  

Using Cornerstone Inventory – Single or Multiple Location System 
Depending on the needs of your practice, your Cornerstone Inventory system may have initially been set 
up as a single location (the default) or multiple location (advanced) system.  

• With single location inventory, an inventory item is stored in only one location.  

• With multiple location inventory, each item can have quantities stored in multiple locations (any 
item can be used in any location). 
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See “Chapter 7: Getting Started with Cornerstone Inventory Setup” in the Cornerstone Administrator’s 
Manual for more information on the differences between single and multiple location inventory systems. 

How Can I Tell Which Type of Inventory Setup Is in Use Now? 

For Cornerstone versions 7.6 and above, you can check to see what type of inventory setup was 
installed by checking the display of your Purchasing Work List window (Inventory > Purchasing Work 
List). If you have single location inventory, the Want/Suggested List tab is the only tab available at the 
top of the window. If you have multiple location inventory, the advanced Locate an Item and Quantity at 
Location tabs are also available. 

Tip: For Cornerstone versions 7.6 and above, single location inventory is the default inventory setup 
used for all new Cornerstone system installations. 

Working within Cornerstone Inventory Windows 
Note: There are two styles of windows within Cornerstone Inventory. For windows that have been 
updated to the grid style, see “Working with Invoice Item Grid Sort and Display Options” below. 

Arranging Columns 

Within most Cornerstone Inventory windows, columns can be added, removed and rearranged. The 
arrangement of columns is based on which user is logged into Cornerstone. Once a user sets a column 
arrangement, it is displayed every time that user logs in. 

 

To rearrange columns: 

1. From any of the applicable inventory windows, click a column header. 

2. While holding the mouse button, drag the column to a different position on the grid. 

To adjust the column width: 

1. Move the mouse arrow across the specific column header to adjust until a double arrow appears. 

2. Hold down the mouse button and drag the mouse to resize the column. 

Click heading to sort 
by column. An arrow 
marks the column and 
the order of the data 
being sorted. 

Click and drag 
column to 
change column 
display order. 

Click and drag a 
column divider to 
expand a column. 

Right-click on the 
heading line and select 
the columns to view. 
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To add and remove columns: 

1. Right-click on a column header. 

2. Left-click to place a check mark next to the name of a column to add it to the grid or left-click on an 
existing check mark to remove the column from the grid. 

To sort items by column: 

1. Click the title of the column to sort the list of items according to that column’s name. 

2. Click the title of the column again to sort the item list in the reverse order. 

Viewing On-Screen Help Information 

You can view helpful tips and instructions on many of the Cornerstone Inventory windows. 

 
On-screen tips and instructions shown on the Receive Order window in Cornerstone Inventory 

Working with Invoice Item Grid Sort and Display Options 
Beginning with Cornerstone 8.3, many Cornerstone Inventory windows have been updated to feature a 
new invoice item grid that provides enhanced sort and display settings (selected columns, column 
order, sort order, etc.) that you can change based on your preferences for viewing the information. 

To rearrange columns within a table: 

 Click and drag a column header (column name) to the left or right 
to move it to the desired location within all currently displayed 
columns. 

To change the table sort order: 

1. If you want to change the order in which information is 
displayed in a table, click the name of the column by which you 
would like to sort the table. A small triangle displays to the right 
of the column name to indicate the column used for the current 
sort order. 
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2. Click the same column header again to reverse the sorting order.  

Note: You can also right-click a column header and select Sort Ascending or Sort Descending to set 
the sort order for a table. The Search for Inventory Item dialog box contains a subset of the search 
options that are listed in the right-click menu.  

To change the table display using the right-click menu options: 

Right-click a column header and select one of the following menu options: 

• Columns (allows you to select/deselect columns to display in the table) 

• Group by [column header] 

• Freeze/Unfreeze [column header] 

Searching for Inventory Items 
The Search for Inventory Item window is used within Cornerstone Inventory to search for and select 
inventory items.  

 

Tip: A Quantity on Hand icon appearing next to the item indicates the inventory item is marked to 
Maintain Quantity on Hand (QOH) in Cornerstone.  

To access the Search for Inventory Item window: 

 Press F2 or double-click in any searchable item ID field within Cornerstone Inventory to display the 

window. The window also appears when you click the magnifying glass  icon next to an item 
field. 

To perform a search: 

1. Use the following search options as needed to narrow your search parameters: 

• From the Vendor drop-down list, select a vendor. 

• From the Classification drop-down list, select an inventory class. 

• In the Description text box, type the beginning letters or full description of the item. This is not 
case sensitive. Select the Search for a word check box to search by keyword. 
Tip: Use the % character as a wildcard before or after a word to enhance searching. 

Cornerstone User’s Manual                  305 



Chapter 21: Getting Started Using Cornerstone* Inventory 

• In the Item ID text box, type the item ID or a portion of the ID. Matches will be suggested as 
you type; matches include all IDs that contain the typed characters in the order given. 

• Select the Search vendor item IDs (only) check box  

• Select the Include inactive inventory items check box. 

Results will display in the list based on the criteria you have entered. Use the navigation arrows at 
the bottom of the window to move through the pages of results. Use the Results per page drop-
down list to control the number of results that display on one page. 
Note: Click Reset to clear the search filters and start a new search. 

2. When you have found the inventory item, select the item in the list and click Select. The Search for 
Inventory Item window closes and the selection appears in the Item field. 

To add a new inventory item to Cornerstone during a search: 

1. From the Search for Inventory Item window, click Add an Item at the bottom of the window to insert 
a new inventory item into the Cornerstone database. 

2. Enter a unique identification code to assign the item in the Item ID field, or press TAB in the Item ID 
field to have Cornerstone automatically assign the next available item ID when adding a new 
inventory item.  

Note: Auto assigned IDs must be enabled by selecting the Auto assign check box in Invoice Item 
defaults (select Controls > Defaults > Practice and Workstation, and then select Invoice Item 
from the menu on the left). 

3. Select the category the item belongs to from the Classification drop-down list. 

4. Type a descriptive name for the item in the Description field. 

5. Select the selling unit of the item from the Unit of measure drop-down list. 

6. Click Save. 

Note: You can set up additional information for the inventory item in Invoice Item Information (Lists 
> Invoice Item) when time allows.  

Internal Stock Usage 
Use the Internal Stock Use feature to deplete tracked inventory items used internally by the practice but 
not invoiced. Through internal usage, you can track the cost of doing business in the different aspects of 
your practice.  

Cost Centers are the areas within the practice where items are used. Some examples of items used 
internally are suture kits, needles, syringes, and catheters, food used for boarding animals, gloves, and 
cotton swabs. 

Note the following when using the Internal Stock Use feature: 

• Only inventory items that have been marked to Maintain Quantity on Hand (QOH) can be used. 

• Any items that are accounted for in internal usage are then taken out of the item’s quantity on hand. 

• You can add to the Internal Usage list after saving it; however, previously saved items cannot be 
modified. 

• You cannot deduct Group or Service items through internal usage. 

Cornerstone User’s Manual                  306 



Chapter 21: Getting Started Using Cornerstone* Inventory 

Before You Begin 

• Set up any Usage Taxes. See “Chapter 10: Setting Up Your Invoice Items” in the Cornerstone 
Administrator’s Manual for information. 

• Set up your practice’s Cost Centers. See “Chapter 7: Getting Started with Cornerstone Inventory 
Setup” in the Cornerstone Administrator’s Manual for information. 

To account for inventory used internally: 

1. On the Inventory menu, select Internal Stock Use. The Internal Stock Use window appears. 

 
Internal Stock Use window 

2. Search for and select the item used internally by the practice in the Item field. The selling unit of 
measure automatically displays in the UOM field. This field cannot be modified. 

3. Enter the amount to be removed from inventory in the Quantity field. This number should be based 
on the selling unit of measure displayed in the UOM field.  

4. If tracking, type the lot number of the inventory item being depleted in the Lot number field. 

5. If applicable, enter the expiration date of the inventory item being depleted in the Expiration field. 

6. If applicable, modify the date the item was removed from inventory in the Date used field. The 
current system date automatically appears in this field. 

7. Multiple location inventory only: Select which place is being depleted of this inventory item from the 
From location drop-down list. 

8. Select the area that will be charged for the use of the item from the Charge to cost center drop-
down list. 

9. If applicable, highlight the tax to apply to this item in the Usage taxes to apply list box. This 
generally applies when the practice pays tax on the item when it is used in-house but doesn’t pay 
tax for it when it is received from the vendor. 

10. If necessary, modify the vendor’s selling unit cost for this item in the Cost field. The cost field 
displays the average cost of the item if tracking QOH. 

11. Click Print to preview, save and/or print the Inventory – Internal Usage Report. 

12. Click Back to return to the Internal Stock Use window. 

13. Click Save to process the depletion of the inventory item from Cornerstone. 
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 To view a list of items used internally, print an Inventory – Internal Usage Report. (See “Inventory - 
Internal Usage Report” on page 336.)  
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This chapter covers processes for using a single location inventory system. For information on setting up 
a single location inventory system, see “Chapter 8: Setting Up a Single Location Inventory System” in the 
Cornerstone Administrator’s Manual. 

 

This chapter covers the following daily usage tasks for a single location inventory system: 

• Adding items to the Want List 

• Managing items using the Purchasing Work List 

• Viewing item purchase history and item information  

Adding Items to the Want List (Single Location Inventory) 
Item order requests can be made on the Want List. Practice staff can use the Want List as a shopping 
list of items—you can add an item that already exists in your system or you can add an item that is not 
carried in inventory. 

• Items placed on the Want List become available to the Purchasing Work List where they can be 
placed on a purchase order and ordered. 

• Items on the Want List can be viewed for a staff member, a status, or a date range. 

• After items are placed on a purchase order and/or an order is placed, depending on practice policy, 
the want item is removed from the Want List or the item’s Status on the Want List is changed from 
Not Done to Complete. 

Tip: To always remove want items from the Want List after they are placed on a purchase order, select 
the Delete want items on completed check box in Inventory defaults (select Controls > Defaults > 
Practice and Workstation, and then select Inventory from the menu on the left).  

To add items to the Want List: 

1. On the Inventory menu, select Want List, or on the toolbar, click the Want List  button. The 
Want List dialog box appears. 

 
Want List dialog box 

2. If the want item is an inventory item, leave the Inventory item check box selected and type the item 

ID in the Item ID text box or press F2 (or click ) to search for and select the ID from the Search 

Cornerstone User’s Manual                  309 



Chapter 22: Using a Single Location Inventory System 

for Inventory Item dialog box. 
OR 
If the want item is not an inventory item, select the Not an inventory item check box, type a 
description, and click OK. The item will appear on the Want List without an item ID. 

3. Inventory Item only: Type the quantity to order in the Quantity text box or in the UOM Quantity text 
box (right box). When you enter the amount in either box, the other box is automatically calculated. If 
left blank, the quantity must be added when the item is placed on an order. 

4. Inventory Item only: If necessary, in the Reason text box, type a reason for requesting the item. The 
reason will print on the Inventory – Want List Report. 

5. Click OK to place the item on the Want List. 

Notes: 

• The item must be set up in Cornerstone before you can order it. 

•  After an item is added to the Want List, it is no longer editable. To view all items on the Want List, 
select Inventory > Purchasing Work List and click the Want List tab. To remove the item, access 
the Purchasing Work List, select the item and click Remove from List. 

Managing Items Using the Purchasing Work List (Single Location Inventory) 
The multi-purpose Purchasing Work List window allows you to do the following: 

• View and select items requested by staff (Want List) and items suggested by the system because 
they are below the reorder point (Suggested List) 

• Open the Want List using the add to Want List link 

• Remove items from the Want List 

• Find a specific item at your practice 

• View the quantity on hand of items available at a location or for a class 

• View stocking levels, reorder points and sales history for an item 

• View item purchase history and item information 

• Add items to a new or existing purchase order 

To access the Purchasing Work List window: 

 On the Inventory menu, select Purchasing Work List. 
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Purchasing Work List window for a single location inventory system 

To search for and view items requested by staff and suggested by the system: 

1. On the Purchasing Work List window, click the Want/Suggested List tab. 

2. Use the following item search criteria as needed to narrow your item search: 

• Select the status of an item requested by staff from the Status drop-down list. This will narrow 
the list to wanted items based on the status selected including all, not done or complete (placed 
on an order). 

• Select the Want Item check box to include items requested by staff members on the list. 

• Select the Suggested Item check box to include items at or below the reorder point set by the 
practice on the list. 

3. Click Search to display the list of inventory items based on the specified criteria. 

Tip: You can change the display of the items list to make it easier to identify specific types of items. 
See “Working within Cornerstone Inventory Windows” on page 303 for information. 

4. To remove an item requested by staff through the Want List, select the item and click Remove from 
List to remove it from the list (Want List items are indicated by the Want List icon ). If a 
confirmation window appears, click Yes. 

Tip: You can assign staff-specific defaults for auto-saving inventory changes and auto-deleting in 
inventory (delete without confirming). For more information, see “Chapter 5: Setting Staff Defaults” in 
the Cornerstone Administrator’s Manual. 

Note: The total cost of selected items based on last cost of item is displayed below the item list. 
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To view stocking levels, reorder points and sales history for an item: 

1. On the Purchasing Work List window, select the item for which you want to view item details.  

2. In the Item Details area on the right side of the window, note information for the item, including the 
location stocking levels and today’s reorder points. 

3. Click the Sales History link to view the item’s sales history for the last three years, including year-to-
date and month-to-date totals. 

To add items to a purchase order: 

1. On any of the Purchasing Work List tabs, select the item(s) to be ordered. 

• To select nonconsecutive items, hold down CTRL, and then click each item you want to select. 

• To select a consecutive group of items, click the first item, hold down SHIFT, and then click the 
last item.  

Tip: Click the Vendor column heading to sort items by vendor. 

2. In the Add to Order area on the right side of the window, make changes to the order details as 
needed: 

• Select the vendor the product(s) will be ordered from in the Vendor drop-down list. If a 
highlighted item(s) is assigned to a primary vendor, that vendor’s name will appear by default in 
the Vendor field. 

• Enter the amount to order in the Order Quantity text box, based on the buying unit of measure 
displayed in the Unit of Measure text box. The order quantity is usually entered if there is only 
one item being added to an order. The unit of measure automatically displays when one item is 
selected and has a buy unit of measure assigned to the item. 

• Type information pertaining to the product in the Notes field. 

3. Click Add to Order to display the Purchase Order View window. This creates a new purchase order 
for the selected item(s) or includes the selected item(s) on an existing purchase order, if there is a 
saved order for the selected vendor. 

4. If this is a new order with the vendor, press TAB. This will automatically insert the next available order 
number in the Purchase order number field. 

5. Verify the correct vendor is in the Vendor field. If necessary, select the vendor from the drop-down 
list. 

6. If necessary, enter or change purchase order information for the items (Qty, UOM, special price, 
cost, status). 

7. If applicable, click the note  icon to type a note. After the note is saved, the icon changes to a 
notepad , indicating a note exists for the item. 

8. If necessary, select an item and click Remove from Order to remove the item from the order. 

9. When finished adding items to the purchase order, do one of the following: 

• Click Save to save purchase order information and make modifications at a later time (will be 
marked as Not Sent). Once you’ve saved the order, you can click Print to print it. 

• Click Place Order to save the purchase order and process the order so it is ready to be 
received by the vendor (will be marked as Sent). 

• Click Cancel to return to the previous window without saving or placing the order. 
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Viewing Item Purchase History and Item Information  
A group of expandable tabs provides information for inventory items marked to Maintain Quantity on 
Hand (QOH). The tabs are available at the bottom of many of the Cornerstone Inventory windows (Add 
New and Edit Purchase Order windows, Add New and Edit Receive Order windows, View Quantity on 
Hand, and Purchasing Work List windows). 

• Item History tab – Displays purchase history information. 

 

• Item information tab – Displays general information for inventory items marked to Maintain QOH. 

 

To view item purchase history and item information: 

1. Select an inventory item, if available. 

2. Click the More Item Information For or Information bar.  

Tip: If the item is not on an available list, click the magnifying glass  icon to search for and select 
the item. 

3. Click the Item History tab or Item Information tab to view information about an item. 

4. Select or search for the next item to view. 

5. Click the More Item Information For or Information bar when finished. 
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This chapter covers processes for using a multiple location inventory system. For information on setting 
up a multiple location inventory system, see “Chapter 9: Setting Up a Multiple Location Inventory 
System” in the Cornerstone Administrator’s Manual. 

 

This chapter covers the following daily usage tasks for a multiple location inventory system: 

• Adding items to the Want List 

• Managing items using the Purchasing Work List 

• Viewing item purchase history, item information and stock at all locations 

Adding Items to the Want List (Multi-Location Inventory) 
Item order requests can be made on the Want List. Practice staff can use the Want List as a shopping 
list of items—you can add an item that already exists in your system or you can add an item that is not 
carried in inventory. 

• Items placed on the Want List become available to the Purchasing Work List where they can be 
placed on a purchase order and ordered. 

• Items on the Want List can be viewed for a staff member, a status, or a date range. 

• After items are placed on a purchase order and/or an order is placed, depending on practice policy, 
the want item is removed from the Want List or the item’s Status on the Want List is changed from 
Not Done to Complete. 

Tip: To always remove want items from the Want List after they are placed on a purchase order, select 
the Delete want items on completed check box in Inventory defaults (select Controls > Defaults > 
Practice and Workstation, and then select Inventory from the menu on the left).  

To add items to the Want List: 

1. On the Inventory menu, select Want List, or on the toolbar, click the Want List  button. The 
Want List dialog box appears. 

 
Want List dialog box 

2. If the want item is an inventory item, leave the Inventory item check box selected and type the item 

ID in the Item ID text box or press F2 (or click ) to search for and select the ID from the Search 
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for Inventory Item dialog box. 
OR 
If the want item is not an inventory item, select the Not an inventory item check box, type a 
description, and click OK. The item will appear on the Want List without an item ID. 

3. Inventory Item only: Type the quantity to order in the Quantity text box or in the UOM Quantity text 
box (right box). When you enter the amount in either box, the other box is automatically calculated. If 
left blank, the quantity must be added when the item is placed on an order. 

4. Inventory Item only: If necessary, in the Reason text box, type a reason for requesting the item. The 
reason will print on the Inventory – Want List Report. 

5. For a multi-location per item inventory setup, if necessary, select a location or group from the 
appropriate drop-down list. 

6. Click OK to place the item on the Want List. 

Notes: 

• The item must be set up in Cornerstone before you can order it. 

•  After an item is added to the Want List, it is no longer editable. To view all items on the Want List, 
select Inventory > Purchasing Work List and click the Want List tab. To remove the item, access 
the Purchasing Work List, select the item and click Remove from List. 

Managing Items Using the Purchasing Work List (Multiple-Location Inventory) 
The multi-purpose Purchasing Work List window allows you to do the following: 

• View and select items requested by staff (Want List) and items suggested by the system because 
they are below the reorder point (Suggested List) 

• Open the Want List using the add to Want List link 

• Remove items from the Want List 

• Find a specific item at your practice 

• View the quantity on hand of items available at a location or for a class 

• View stocking levels, reorder points and sales history for an item 

• View item purchase history and item information 

• Add items to a new or existing purchase order 

Note: You can click Go to Transfer to access the Find and Transfer Items window to move items from 
one location to another location. 

To access the Purchasing Work List window: 

 On the Inventory menu, select Purchasing Work List. 
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Purchasing Work List window for a multiple location inventory system 

To search for and view items requested by staff and suggested by the system: 

1. On the Purchasing Work List window, click the Want/Suggested List tab. 

2. Use the following item search criteria as needed to narrow your item search: 

• Select a location group from the Group drop-down list to narrow the list of items to those 
requested by staff (Want List items) or on/below the order point set up by the practice 
(Suggested items) for a specific group of locations. 

• Select the status of an item requested by staff from the Status drop-down list. This will narrow 
the list to wanted items based on the status selected including all, not done or complete (placed 
on an order). 

• Select the Want Item check box to include items requested by staff members on the list. 

• Select the Suggested Item check box to include items at or below the reorder point set by the 
practice on the list. 

Note: If multiple locations are set up, at some locations, items at or below their reorder point may 
not appear on the Suggested List if they are overstocked in other locations. In this case, you could 
use the Go to Transfer option to move items from one location to another location.  

3. Click Search to display the list of inventory items based on the specified criteria. 

Tip: You can change the display of the items list to make it easier to identify specific types of items. 
See “Working within Cornerstone Inventory Windows” on page 303 for information. 

4. To remove an item requested by staff through the Want List, select the item and click Remove from 
List to remove it from the list (Want List items are indicated by the Want List icon ). If a 
confirmation window appears, click Yes. 

Tip: You can assign staff-specific defaults for auto-saving inventory changes and auto-deleting in 
inventory (delete without confirming). For more information, see “Chapter 5: Setting Staff Defaults” in 
the Cornerstone Administrator’s Manual. 

Note: The total cost of selected items based on last cost of item is displayed below the item list. 
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To view stocking levels, reorder points and sales history for an item: 

1. On the Purchasing Work List window, select the item for which you want to view item details.  

2. In the Item Details area on the right side of the window, note information for the item, including the 
location stocking levels and today’s reorder points. 

3. Click the Sales History link to view the item’s sales history for the last three years, including year-to-
date and month-to-date totals. 

To find a specific item at your practice: 

1. On the Purchasing Work List window, click the Locate an Item tab. 

Note: If an item is highlighted in another tab of the Purchasing Work List, and the Locate an Item tab 
is selected, quantity information for the item displays. 

2. Use the following item search criteria as needed to narrow your item search: 

• In the Item ID field, search for and select an inventory item to view. 

• Select a group of locations in the Group drop-down list to view the quantity on hand for the item 
in that group of locations only. 

• Select a location in the Location drop-down list to view the quantity on hand for the inventory 
item in that location only. 

To view the quantity on hand of items available at a location or for a class: 

1. On the Purchasing Work List window, click the Quantity at Location tab. 

2. To view the quantity on hand of all items at a specific location, select a location in the Location 
drop-down list. 

3. To view the quantity on hand of items assigned to a specific class, select a class in the 
Classification drop-down list. 

To add items to a purchase order: 

1. On any of the Purchasing Work List tabs, select the item(s) to be ordered. 

• To select nonconsecutive items, hold down CTRL, and then click each item you want to select. 

• To select a consecutive group of items, click the first item, hold down SHIFT, and then click the 
last item.  

Tip: Click the Vendor column heading to sort items by vendor. 

2. In the Add to Order area on the right side of the window, make changes to the order details as 
needed: 

• Select the vendor the product(s) will be ordered from in the Vendor drop-down list. If a 
highlighted item(s) is assigned to a primary vendor, that vendor’s name will appear by default in 
the Vendor field. 

• Enter the amount to order in the Order Quantity text box, based on the buying unit of measure 
displayed in the Unit of Measure text box. The order quantity is usually entered if there is only 
one item being added to an order. The unit of measure automatically displays when one item is 
selected and has a buy unit of measure assigned to the item. 

• Type information pertaining to the product in the Notes field. 
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3. Click Add to Order to display the Purchase Order View window. This creates a new purchase order 
for the selected item(s) or includes the selected item(s) on an existing purchase order, if there is a 
saved order for the selected vendor. 

4. If this is a new order with the vendor, press TAB. This will automatically insert the next available order 
number in the Purchase order number field. 

5. Verify the correct vendor is in the Vendor field. If necessary, select the vendor from the drop-down 
list. 

6. If necessary, enter or change purchase order information for the items (Qty, UOM, special price, 
cost, status). 

7. If applicable, click the note  icon to type a note. After the note is saved, the icon changes to a 
notepad , indicating a note exists for the item. 

8. If necessary, select an item and click Remove from Order to remove the item from the order. 

9. When finished adding items to the purchase order, do one of the following: 

• Click Save to save purchase order information and make modifications at a later time (will be 
marked as Not Sent). Once you’ve saved the order, you can click Print to print it. 

• Click Place Order to save the purchase order and process the order so it is ready to be 
received by the vendor (will be marked as Sent). 

• Click Cancel to return to the previous window without saving or placing the order. 

Viewing Item Purchase History and Item Information 
A group of expandable tabs provides information for inventory items marked to Maintain Quantity on 
Hand (QOH). The tabs are available at the bottom of many of the Cornerstone Inventory windows (Add 
New and Edit Purchase Order windows, Add New and Edit Receive Order windows, View Quantity on 
Hand, and Purchasing Work List windows). 

• Item History tab – Displays purchase history information.
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• Item information tab – Displays general information for inventory items marked to Maintain QOH.

 

To view item purchase history and item information: 

1. Select an inventory item, if available. 

2. Click the More Item Information For or Information bar.  

Tip: If the item is not on an available list, click the magnifying glass  icon to search for and select 
the item. 

3. Click the Item History tab or Item Information tab to view information about an item. 

4. Select or search for the next item to view. 

5. Click the More Item Information or Information bar when finished. 
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This chapter provides information on several additional Cornerstone* Inventory tasks that are common 
to both Single and Multiple Location Inventory systems. These tasks include: 

• Managing orders using the Order List 

• Saving and posting a receipt 

• Editing backorder information 

• Return an item to a vendor 

• Generating inventory reports 

Managing Orders Using the Order List 
Purchase orders provide a record of items that are ordered from a vendor. After a purchase order is 
created and saved and/or an order is placed, the purchase order can be reopened, items can be added 
and order information can be edited, if necessary. 

To track items on order with vendors and orders that have been partially received from vendors within 
Cornerstone, use the Order List window. The list automatically displays orders managed by 
staff/management within the past two weeks. 

To view and manage existing purchase orders using the Order List: 

1. On the Inventory menu, select Order List. The Purchase Order List window appears. 

 
Purchase Order List window 
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2. To find an order or orders: 

• Select a vendor from the Vendor drop-down list to view purchase orders for the specified 
vendor only. 

• Select a status from the Status drop-down list to view purchase orders for the specified status 
only. Status options include: 

o Not Sent – The order has been saved but not placed. This is useful if more items will be 
added to the order at a later date. 

o Sent – The order is ready for the vendor and has been placed in Cornerstone. When 
working with receipts for the vendor, the item(s) will appear on the list of items ready to be 
received. 

o Partial – The practice has received one or more, not all, items on a placed order from the 
vendor within the Receipt List. 

o Closed – All items on the order were received or the order was manually closed by the 
practice (orders are typically closed manually only if the order is cancelled). 

• In the Date Range boxes, enter the date range to include. The date two weeks prior to the 
current system date appears by default. 

3. If you entered search criteria, click Search. Orders that match the criteria entered will appear on the 
list. 

4. To modify an existing purchase order created in Cornerstone, select an order with a status of Not 
sent or Sent and click Edit. 

5. To preview, print or save an Inventory – Purchase Order Report, select a purchase order and click 
Print. 

6. To remove an order from Cornerstone, select a purchase order with a status of Not sent and click 
Remove Order. 

7. To manually cancel the remaining items on order, select a purchase order with a status of Sent or 
Partial and click Close Order. The status of the purchase order is changed to Closed and any 
backorders or quantities that have not been received are cancelled. 

8. To go directly to the Receive Order window and receive the order, select a purchase order with a 
status of Sent or Partial and click Receive Order. 

To add a new purchase order using the Order List: 

1. On the Inventory menu, select Order List. The Order List window appears. 

2. Click Add New Order to create a new purchase order for a vendor. The Create Purchase Order 
window appears. 

3. In the PO Number text box, enter a unique number to track the purchase order within Cornerstone, 
or press TAB to have Cornerstone automatically generate the next available purchase order number. 

4. From the Vendor drop-down list, select the vendor with whom the order will be placed. 

5. If applicable, from the Group drop-down list, select the group of locations for which the items are 
being ordered. 

6. Search for and select the item to add to this order in the ID field, and press TAB. The name of the 
item to be ordered will display in the Description field, and the person currently logged into 
Cornerstone is listed in the Ordered by field. 
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Note: Text in red may indicate the item is on another purchase order or the item is overstocked at 
the location. 

Tip: The description can be manually changed if the item is marked as a Miscellaneous item on 
the Invoice Item Information window’s Info tab. However, when printing the purchase order, the 
original description appears. 

7. Enter the total amount of the item to be ordered, based on unit of measure (UOM), in the Qty field. 

8. If necessary, select a different unit of measure in the UOM field. The buy unit of measure displays by 
default. 

9. If the buy/sell ratio is set for the item and the unit is changed to the selling unit, the quantity is 
calculated according to the ratio. 

10. If the item will be purchased at a special price, select Yes from the SP drop-down list. The item’s 
vendor cost will not update when received, which, in turn, will not affect the average cost. Examples 
of items purchased at special cost include free samples and promotional items. 

11. If necessary, adjust the vendor’s cost of the item, based on the unit of measure, in the Cost field. 
The previous cost for the item displays in the Cost field by default if the item was previously received 
from the vendor. The Total value field in the lower right area of the window will display the total cost 
of all items on the purchase order. 

12. If necessary, modify the state of the item being ordered by selecting an option from the Status drop-
down. Status options include: 

• Ordered – This option indicates the item is ready to be received by the vendor. 

• Backordered – This option indicates the item being ordered from the vendor is not immediately 
available for delivery but will be available from the vendor at a later date. 

13. If necessary, click the note  icon to type a note. After the note is saved the icon changes to a 
notepad , indicating a note exists for the item. This note will be available when receiving the item 
from the vendor and prints on the purchase order if the Print purchase order notes check box is 
selected in Inventory defaults. 

14. Continue to add items as needed, until all items being ordered from the vendor are added to the 
purchase order. 

15. Click Print to preview, print or save a copy of this purchase order in report form. 

16. If necessary, select an item and click Remove from Order to remove it from the purchase order. 

17. When finished adding items to the purchase order, do one of the following: 

• Click Save to save purchase order information and make modifications at a later time (will be 
marked as Not Sent). If saving, the purchase order has not been placed at this point, it will not 
display in the Receive Order window. 

• Click Place Order to save the purchase order and process the order so it is ready to be 
received by the vendor (will be marked as Sent). If placing the order, the items from the order 
appear on the Receive Order window for the vendor. 

• Click Cancel to return to the previous window without saving or placing the order. 

Saving and Posting a Receipt 
The Receipt List is used to enter inventory received by various vendors into Cornerstone. 
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To search for receipts from the Receipt List: 

1. On the Inventory menu, select Receipt List. The Receipt List window appears. 

 
Receipt List window 

2. Use the fields in the Find receipts area to find a receipt or receipts: 

• Select a vendor from the Vendor drop-down list to view receipts for the specified vendor only. 

• Select a status from the Status drop-down list to view receipts for the specified status only. 
Status options include: 

o All – includes all receipts regardless of status. 

o Posted – Receipts that have been processed. It is not possible to modify receipts once 
posted. 

o Not posted – Receipts that have been saved but not processed. This is useful if more items 
will be added to the receipt at a later date. 

• Manually type a beginning date in the From field or click the drop-down arrow and select a date 
from the calendar in order to find receipts on or after the selected date. The date two weeks 
prior to the current system date appears by default. 

• Manually type an ending date in the To field or click the drop-down arrow and select a date from 
the calendar in order to find receipts on or before the selected date. The current system date 
appears by default in this field. 

3. If criteria were entered in the Find receipts area of the Receipt List, click Search. Receipts that 
match the criteria entered will appear on the list. 

4. To display the Receive Order window and review information for the receipt, select a receipt and 
click View.  

5. To preview, print or save an Inventory – Receipt Report, select a receipt and click Print. 

6. To remove a receipt from Cornerstone, select a receipt with a status of Not Posted and click Delete. 

To save a new receipt: 

1. On the Inventory menu, select Receipt List. The Receipt List window appears. 

2. Click Receive an Order. The Receive Order window appears. 

Tip: The Receive Order window can also be accessed from the Order List by selecting a purchase 
order and pressing the Receive Order button. 
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Receive Order window 

3. Use the fields in the Receipt information area to specify receipt information: 

• Select the vendor from which the items are being received from the Vendor drop-down list. 

• Type the invoice or packing slip number provided by the vendor in the Receipt number field. 
Items on a purchase order(s) for the specified vendor will display on the list below. The 
identification number assigned to the order displays in the PO number field for each item. 

• If necessary, adjust the date the shipment was received in the Date field. The current system 
date will automatically display. 

4. If necessary, select a specific saved receipt in the Open receipts for vendor list. This list displays 
open, unfinished receipts for the selected vendor. To complete a receipt that has been saved, select 
the receipt number in the Open receipts for vendor list. Items on the receipt display in the list 
below. 

5. If necessary, select the purchase order(s) to view on the list below in the Purchase order number 
drop-down list. This field lists open purchase orders that include the date the order was created. To 
limit the items to be received to one purchase order, select it from the list or, if not receiving items 
from any purchase order, select None. No items will display on the receipt. 

6. To organize the items by the purchase order number in the order of the lines on the original 
purchase order, select the Sort in original PO sequence check box. 

7. For the items appearing in the list, change the Receive Order settings for each item as needed: 

• Mark the purchase order items being received from the vendor by doing one of the following: 

o To receive items individually, click in the Status field and select Received from the drop-
down list. 

o To receive all items listed from the purchase order(s), click the Receive all button located in 
the lower portion of the window. The status of all items on the order(s) change to Received. 

• If necessary, change the status of applicable inventory items in the Status field: 
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o When a line item’s entire order quantity is backordered, change the status to Backordered. 

o When only a portion of an ordered item is received, change the status of the line item to 
Received and type the quantity receiving into inventory. This creates a second line showing 
the remaining quantity with a status of Not Received. If applicable, change the status to 
Backordered. 

o When an item’s entire order quantity is cancelled, change the status to Cancelled. 

• Verify that the total number of the item to be received in the Qty field is correct (based on the 
unit of measure in the UOM field). If necessary, enter a new quantity being received. 

Note: If an item received is less than the amount placed on the purchase order, the item will 
appear on a second line less the amount received.  

• If necessary, click the note  icon to type a note. After the note is saved, the icon changes to a 
notepad , indicating a note exists for the item. 

Note: Receipt notes display on reports and on the receipt. If there was a note added when you 
created the purchase order, the notepad icon will display for this item on the Receive Order 
window. Click this icon to display information entered during ordering. 

• If applicable, select the appropriate unit of measure from the UOM drop-down list; verify that the 
quantity and cost information is accurate based on this UOM. 

• Verify that the vendor’s cost for the product in the Cost field is correct (based on the unit of 
measure that displays). If not, enter the correct vendor’s unit cost. 

• If the item is purchased at a special price, click on the special price $ icon to change it to a 
colored  icon. As a result, the item’s vendor cost will not update, which, in turn, will not 
affect the average cost. 

• If applicable, verify that the individual tax applied to the item is correct in the Tax field. 
Alternatively, put the total tax applied to the shipment in the Total tax field in the lower portion of 
the window. If entering tax for the individual items on the receipt, the total for all line items is 
calculated and displays in the field. This information is not added to the cost of the items in 
Cornerstone. 

8. If you want to manually add items being received that are not listed on a purchase order, click in the 
next available ID field, search for and select the item, and fill in the remaining fields. 

9. If necessary, select a manually entered line item and click Remove item to delete it from the receipt. 

10. For items added through purchase orders, change the status of the item to the applicable option if 
not receiving at this time. 

11. If applicable, click Receipt item detail and complete the location, expiration date and lot number 
information for tracked inventory items appearing in red. If information is not entered the receipt 
cannot be posted.  

Tip: If the item is tracking the expiration date and/or lot number, this will be indicated by a (?) in the 
applicable field. If necessary, highlight a line item; click Copy line to add an additional line for the 
item to the list. This would occur if there are several expiration dates and/or lot numbers for an item 
or if it’s being received into multiple locations. 

12. To display the View Purchase Order window for the item, select an item and click View order. 

13. Enter the shipping charges added by the vendor in the Shipping field. 

14. Click Save And Print to preview, print or save the Inventory – Receipt Report. 
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15. Click Save to save the current receipt information and give staff the ability to make modifications at 
a later time. 

To post a saved receipt: 

1. On the Inventory menu, select Receipt List. The Receipt List window appears. 

2. Click Receive an Order to create a new receipt or select a receipt and click Edit to modify a receipt 
that has not been posted. 

3. Enter or change necessary information, and verify that the total cost of the items on the receipt 
matches the cost listed in the Total field. 

4. Click Post to process a completed receipt. The Change prices window displays each item being 
received. 

5. On the Change prices window, make any necessary changes to the pricing information for the 
items. Note the following guidelines for changing prices: 

• If the auto-calculate and markup information is set for an item, it will appear on the list. 

• The selling price of the item will be updated if the unit cost was updated when the item was 
received. The price update will not occur if the Special Price flag is selected. 

• The new pricing unit cost equals the cost of the item from the Receive Order window. 

• When receiving an item with more than one unit cost, the highest cost becomes the new unit 
cost. Staff may enter new markup information for the item in order to calculate a new price for 
the item or enter a new price to calculate the markup of the product. 

6. Click Post. The QOH, cost and receipt item details are updated. 

To receive an order from the Purchase Order List: 

1. Select Inventory > Order List. The Purchase Order List opens. 

2. Select the purchase order and click Receive Order. 

3. Type the receipt number for your order in the Receipt Number box. The item list displays.  

4. Review the order for completeness and update the status by either clicking Receive All or by 
selecting Received from the Status drop-down list for each item.   

5. Missing order information (e.g., lot number) is in red text. You must update this information before 
you can post the order. Click Receipt Item Details to fill in the remaining fields. 

6. Click Post. 

7. In the Change Prices window, make any final adjustments and view the current and new pricing, if 
applicable. 

8. When finished making any changes, click Post. 

Managing Backorders 
Backorders appear on the list if an item placed on a purchase order has a status of “Backorder” or if the 
item is placed on backorder when it’s received through the Receipt List.  

Note: An item cannot be manually added to the Backorder List. 

To search for backordered items on the Backorder List: 

1. On the Inventory menu, select Backorder List. The Backorder List window appears. 
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Backorder List window 

2. Use the fields in the Find backordered items area to find the applicable items: 

• Select a vendor from the Vendor drop-down list to narrow the list of backorders to those for a 
specific vendor. 

• Select a category of inventory items from the Classification drop-down list to narrow the list to 
items from the selected class. 

• If entering search criteria, click Search to narrow the list to the applicable criteria. 

3. To preview, print or save the purchase order to which the item is assigned, select a backordered 
item and click View Purchase Order. 

4. To preview, print or save the Inventory – Backorder Report, click Print Backorders. 

5. If necessary, select a backorder and click Cancel Backorder if the item is no longer going to be 
received on an order placed with the vendor. If a confirmation window appears, click Yes to cancel 
the backorder within Cornerstone. 

To modify a backordered item: 

1. Select the backordered item to modify on the Backorder List. 

2. Click Edit Backorder. The Backorder Detail window appears. 

3. Do the following to edit the backordered item as needed: 

• Enter a new quantity on backorder in the Backorder qty field. When modifying the quantity on 
backorder, it is only possible to enter a quantity less than was originally ordered.  

• Manually type a date or left-click the drop-down arrow to display a calendar and then choose a 
date the item is expected to be delivered in the Expected delivery drop-down list. 

• Type a note pertaining to the backordered item in the Notes field. 

4. Click Save. 

Returning Items to a Vendor 
Use the Return to Vendor feature to track inventory items returned to the vendor and automatically adjust 
inventory to account for the returns within Cornerstone. It is only possible to return items marked to 
Maintain Quantity on Hand (QOH) in Cornerstone. 

To return items to a vendor: 

1. On the Inventory menu, select Return to Vendor. The Return to Vendor window appears. 
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Return to Vendor window 

2. In the Vendor field, select the vendor to return items to. 

3. In the RMA number field, enter the vendor’s Return Merchandise Authorization number or press 
TAB if there is no RMA for the return items. 

4. In the Return date field, type or select the date of the return. 

5. Use the fields in the Find items to return area to search for inventory items to return: 

• Select a location from which the item will be returned in the Location drop-down list to narrow 
the list of items to those assigned that location. 

• In the Item field, double-click or press F2 to search for and select a specific item to return. 

• Select the primary vendor assigned the item from the Primary vendor drop-down list to narrow 
the list of items to those assigned that vendor. 

6. Click Advanced Search to search using an expanded group of search options: 

a. Multiple location inventory only: Select a group of locations in the Group drop-down list to 
narrow the list of items to that group of locations only. 

b. Select a category of locations in the Classification drop-down list to narrow the list of items to 
that class only. 

c. Type a lot number in the Lot number field to find items with that lot number. 

d. Type or select a range of dates in the Expiration date From/To fields to find items with an 
expiration date falling within the date range. 

e. When you have finished setting advanced search options, click Search. Results will display in 
the list based on the criteria you have entered. 
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f. To remove the search criteria to begin a new search, click Clear. 

g. To hide the advanced search fields, click Basic search. 

7. In the item list, select the item(s) to be sent back to the vendor. 

• To select nonconsecutive items, hold down the CTRL key, and then click each item you want to 
select. 

• To select a consecutive group of items, click the first item, hold down the SHIFT key, and then 
click the last item.  

8. Click Return. 

9. Adjust the return information for the item(s) in the Return to Vendor columns. Options include: 

• ID/Description – The item ID and name of the product to be returned. 

• Qty – The total number of items to be returned based on unit of measure. 

• UOM – The selling unit of measure of the item. 

• Lot no. – The lot number of the item, if required, to be returned. 

• Exp. Date – The expiration date of the item, if required, to be returned. 

• Cost – The unit cost of the item. 

• Tax – The individual tax of the item, if applicable. Instead of entering a tax amount for each item, 
you can choose to enter a total tax amount in the Total Tax field for all of the items. 

• Note – A note to explain why the item is being returned. 

• Ext. cost – The total cost of a line item returned. This is the unit cost of the item multiplied by the 
quantity returned. The Ext. cost column is not displayed by default, but can be added by right-
clicking in any column header and selecting Ext. cost. 

10. Select a line item in the list of returns and click Remove item to delete it from the list of items to 
return to the vendor. 

11. If applicable, enter charges that the vendor applies for restocking retuned item(s) in the Restock fee 
field. 

12. If applicable, enter any shipping charges that apply to the return in the Shipping field. 

13. If applicable, enter the total tax applied by the vendor for the item(s) in the Total tax field. If you have 
entered tax for individual returned items, this total is automatically calculated. 

14. Do one of the following: 

• Click Save to process the return and update the quantity on hand of the item(s) within 
Cornerstone. 

• Click Save & Print to process the return and preview or print the Inventory – Returns Report. 

• Click Cancel to discontinue the return. 

Inventory Reports 
Once you are up and running with using Cornerstone Inventory, you can begin to generate data to 
analyze your practice, maintain better inventory control, and determine how to increase profitability. The 
data you need is easy to collect with Cornerstone Inventory reports. 

Note: Invoice item reports are covered in “Chapter 10: Setting Up Your Invoice Items” in the Cornerstone 
Administrator’s Manual. 
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Note: Inventory reports reflect only those items marked to Maintain Quantity on Hand (QOH). 

To generate an inventory report: 

1. On the Reports menu, select Find a Report. The Report Search window appears. 

2. In the Reports list, click the plus sign [+] to the left of Inventory, and then select the applicable 
Inventory report. 

 
Inventory reports 

3. Click Create report, and then click Run. The Inventory Report Criteria Selection window appears. 
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Inventory Report Criteria Selection window 

4. From the Sort by drop-down list, select a sort option to arrange the information on the report in a 
certain order.  

5. Use the fields in the Set report range area to enter criteria and filter the information that appears on 
the report: 

a. From the Description drop-down list, select a category to use to narrow the report. 

b. In the Starting value and Ending value fields, enter the beginning criteria and ending criteria 
that will be used to narrow the report. Depending on the description selected, it may be possible 
to press F2 in the Starting value and Ending value fields to search for and select the 
appropriate item or value from a list. 

c. From the And/Or drop-down list, select the appropriate option to include additional search 
criteria—select And to include all of the description ranges entered or select Or to include any 
of the description ranges entered. 

d. To clear a range, highlight the range row and click Remove Range (or press CTRL+D). 
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6. To preview the report before printing, click Preview. If there are results that match the criteria, the 
Inventory Report Preview window displays information based on the specified sort order and range. 

 
Inventory Report Preview window 

7. Change the page that is displayed in the preview window by clicking First Page ,  

Previous Page , Next Page , or Last Page . 

8. Change how large the page is displayed by clicking: 

 Actual Size to show the page in its actual size 

 Fit Page to resize so the whole page is visible 

 Fit Width to resize so that the page is shown as wide as the window 

 Zoom In to display the page larger 

 Zoom Out to display the page smaller 

 Zoom Ratio to either select a zoom percentage from the drop-down menu or type a 
percentage and press ENTER to resize to that zoom percentage 

9. To print the report from the preview window, click Print , or to save the information to a file, click 

Save . 

10. Click Back to return to the Inventory Report Criteria Selection window. 
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11. To print the report from the Inventory Report Criteria Selection window, with the desired criteria 
selected, do one of the following: 

• Click Print Now to print the report immediately to the default printer. 

• Click Print to select print options before printing the report. 

12. Click Back and then click the Close  button to return to the Report Search window.  

Inventory - Adjustment Report 

Use the Inventory - Adjustment Report to view a list of quantity or price adjustments in inventory.  

 

 

Inventory - Audit Open Details Report 

Use the Inventory - Audit Open Details Report to display an itemized listing of inventory items that have 
item details completed. This listing includes location, expiration date and lot number for items marked as 
verified but have not been finalized yet.  

 

 

Inventory - Audit Report 

Use the Inventory - Audit Report to display an itemized listing of inventory item transactions in 
Cornerstone. This list can be used as a reference if re-keying data is necessary. When printing this 
report, enter ranges to filter the report to avoid printing a large report.  
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Inventory - Backorder Report 

Use the Inventory - Backorder Report to view all items on back order.  

 

 

Inventory - Cost Report 

Use the Inventory - Cost Report to display the cost of inventory on hand. This is a good report to print 
when processing end-of-year. If the practice does not perform an EOY cycle count, print this report to 
obtain the value of EOY inventory information.  

 

 

Inventory - Cost Totals Report 

The Inventory - Cost Totals Report displays the total cost of inventory on hand, summarized by item 
classification.  
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Inventory - Counts Report 

Use the Inventory - Counts Report when performing a cycle count of inventory items marked to Maintain 
Quantity on Hand (QOH). The report lists the current quantity on hand for each item and provides a 
space to write the actual number of items physically available for each item.  

 

 

Inventory - Evaluation Report 

Use the Inventory - Evaluation Report to view information about each inventory item marked to Maintain 
Quantity on Hand (QOH).  

 

 

Inventory - Expiration Date Report 

Use the Inventory - Expiration Date Report to view a list of inventory items that will expire before a 
specified date.  
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Inventory - Internal Usage Report 

Use the Inventory - Internal Usage Report to view all the items and their associated costs that were used 
internally by the practice  

 

 

Inventory - Item Vendor Information Report 

Use the Inventory - Item Vendor Information Report to view a list of vendors and associated information 
assigned to inventory items through the Invoice Item List.  

 

 

Inventory - Items Profit Analysis Report 

Use the Inventory - Items Profit Analysis Report to determine profitability of inventory items sold. 

Note: For data to appear in the appropriate columns, end-of-month must be processed twice and end-
of-year once, before data appears for the appropriate columns for this report. The data in this report 
corresponds to the data in the EOM Inventory Sales Report.  

 

 

Inventory - Linked Items Report 

The Inventory - Linked Items Report lists all of the invoice items that have inventory items linked to them.  
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Inventory - On Order Report 

Use the Inventory - On Order Report to view detailed order information for items currently on order.  

 

 

Inventory - Overstock Report 

The Inventory - Overstock Report displays a list of inventory items that are above their overstock point, 
according to reorder information set up at the practice.  

 

 

Inventory - Partial Receipts Report 

The Inventory - Partial Receipts Report lists orders that have been partially filled but remain open 
because some items on the order have not been received yet.  

 

 

Inventory - Purchase History Report 

Use the Inventory - Purchase History Report to view a list of past vendor transactions for the practice, 
including the receipt and return of inventory items.  
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Inventory - Receipt Report 

Use the Inventory - Receipt Report to view detailed information about items the practice has received.  

 

 

Inventory - Reorder Report 

Use the Inventory - Reorder Report to view a list of inventory items, marked to Maintain Quantity on Hand 
(QOH) that are at or below their reorder points. This report contains the same information that appears 
within the Automatic Suggestions tab on the Purchasing Work List.  

 

 

Inventory - Returns Report 

The Inventory - Returns Report lists all of the items that have been returned to a vendor.  

 

 

Inventory - Turnover Report 

The Inventory - Turnover Report helps track how many times inventory completes a cycle of being 
received or sold. Use the ratios to adjust purchase patterns and to help optimize cash flow.  

Note: The ratio that appears is the amount of the item depletion, divided by the item’s average quantity 
on hand (QOH). The validity of the report depends on the accuracy of the QOH. If receipts, returns, and 
internal usage are not used correctly, the turnover ratio may not be accurate. 

On the Inventory - Turnover Report preview window, select the Beginning Period Date Processed and 
the Ending Period Date Processed to calculate the turnover ratio for the specified month’s date range. 
Click OK. The Set report range area appears. If applicable, select a range of information and then 
preview or print the report. 

Note: End of Month (EOM) must be processed in order to have date selections available.  
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Inventory - Usage Tax Report 

Some states require practices to pay taxes on items used internally. Use the Inventory - Usage Tax 
Report to show the cumulative amount of tax owed based on internal use.  

 

 

Inventory - Vendor Summary Report 

Use the Inventory - Vendor Summary Report to view the detailed information about the vendors that are 
set up in Cornerstone.  

 

 

Inventory - Want List Report 

Use the Inventory - Want List Report to view details of items currently on the Want List.  
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IDEXX SmartOrder* electronic inventory ordering allows for a more efficient inventory work flow with  
real-time online inventory ordering through MWI® Veterinary Supply. Using the IDEXX SmartOrder 
connection, orders placed within the Cornerstone* Practice Management System receive real-time 
inventory status updates and pricing updates from MWI. Order tracking is provided once MWI has 
processed an order and as orders are shipped. In addition, Cornerstone automatically recognizes the 
receipt of the shipment.  

Note: For information on setting up IDEXX SmartOrder and MWI electronic inventory ordering, see the 
help for the Practice Information window in Cornerstone. 

Benefits of IDEXX SmartOrder include: 

• Ordering from within your practice management system—The order process is within your work 
flow so you do not have to switch among multiple systems to place or track an order. 

• Real-time pricing details—When you place an order, cost for that item is displayed in the purchase 
order. In addition, when quantity discount opportunities are available, a notification is visible in the 
SP (Special Pricing) column of the purchase order. 

• Immediate notification of item availability—You will know right away if items are on back order.  

• Item status updates—Orders can be tracked from the time they’re placed to the time they arrive at 
the practice. 

• Automated electronic receipt of items—As ordered items arrive at the practice, receipts 
automatically fill with the appropriate information for quick and easy processing. 

Creating an MWI Purchase Order in Cornerstone  

To create a purchase order for MWI: 

1. Access the Create Purchase Order window from either the Purchase Order List or 
Purchasing Work List window. 

Cornerstone User’s Manual                  340 



Chapter 25: Electronic Inventory Ordering with IDEXX SmartOrder* Inventory Solution and MWI Veterinary Supply® 

 

2. On the Create Purchase Order window, select MWI Veterinary Supply or your practice-
specific associated vendor for MWI as the vendor. 

3. In the invoice item grid, in the ID field, type the item ID and press TAB, or press F2 to 
search for and select an item from the Search for Inventory Item dialog box. 

Once an item has been entered in the grid, Cornerstone performs a real-time check to verify the 
following: 

• Item has a matching MWI vendor item ID 

• Ordered quantity is available 

• Item cost 

• Any available quantity discounts 

Note: An invoice item line marked “Back order” displays if the item is on back order with the 
selected vendor. Contact MWI directly to check on expected date of availability. 

4. A link for the MWI fulfillment and support terms of sale is displayed on the right side of the 
Purchase Order List window. Click the link to review the order. You can also click the link to 
review MWI’s terms and conditions. 

Cornerstone User’s Manual                  341 



Chapter 25: Electronic Inventory Ordering with IDEXX SmartOrder* Inventory Solution and MWI Veterinary Supply® 

 
5. Select Place Order. 

Notes:  

• When you place an order through IDEXX SmartOrder, the order is sent to MWI for fulfillment. MWI is 
fully responsible for fulfillment of your order, including providing customer support related to your 
order. 

• If you have a credit card on file at MWI and are set up to be billed by credit card, you will be billed 
when you place the order. You will not be able to pay by credit card when you receive the order. 

Adding Vendor Item IDs for Matching Inventory Items in Cornerstone  
When adding items to a purchase order, if an invoice item is not recognized by MWI or if the invoice item 
does not have an associated MWI vendor item ID in Cornerstone, the invoice item line will display with a 
yellow background and an alert message box appears. 

At this point, you may either remove the item from the order or double-click the item’s description to 
open the Suggested Item List dialog box and select a suggested MWI item ID match for the item.  

On the Suggested Item List dialog box, Cornerstone automatically populates the Description field with 
the invoice item’s description in Cornerstone. Click Search to find any closely matching MWI item 
descriptions. If you are unable to locate a matching item, you can refine search terms or change the 
description to one or more words that may be recognizable and click Search again. If you select the 
MWI item as a match, the MWI vendor item ID is automatically applied to the Cornerstone item. This item 
will now be available for online ordering from Cornerstone in the future.  

Note:  If you make a mistake mapping your item ID to the MWI item ID, you will not be able to assign 
that MWI vendor item ID. To remove the incorrect mapping, select Lists > Invoice Item and search for 
the item. Click Update. On the Inventory tab, click Item Vendor and delete the vendor item ID on the 
grid.  
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Assigning Multiple Vendor Item IDs to a Single Inventory Item ID  

You can set up multiple vendor item IDs for a single product as long as you use the same buy/sell ratio 
for each vendor item ID.  

For example, you might have more than one vendor for amoxicillin 50mg capsules. With both vendors, 
you buy in bottles of 50 capsules but sell individually. In this case, you could set up a vendor item ID for 
each vendor and link both vendor item IDs to the same inventory item ID.  

 Buy Sell Example 
Inventory 
Item ID 

Example 
Vendor Item 
ID 

Vendor A Bottle of 50 Single tablet 1001 204 

Vendor B Bottle of 50 Single tablet 1001 573 

Adding a Vendor Item ID While Working with Inventory Orders 
As in earlier versions of Cornerstone, you can add a new invoice item when searching for an item on the 
Search for Inventory Item dialog box. The enhanced Search for Inventory Item dialog box in Cornerstone 
8.3 now includes new Vendor and Vendor Item ID fields that provide a quick way to add the primary 
vendor/vendor item ID information for the item. 

 

Note: The alternative method for adding vendor and vendor item ID information for an item is as follows. 
Select Lists > Invoice Item, and then click Update. On the Inventory tab, click Item Vendor, and then 
type the vendor and vendor item ID in the applicable fields in the grid (scroll horizontally to access the 
Vendor item ID field). 
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Tracking Order Statuses from Cornerstone  
New order tracking features for electronic inventory orders allow you to: 

• See when the status of an ordered item changes, indicating if the order was sent, if the vendor 
received the order successfully, etc. 

o If the order is received successfully by MWI, the status is Sent – Online. 

o If the order is not received by MWI, you will see a message asking you to complete the 
order offline and the status is Sent. If this happens, you need to use another method to 
send the order, such as by fax or calling MWI. 

 

• Track individual invoice items in the order by clicking the Track link. This link launches the 
associated website (USPS, UPS®, or FedEx®) to access tracking details. The link appears on the 
purchase order once MWI has completed processing and shipped the item. 

• After submitting your order, you will receive a confirmation notice informing you that your order has 
been placed with your practice’s associated vendor for MWI, along with a confirmation number for 
use in the event you have to contact MWI. 
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Synchronization of Electronic Inventory Orders with MWI 
If you are set up to use IDEXX SmartOrder with MWI online inventory ordering, Cornerstone checks MWI 
order history to detect unmatched orders.  

Unmatched purchase orders are created when you manually create an order—for example, if you place 
an order online, by phone, or by fax. You can view unmatched purchase orders in the Unmatched 
Orders area on the right of the Purchase Order List window, and use the following procedure to create 
matching purchase orders for them. This synchronizes the electronic inventory orders from MWI with 
Cornerstone and adds them to the Purchase Order List window. 

If you start an order in Cornerstone but Cornerstone is not able to connect with MWI, a message 
appears telling you that you need to complete the order offline. After you place this order (for example, 
by phone or fax), Cornerstone detects it as an unmatched order. However, because a purchase order 
was created before the connectivity problem occurred, you need to follow a special procedure to 
synchronize this kind of unmatched order. Otherwise, an extra duplicate purchase order will remain in 
Cornerstone. In a duplicate unmatched order situation, synchronize the manually created purchase 
order, and then use the Delete button to delete the original purchase order created in Cornerstone. 

 (See “To synchronize an order started in Cornerstone but completed offline” below.) 

Duplicate unmatched orders are created if you begin an order using IDEXX Smartorder in Cornerstone 
but need to complete the order manually. (This might happen if Internet connectivity issues prevent you 
from completing an order through Cornerstone.)  

 

To synchronize electronic inventory orders with MWI: 

1. Select the view all link to open the Unmatched Purchase Orders window. 

2. Select an order in the top grid to view the invoice items on that order in the bottom grid.  

3. For any invoice item that does not have an associated Cornerstone inventory item ID, add the ID in 
the appropriate box in the Inventory Item column. All invoices must have associated Cornerstone 
inventory item IDs for the order to be reconciled and created. 
Note: See “Adding Vendor Item IDs for Matching Inventory Items in Cornerstone” on page 342. 

4. When each line item has been matched to an associated inventory item in Cornerstone, click Save 
to create the purchase order in Cornerstone. The Unmatched Purchase Orders window closes, and 
the purchase order appears on the Purchase Order List window. 
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To synchronize an order started in Cornerstone but completed offline: 

1. Select the view all link to open the Unmatched Purchase Orders window. 

 
2. If you know that the order listed is a duplicate, select it and click Delete to use the original 

purchase order from the Purchase Order List.  
Tip: The original purchase order has a lower purchase order number. 
OR 
If you decide to synchronize the unmatched order, follow the “To synchronize electronic 
inventory orders with MWI” above. 
Note: You must close the original purchase order in the Purchase Order List after you have 
synchronized the new unmatched order.  
To close an order: 

a. On the Purchase Order List, select the purchase order that was originally created for this order. 

b. Click Close Order. The status changes to Closed. 

c. Click Delete. The original purchase order is removed from the Purchase Order List. 

Receiving Orders 

To receive an order: 

1. Select Inventory > Order List. The Purchase Order List opens. 

2. Select the purchase order and click Receive Order. 

3. Type the receipt number for your order in the Receipt Number box. The item list displays.  

4. Review the order for completeness and update the status by either clicking Receive All or by 
selecting Received from the Status drop-down list for each item.   

5. Missing order information (e.g., lot number) is in red text. You must update this information before 
you can post the order. Click Receipt Item Details to fill in the remaining fields. 

6. Click Post. 

7. In the Change Prices window, make any final adjustments and view the current and new pricing, if 
applicable. 

8. When finished making any changes, click Post. 
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Overview 
Cornerstone* Imaging provides standard imaging functionality and comes standard with the IDEXX 
Cornerstone* Practice Management System.  

Cornerstone Imaging allows users to:  

• Download or import images from medical devices, such as scanners, ultrasound equipment, 
endoscopes and digital cameras 

• Save images to patient history for later review 

• Provide a customized CD with an image viewer. This allows a practitioner or client to provide patient 
images to a referring specialist or back to a referring veterinarian in a digital format (DICOM® and 
jpeg) 

Note: Staff members must have appropriate security permissions to access the Cornerstone Imaging 
features. 

Before You Begin 

• Install any compatible devices (for example, scanners) and any necessary accompanying TWAIN 
software. 

• Set up your Imaging defaults. See “Chapter 6: Setting Cornerstone Imaging Defaults” in the 
Cornerstone Administrator’s Manual for information on setting Cornerstone Imaging defaults and 
system settings. 

Common Interactions 
The imaging features of the Cornerstone software have been designed so that a number of different 
windows function in similar ways. Below are some tips to remember when using the software.  

To select multiple items: 

 If you want to select more than one image thumbnail on the Image Explorer window or the Image 
Viewer window, hold down the CTRL key while you select the items you want. In the Image Explorer, 
you can also select a group of images by clicking the first image in the group and then holding 
down the SHIFT key while you click the last image in the group. The first and last images and all the 
images between them are selected. 

To deselect items: 

 If you want to deselect something that you have selected, click again while holding down the CTRL 
key. The item or thumbnail is no longer selected.  

To sort columns:  

1. If you want to change the order in which information is displayed in a table, click the name of the 
column by which you would like to sort the table. An example of such a window is the Select Patient 
dialog box that is used when reassigning studies. 

2. Click the same name again to reverse the sorting order.  
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To begin image-related actions quickly:  

1. For most of the actions which you can begin on the Image Explorer window, such as printing, 
emailing, or creating a patient CD, if you want to apply the action to a whole study or series, you 
only need to select one image that belongs to that study or series.  

2. Click the appropriate button on the right side of the Image Explorer or right-click and select the 
action from the menu.  

3. In the dialog box that appears, select Study if you want the action to be carried out on the whole 
study, Series if you want the whole series, or Image if you want only the image. 

To begin image-related actions with a right-click:  

 In both the Image Explorer and the Image Viewer, if you right-click on an image thumbnail, a menu 
lists actions that you can perform on the image (or images) that you have selected. Examples of 
these actions include reviewing, emailing, or printing images from the Image Explorer and cloning or 
emailing images from the Image Viewer.  

Cornerstone Imaging Basics 

Accessing Cornerstone Imaging Features 

To access the Image Explorer window for a patient:  

 With a patient selected on the Patient Clipboard*, in the Patient list area, right-click the patient name 
and select Image Explorer. 

To access the Image Explorer window without selecting a patient:  

1. Do one of the following: 

• Click the Image Explorer  toolbar button. 

• On the Activities menu, select Imaging> Image Explorer.  

2. To find images for a client and/or patient, see “Search Area (Quick Search Tab)” on page 357. 

To access the Image Viewer window:  

 Do one of the following: 

• From the Patient Clipboard, double-click the image series in the Patient History area Summary 
tab. The Image Viewer window appears, with one image displayed in the main window and the 
rest of the image series displayed as thumbnail images in the Thumbnail pane. 

• From the Image Explorer, do one of the following: 

o Double-click the thumbnail for the image. 

o Click the thumbnail for the image, and then click Review. 

o Right-click the thumbnail for the image, and then select Review. 

To access the Archive Images window:  

 On the Activities menu, select Imaging> Archiving. 

Exporting Images 

Images can be exported from Cornerstone in different image file formats to be imported into other 
software programs or to be sent over the Internet. Cornerstone can export images in the following 
formats: bitmap, JPEG, and TIFF. 
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To export an image: 

1. Using the Image Explorer, right-click the thumbnail for the desired image, and select Save As from 
the pop-up menu. 

2. On the Save As dialog box, enter a name for the image, and select a format and a location for the 
file. 

3. At the bottom of the Save As dialog box, do the following: 

• Select Burn Overlays if you want the images that you email to contain the overlay information 
displayed in the Image Viewer.  

• Select Burn Annotations if you want the images that you email to contain the annotations 
created in the Image Viewer. 

Note: See “Applying Annotations and Overlays” on page 372 for information on annotations and 
overlays. 

4. Click Save to complete the process.  

Reassigning an Image Study 

An image study can be reassigned to a different patient, if necessary. 

Note: Image, series, and study are important concepts in Cornerstone Imaging. For more information, 
see “About Image, Series and Study” on page 361. 

To reassign a study: 

1. In the Image Explorer, select an image from the study you want to assign to a different patient. Click 
Reassign on the right, or right-click and select Reassign from the pop-up menu. The Select Patient 
dialog box appears. 

2. To find the patient to whom the study will now be assigned, type information in the text boxes at the 
top of the Select Patient dialog box, and click Search. The search results appear in the table lower 
down in the dialog box. 

3. In the table, click the patient to whom you want to assign the image record, and then click the red 
Select Patient button on the far right. The study is moved to the patient you have selected. The 
Image Explorer now shows the patient with all its studies. 

Deleting Studies 

Your ability to delete image studies is dependent on your security settings. 

To delete a study in the Image Explorer: 

1. Click the study in the Results Detail window to select it. 

2. Click the Delete button in the column on the right, or right-click and select Delete from the pop-up 
menu. 

3. The Confirm dialog box appears. Click Yes. The study is deleted. 

Deleting Images 

Your ability to delete individual images is dependent on your security settings. 

To delete an image in the Image Explorer: 

1. Click the image’s thumbnail to select it. 

2. Click the Delete button in the column on the right, or right-click and select Delete from the pop-up 
menu.  
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3. The Confirm dialog box appears. Click Yes. The image is deleted. 

Importing and Acquiring Images from Scanners, Ultrasound, Digital Cameras, etc. 

Scanning Images 

To scan images: 

1. Do one of the following:  

• With a patient selected on the Patient Clipboard, in the Patient list area, right-click the patient 
name and select Image Import. The Image Viewer appears. 

• Click the Image Explorer  toolbar button. The Image Explorer window appears.  

• On the Activities menu, select Imaging > Image Explorer. The Image Explorer window 
appears.  

2. If you selected client and patient on the Patient Clipboard, go to step 3; otherwise choose one of the 
following options on the Image Explorer.  

• Click the Quick Search tab to search for client or patient by name or ID and/or date or species. 
Select search criteria and click Search. Select client and patient and click Import. The Image 
Viewer appears. 

• Click the Advanced Search tab to search for client and patient by client/patient name or ID, 
keywords, date range, type of modality (ultrasound, endoscope, etc.) and inactive/deceased 
patients. Click Search. Select client and patient and click Import. The Image Viewer appears. 

3. Click the Open tool  and then: 

• To scan images with a scanner that allows you to scan multiple pages at one time, click Multi 
TWAIN. The images are acquired and displayed. 

• To scan images with a device such as a flatbed scanner, where you have to scan one image at 
a time, click Single TWAIN. The images are acquired and displayed. Repeat this step for each 
image you want to import for this patient. 

4. Click Edit Image Detail . The Image Details dialog box appears. 
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Image Details dialog box  

a. Type a title for this group of images in the Series Title text box.  

b. If necessary, change the Capture Date for the group of images. 

c. Click OK. The Image Details dialog box closes.  

5. Click Save , and then select the Save option. 

6. Click OK, and then click the close button (x) in the upper right corner. The Image Viewer window 
closes. 

Importing (Acquiring) Images Captured by Various Devices 
The following file formats can be imported into the Cornerstone software: 

.bmp—Microsoft® Windows® bitmap 

.jpg or .jp2—Joint Photographic Experts Group (JPEG) file interchange format or JPEG 2000 

.tif—Tagged image file format (TIFF) 

.avi—Audio video interleaved format 

.mpg—Moving Picture Experts Group format 

Before importing images, you must have the corresponding client and patient records set up in 
Cornerstone. See “Adding or Updating Client” on page 40 and “Adding or Updating Patient Information” 
on page 55 for more information. 

Tip: The Import option does not apply to digital radiography.  

Cornerstone User’s Manual                  353 



Chapter 26: Using Cornerstone* Imaging 

To import images: 

1. Do one of the following:  

• On the Patient Clipboard, select the client and patient. Right-click in the Patient History area and 
select Image Import. The Image Viewer appears. 

• Click the Image Explorer  toolbar button. The Image Explorer window appears.  

• On the Activities menu, select Imaging > Image Explorer. The Image Explorer window 
appears.  

2. If you selected client and patient on the Patient Clipboard, go to step 3; otherwise choose one of the 
following options on the Image Explorer.  

• Click the Quick Search tab to search for client or patient by name or ID and/or date or species. 
Select search criteria and click Search. Select client and patient and click Import. The Image 
Viewer appears. 

• Click the Advanced Search tab to search for client and patient by client/patient name or ID, 
keywords, date range, type of modality (ultrasound, endoscope, etc.) and inactive/deceased 
patients. Click Search. Select client and patient and click Import. The Image Viewer appears. 

3. Click the Open tool , and then: 

a. Click File. The Open dialog box appears.  

b. Use the Look In drop-down menu to locate the disk drive and folder where the image is stored. 
Most digital cameras appear as disk drives. 

c. Select the image and click Open. The image is imported and displayed.  

d. Repeat steps 3a through 3c for each image you want to import for this patient. 

4. Click Edit Image Detail . In the Image Details dialog box: 

a. Type a title for this group of images in the Series Title text box.  

b. If necessary, change the Capture Date for the group of images. 

c. Click OK. The Image Details dialog box closes. 

5. Click Save , and then select the Save option. 

6. Click OK, and then click the close button (x) in the upper right corner. The Image Viewer window 
closes. 

To add an imported image to a series: 

1. Using the Image Explorer, enter the patient name and click Search to find the series. Open the 
series in the Image Viewer. 

2. Click the Open tool , and follow the “To import images” instructions above, starting with step 3. 

When the image(s) are added, they are added to the series displayed in the Image Viewer.  

Note: When you close the Image Viewer, the new image’s thumbnail may not be displayed 
immediately in the Image Viewer. Click Clear and search again to find the patient. The thumbnail for 
the imported image appears. 
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Viewing and Importing Multimedia Files 

The Cornerstone software supports the ability to view multimedia files (e.g., ultrasound images). You can 
capture, import, and view multimedia files, multi-frame files, AVI (.avi) files, and MPEG (.mpg) files. 

To view multimedia (cine) files and capture images: 

1. In the Image Explorer window, enter the patient’s name and click Search. 

2. Select the patient from the list, and then click Import. 

3. Click Open, and then select File. The Select File dialog box appears. 

4. Select the multimedia file that you want to view and click OK. 

The cine file appears in the Image Viewer window with the Cine toolbar displayed along the bottom 
of the window. 

Use these tools to view the selected cine file: 

 

 Click Play/Pause to start, pause, or resume the video. 

 
This button is only available with the Cornerstone Diagnostic Imaging 
module. 

Click Capture to capture a single frame of the video as a still  
image. The still images you capture from the video can be  
enhanced and edited using the editing and annotation tools, and  
they are saved as part of the same series as the original video. 

Note: The Cine toolbar appears only on the original  
video image. 

 
Click Slower to slow down the video.  

 
Click Faster to speed up the video. 

 
Click Stop to stop the video and return to the beginning. 

 
Click Zoom In to increase the size of the image. 

 
Click Zoom Out to decrease the size of the image. 
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Click Full Screen to make the video fill the screen. 

 
Note: Use the following keys to control playback in full screen mode: 

• Press the SPACEBAR to play or pause the video. 

• Press ESC or double-click anywhere on the screen to return to 
the Image Viewer in normal mode. 

 Click the slide bar to move quickly to a specific spot in the video. 

 

Using the Image Explorer Window 

Overview 

The Image Explorer window lets you search for clients, patients, and images, and it displays thumbnails 
of your images, organized by client, patient, date, and series. The window comes in two versions: 

• The Quick Search tab provides the most commonly used search criteria. 

• The Advanced Search tab provides a larger range of search criteria. 

Tip: You can set Advanced Search as your default search option on the Image Explorer. On the 
Controls menu, select Defaults > Staff, click the Miscellaneous tab and select the Show advanced 
search on Image Explorer check box.  

About the Image Explorer 

To display the Image Explorer with the client and patient information already displayed, on the Patient 
Clipboard, select the client and patient, right-click the patient name, and then select Image Explorer. 
The Image Explorer window appears, and displays thumbnail images for this patient. 

To display the Image Explorer without a client and patient displayed, select Activities> Imaging > 

Image Explorer from the menu at the top of the window or click the Image Explorer  toolbar button. 
In the upper left corner of the window, choose either the Quick Search tab or the Advanced Search tab 
to display the version of the search area you want. 
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The parts of the Image Explorer window  

The parts of the Image Explorer window work together as follows: 

• The Search area lets you enter search criteria. 

• The Summary List area lists the clients, patients, and dates that match your search.  

• The Results Detail area shows image thumbnails for the patient or date that is selected from the 
Summary List. 

• The Information area shows basic information about the image, patient, or client selected. 

• The buttons on the right launch activities related to the image, patient, or client. 

• The Connections status bar displays the current status of the connections that are related to 
imaging.  

Search Area (Quick Search Tab) 

To search for a patient or client by using the Quick Search tab: 

1. Type information in one or more text boxes in the search area: 

• Client and Patient – Type client first and last name, patient name, and/or client or patient IDs. 

• Date – Select a time period from the drop-down list. 

• Species – Select a species from the drop-down list. 

2. Click Search. Results are displayed in the Summary List area and the Results Detail area. 

Note: If your search criteria will provide a very large number of results and run a long time, a dialog box 
warns you and gives you the option to stop the search. 

Search 
area 

Summary 
List area 

Results 
Detail area 

Information 
area 

Button 
area 

Connections 
status bar 
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If you want to clear the search text boxes and start over, click Clear. This also clears all the results in the 
Summary List area and the Results Detail area. 

Search Area (Advanced Search Tab) 

To search for a patient or client by using the Advanced Search tab: 

1. Type information in one or more text boxes in the search area: 

• Client ID – Type the ID or press F2 and use the Client List dialog box to choose the client. 

• Client First Name and Client Last Name – Type the name or press F2 and use the Client List 
dialog box to choose the client. 

• Patient ID – Type the ID or press F2 and use the Patient List dialog box to choose the patient. 

• Patient Name – Type the patient name or press F2 and use the Patient List dialog box to 
choose the patient. 

• Species – Select a species from the drop-down list. 

• Keywords – Select image keywords and case categories from the list. 

• Date – Select a time period. 

• Start and End – Type the start and end dates of a time period to search, or select the dates 
using the drop-down calendars. 

• Source/Modality – Select the type of device used to capture the images. 

• Doctor – Select the name of the veterinarian for whom the image was taken. 

• Workstation – Select the name of the computer used to capture the image. 

2. If you want your search results to include patients who are inactive or deceased, check the Include 
Inactive/Deceased Patients check box. 

3. Click Search to run your search. Results are displayed in the Summary List area and the Results 
Detail area. 

Note: If your search criteria will provide a very large number of results and run a long time, a dialog 
box warns you and gives you the option to stop the search. 

4. If you want to clear the search text boxes and start over, click Clear. This also clears all the results in 
the Summary List area and the Results Detail area. 

Summary List Area 

The Summary List area displays the results of your search in a folder-tree-style list. Clients are shown on 
the first level of the tree, furthest to the left. Patients are shown in the next level down and dates when 
images were taken are shown in the next level of the tree. In the last level of the tree, furthest to the right, 
are tiny thumbnail images representing individual studies and cases. 

 Click on any level of the list to select a client, patient, date, or study. The Information area displays 
corresponding client and patient information. When you select a patient or date, the Results Detail 
area shows thumbnails of the images for that patient and/or date. 
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To close and open folders: 

• Click the minus sign (-) to close the folder and hide the items within it. 

• Click the plus sign (+) to open a folder and display the items within it. 

 

 
The Summary List area 

Results Detail Area 

When you select a patient or a date in the Summary List, the Results Detail area displays images for that 
patient or for that patient on that date. The images are grouped by study and series. 

The header line for each study displays the study name, which is the date and time when the images in 
the study were captured. 

The header line for each series shows the date that the images in the series were taken and the name of 
the series. 

To select images: 

• Click an image to select it. 

• Click the area around the images to select an entire series. 

• Click the study header to select the whole study. 

• Hold down the CTRL key while clicking to select more than one image, series, or study. 

• Hold down the SHIFT key and click two images to select them and everything between them. 

• Click Select All to select all of the images that are displayed in the Results Detail area for this 
patient. 

Note: Image, series, and study are important concepts in Cornerstone. The way images are organized is 
based on the DICOM® (Digital Imaging and Communications in Medicine) information standard for 
medical imaging. A series holds a group of one or more images, and a study holds one or more series.  
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Information Area 

When you select a client, patient, date, or study from the Summary List, or when you select an image or 
series in the Results Detail area, the Information area displays the following details: 

• Client Name 

• Client ID 

• Patient Name 

• Patient ID 

• Species 

If you have selected a client, only the Client Name and Client ID are displayed. 

Button Area 

Use the following buttons to work with images. Many of the same tasks can be selected by right-clicking 
a thumbnail image and selecting the task from the pop-up menu. 

Note: Most of the buttons are only active when you have one or more images selected. When buttons 
are not active, they appear in a lighter color. 

 

 

Click the Import button to use the Image Viewer window to import an 
image from a file, a scanner, or another device. 

 
 

 

Click the Review button to review images, series, or studies. 

 

 

 

Click the Create Patient CD button to save images, series, or studies to 
a CD. 

 
 Click the Print button to print an image. 

 

 

Click the E-mail button to send images, series, or studies via email. 

 

 

 

Click the Reassign button to reassign a study to a different patient. 

 

 

 

Click the Delete button to delete a study or a case. (If you are 
designated as the administrator for your Cornerstone software, you can 
also use this button to delete individual images.) 

Connections Status Bar  

The Cornerstone software on your computer is connected to other computers inside and outside of your 
practice. The Connections status bar displays the current state of the connections that are related to 
imaging. 

 

Cornerstone User’s Manual                  360 



Chapter 26: Using Cornerstone* Imaging 

To view the overall connection status: 

The Connections status bar is displayed in the lower left of the Image Explorer window. It is also 
displayed in the Imaging Dashboard (Diagnostic and Digital Radiography only). The color of the icon 
indicates the status of all of the imaging connections for the computer. 

• Red—One or more of the connections that have been set up is not running. 

• Yellow—One or more of the connections requires attention. 

• Green—All of the connections that have been set up are running. 

To view status for each connection:  

 Click Connections in the lower left of the Image Explorer window (or Imaging Dashboard, if you 
have an IDEXX Digital Imaging system). The status bar opens.  

Connection status details: 

A colored status icon is displayed for each connection:  

• Red—Not running 

• Yellow—Requires attention (for example, a yellow status for the DICOM® connection indicates a 
problem sending or receiving images) 

• Green—Running 

• Gray—Not set up on this computer 

Note: If you move your mouse over an icon, text with status details appears. 

The connections are:  

• DICOM—This icon appears only on the computer that is the server for your Cornerstone 
network. It shows whether IDEXX DICOM services, which sends and receives DICOM images, is 
running. It also shows whether any failure has occurred in sending or receiving images. You can 
use the links next to the icon to start or stop DICOM services or to view the DICOM queue. 
Note: This icon is activated only if you have the Diagnostic Imaging module.  

• Database—If you have a server/workstation set up, each computer is connected to the 
database that resides on the server. This icon shows the status of that connection. 

• MWL-This icon does not display for the current version of Cornerstone. 

• SmartService—This status icon appears only on the Cornerstone server. It shows the status of 
your connection to IDEXX SmartService* technology, which allows you to upgrade your software 
over the Internet. 

• Telemedicine—If you have set up a connection to one or more telemedicine providers, this icon 
shows the status of those connections. 

• SmartLink—If IDEXX SmartLink* technology is set up for your IDEXX Digital Imaging system, 
this icon shows the status of the connection between the Diagnostic Imaging module and the 
rest of the Cornerstone software. 

About Image, Series and Study 

Image, series, and studies are important concepts in Cornerstone. The images that you capture are 
organized into series and studies. Often, when you use the software to perform some action, such as 
emailing images, creating a case, or creating a Patient CD, you will be asked whether you want to 
perform that activity on the image, the series, or the study.  
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Because the terms “series” and “study” are part of the DICOM standard, you may encounter them when 
using DICOM-compliant equipment, such as endoscopes or digital radiography equipment.  

Image 

In the Cornerstone software, “image” refers to a single digital image file, which may be a photograph, a 
scanned document, a movie file, an x-ray or radiograph, or an image from another diagnostic imaging 
modality, such as CT or ultrasound. 

You can see thumbnails of images on the Image Explorer window. You can see the image itself on the 
Image Viewer window. 

Series 

A series is a group of related images. Often all of the images in a series are of the same body part or are 
taken within the same anatomical region.  

In the Image Explorer, the header line for each series shows the name of the series and turns from gray 
to red when the entire series is selected.  

 
How images are grouped in a series on the Image Explorer 

When you open an image in the Image Viewer window, the rest of that image’s series is also loaded in 
the Image Viewer. If the Thumbnail Pane is open in the Image Viewer, it displays the whole series. 

Study 

A study is a group of image series that were captured at the same time for the same patient.  

On the Image Explorer window, the study name is shown above the series that belongs to that study.  

The DICOM standard requires series and study information be recorded for every image. If you take only 
a single image during a capture session, a series and study will still be created, even though that image 
is the only image in the series and that series is the only one in the study. Also, all of the images within 
the series that make up a single study must come from the same patient.  
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   The relationship of images, series, and study  

Reviewing Images 

The Image Viewer Toolbar 

The Image Viewer window provides tools that let you change and enhance your images. These tools are 
described below. 

Some image editing tools, such as the Magnify tool and the Pan tool, remain active until you do one of 
the following: 

• Click the button a second time 

• Click another tool button 

• Right-click anywhere on the image and select Complete Action from the pop-up menu. 

Note: Each image can have only one manipulated version. If you make changes to the manipulated 
version, Cornerstone will overwrite your previous manipulated image. The original image is never 
overwritten. You can always return to the version of the image that you saved at the end of the capture 
process by using the Restore Original tool.  

 
The Open tool allows you to open images from various sources and import them into Cornerstone. 
Select the Open tool, and then select an image type from the drop-down list. A dialog box appears 
where you can specify the source and type of file you want to bring into the Cornerstone software. 

For more information about using this tool, see “Importing (Acquiring) Images Captured by Various 
Devices” on page 353. 

 

 

The Save tool saves the image to a file. When you click the tool, select Save to save the current 
version of the image within the Cornerstone software.  

If you want to save another copy of the image, click Save As. A dialog box appears where you can 
enter a name for the image and select a format in which to save it. Click Save to complete the 
process. 

The format choices in the dialog box are: bitmap, JPEG, and TIFF. 
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The Print tool allows you to print the currently selected image. Click the Print tool to display the Print 
Preview window. In this window, you can view the pages you are about to print. When you are ready 
to print, click the Print icon in the upper left corner of the window. 

 
The Edit Image Details tool opens the Image Details dialog box, where you can view and update 
additional details about the image, including Title, Technique information, and Comments. You can 
also mark this image as a key image by checking the Key Image text box. See “Editing Image 
Details” on page 371 for more information. 

 

 

Rotate and Flip Tools 

Click the Rotate and Flip tool to open the Rotate and Flip toolbar. These tools allow you to change 
the orientation of an image. 

Note: If you rotate or flip an image that has annotations on it, the annotations will rotate or flip, as well. 

Note: After an image is rotated, a marker appears and shows the number of degrees clockwise the 
image has been rotated from the orientation in which it was captured. An “X!” marker appears after 
horizontal flips and a “Y!” after vertical flips. These markers are always displayed with the image in 
Cornerstone and cannot be hidden. 

 
 
The Rotate Clockwise tool rotates an image 90 degrees clockwise each time the tool is 
clicked. 

 
 
The Rotate Counterclockwise tool rotates an image 90 degrees counterclockwise each 
time the tool is clicked. 

 
 
The Flip Horizontal tool flips an image along the Y-axis each time the tool is clicked. 
 

 
 
The Flip Vertical tool flips an image along the X-axis each time the tool is clicked. 
 

 

 

The Window/Level tool allows you to manipulate the contrast (also called window) and brightness 
(also called level). Click the Window/Level tool, and then click and drag the cursor: 

• To the right to increase the window  

• To the left to decrease the window 

• Up to decrease the level  

• Down to increase the level 
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Annotation Tools 

Click the Annotate tool to open the Annotation toolbar. You can use these tools to draw on an image 
or to make annotations on an image. 

 
 

 

Pointer—use this tool to manipulate an annotation that you have already placed: 

• To move an annotation, click the Pointer tool, select the annotation, and move it to 
the new location. 

• To delete an annotation, click the Pointer tool, right-click the annotation, and select 
DELETE. 

• To change the font, color, or size of a text annotation, click to select the annotation, 
and then right-click on the annotation with the Pointer tool. Make the desired 
changes and click OK. 

• To change the units of measurement, line attributes, font, or color, right-click on the 
annotation with the Pointer tool. Then make the desired changes and click OK. 

 
 
Arrow—Click and drag to draw a straight-lined arrow. 
 

 
 

 

Calibrate—Click and drag to draw a line on the image that corresponds to a feature on the 
image for which you know the actual measurement. The Calibration Settings dialog box 
appears. Do the following:  
1. Click OK in the Message dialog box, and then draw a line on the part of the image for 

which you know the measurement. 

2. The Calibration Settings Annotation dialog box appears. Click the Calibration Settings 
tab. 

3. Select the unit you want to use (such as inches or centimeters) from the list in the 
Measurement Units area.  

4. In the Length text box, type the number of those units (inches, centimeters, etc.) that 
matches the length of the line on the animal. 

5. When you finish entering information, click Save. The dialog box closes and the image is 
displayed in actual size. The Calibrated overlay for this image reads “Calibrated: true.” 

Note: This calibration setting remains accurate as long as the distance between the x-ray 
source the x-ray plate remains the same. If the source-to-plate distance changes, you must 
recalibrate by repeating steps 1 through 5. 

 
 
Ellipse—Click and drag to draw a circle or oval around part of an image. 
 

 
 
Freehand Line—Click and drag to draw a freeform line. 
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Protractor—Click and drag to draw specific angles on the image. Click to place the 
endpoint of one line, drag a line to the corner of the angle, and release. Then click to place 
the endpoint of the second line. The angle measurement between the two lines is 
displayed. 

 
 
Rectangle—Click and drag to draw a box around part of an image. 
 

 
 

 

Ruler—Click and drag to draw specific measurements and lines on an image. The units 
of measure, line attributes, font, and color can be changed with the Pointer tool. (See 
the Pointer tool instructions above.) 

WARNING: The Ruler tool is accurate only if the system has been calibrated for this type 
of image or if this image has been calibrated with the Calibration tool. 

If the system and/or image is not yet calibrated when you click the Ruler tool, a dialog 
box appears in order to begin the calibration process. See the Calibration tool 
instructions for more details. 

 
 
Straight Line—Click and drag to draw straight lines on an image. 
 

 
 
Text—Click and drag to create a text box on an image, and then type text in the box. 

The font, color, and size of text can be changed with the Pointer tool. (See the Pointer 
tool instructions above.) 

 

 

The Zoom menu allows you to zoom in or out of an image by specifying the zoom percentage.  
• Use the drop-down list to select one of the preset zoom levels—25%, 50%, 75%, 100%, or Fit to 

Window. If you select 100%, the image is displayed at the same size as the plate on which the 
image was captured. 

• Type a number and press ENTER to zoom to that percentage. 

• If you select Actual Size, the size of the image on the screen matches the size of the animal that 
was imaged. 

WARNING: The Actual Size tool is only accurate if this image has been calibrated with the 
Calibration tool. 

If the system and/or the image is not yet calibrated when you select Actual Size, a dialog box 
appears so that you can begin the calibration process. See the Calibration tool instructions for more 
details. 

Note: Due to dots-per-inch issues on some computers, measurements taken while an image is 
being viewed in actual size may be off by a fraction of a millimeter. When absolute accuracy is 
required, include a reference object of a known size in your image. Also, the Actual Size feature does 
not work if you are using your computer with a projector that displays the image at a very large size, 
e.g., on a wall.  
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Magnify Tools 

Clicking the Magnify Toolbar tool opens up a set of tools that you can use to enlarge a portion of the 
image. 

 
 

 

The Magnify tool allows you to see a particular part of an image in greater detail. Click 
the tool, and then click any area of the image to view that area in greater detail. As you 
move the tool around the image, you move the area that is magnified. When you stop 
moving the magnify tool, a scale appears at the bottom of the magnified area. Move the 
slider on the scale to increase or decrease the amount of magnification from 1x to 10x. 

You can also change the window and level (contrast and brightness) within the 
magnified area by selecting the Lock Window check box and then clicking and 
dragging the mouse pointer within the magnified area. When you are done, deselect 
Lock Window to continue using the Magnify Tool, or click the Magnify button again to 
deactivate the magnifier. 

 
 
The Customize tool allows you to change the way the Magnify tool works. Click the 
Customize tool to open the Advanced Magnification dialog box. Specify the desired 
height and width of the Magnify tool area (in pixels). In the Zoom text box, specify the 
desired amount of magnification. 
 

 
 
The Zoom tool allows you to zoom in to or out of an image. Click the Zoom tool, and 
then click and drag the mouse. Move up to zoom out (the image gets smaller)or down 
to zoom in (the image gets larger).  

Note: Be sure to release the mouse button completely between zooming in one 
direction and zooming in the other direction. Also, be sure that the mouse pointer is 
within the Image Viewer window when you click to begin the zoom action. 

 
The Pan tool allows you to click and drag the image to move it within the window. 
 

 
The Invert tool automatically inverts the colors in your image—white becomes black, and black 
becomes white. 
 

 
The Crop tool allows you to cut out unwanted parts of an image.  

To crop an image, select the tool, and then click and drag the crop border so that it contains the part 
of the image you want to keep.  

• To adjust the border, click and drag an edge of the rectangle. 

• To rotate the crop area, click and drag one of the corners. 

• To move the crop area, click and drag anywhere within the border. 

Right-click inside the border, and select Apply Crop. The image is cropped to the selected area. 
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The Restore Original tool allows you to return the image to the way it looked when you clicked Done 
Capture at the end of the image capture process. 
 

 
Display Configuration Tools  

Clicking the Display Configuration Toolbar tool opens a set of tools that you can use to change how 
images are displayed in the viewer. 

 
 

 

The Edit Overlays tool is used to select the information that you would like to display in 
the image overlays. When you click this tool, a table appears that allows you to specify 
how each piece of information is displayed in the overlays: 
• In the Display column, check or uncheck the box to display or hide each piece of 

information. 

• In the Grouping column, use the drop-down list to select the area of the window 
where you want this piece of information to be displayed. 

• In the Order column, use the drop-down list to specify where this piece of 
information will appear within a line. 

• In the Line Number column, type the line number within this grouping where you 
want to display this piece of information. 

 

 
 
The Configure Toolbar tool allows you to customize the Image Viewer by selecting the 
tools you want displayed in the toolbar at the top of the window. Some tools, like the 
Print tool and the Save tool, cannot be removed from the toolbar. 

To configure the toolbar: 
1. Click Display Configuration, and select the Toolbar Configuration button from 

the drop-down menu. The Toolbar Configuration dialog box appears, 
containing a list of the tools that can appear in the toolbar. 

2. Select the check boxes next to the names of the tools you want to be 
displayed. Uncheck the boxes for tools that you want to hide. 

3. Click OK when you have finished. The toolbar now includes only the tools you 
have selected. 

 
 
The Toggle Annotations tool allows you to show or hide image annotations. 
 

 
 
The Toggle Overlays tool allows you to turn the image overlays on and off. 
 

 
The Help tool displays the online Help in a new window. 
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The Thumbnail Pane 

Moving, Resizing, or Hiding the Thumbnail Pane 

You can move the Thumbnail pane so that it is displayed either at the bottom of the Image Viewer or 
along the left or right side of the window. You can also hide the thumbnail pane when you do not need it. 
Moving or hiding the thumbnail pane allows you to make the best use of the space in the Image Viewer, 
so that the image in the main window is as large as possible. 

You can use the Thumbnail pane to select an image to display in the main window. 

To change the image that is displayed in the main window of the Image Viewer:  

 Double-click the thumbnail for the image that you want to see displayed in the main window. The 
thumbnail you have selected is outlined in red, and that image appears in the main Image Viewer 
window. 

Using the Thumbnail Pane to Move Around within an Image 

When you have zoomed in so that the image is larger than the main Image Viewer window, you can use 
the thumbnail to choose which part of the image is displayed. 

To use the thumbnail to move within the main image: 

 The small blue rectangle within the thumbnail shows the section of the image that is currently shown 
in the main Image Viewer window. Click inside the rectangle and drag it within the thumbnail. In the 
main window, the corresponding part of the image is displayed.   

To move the Thumbnail pane:  

 Click on the bar at the top of the Thumbnail pane and hold down the left mouse button while you 
drag it to the new position. A dark gray outline shows where the Thumbnail pane will be when you 
release the mouse button. 

Right-click on the bar at the top of the thumbnail pane and select: 

• Move left to move the Thumbnail pane to the left side of the window. 

• Move right to move the Thumbnail pane to the right side of the window. 

• Move down to move the Thumbnail pane to the bottom of the window. 

To hide the Thumbnail pane 

 Click on the line between the Thumbnail pane and the main Image Viewer window so that the pointer 
becomes a two-sided arrow. Hold down the left mouse button while you drag the line to the outside 
edge of the window.  

 Right-click on the bar at the top of the Thumbnail pane and select Hide. 

To resize the Thumbnail pane: 

 Move the mouse over the thin line between the main window and the Thumbnail pane so that the 
pointer becomes a two-way arrow. Click and drag to make the pane larger or smaller.  

 Right-click on the bar at the top of the Thumbnail pane and select: 
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• Hide to shrink the Thumbnail pane to a thin line on the edge of the Image Viewer. 

• Maximize to make the Thumbnail pane as large as possible. 

• Restore to return the Thumbnail pane to the last size that you made it, undoing the most recent 
size change. 

To resize or hide the Thumbnail pane using the pointer arrows: 

1. Find the pointer arrows: 

• If the Thumbnail pane is on the right or left side of the window, there are two little black triangles 
on a red background at the top of the pane.  

• If the Thumbnail pane is on the bottom of the window, the little black triangles with the red 
background are on the left side. 

2. Click the arrows to resize the Thumbnail pane: 

• Click the arrow that points toward the main window to make the Thumbnail pane bigger. 

• Click the arrow that points toward the outside of the window to hide the Thumbnail pane. 

Using Full Screen Mode 

When the Image Viewer window is in full screen mode, the toolbar and the Thumbnail pane are hidden 
so that the image is displayed as large as possible on your screen. 

To turn full screen mode on and off: 

1. Press the F11 key to turn on full screen mode. 

2. Press the F11 key or the ESC key to return the Image Viewer window to normal mode, with the 
toolbar and Thumbnail pane displayed. 

To use the Image Viewer tools in full screen mode: 

1. Press the F10 key to display a menu of Image Viewer tools in the upper right corner of the screen. 

2. Select a tool from the menu. The tools work as they do in the Image Viewer window in normal mode. 

Using Imaging Shortcuts 

When viewing images in the Image Viewer, the following keyboard and mouse shortcuts are available.  

Note: To activate shortcuts, on the Controls menu, select Defaults > Staff. Click the Miscellaneous 
tab and select the Enable keyboard shortcuts check box. 

• To rotate the image 90 degrees counterclockwise, click the A key. 

• To rotate the image 90 degrees clockwise, click the S key. 

• To move the image around, right-click while holding down the M key and moving the mouse. (This is 
the same as using the Pan tool.)  

• To zoom, hold down the right mouse button and move the mouse.  

• To return to original zoom (image fits in window), double-right-click. 

• To move a magnified area around the image, hold down the SHIFT key, and click the right mouse 
button. (This is the same as using the Magnify tool.)  

• To change the window (brightness) for the image, hold down the left mouse button, and move the 
mouse left and right. 
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• To change the level (contrast) for the image, hold down the left mouse button, and move the mouse 
up and down. 

• To return to original window/level settings, double-left-click. 

Editing Image Details 

The Edit Image Details tool opens the Image Details dialog box, where you can view and update 
additional details about the image. 

Note: The image details feature should be used only in a manner consistent with local laws governing 
the maintenance of veterinary records used for diagnostic purposes. 

In the top section, you can change the information in the following text boxes:  

• Study displays the name of the image study to which this image belongs. This name is 
automatically filled in when you capture an image. If you change it here, it is changed for all images 
in this study. 

• Title is the name of this image. When you capture an image, the exam type becomes the title of the 
image. 

• Series Title displays the name of the image series to which this image belongs. This name is 
automatically filled in when you capture an image, based on the exam type group that includes that 
image. 

• The Key Image check box lets you mark this as a key image. Key images may be useful if you have 
Cornerstone Diagnostic Imaging and a DICOM printer. 

On the left of the dialog box are a number of informational fields which cannot be altered, as well as 
three text boxes in which you can change information. These are:  

• Client Name  

• Patient Name   

• Capture Date—the date the image was captured 

 Type a date in the text box or use the drop-down calendar to select the date. 

Note: The ability to change the capture date is provided so that the proper date can be entered for 
scanned documents.  

• Modified Date—the date the image was last changed 

• Tech Name—the name of the person who was logged in to Cornerstone when the image was 
captured 

• Veterinarian—the veterinarian for whom the image was captured 

 Select the name of the veterinarian from the drop-down menu. 

On the right side of the pop-up is technical information about how the image was captured. You can edit 
all of these text boxes:  

• Source and Modality—These text boxes refer to the kind of equipment that was used to capture the 
image. You can search for information in this text box on the Advanced Search tab of the Image 
Explorer. 

• Keywords—Select keywords for the images in this series. You can search for images with specific 
keywords from the Advanced Search tab of the Image Explorer window. 
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In the Series Comments area, type comments about the image series to which this image belongs. 
These comments are attached to all of the images in this series. 

The following text boxes appear on the Technique Details tab. Most of these text boxes are related to 
the radiology log. For more information, see “Using the Radiology Log” on page 385.  

• Distance—the distance from the x-ray source to the x-ray plate. In the text box to the right, use the 
drop-down menu to choose the unit of measure for this distance, such as millimeters or inches. 

• Thickness cm—the thickness of the body part being imaged, in centimeters. 

• Exposure mAs—the amount of x-ray exposure used for this image. This is calculated automatically 
if you enter values in the Exposure mA and Exposure time sec text boxes.  

• Exposure mA—the amount of current in millamperes (mA). 

• Exposure time sec—the duration of the exposure in seconds, which can be typed as a decimal 
value in the text box or selected as a fraction from the drop-down menu. 

• Exposure kVp —the amount of voltage (peak kilovoltage) used for this image 

• Level of sedation—whether the patient was awake, sedated, or anesthetized (select from drop-
down menu). 

• Use of grid—a check box to indicate whether or not a grid was used. 

Note: The image details feature should be used only in a manner consistent with local laws governing 
the maintenance of veterinary records used for diagnostic purposes.  

Reverting and Undoing Changes 

Each image can have only one manipulated version. If you make changes to the manipulated version, 
Cornerstone will overwrite your previous manipulated image. The original image is never overwritten. You 
can always return to the version of the image that you saved at the end of the import process by using 
the Restore Original tool. 

If you want to undo changes made while working in the Image Viewer, simply close the Image Viewer 
without saving. When you open the image again in the Image Viewer, the image looks the way it did the 
last time you saved it. 

Emailing Images from the Image Viewer window 

You can email images quickly from the Image Viewer window. See “Emailing Images” on page 377. 

Distributing Images 

Applying Annotations and Overlays 

Whenever you send an image out of the Cornerstone software, you have the choice of adding two kinds 
of information: 

• Annotations are elements that you add to the image in the Image Viewer, such as arrows, text, and 
measurements. 

• Overlays are information that is stored in the Cornerstone software, such as patient name, patient 
date of birth, image name, series name, and the date and time that the image was taken.  

You have the choice to apply annotations and overlays whenever you:  

• create a patient CD  

• print an image 
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• email one or more images 

• save an image with the Save As feature  

At the start of any of the emailing, printing, and patient CD creation processes, a dialog box appears 
with check boxes in which you can select to apply annotations and to apply overlays. When you save an 
image with the Save As feature, the check boxes appear at the bottom of the Save As dialog box. To set 
up these check boxes so that they are selected by default, see “Chapter 6: Setting Cornerstone Imaging 
Defaults” in the Cornerstone Administrator’s Manual. 

Creating a Patient CD 

You can create a CD or DVD that contains images for a patient. The CD or DVD will contain both JPEG 
and DICOM versions of the images, as well as patient information and image viewing software. You can 
create a patient CD from either the Image Explorer window or the Image Viewer window. 

Note: By default, the DICOM image included on the CD is the original version of the radiograph, as it 
looked when you imported or received the file. Changes made on the Image Viewer window, such as 
window/level (brightness/contrast) adjustments, are not part of the DICOM image, although they are part 
of the JPEG image. If you want to use the current version of the radiograph for the DICOM image, 
contact IDEXX Customer Support. For service within the United States or Canada, call 1-877-433-9948.  

For more information about the process of recording information to a CD, see “About the CD Writing 
Process” on page 392.  

Note: The viewing software requires Java™ version 1.5, which is included on the disk. 

To create a Patient CD from the Image Explorer:  

1. On the Image Explorer window, select the series or images you want to copy to a CD.  

2. Insert a blank CD. 

Note: You can also use a DVD if you have a DVD-burning drive and if the computer used to view the 
images has a DVD drive. 

3. Click Create Patient CD. The Select Images dialog box appears. 

4. Do the following:  

• Select Study to create a Patient CD with the study to which the selected images belong. 

• Select Series to create a Patient CD with the series to which the selected images belong. 

• Select Image to create a Patient CD with only the images you have selected. 

• Select Apply Overlays if you want the images in the case to contain the overlay information 
displayed in the Image Viewer. 

• Select Apply Annotations if you want the images in the case to contain the annotations 
created in the Image Viewer. 

Note: For more information about image, series, and study, see “About Image, Series and Study” on 
page 361. For more information about applying overlays and annotations, see “Applying Annotations 
and Overlays” on page 372. 

5. Click Select. The Select Export Preference dialog box appears.  

6. In the Number of Copies text box, enter the number of copies of this patient CD you want to make. 

7. Make sure the CD/DVD option is selected, and then click OK. The Patient CD Progress dialog box 
appears. When the files are ready, the “Patient CD compilation complete” message is displayed. 
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8. Click OK. 

9. When the process is complete, the finished CD is ejected automatically. 

Note: Once you create a patient CD, you cannot add or change the information on the CD. 

To save patient CD information to a file location from the Image Explorer:  

Use this process if you want to bypass the Patient CD process. You might do this if you want to put the 
images in an email or on a USB flash drive, or you might want to compile the information for Patient CDs 
throughout the day and then burn the CDs at a later time using the CD burning capabilities in Windows. 

1. On the Image Explorer window, select the series or images you want to save to a file location.  

2. Click Create Patient CD, and select the image level (Study, Series, or Image). The Select Export 
Preference dialog box appears.  

3. Select File Folder, and click Browse to select the location where you want to save the Patient CD 
information.  

4. Select a location in the Save In drop-down list and click Save. 

5. Click OK. The Patient CD Progress dialog box appears. When the files are finished, the “Patient CD 
complete” message is displayed. 

6. Click OK to close the Patient CD Progress dialog box. 

Viewing a Patient CD  

To view a patient CD:  

1. Insert the patient CD into the CD drive. After several seconds, the Patient CD Viewer opens. The 
viewer displays information about the patient, and the name and address of the practice. 
Thumbnails of all the images on the CD or DVD are displayed. 

Note: The Patient CD and the viewer software included on the CD have been tested on Windows 
operating systems; however, they may not be compatible with other operating systems, such as the 
Mac OS® X operating system. 
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The initial Patient CD window 

2. To view a JPEG of an image, click the image. The image opens in the default Internet browser or 
JPEG viewing software on your computer. 

3. To view images in a streamlined version of the Image Viewer, select the check boxes next to one or 
more images, and click Open Images. 

4. If you want to open all of the images on the CD or DVD, click Select All, and then click Open 
Images. 

The images will appear in the viewer. If you select multiple images, you can move from one image to 
another by using the Thumbnail pane. 

Note: Because the viewer is running from the CD or DVD drive, it may take a few moments to open 
the images. 
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The Patient CD Image Viewer window 

5. To enhance the image, use the tools at the top of the window. The following tools are available: 
Rotate Clockwise, Rotate Counterclockwise, Flip Horizontal, Flip Vertical, Window/Level, Zoom, 
Magnify, Pan, Invert, and Toggle Overlays. 

Note: These tools work the same way that they do in the Image Viewer, but you cannot save the 
changes you make to the images. 

6. When finished, click the X in the upper right corner of the window to close the Patient CD viewer, 
and then remove the CD or DVD from the CD drive. 

Printing Images 

The Cornerstone software offers several printing options for your image files. You can print: 

• The image with comments 

• The image without comments 

• The image only 

• A series or study 

• Multiple image files for a single patient 

To print an image with comments: 

1. In the Image Explorer, find and select the image or images that you want to print. (For details, see 
“About the Image Explorer” on page 356.) 

2. Click Print.  
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3. In the dialog box: 

• If you want the printed images to contain the overlay information displayed in the Image Viewer, 
select Apply Overlays. 

• If you want the printed images to contain the annotations created in the Image Viewer, select 
Apply Annotations. 

4. Click one of these buttons:  

• Study, if you want to print the studies to which the selected images belong 

• Series, if you want to print the series to which the selected images belong 

• Image, if you want to print only the selected image 

Note: For more information about image, series and study, see “About Image, Series and Study“ on 
page 361. 

The Print Preview dialog box appears. 

5. Click Page Setup. 

6. Select the appropriate print options, and then click OK. 

Emailing Images 

You can email images quickly from either the Image Explorer or the Image Viewer.  

You can email an image, series, or study. Also, you can select the format in which the images are sent: 
JPEG and TIFF formats can be viewed by most Internet browsers and many graphics programs.  

Note: You need to set up your system’s email defaults before you can email images. See “Chapter 6: 
Setting Cornerstone Imaging Defaults” in the Cornerstone Administrator’s Manual for information. 

To email images, series, or studies from the Image Explorer window: 

1. In the Image Explorer, click to select the images, series, or studies that you want to send, and then 
click the E-mail button, or right-click one of the selected items and select E-mail from the menu. 

2. Do the following:  

• Select Study to email the study to which the selected images belong. 

• Select Series to email the series to which the selected images belong. 

• Select Image to email only the images you have selected. 

• Select Apply Overlays if you want the images to contain the overlay information displayed in 
the Image Viewer. 

• Select Apply Annotations if you want the images to contain the annotations created in the 
Image Viewer. 

Note: For more information about image, series and study, see “About Image, Series and Study“ on 
page 361. For more information about applying overlays and annotations, see “Applying Annotations 
and Overlays” on page 372. 

3. Click Select. The E-mail dialog box appears. 

4. In the To text box, select or type the email address, or leave the default value. 

5. In the Subject text box, type the subject of the email or leave the default value (your practice name). 

6. To include a message, type it in the Message text box. 
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7. Select the image file format in the Export File Type drop-down list. The text boxes in the lower left 
corner of the dialog box display the number of images and the estimated total size of the images in 
megabytes (MB). 

8. Click Send to complete the process. 

To email images, series, or studies from the Image Viewer: 

1. To select the image that you want to send, click the image thumbnail in the Thumbnail pane so that 
red borders are displayed around the thumbnail. 

2. Right-click the thumbnail, and select E-mail from the menu. 

3. Do the following:  

• Select Study to email the study to which the selected images belong. 

• Select Series to email the series to which the selected images belong. 

• Select Image to email only the images you have selected. 

• Select Apply Overlays if you want the images to contain the overlay information displayed in 
the Image Viewer. 

• Select Apply Annotations if you want the images to contain the annotations created in the 
Image Viewer. 

4. Click Select. The E-mail dialog box appears.  

5. In the To text box, select or type the email address, or leave the default value. 

6. In the Subject text box, type the subject of the email or leave the default value (your practice name). 

7. To include a message, type it in the Message text box. 

8. Select the image file format in the Export File Type drop-down list. The text boxes in the lower left 
corner of the dialog box display the number of images and the estimated total size of the images in 
megabytes (MB). 

9. Click Send to complete the process. 

Using Case to Send to a Telemedicine Provider or Export Images 
Using IDEXX Integration Technology for Telemedicine, you can use the Case feature to send cases to a 
telemedicine provider. You can see the status of the submission from the Image Explorer and, when a 
report comes back from the provider, you are able to open it from the Cornerstone* software. 

Using the Case feature, you can also create a case and email that case, export the case to CD/DVD or 
create a patient CD with the case. 

Note: Only images that you have available in Cornerstone on the Image Explorer window can be 
included in case emails, exported cases or case patient CDs. Images and other files that are attached to 
the case by using the Thumbnails pane on the Case Detail dialog box are not included. 

Note: The patient CD viewing software requires Java™ version 1.5, which is included on the disk. 

Note: To email cases, you must have an email system configured on your computer. 
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Creating a Case and Adding Images 

To create a case and add images in Cornerstone Imaging: 

Note: Before you create a case in Cornerstone Imaging, you need to copy any images you want to 
attach to the case to a file location. 

1. On the Patient Clipboard, in the Patient History area, right-click and select New Case. The Case 
Detail dialog box appears. 

2. In the Case Title text box, type a name for this case. 

3. In the Staff / User drop-down list, select the staff member or Cornerstone software user associated 
with this case. 

4. Expand the Thumbnails pane if it is not already open. 

 
Case Detail dialog box 

5. If you want to attach images and supporting material, do the following: 

a. Click Attach File. The Open dialog box appears. 

b. Use the dialog box to select the file(s) you want to add and click Open.  

c. Repeat these steps if you want to attach additional files. 

6. If you want to remove an attachment or image, select its thumbnail and click Remove. 

Submitting a Case to a Telemedicine Provider 

To submit a case to a telemedicine provider: 

1. On the Case Detail dialog box, expand the Case Actions pane. 

2. Select the tab for the telemedicine provider you want to use or, if you have set up more than one 
telemedicine provider, select the Telemedicine tab and then select the provider you want from the 
Tele Provider drop-down list. 

3. Click Submit Case. A web browser opens and displays the provider’s web site. 

4. Complete the information needed to submit the case: 
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• Although patient data is automatically filled in, be sure to check that it is accurate. 

• Select the service to which you want to submit (such as cardiology or radiology). 

• Include relevant history and information about the presenting complaint. 

5. When you complete the submission process, close the window for the telemedicine provider’s web 
site. 

Note: On the Case Detail dialog box in Cornerstone, you’ll see that the Submit Case button is now 
the View Case button. Click this button to open a browser window to see the case on the 
telemedicine provider’s web site. 

 
Telemedicine tab on the Case Detail dialog box 

Viewing Case Status and Reports 

To view the status of a telemedicine submission: 

1. On the Patient Clipboard, right-click in the Patient History area and select Image Explorer. 

2. Click the Advanced Search tab and make sure that the Cases text box is selected. 

 
Image Explorer Advanced Search tab 

In the Results Detail area, a thumbnail is displayed on the left for the Case and thumbnails for each 
submission to the right. Generally, these thumbnails show a service to which the case has been 
submitted and the status of the submission for that service. The thumbnails are updated with the 
latest status every five minutes. 
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Thumbnails display for the case and for each submission 

3. Double-click a submission thumbnail to see general details about the submission on the Case 
Actions pane of the Case Detail dialog box. 

4. To view full details of the case, click View Case. A web browser will open and display the 
information on the telemedicine provider’s web site. 

Submission statuses: 

Started You have created a case and entered some or all of the information, but you have not yet 
submitted the case to a telemedicine provider.  

To submit the case, expand the Case Actions tab, select the tab for the telemedicine provider 
you want, and click Submit. 

 
Sending You have submitted the case. Information and image(s) are in the process of being sent.  

 
Received All images and information for the case have been received by the telemedicine provider. The 

case is ready for a specialist to read it. 

 
In Process A specialist is reading the case. 

 
Attention! A problem has occurred. Click the icon to find information about what has happened and what 

you should do. Situations in which you might see this thumbnail include: 

Case information was not successfully received.  

Additional information is needed by the specialist. 

 

Cancelled The submission has been cancelled. 

 
Completed The specialist has completed reading the case and sent a report back. Click the icon to read 

the report. (See the instructions below for further information.) 
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To view and print a report: 

1. Double-click a submission thumbnail with a status of Completed. The report opens in the Adobe 
Reader® software. 

2. If you want to print the report, click Print  . 

Working with Submitted Cases 

To add images or other attachments after submitting a case: 

After a case has been submitted, you can no longer add images or other material to the case in 
Cornerstone. You need to use the attachment feature on the telemedicine provider’s web site instead. 

1. On the Patient Clipboard, right-click in the Patient History area and select Image Explorer. 

2. Click the Advanced Search tab and make sure that the Cases text box is selected. 

3. Double-click a submission thumbnail. The submission Case window opens, displaying Case Actions 
pane and the tab for the telemedicine provider. 

4. Click View Case. A web browser will open and display the information on the telemedicine 
provider’s web site. 

5. Use the attachment feature on the telemedicine provider’s web site to attach additional images or 
supporting material. 

6. Close the provider’s web site. 

To assign a telemedicine submission created outside of Cornerstone: 

In most cases, if you submit a case to your telemedicine provider without using Cornerstone, 
Cornerstone will be able to match the submission status and any resulting reports to the proper patient 
in Cornerstone. If the status or report does not show up automatically, use the following process to 
manually match the submission to the patient. 

1. On the menu bar, select Activities> Imaging> Telemedicine Queue. The Telemedicine Queue 
window appears and displays all telemedicine submissions that are not assigned to a patient. 

2. To view a submission, select it in the table and click View Case. The Case Detail dialog box opens 
and displays the submission information. 

3. To assign this submission to a patient, click Assign. The Select Client and Patient dialog box 
appears.  

4. Type the patient’s name or ID in the text box and click Search.  

5. Select the patient in the table and click Select. A case containing this submission is created for this 
patient. Submission status is displayed on the Image Explorer window and you are able to view 
information or reports for the case on the Case window. 

Creating a Patient CD from a Case 

When you create a patient CD from a case, the viewing software on the CD or DVD shows the images 
that are part of the case. Any text that you’ve added to the case on the Case Actions tab is recorded as 
a separate file on the CD or DVD. 

To save patient CD information for a case to a file location: 

Use this process if you want to bypass the patient CD process. You might do this if you want to put the 
images in an email or on a USB flash drive, or you might want to compile the information for patient CDs 
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throughout the day and then burn the CDs at a later time using the CD burning capabilities in the 
Microsoft® Windows® operating system. 

1.  On the Case Detail window, if the Case Actions pane is not open, click Expand>>. 

2.  Click the Patient CD tab. The patient CD options are displayed. 

3.  Select File Folder, and type the file folder location in the text box, or click Browse and browse to the 
folder that you want to use.  

4.  Do one of the following: 

a.  In the Medical Notes/SOAP text box, type any notes that you want saved on the CD. These 
notes will be saved in a text file labeled with the name of the case. 

b.  To add medical notes/SOAP from the patient’s medical history:  

i.  Click Medical History. 

ii.  Select the medical notes to include by using the Medical Notes/SOAP Selection Screen 
dialog box. 

iii.  Click OK. The medical notes you have chosen are displayed in the Medical Notes/SOAP 
text box, where you are able to edit them. 

5.  If you want to add annotations or overlays to the JPEG files that will be included on the CD, click 
Apply Annotations and/or Apply Overlays. 

6.  Select a location in the Save In drop-down list and click Save. 

Sending Cases via Email  

The case feature allows you to email a case, with its images and any text that you have added on the 
Case Actions tab. 

To email a case: 

1.  On the Case Detail window, if the Case Actions pane is not open, click Expand>>. 

2.  Click the E-mail tab. The email options are displayed. 

3.  In the To text box, type the email address for the specialist to whom you are sending the case, or 
select the address from your address book by doing the following: 
• Click Address Book. The Address Book dialog box appears. 

• Select an address and click OK. The address is displayed in the To text box. 

4.  Do one of the following: 

a.  In the Medical Notes/SOAP text box, type any notes that you in the text file that will accompany 
the case. These notes will be saved in a text file labeled with the name of the case. 

b.  To add medical notes/SOAP from the patient’s medical history:  

i.  Click Medical History. 

ii.  Select the medical notes to include by using the Medical Notes/SOAP Selection Screen 
dialog box. 

iii.  Click OK. The medical notes you have chosen are displayed in the Medical Notes/SOAP 
text box, where you are able to edit them. 

5.  Select the type of file that the Cornerstone software should use to email the images in the E-mail 
Attachment File Type text box. 

6.  If you want to add annotations or overlays to the files that will be emailed, click Apply Annotations 
and/or Apply Overlays. 

7.  Do one of the following: 

• To email the case, select Send. 

• To save this case to send later, click Save and Exit.  
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Note: If you receive a message or warning about the safety of sending the email, click OK.  

Exporting Cases to a CD or DVD 

You can create a CD or DVD containing case images and notes. Unlike the patient CD option, this 
method does not put a streamlined version of the Cornerstone Image Viewer on the CD or DVD, so the 
recipient of the disk will need to have software that can display the images. 

To export a case to a CD or DVD:  

1.  On the Case Detail window, if the Case Actions pane is not open, click Expand>>. 
2.  Click the Export tab. The export options are displayed.  

3.  Select CD/DVD to save the case to a CD or DVD.  

Note: If you want to save the case to a file location select File Folder and choose a file location. You 
might do this if you wanted to save the case onto a USB flash drive, or to compile the burn the case 
onto CD at a later time using the CD burning capabilities in the Windows operating system  

4.  Do one of the following: 

a.  In the Medical Notes/SOAP text box, type any notes that you want included in the text file that 
will accompany the case. These notes will be saved in a text file labeled with the name of the 
case. 

b.  To add medical notes/SOAP from the patient’s medical history:  

i.  Click Medical History. 

ii.  Select the medical notes to include by using the Medical Notes/SOAP Selection Screen 
dialog box. 

iii.  Click OK. The medical notes you have chosen are displayed in the Medical Notes/SOAP 
text box, where you are able to edit them. 

5.  Select the type of file that the Cornerstone software should use to export the images in the Export 
File Type text box.  

6.  If you want to add annotations or overlays to the files that will be exported, click Apply Annotations 
and/or Apply Overlays. 

7.  Click Export. The files are copied to the selected disc. 

Image file names and formats: 

Image file names have the following format:  

PatientName_OwnerLastName_ImageTitle_YYMMDD_PG.xxx 

where YYMMDD is the date the image was captured, PG is the page number of the image, and .xxx is 
the type of file. 

Text file names and formats: 

Text file names have the following format:  

PatientName_OwnerLastName_CaseTitle_YYMMDD.txt 

The text files are described in the next section, “Text File Contents." 
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Text File Contents 

A text file is sent with the case whenever you email a case, export a case to a CD/DVD, or create a 
patient CD with a case. This text file contains: 

• Information about the case 

• Patient information 

• Client information 

• Information about the images in the case 

• Contact information for your practice 

On a patient CD, this text file is included on the CD separately from the patient CD viewer, and can be 
accessed through the Windows® operating system. 

Using the Address Book  
The address book gives you quick access to email addresses to which you frequently send images from 
Cornerstone.  

To select an address:  

1. Select the row in the table for the email address you want. If you want to select more than one 
address, hold down CTRL while you click. 

2. Click OK. The Address Book dialog box closes and the email address appears in the To text box. 

To set up addresses: 

1. Click Add E-mail Address. A new row appears in the table. 

2. Click the new row. 

3. In the Description text box, type a name for this email address. 

4. In the Email Address text box, type the address. 

5. Click Save. 

6. Repeat steps 2-5 for each address you want to enter. 

7. When you have finished entering addresses, click Close to close the dialog box. 

Using the Radiology Log 
The Radiology Log feature in Cornerstone offers several ways to record log entries and add or edit 
information: 

• If your images are stored within Cornerstone, radiology log entries are automatically recorded but you 
need to record exposure information later. You can do this on either: 

o On the log itself—for a particular patient or for all patients 

o On the Image Detail dialog box—for a particular image, either during the capture process or when 
reviewing the image 

• If you capture and store images outside of Cornerstone, you can manually create a log entry and add 
radiology log information on the Radiology Log window. 

Once a log has been generated, you can view the entire log or a portion of it, and can print it, email it, or 
export it as a PDF (Portable Document Format) file. 

Note: With the addition of the Radiology Log feature in Cornerstone 8.1, you no longer need to use the 
“Cornerstone Radiology (Imaging) Template” Classic medical note. 
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Entering Information for Images Stored Outside of Cornerstone 

If you capture images outside of Cornerstone and would like to record radiology details in a patient’s 
medical record, you can manually enter radiology information in Cornerstone.  

To manually enter radiology log information: 

1. With the patient’s record open on the Patient Clipboard, in the Patient History area, right-click and 
select Radiology Log.   

2. To add a log entry manually, click Add Entry. A new row is added to the table. 

3. In the table, you can add entries or modify any information that wasn’t automatically recorded by 
Cornerstone: 

• Scroll down to see all the entries, and scroll to the right to see all the information for each image. 

• To add a log entry manually, click Add Entry and enter information in the row that is added to the 
table. 

• To delete a log entry, highlight the row and click Delete Entry. 

 Note: You can only delete entries that you have added manually. Entries created automatically 
by the Cornerstone software cannot be deleted. 

• To modify information that was not entered automatically by the software, click in the text box and 
edit the text. 

• Fill in any of the following text boxes for which you want to record information: 

o Thickness—Type the thickness of the body part being imaged. 

o Exposure mAs—Type the amount of x-ray exposure in milliampere-seconds (mAs). This is 
calculated automatically if you enter values in the Exposure mA and Exposure time sec text 
boxes. 

o Exposure mA—Type the amount of current in milliamperes (mA). 

o Exposure time sec—Type the duration of the exposure in seconds as a decimal value or use 
the drop-down menu to select a fraction of a second. 

o Exposure kVp—Type the amount of voltage (peak kilovoltage) used for this image. 

o Level of sedation—Select from the drop-down menu.  

o Use of Grid—Select the check box if a grid was used. 

 Note: If you added this entry manually, you may be able to edit additional text boxes. Use the 
Patient ID and Client ID text boxes if you want to change the patient or client. 

4. Use the buttons on the right to print, email, or export the log to a PDF file. 

5. Click Close in the upper right corner of the Radiology Log dialog box to close it. 

Entering Information for Images Stored Within Cornerstone  

A radiology log entry is automatically recorded for each radiograph captured by Cornerstone using an 
IDEXX Digital Imaging System (and for images you import into Cornerstone). The information in this entry 
can be modified or added to during the capture process or when you are reviewing the images later.  

To record radiology log information for a patient: 

1. On the Patient Clipboard, with a patient selected, right-click in the Patient History area and select 
Radiology Log. The Radiology Log window appears, displaying log entries for this patient. 

2. In the table, you can add entries or modify any information that wasn’t automatically recorded by 
Cornerstone. (See step 3 in the “To manually enter radiology log information” procedure in the 
preceding section for more details about entering this information.)  

3. Click Save. 
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Radiology Log displaying log entries for a patient 

To record radiology log information for an image: 

1. Do one of the following: 

• On the Image Viewer window, click Edit Image Details . 

• On the Image Capture window, after you have captured an image and the buttons at the top of 

the screen have turned red, click Image Information . 

2. Click the Technique Details tab. 
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Image Details – Technique Details tab 

3. Fill in any of the following text boxes for which you want to record information.  

• Thickness—Type the thickness of the body part being imaged. 

• Exposure mAs—Type the amount of x-ray exposure in milliampere-seconds (mAs). This is 
calculated automatically if you enter values in the Exposure mA and Exposure time sec text 
boxes. 

• Exposure mA—Type the amount of current in milliamperes (mA). 

• Exposure time sec—Type the duration of the exposure in seconds as a decimal value or use 
the drop-down menu to select a fraction of a second. 

• Exposure kVp—Type the amount of voltage (peak kilovoltage) used for this image. 

• Use of Grid—Select the check box if a grid was used. 

• Level of sedation—Select from the drop-down menu. 

4. Click OK to save the information and close the dialog box. 

5. If you are on the Image Viewer window, save the image before you exit. If you are on the Image 
Capture window, the image and any changes you’ve made to the radiology log are saved when you 
click Done Capture.  

Viewing, Editing, Printing, Emailing, and Exporting the Radiology Log 

To view, edit, print, email, and export the radiology log: 

1. Do one of the following:  

• On the Activities menu, select Imaging > Radiology Log; use the search fields to specify the 
client, patient, or time period for which you want to view the log; then click Search. 
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Note: If you are on the Image Explorer window and have a patient selected, the radiology log 
opens with information for that patient displayed. To search for different information, click Clear 
and use the search fields. 

• To view the radiology log for a specific patient, with the patient’s record open on the Patient 
Clipboard, in the Patient History area, right-click and select Radiology Log.   

 
Radiology Log window 

2. In the table, you can add entries or modify any information that wasn’t automatically recorded by 
Cornerstone: 

• Scroll down to see all the entries, and scroll to the right to see all the information for each image. 

• To add a log entry manually, click Add Entry and enter information in the row that is added to 
the table. 

• To delete a log entry, highlight the row and click Delete Entry. 

• To modify information that was not entered by the software automatically, click in the text box, 
edit the text, and click Save. 

3. Use the buttons on the right to print, email, or export the log to a PDF file: 

• To email, click E-mail Log, fill in the text boxes on the E-mail dialog box, and click Send. The 
log is sent as a PDF file attached to your email. 

• To print, click Print Log. The Print Preview window appears, where you can view the log as it will 
be printed, and can click Print to print it. 

• To export the log as a PDF file, click Export as PDF. The Save As dialog box appears. Select a 
location in the Save In text box or the browsing area below it, type a name in the File Name text 
box, and click Save. 
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Note: PDFs are viewed with the Adobe Reader® software (formerly Acrobat® Reader®), which is 
installed on IDEXX-supplied computers. You can download Adobe Reader software for free at 
http://get.adobe.com/reader/. 

4. Click Close in the upper right corner of the Radiology Log dialog box to close it. 

Archiving Images 

The Cornerstone software lets you archive your images to save space on your computer and to make 
image management easier. Archiving removes image files from your computer and saves them to a CD 
or DVD, or to a network location, such as a server. This saves space on your computer and makes 
image management easier. 

For more information about the process of recording information to a CD, see “About the CD Writing 
Process” on page 392.  

IMPORTANT: It is important to store archived images in a safe location that is backed up regularly. If 
archived data is lost or damaged, images cannot be recovered. 

To archive images: 

1. On the Activities menu, select Imaging> Archiving to open the Archive Images dialog box. 

 
Archive Images dialog box 
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2. Use the text boxes and options in the Search Archive area to specify the images you want to archive: 

• Use the Patient and Client text boxes to search for images of a particular patient or client. 

• To search for images between two dates, type dates in the Start Date and End Date text boxes, 
or click dates in the drop-down calendars. 

• To search for images of inactive patients, select Include Inactive. 

• To search for images of deceased patients, select Include Deceased. 

3. To filter your search results to show only those patients who are inactive or deceased, select the 
Show only inactive/deceased check box. To search for particular inactive or deceased patients, fill 
in additional search criteria as needed. 

4. Click Search. The results are shown in the table below the Search Archive area. Each row displays 
the following information for an image study: 

• Name—the patient’s name 

• Patient ID  

• Client—the client’s name 

• # of Images—the number of images in the study 

• Capture date—the date the images in the study were captured 

• Title—the title of the study 

• Study Image—a thumbnail version of the first image in the study 

5. By default, all of the studies in the table are selected, but you can change which studies are 
selected:  

• Hold down the CTRL key and click to deselect or select individual studies. 

• Click Select All to select all the studies in the table. 

• Click Deselect All to deselect all of the studies in the table. 

6. In the Archive To area:  

• If you want to archive to a CD or DVD, select CD/DVD. If you want to make multiple copies, type 
a number in the Number of Copies text box. 

• If you want to archive to a location on your computer (not recommended) or the network, select 
File Folder, and use the text box and Browse button to specify the location where the archive 
files should be stored.  

Note: IDEXX recommends archiving images to a dedicated storage solution such as an external 
hard disk. Like any image files, the archived files on this storage device should be backed up 
periodically. 

7. Click Archive to archive the selected image studies to the archive location you have specified. 

Note: Archived images are labeled as “Archived” when displayed in the Image Explorer window.  

Note: If you are archiving to CD or DVD, be sure to label the disc with the date. IDEXX recommends 
using the same format as the Cornerstone software, i.e., “Cornerstone Images YYYY-MM-DD (#)” where 
# is the CD number. This will enable you to select the correct disc if you need to access any archived 
images in the future. 
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Viewing Archived Images 

When an image is archived, it is removed from the database on the computer and stored in your 
selected archive location (e.g., archive hard drive, CD, network server, etc.). A thumbnail of the image 
remains in the patient record as a reference to the image. Archived images are labeled as “Archived.” 

 
An archived image 

To view an archived image: 

1. Use the Image Explorer to find the archived image. (For more information, see “About the Image 
Explorer” on page 356.) 

2. Double-click the thumbnail of an archived image to open it.  

a. If the image is readily accessible (e.g., on a networked computer or server), it opens in the 
Image Viewer window.  

b. If the archived image is stored in a remote location (such as a CD), a message box displays the 
location. Insert the disc or browse to the location on the external hard drive or network, and click 
OK. The image appears in the Image Viewer window.  

3. If you want to make this image an active image again: 

a. Make a change to the image. One easy method is to rotate the image and then rotate the image 
back to its original position. 

b. Click Save, and select Save from the drop-down menu. You can now use this image like any 
other image in Cornerstone. 

About the CD Writing Process 
The creation of CDs (or DVDs) from Cornerstone is handled by the IDEXX Media Write Utility. The utility 
is used whenever you create a patient CD or archive images to a CD. 

Note: The Patient CD and the viewer software included on the CD have been tested on Windows 
operating systems; however, they may not be compatible with other operating systems, such as the Mac 
OS® X operating system. 

When you begin the CD writing process: 

1. If you are given a choice, be sure that the CD/DVD option is selected.  

2. If you see a Number of Copies text box, enter the number of copies of this patient CD you want to 
make. 
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During the CD writing process: 

1. If you want to cancel the CD writing process:  

• The first time you create a patient CD after restarting the Cornerstone software, a balloon 
appears in the lower left of the computer screen. Click this balloon and select the option to 
cancel the CD writing process.  

• For every subsequent CD you create, an icon for the IDEXX Media Write Utility appears at the 
bottom of the screen. Click the icon to open the IDEXX Media Write Utility and select Cancel 
Write.  

2. If you want to view the progress of the CD writing process:  

• The first time you create a patient CD after restarting the Cornerstone software, a balloon 
appears in the lower left corner of the computer screen. Click this balloon and select the option 
to open the IDEXX Media Write Utility.  

• For every subsequent CD you create, an icon for the IDEXX Media Write Utility appears at the 
bottom of the screen. Click the icon to open the IDEXX Media Write Utility to view progress. 

3. Click OK to close the Message dialog box. 

4. When the process is complete, the finished CD is ejected automatically. 

Note: Once you create a CD, you cannot add to or change the information on the CD. 
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Cornerstone User’s Manual                  394 



Chapter 27: Using Hill’s® Feeding Guide Software 

This chapter covers daily tasks for using Hill’s Feeding Guide Software in Cornerstone. For information 
on steps required to set up Hill’s Feeding Guide Software, see “Chapter 24: Setting Up Hill’s Feeding 
Guide Software” in the Cornerstone Administrator’s Manual. 

 

Using Hill’s Feeding Guide Software 
Hill’s® Feeding Guide Software (FGS) is included with your IDEXX Cornerstone* Practice Management 
System. Using FGS, you can print dietary instructions and nutritional information about Hill’s pet food 
products to help your clients keep their pets healthy. 

Feeding Guide Software shows your clients: 

• The financial benefit of feeding Hill’s products. 

• The proper feeding instructions for a healthier pet. 

Before You Begin 

• Set up the Feeding Guide Software and link Hill’s pet food invoice items to the Feeding Guide 
Software special action on the Invoice Item Information window’s Spec. Actions tab.  

• Update the patient’s weight.  

To use the Hill’s Feeding Guide: 

1. Do one of the following to access the Hill’s Feeding Guide dialog box: 

• Create a new invoice and add the Hill’s pet food invoice item or open an existing invoice with 
the item. Click Special (special actions) and select Feeding Guide Software in the Special 
Actions dialog box. 

• On the Activities menu, select Feeding Guide > Feeding Guide Profile. 

The Hill’s Feeding Guide dialog box appears. 

 
Hill’s Feeding Guide dialog box 
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2. Enter the Client ID and corresponding Patient ID. The patient’s current weight appears by default in 
the Ideal Weight box. Change the Ideal Weight, if necessary. 

3. In the Indication field, select the type of Hill’s diet product to feed the patient. Select the specific 
Product and Package size.  

Note: If a product is selected that could be recommended for more than one dietary purpose, the 
Purpose box appears before Cornerstone calculates the Feeding Information. Select the reason this 
product is being recommended and click OK. 

Tip: You can click Assist to use the Selection Assistant to determine the product to use for the 
patient’s condition. See “Using the Feeding Guide Selection Assistant” on page 396.  

4. Once you have entered the Dietary Information, the Feeding information is calculated automatically. 
If necessary, change the Amount to Feed the patient. Amounts appear to the nearest 1/8 cup. 
(Amounts over 20 pounds increase by 1/4 cup.) The number of days a bag or case (for cans) of the 
product should last and the cost per day to feed the patient the product correlate to the amount. 

5. Click Print to print the feeding instructions. The Print Options dialog box appears with one (1) 
Feeding Guide Profile selected to print by default. 

 
Print Options for Feeding guide profile and Product information 

6. Click Preview to view the Feeding Guide Profile in the Reports Preview window, or click Print to print 
the profile. (You can change the number of copies to print, if necessary.) 

7. If you want to print information about the product, select the Product information check box and 
click Preview to view the information in the Reports Preview window, or click Print to print the 
information.  

8. Click Close to return to the Hill’s Feeding Guide dialog box. 

9. Click Close to exit. 

Using the Feeding Guide Selection Assistant 
The Selection Assistant is a component of the Hill’s Feeding Guide Software designed to help you make 
pet food recommendations to your clients based on the patient’s current condition. 

To use the Feeding Guide Selection Assistant: 

1. From the Hill’s Feeding Guide dialog box, enter the Client ID, Patient ID and the patient’s Ideal 
Weight. 

2. Click Assist. The Selection Assistant dialog box appears. 

 
Selection Assistant dialog box 
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3. Select the Category of the patient’s dietary concern from the drop-down list. (Categories include: 
Acute Care/Recovery, Adverse Reaction to Foods, Cancer, Cardiovascular Conditions, Fiber 
Responsive Diseases, Gastrointestinal Disease, Hepatic Diseases, Obesity, Oral Care, Renal 
Disease and Urolithiasis.) 

4. Select the patient’s specific dietary Conditions from the drop-down list. (Conditions are specific to 
the condition you selected.) 

5. Select a Product from the suggested items in the drop-down list. 

6. Click Transfer. The product information appears in the Dietary Information. 

7. Select the Package Size the client is purchasing. The Feeding Information appears. Continue using 
the Feeding Guide as usual. 
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This chapter covers daily usage tasks in the Mobile Computing module in Cornerstone. For information 
on steps required to set up the Mobile Computing module, see “Chapter 31: Setting Up the Mobile 
Computing Module” in the Cornerstone Administrator’s Manual. 

 

Overview 
The Mobile Computing module with mobile computer synchronization provides the ability to use the 
IDEXX Cornerstone* Practice Management System outside of the practice. A mobile computer could be 
a laptop or a tablet PC. 

After returning to the practice, the data on a mobile computer can be downloaded to the main practice 
database. The database on the mobile computer is also updated to match the main database. 

Information That Can Be Viewed or Changed on a Mobile Computer 
Understanding what types of information can be changed on a mobile computer will be easier if you 
remember that the information on the mobile computer is secondary to the information on the main 
practice server. 

Some features in Cornerstone cannot be accessed from a mobile computer because this would cause 
the mobile computer database to conflict with your practice database when the synchronization process 
occurs. Generally, information relating to clients and patients can be created or updated. 

Information that can be created or updated 

Client and patient information 
Patient vital signs/weight 
Patient diagnoses 
Patient problems 
Patient medical notes 
Rabies/vaccine tag information 
Reminders 
Correspondence 
Estimates 

Information that can be created, but not updated 

Prescriptions  
Lab Requests  

Patient Visit List (PVL)† 

Invoices† 
Images  

† Items created on the mobile computer can be updated until the next synchronization process is run. 

Information that can be viewed, but not created or updated 

All reports in Cornerstone Foundation (with applicable security) except Referral reports 
Open invoices that were created on the main system 
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The Appointment Scheduler Schedule for Today window 
Setup information, such as discounts, taxes, classifications, etc.  

Information that cannot be accessed 

Practice defaults 
Inventory 
Practice Explorer* 
Patient Advisor* 
Time Clock 

How Does the Patient Visit List Work with Mobile Computing? 
If a patient has items on the Patient Visit List on the main system, those items cannot be viewed on the 
mobile computer. However, items may be added to the Patient Visit List on the mobile computer. When 
the synchronization process is run, items from the mobile computer’s Patient Visit List will be added to 
the Patient Visit List on the main system. Use care when adding items to the Patient Visit List so you do 
not inadvertently create duplicate entries. 

Mobile Computing Menu Options 
The Mobile Computing menu is located on the Tools menu. These tasks on the Mobile Computing menu 
can only be performed on a mobile computer: Create and Undo Mobile Computer and Synchronize. 
These menu options may only be selected from the server or a regular workstation: Mobile Computer 
List and Mobile Computer Checkout Report. 

Note: The other options on the Tools menu (Merge client/patient, Mass markup, Purge data, etc.) 
cannot be accessed when a mobile computer is in use. To access other options on the Tools menu, 
synchronize all mobile computers, and then undo the mobile computers (the mobile computer list must 
be empty). Perform necessary functions, and then recreate the mobile computers. 

Cornerstone provides an easy way to help you remember if you’re working on the mobile computer. The 
name of the mobile computer displays in the title bar as shown here: 

 

Checking out Medical Notes and Correspondence 

If a staff member plans to update tentative medical notes and correspondence from the mobile 
computer, this information must be “checked out” to the mobile computer. The check out process is set 
up when a mobile computer is created and can be changed when it is synchronized.  

Medical notes and correspondence that are checked out to a staff member on a mobile computer 
cannot be updated on the main system until it is synchronized and the notes and correspondence for 
that staff member are checked back in.  

When a staff member’s tentative medical notes and correspondence are checked out, the staff member 
may only update the notes and correspondence on the mobile computer. New medical notes and 
correspondence may be created on either the main system or the mobile computer. 

Example:  

Ann Smith and Mark Jones alternate time spent in the office. The first week, it’s Ann’s turn to be on the 
road. Ann’s tentative medical notes and correspondence are “checked out” on the laptop. Ann’s 
tentative medical notes and correspondence may only be updated from the laptop. Neither she nor 
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anyone else can update her tentative medical notes and correspondence from the main system. The 
next week, it’s Ann’s turn to be in the office and Mark will be on the road. The laptop must be 
synchronized and Ann’s tentative medical notes and correspondence must be checked back into the 
main system. Mark’s tentative medical notes and correspondence must be checked out to the laptop.  

For more information on checking medical notes and correspondence in or out, see “Synchronizing the 
Mobile Computer” on page 401. 

Using the Mobile Computing Module 

Creating a Mobile Computer (Laptop) 

To create a mobile computer in Cornerstone: 

Note: Perform this task on the mobile computer; you must be connected to the Cornerstone Database 
Server. Make sure you have enough hard disk space for the database before beginning. 

1. On the Tools menu, select Mobile Computing > Create. 

2. Enter the name for your mobile database. This name is used to identify the database in the main 
practice database. Click Next. 

3. If needed, change the default location for the mobile database and shared folders. Click Next. 

4. If this machine has previously been used for the Mobile Computing module, a message appears 
asking if you’re sure you want to overwrite the existing information. Click Yes to continue setup. 

5. Select the staff members who will be checking out Tentative or Draft medical notes on this machine. 
Press CTRL and click to select/deselect staff (highlighted/shaded staff names are selected). Click 
Next.  

 
Synchronize Databases window 

6. Select the staff members who will be checking out Tentative or Draft correspondence on this 
machine. Press CTRL and click to select (or deselect) staff (highlighted/shaded staff names are 
selected). Click Next. 

7. The database will be created. This process can take several minutes, depending on the size of your 
database. When the copying process is complete, click Finish. 

Cornerstone User’s Manual                  400 



Chapter 28: Using the Mobile Computing Module 

Once you have the mobile computer set up, you can use the laptop as you normally use Cornerstone. 
See “Information That Can Be Viewed or Changed on a Mobile Computer” on page 398 for more details 
about mobile computer use.  

Selecting a Printer for the Mobile Computer 

To select a printer for the mobile computer: 

1. When you log into Cornerstone on the mobile computer, the Mobile Computer Printer Selection box 
appears. Select the printers you want to use for this session of Cornerstone:  

• Select Clinic printer(s) to use your regular network printers.  

• Select Mobile printer(s) to use a printer directly connected to the mobile computer. These 
assignments are temporary and will be overwritten the next time synchronization is run.  

 
Mobile Computer Printer Selection dialog box 

2. If you are using a mobile computer without a printer attached to it, you can save your documents as 
PDFs using the Cornerstone PDF printer. 

3. Click OK to save your changes.  

Synchronizing the Mobile Computer 

It’s important to periodically download the data from the mobile computer to the main practice database 
and to update the mobile computer database from the main practice database. This process is called 
synchronization. 

If your practice has more than one mobile computer, the synchronization process must be run on each 
laptop. You cannot synchronize more than one mobile computer at a time. 

You cannot synchronize the mobile computer if you have open invoices on the laptop.  

While the synchronization process is running, you can continue working on the main server. However, 
you will not be able to post an invoice while the mobile computer data is being copied to the main 
server. 

When the synchronization is run, the estimates, invoices and prescriptions on the mobile computer are 
copied to the main practice database. You will be able to tell where the estimate/invoice originated 
based on the ID. Part of the number is the identifying ID of the mobile computer. 

To synchronize the mobile computer: 

Note: Perform this task on the mobile computer; you must be connected to the Cornerstone Database 
Server. 

1. On the Tools menu, select Mobile Computing > Synchronize. 

2. Press the CTRL key and click to select (or deselect highlighted) staff to check out tentative medical 
notes. Click Next.  
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3. Press CTRL and click to select (or deselect highlighted) staff to check out tentative correspondence. 
Click Next.  

4. Your database will be synchronized. Click Finish. 

Conflicts and Exceptions 

If there is a conflict between the mobile computer database and the main system, you must resolve it 
before the synchronization can continue. For example, if new client records were entered on the mobile 
computer and the main system using the same ID, a message will display during synchronization. You 
will be required to enter a new ID for the client record created from the mobile computer before 
synchronization can continue.  

Occasionally, data from the mobile computer may be overwritten by data from the main system during 
the synchronization process. For example, if the same client’s address was updated on both the mobile 
computer and the main system, the address entered from the main system will overwrite the address 
entered from the mobile computer. This is called an exception. If an exception occurs, you can print the 
Exception Report from the mobile computer during the synchronization process. If needed, you can use 
this report to update the data on the main system. 

Any words that you add to the spell checker dictionary also need to be added on the main system. Each 
time synchronization is run, the main system’s dictionary overwrites the dictionary on the mobile 
computer. 

Using the Mobile Computer as a Regular Workstation (to Undo) 

If you are upgrading or changing mobile computers, or if you want to use the mobile computer as a 
regular Cornerstone workstation, remove the mobile computer from the Mobile Computing List.  

To use the mobile computer as a regular workstation: 

Note: Perform this task on the mobile computer; you must be connected to the Cornerstone Database 
Server. 

1. On the Tools menu, select Mobile Computing > Undo Mobile Computer. The following message 
displays.  

 
Undo Mobile Computer message 

2. Click Yes if you are sure you want to remove the mobile computer. The mobile computer will be 
removed. 
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This chapter covers referral relationship management tasks in Cornerstone. For information on steps 
required to set up Referral Relationship Management, see “Chapter 23: Referral Relationship 
Management” in the Cornerstone Administrator’s Manual.  

Overview 
The IDEXX Cornerstone* Practice Management System offers specialists in all disciplines a 
comprehensive solution for managing relationships with referring veterinarians (RDVMs). With these 
referral management features, specialists and their staff can easily monitor the pulse of all activity 
relating to RDVMs and their patients. 

Referral management features allow you to: 

• Identify patients/clients referred by a particular RDVM 

• Identify RDVMs associated with a particular patient 

• Identify RDVMs associated with a particular hospital 

• Quickly access notes about an RDVM’s education, interests, first referral date, etc. 

• Document and view RDVM/hospital communication preferences 

• View RDVM and hospital communication preferences from the Patient Clipboard* window 

• Search for RDVMs/hospitals using common filters including name, city, phone, or fax number. 

Note:  For detailed information about setting up and using Referral Relationship Management, see 
the “Referral Relationship Management” section in the Cornerstone help. 

Finding and Viewing Referral Veterinarian Information on the Doctor List 
Using the Doctor List window (Lists > Referrals > Doctors), you can quickly find a referral veterinarian 
(RDVM) using common search filters such as name, doctor ID, phone, or fax number. 

 

You can click the phone icon to access all personal and hospital-affiliated phone and fax numbers for 
the RDVM within the Doctor List window. The primary contact number is indicated for both personal and 
hospital numbers. 
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Adding, Editing, and Viewing Referral Veterinarian Information on the Doctor 
Information Window 

Hospitals Tab 

The Doctor Information window’s Hospitals tab allows you to: 

• Associate one or more hospitals with the RDVM (an RDVM must be associated with at least one 
hospital). 

• Add or edit the preferred contact phone numbers, email, and fax information for this doctor at a 
selected hospital. 

• Indicate the RDVM’s communication preferences and contact information to use when at a selected 
hospital. 

Note: The Email communication preference will be selected automatically if the hospital’s Send info via 
field was set to Email prior to installing Cornerstone. 

 

 

Personal Information Tab 

The Doctor Information window’s Personal Information tab allows you to: 

• Specify if you want to display the doctor’s contact information on the Patient Clipboard based on 
Personal preferences (those selected on the Personal Information tab), Hospital related 
preferences (those selected on the Hospitals tab), or both. 

• Add or edit personal contact information for this doctor. 
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• Indicate the doctor’s personal communication preferences. 

Note: The Email communication preference will be selected automatically if the Send info via field was 
set to Email prior to installing Cornerstone 8.3. 

 

 

Patients Tab 

The Doctor Information window’s Patients tab allows you to: 

• View checked in/checked out patients referred by the RDVM. 

• Double-click to open the Patient Clipboard for a patient on this tab. 
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Sales Tab 

The Doctor Information window’s Sales tab allows you to: 

• View the monthly sales generated based on referrals from this RDVM. 

• View number of new patient referrals and recheck referrals for each monthly sales period. 

 

 

Notes Tab 

The Doctor Information window’s Notes tab allows you to: 

• Add, edit, or view notes associated with this RDVM. 

• See the date of the first referral associated with this RDVM. 
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Finding and Viewing Referral Hospital Information on the Hospital List 
Using the Hospital List window (Lists > Referrals > Hospitals), you can quickly find a referral hospital 
using common search filters, such as city, phone, or fax number. 

 

When you highlight a hospital on the Hospital List, the hospital’s address, phone, and fax information 
display at the bottom of the window. 

Adding, Editing, and Viewing Referral Hospital Information on the Hospital 
Information Window 

Information Tab 

The Hospital Information window’s Information tab allows you to: 

• Add or edit contact information for this hospital. 

• Indicate the hospital’s communication preferences. 

 

 

Doctors Tab 

The Hospital Information window’s Doctors tab allows you to: 

• View referral veterinarians (RDVMs) associated with this hospital. 
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• Open the Doctor Information window for a doctor by double-clicking a listed RDVM (or by clicking 
the View details link near the bottom of the window for a selected RDVM). 

 

 

Patients Tab 

The Hospital Information window’s Patients tab allows you to: 

• View checked in/checked out patients referred by an RDVM at this hospital. 

• Double-click to open the Patient Clipboard for a patient on this tab. 

 

 

Sales Tab 

The Hospital Information window’s Sales tab allows you to: 

• View the monthly sales generated based on referrals from this hospital. 

• View number of new patient referrals and recheck referrals for each monthly sales period, v. 
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Notes Tab 

The Hospital Information window’s Notes tab allows you to: 

• Add, edit, or view notes associated with the referral hospital. 

• See the date of the first referral associated with this hospital. 

 

 

Accessing Referral Information and Referral History in Patient Information 
The Patient Information window’s Referrals tab serves as a dual-purpose tab, allowing you to view both 
referral veterinarians (RDVM) and hospitals for this patient and the referral history of the patient.  

You should verify the RDVM information for a patient for each visit or case and update it as necessary. 
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Referrals Tab—Patient RDVMs View 

The Referrals tab–Patient RDVMs view allows you to: 

• Identify RDVMs associated with this patient for this visit. 

• Specify a primary RDVM to be associated with this patient on the Patient Clipboard, in referral 
history, and on referral revenue reports. 

• Specify if an RDVM should be included on communications associated with this visit (using the This 
visit check box). The This visit check box is automatically selected for the primary RDVM, but you 
can clear the check box if the client has requested that the primary RDVM not receive 
communications. 

• View communication preferences for a selected RDVM and hospital and associated contact 
information. 

• View the RDVM history for the patient. 

Note: When viewing the Referrals tab in Referral History view, click the view RDVMs for this patient link 
to switch the tab to Patient RDVMs view. 

 

When an RDVM is selected, the associated communication preferences are listed in the box at the 
bottom of the tab. Use the scrollbar on the right side of the box to scroll through the available 
communication preferences: 

• Personal—Displays the RDVM’s personal communication preferences. If you want to view detailed 
personal contact information for this RDVM, click the view details link on the right to display the 
information on the Doctor Information window’s Personal Information tab. 

• When at [hospital name]—Displays the RDVM’s communication preferences when at the hospital 
selected above. If you want to view detailed hospital contact information for this RDVM, click the 
view details link on the right to display the information on the Hospitals tab in the Doctor 
Information window. 
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• Hospital: [hospital name]—Displays the selected hospital’s communication preferences. If you 
want to view detailed contact information for this hospital, click the view details link on the right to 
display the information on the Information tab in the Hospital Information window. 

 

Referrals Tab–History View 

The Referrals tab—Referral History view allows you to: 

 View complete referral history for this patient, including the date when the primary RDVM/hospital 
was assigned to this patient. 

Note: When viewing the Referrals tab in Patient RDVMs view, click the view referral history link to 
switch the tab to Patient History view. 

 

 

Accessing Referral Information on the Patient Clipboard* Window 

Patient Information  

In addition to an updated layout to accommodate quick “at a glance” scanning, the Patient information 
area now includes information on the patient’s primary referral veterinarian (RDVM), the RDVM primary 
phone number, and a link to view more RDVMs for this patient (or a link to add an RDVM if one has not 
been assigned for this patient). 
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RDVMs Tab (Referrals tab prior to Cornerstone 8.3) 

Click the RDVMs button  in the Patient Information area to access the tab. 

• The RDVMs tab lists the patient’s current RDVMs and their associated hospitals. 

• The RDVMs tab right-click menu provides quick access to detailed referral information and contacts 
for this patient. 

 

When an RDVM is selected on this tab, the associated communication preferences are listed in the box 
at the bottom of the tab.  

• Use the scrollbar on the right side of the box to scroll through the available communication 
preferences. 

• Click the view details link to access detailed contact information. 

Note: The communication preferences that display here vary depending on the Patient Clipboard 
display preferences selected for the RDVM on the Personal Information tab in the Doctor Information 
window.  
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Referral Information on the Patient Check-in/out Window 
On the Patient Check-in/out window, if a primary RDVM has been assigned for this patient, the RDVM is 
listed. In addition, the add/edit RDVMs link opens the Patient Information window’s Referral tab, 
allowing you to: 

• Add a new RDVM for this patient. 

• Access information for an existing RDVM. 

• Specify a primary RDVM for this visit by selecting the Primary option. 

• Specify the RDVMs you want to receive communications associated with this visit by 
selecting/clearing the This visit check box for each listed RDVM. The RDVM must have 
communication preferences set up in Cornerstone for the information to automatically appear in the 
Communications window. 

 

Referral Information for Mobile Computing  
RDVM information is enabled and viewable via hyperlinks for Mobile Computing module users. Click the 
links to open a read-only view of the Patient Information > RDVMs tab.  There are also two options 
available when you right-click in the Patient Information > RDVMs tab (View all Patient RDVMs and 
View Referral History). 

Referral Reports 
In the Report Search window (Reports > Find a Report), a variety of referral reports are available in the 
Reports list under the Referral group and under the End of Month > Referral Reports group. Click a 
report to display its details in the right pane. 

Referral Reports: 

• Referral Doctor Master Report—Prints a list of all the referral doctors (by Doctor ID) you have set up 
in Cornerstone.  
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• Referral Hospital Master Report —Prints a list of all the referral hospitals (Hospital ID) you have set 
up.  

End of Month > Referral reports: 

• Referral Reports by Staff—Shows the work done by a staff member of your practice for another 
hospital. 

• Referral Report—Doctor by Hospital 

• Referral Report—Hospital by Doctor 

• Referral Report—Referral Summary 

• Referral Summary—Doctor by Hospital 

• Referral Summary—Hospital by Doctor 

• Referral Summary by Doctor 

• Referral Summary by Hospital 

• Referral Revenue Report by Doctor by Revenue Center 

• Referral Revenue Report by Hospital by Revenue Center 
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Overview 
For Laboratory module users, IDEXX Cornerstone* Practice Management System, excluding the Mobile 
Computing Module, includes optional access to VetConnect* PLUS, a powerful web-based tool that lets 
you view and compare IDEXX in-house diagnostics and IDEXX Reference Laboratories data side by 
side. 

VetConnect PLUS works within the standard Cornerstone workflow for viewing results and has an 
enhanced format for viewing, comparing, and graphing result data. You can also visit 
vetconnectplus.com to view your results in a browser.  

For more information about VetConnect PLUS, contact VetConnect PLUS Client Services at 1-888-433-
9987 or visit vetconnect.com.  

VetConnect PLUS must be set up in the Practice Information window (select Lists > Practice and then 
click Update). 

Here’s an example of a VetConnect PLUS tab. 
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Using VetConnect PLUS, you can: 

• View the latest IDEXX test results in an enhanced and interactive window as soon as they are 
sent from the IDEXX Reference Laboratories or from your in-house analyzers. 

• See the complete history of a patient’s known IDEXX test results. 

• Compare results from IDEXX Reference Laboratories and IDEXX VetLab* Station tests side by 
side. (To do so, you must activate VetConnect PLUS on IDEXX VetLab Station.) 

• Graph and view trends for IDEXX test results with the click of a button. 

Data Storage in VetConnect PLUS 
VetConnect PLUS uses patient and test data stored on secure Vet Connect PLUS servers (that is, in “the 
cloud”). If you choose to activate VetConnect PLUS, IDEXX will ask permission to upload a copy of 
historical data from IDEXX Reference Laboratories from your VetConnect account and/or IDEXX VetLab 
Station. IDEXX will not upload this information without your consent. No information is uploaded from 
Cornerstone; Cornerstone performance is not affected. 

Your data in VetConnect PLUS is secure: 

• Sensitive data is not stored in VetConnect PLUS. VetConnect PLUS stores and displays only the 
following: 

• Patient demographics (name, ID, age, sex, species, breed) 

• Client names and IDs 

• Patient test results and the source of the results (IDEXX Reference Laboratories, ProCyte Dx*, 
Hematology Analyzer, SNAP* tests, etc.) 

• VetConnect PLUS does not store or display financial information, phone numbers, addresses, or 
any personal information from your practice, staff, or clients. 

Setup 

Prerequisites 
To activate VetConnect PLUS, your practice must have: 

• Internet access at the workstation where you want to view VetConnect PLUS.  

• Windows®Internet Explorer® 7 or later must be installed on each Cornerstone workstation. It does 
not have to be the default Internet browser. 

• If you want to view in-house results, you must have IDEXX SmartLink* technology to provide 
bidirectional flow between Cornerstone and your IDEXX VetLab Station. In addition, IDEXX 
SmartService* Solutions must be set up for the IDEXX VetLab Station. Call your IDEXX Connectivity 
Consultant at 1-877-256-8457 to order IDEXX SmartLink for your IDEXX VetLab Station if your 
practice does not already have it. 

• If you want to view IDEXX Reference Laboratories results, you must have IDEXX SmartLink* 
technology to provide bidirectional flow between Cornerstone and the IDEXX Reference 
Laboratories. Call your IDEXX Connectivity Consultant at 1-877-256-8457 to order IDEXX SmartLink 
if your practice does not already have it. 

• A VetConnect account with administrator user name and password. Call VetConnect PLUS Client 
Services at 1-888-433-9987 to request an account if your practice does not already have one. 
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Activating VetConnect PLUS 
You can activate VetConnect PLUS immediately following installation of Cornerstone 8.3 software or 
anytime after that. After you activate VetConnect PLUS from within Cornerstone, activate VetConnect 
PLUS from your IDEXX VetLab Station (if applicable). 

To activate VetConnect PLUS: 

1. From the Cornerstone Practice Information window (Lists> Practice), select your practice 
name, and then click Update. This must be your primary practice if you are a Multi-
Location Single Database user. 

2. From the Account information for drop-down list, select VetConnect PLUS. 

3. If you are a new IDEXX Reference Laboratories user, select the VetConnect option, enter 
your practice’s VetConnect administrator user name and password, and then click Submit 
to Activate VetConnect PLUS. 
OR 
If you are an existing IDEXX Reference Laboratories user, the VCAgent option should be 
selected and your VetConnect user name and password should be completed. Click 
Submit to Activate VetConnect PLUS. 

4. Read the agreement, and then click Accept.  
A message states that IDEXX Reference Laboratories historical data will be uploaded.  

5. Click Next.  

6. IDEXX VetLab Station only: A message giving you the option to print instructions on 
uploading data displays. Click Yes to open the printable message or No to continue.  

7. Click Finish. 

8. A message states that activation is complete and that data upload will continue. Close the 
message window.  

The upload of IDEXX Reference Laboratories historical data that began during activation will 
continue, with the most recent results uploaded first. Upload can take up to 24 hours, 
depending on the number of results being uploaded. You can continue to use Cornerstone 
software during the upload; Cornerstone performance will not be affected.  

To upload data from your IDEXX VetLab Station: 

1. On the IDEXX VetLab Station, tap Settings, and then select the VetConnect PLUS tab. 

2. Tap Activate VetConnect PLUS. 

3. Accept the VetConnect PLUS user agreement.  

4. Enter your VetConnect user name and password.  

5. Tap Next. A confirmation message is displayed. Close the message.  

Data is uploaded in reverse order, starting with your most recent results. You can continue to use 
the IDEXX VetLab Station during the upload.  

Disabling Access to VetConnect PLUS 
If you prefer to use the standard Cornerstone 8.3 workflow for viewing results, you do not need to 
deactivate VetConnect PLUS. All your test results are always available in standard Cornerstone 8.3 
windows. However, if you want to disable access to VetConnect PLUS, you can do so in Cornerstone.  
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To disable access to VetConnect PLUS: 

1. From the Cornerstone Practice Information window (Lists> Practice), select your practice name, 
and then click Update. 

2. From the Account information for drop-down list, select VetConnect PLUS. 

3. Select Disable VetConnect PLUS online services, and then click OK.  

Use 
You can open a patient’s IDEXX Lab Report in Cornerstone and then select the VetConnect PLUS tab in 
the Detailed Lab Results Set window. 

To use VetConnect PLUS from the IDEXX Lab Report: 

1. In the Cornerstone software, open the patient record, and then use your preferred method to open 

an IDEXX Lab Report  that contains the test results you want to see (for example, double-click an 
IDEXX Lab Report on the Summary tab in the Patient Clipboard). 

The Detailed Lab Result Set window opens. 

2. Select the VetConnect PLUS tab. 

3. When finished, close the results window.  

Understanding the VetConnect PLUS Tab  

Results in VetConnect PLUS are organized by date 

VetConnect PLUS displays the selected result in its main window. All other results in the patient’s history 
are also available, organized by date. Click a date tab to open the results. 

 

Results for the same analyte are displayed side by side 

VetConnect PLUS automatically displays both the selected result and other results for the same analyte 
that it found in patient history so you can easily compare them. 

In the example below, hematocrit results 11/13/11, are currently selected. VetConnect PLUS also found 
hematocrit results for 5/8/11 and 1/17/11.  
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Click Trending to graph selected analytes 

Select one or more analytes in the left column and then click  to display graphs on the right. The 
gray rectangle behind the graph indicates the reference interval. 

 
 

Tips: 

•  You can click Trending before or after you select the analyte names.  

• Click  to open the trending graph in its own window. 

Toolbar buttons 

The following buttons are at the top of the VetConnect PLUS tab: 

Patient Tools  

 

Displays patient information and indicates the patient’s species, including: 

• Feline 

• Canine 

• Equine 

• Exotics and other species 

 
Displays all diagnostic results for the current patient. A green plus indicates 
there are possible matches to the current patient record that should be 
reviewed. 

Result Tools  

 
Send the open result by email 

 
Print the open result 

 
Share a result with IDEXX Pet Health Network* Pro 

 Graph results for selected analytes 
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Send a client-friendly report for a canine or feline patient.  

These reports have been designed to communicate information about the 
patient in a format that clients will find clear and engaging. Available reports 
include the Preventative Care Summary (feline or canine) and SNAP* 4Dx* 
Plus Summary (canine only).  

 
View the VetConnect PLUS communications log, which shows details of 
diagnostic lab results and client-friendly reports that have been emailed, 
printed out, or shared through Pet Health Network Pro for the patient. The 
log includes a record of any comments that were sent with results or 
summaries. 

Note: The information in the VetConnect PLUS communication log is not 
viewable elsewhere in Cornerstone. If you want to have a copy of a 
communication in the Cornerstone patient history, print it as a PDF and 
attach it to a medical note. 

 

Most buttons are toggles 

If clicking a button opens a dialog box, window, or menu, click the same button to close it. 

Additional VetConnect PLUS Features 
VetConnect PLUS is updated independently of Cornerstone. From time to time, you may see new 
features in VetConnect PLUS even though you have not upgraded your Cornerstone software. To learn 
about the latest VetConnect PLUS enhancements and new features, periodically do the following: 

1. Open any lab result on the VetConnect PLUS Lab Results tab of the Detailed Lab Results window. 

2. Scroll to the bottom of the results, and click Customer Support. 

3. In the Getting Started area, click the tutorials for getting started link. 
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In Cornerstone* Practice Management Software (excluding the Mobile Computing module), the Antech 
Diagnostics® laboratory module enables online test ordering and automatic result download. The 
updated module offers the following enhancements: 

• The Antech Diagnostics profile list (a list of commonly used Antech order codes) is updated 
automatically by Antech Diagnostics, as needed. The IDEXX Cornerstone* Practice Management 
System software alerts you when Antech updates its list prices.  

• You can specify an automatic markup percentage for Antech Diagnostic profiles, just as you can for 
IDEXX profiles. 

• When you order an Antech Diagnostics profile, Cornerstone software checks the order for accuracy 
and then generates a bar-coded Antech Diagnostics order form appropriate for the profile type. Print 
the form and include it with your specimens. 

• When your order is complete, Cornerstone sends the profile request to the laboratory electronically.  

• Results are automatically downloaded from the laboratory approximately once per hour. 

Contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386 for information about 
purchasing and activating the Antech Diagnostics laboratory module. 
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With earlier versions of Cornerstone software, LifeLearn® client education handouts could be purchased 
on CD and integrated with Cornerstone through a one-time document import process. Starting with 
Cornerstone 8.3, through a subscription to the LifeLearn ClientEd Online web-based portal, Cornerstone 
users can experience the added flexibility and convenience of having continually updated articles that 
can be customized and edited as often as you like, with new articles added regularly. For more 
information about LifeLearn documents on CD, see “Chapter 18: Setting Up Classic Medical Notes; 
Loading LifeLearn” in the Cornerstone Administrator’s Manual. 

LifeLearn ClientEd Online: 

• Access an extensive library of over 1,200 fully searchable, illustrated, educational titles that you can 
email, print, or save. 

• Add or replace content within any article with an easy-to-use content management system (CMS). 

• Add your own articles to your custom library. 

• Personalize articles to your specific patients. 

• Reinforce your online presence and turn your website into a knowledge center.  

• In Cornerstone, link content directly to diagnostic and treatment codes for automatic printing and 
storage in your patient’s medical records. For more information, see the Diagnostic Codes section 
in “Chapter 3: Setting Up Lists and Information” of the Cornerstone Administrator’s Manual or see 
the Diagnostic Codes help topic in Cornerstone. 

After activating the ClientEd Online service through LifeLearn and performing an initial document 
synchronization, ClientEd Online documents are available for selection within the Cornerstone software.  

For more information on LifeLearn ClientEd Online, visit  
www.lifelearn-cliented.com/about cliented or contact your IDEXX Cornerstone Sales Representative at 
1-800-283-8386. 

Note: Using LifeLearn ClientEd Online documents requires Microsoft® Word 2003 or newer.  

Getting Started with LifeLearn ClientEd Online 
Both new and existing LifeLearn customers must subscribe to the ClientEd Online service. Please 
contact your IDEXX Cornerstone Sales Representative at 1-800-283-8386 for more information.  

Once you have completed the sign-up process and received your LifeLearn username and password, 
you can then perform the synchronization in Cornerstone to begin printing your ClientEd Online client 
handout documents. 

Notes:  

• If you currently use CD-based LifeLearn documents with Cornerstone, existing documents you may 
have customized or edited will not be overwritten during the sync process in Cornerstone. 

o To avoid duplicate templates in the template list, delete any CD-based LifeLearn documents 
that you no longer want to use. From the toolbar, select Lists > Documents to review and 
delete templates before you synchronize. 
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o If you had special actions set up with CD-based LifeLearn documents (for example, to 
automatically print), change the special actions to link them to the online documents. 

• There is a one-time user license fee associated with ClientEd Online, as well as a monthly 
subscription fee. 

 

Synchronizing LifeLearn ClientEd Online Documents with Cornerstone 
Upon activation of the ClientEd Online service with LifeLearn, in Cornerstone select Tools > 
Synchronize LifeLearn Documents.  

 

On the LifeLearn ClientEd Sync dialog box’s Account tab, enter your LifeLearn account username and 
password in the fields provided. Leave all other fields at their default settings, and click Sync Now to 
update Cornerstone with the latest documents available. Once the first synchronization is run, you can 
then return to this dialog box at any time to sync and receive any new documents or edits in your online 
library. 

Note: Depending on the speed of your Internet connection and transfer rate, the synchronization 
process may take a long time the first time you sync all documents with Cornerstone. Consider doing 
your initial sync during a time that you do not need to use that workstation, as it will be dedicated to the 
sync process. 

Customizing and Editing Your Library of ClientEd Online Documents 
LifeLearn ClientEd Online provides you with the added flexibility to edit the handouts and to ensure 
consistency of the handouts across your practice. You can: 

• Edit the handouts as often as you like.  

• Customize any document to reflect your practice’s philosophy, style, or culture.  

• Add your own articles to your library.  

• Access a record of the edits made, date of the edit, and who in your practice has made the edits.  
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Any edits made in your online library will be retained and reflected the next time you sync your LifeLearn 
ClientEd Online documents in Cornerstone. 

Note: You will receive detailed instructions on editing and customizing your library of documents when 
you sign up for the ClientEd Online service with LifeLearn. 

 

Selecting a LifeLearn Document from the Start New Document Window 
Using the Start New Document window, you can search for a LifeLearn document by keyword, species, 
topic, and/or system.  

Note: LifeLearn documents do not display in the Preview pane like other document templates because 
LifeLearn documents are Microsoft® Word documents. 

 

Select the document and click OK to open the document in Microsoft Word with predefined practice and 
patient demographics included in the appropriate fields within the document. 

Note: Microsoft Word is required to print LifeLearn documents that include your Cornerstone practice 
information and patient demographics. (Word Viewer can be used, but note that the Cornerstone 
practice and patient information will not be included in the documents if printing from Word Viewer.) 

Other Ways to Use LifeLearn ClientEd Documents with Cornerstone  
In addition to accessing LifeLearn documents on the Start New Document window, these documents 
can also be linked to certain actions in Cornerstone to streamline your client communications and 
automatically print client handouts. 

In Cornerstone, you can link documents to: 

• An invoice item, using the Print Document special action. 

• A reason for visit. 

• A diagnosis code  

Note: Mobile Computing module users in the field will not be able to sync LifeLearn documents but will 
be able to search for them. 
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IDEXX Pet Health Network* Pro lets you manage communication to and from your clients right inside the 
IDEXX Cornerstone* Practice Management System.  

The tools available when you use Pet Health Network Pro with Cornerstone include: 

• Sending automatic reminders by mail and/or email. 

• Allowing clients to confirm appointments by email or text. 

• Receiving requests for appointments and prescriptions from clients via the Petly* website, as well as 
receiving updated client information. 

• Sharing selected documents from the patient record with clients electronically. 

Your clients interact with Pet Health Network Pro through email, text messages, and the personalized pet 
pages at Petly.com. 

Setup 

Activate and Set Up Pet Health Network Pro 
Before you use the new Pet Health Network Pro features, you need to sign up for the service. Get started 
by contacting a Pet Health Network Pro communications specialist at 1-855-627-6570 or 
support@pethealthnetworkpro.com. The specialist will walk you through the set up of Pet Health 
Network Pro for your practice. The setup steps for some key features are outlined below, and you can 
find more detailed guidance on each Pet Health Network Pro screen. 

Note: Pet Health Network Pro is a subscription-based service. There is also a charge for postcard 
communications. Contact Pet Health Network Pro for subscription information. 

Set Up Reminders on Pet Health Network Pro 
You can set up email and/or postcard reminders that will be sent automatically to clients a specified 
number of weeks before a patient is due for an appointment. Email reminders allow clients to confirm the 
appointment electronically. 

To set up reminders: 

1. Log in to Pet Health Network Pro, and click Communications and Medical Reminders.  

2. On the Medical Reminders screen, fill in the information in the Schedule and Options areas. 

3. If necessary, click the edit links to edit the design of postcards and email messages. 

4. When you have finished setting up reminders, log out of Pet Health Network Pro and close your 
browser window. 

Set Up Appointment Request and Pharmacy Request Options 
When you have Pet Health Network Pro, you can give your clients the ability to request appointment 
times from their account on Petly.com. You can also give them the ability to request prescription refills 
from Petly.com. Cornerstone displays these requests so that you can schedule the appointment or refill 
the prescription based on the information the client sends. 
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To set up appointment request and pharmacy options: 

1. Log in to Pet Health Network Pro, and click Petly.  

2. Fill in the information in the Appointment Requests and Prescription Requests areas. 

3. When you have finished completing the information, log out of Pet Health Network Pro and close 
your browser window. 

Set Up Missing Client Email Alert Options 
Pet Health Network Pro uses the client email information stored in Cornerstone to send out reminders, 
confirmation requests, and invitations for clients to join Petly.com. To ensure that email information is 
obtained, a missing email alert has been added to Cornerstone. You can configure how this alert is 
displayed and whether it is displayed at all. The alert is displayed on the Patient Clipboard and in the 
Client Alert window. 

To set up the Missing Client Email Address alert: 

1. On the menu bar, select Controls> Defaults> Practice and Workstation, and then select Alerts in 
the navigation pane. 

2. Make sure that Missing Client Email Address is selected. 

3. Click Save to save your changes. 

Use 

View Incoming Client Requests and information via the IDEXX Message Center 
If a client uses Pet Health Network Pro to send a request for an appointment or prescription refill or to 
update client information, you can view that information from the IDEXX Message Center in Cornerstone.  

To view and act upon client requests and information: 

1. On the Cornerstone toolbar, click the IDEXX Message Center  button . 

2. Click the Client Messages tab.  

3. Click the appropriate subtab: 

• Appointment Requests 

• Prescription Requests 

• Client Updates 

Each tab displays a list of messages. Messages in black are 
unread. If there is more information than the message center 
can display at one time, use the arrow buttons at the bottom of 
the window to move forward and back through the pages. If you 

want to update the list of messages, click Refresh . 

4. To open a message, double-click it.  

OR 

To act on more than one message, hold down the CTRL key 
and click each message you want, then right-click and select 
Open. 
A dialog box displays each selected appointment request, prescription request, or client update. 
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5. If you want to copy text from the message, highlight it and press CTRL+C. To paste this text in a text 
box elsewhere in Cornerstone, click inside the text box and press CTRL+V.  

6. To open the Patient Clipboard so that you can schedule the appointment, enter the prescription 
refill, or make updates to client information, click the Patient Clipboard link in the lower right of the 
dialog box. 

Additional Message Center Tips 

• The IDEXX Message Center lists all recently returned results from IDEXX Reference Laboratories and 

IDEXX VetLab* Station. Click the IDEXX Message Center  button on the toolbar to open the 
window, and then click the Lab Results tab. The button appears in red and black when there are 
unread messages. 

• The number of messages in each tab and subtab appears in brackets next to the tab or subtab 
name. 

• Client messages are bold black when they are unread, and light gray after you have read them.  
Tip: If you want to turn a read message back to its unread state, right-click it and select Mark as 
unread. 

• Once a message has been deleted, it is gone from Cornerstone and cannot be retrieved; however, 
you can keep messages indefinitely if you choose. 

Automatic Appointment Confirmations through Pet Health Network Pro 
If you set up email reminders in Pet Health Network Pro, the reminder includes a button that the client 
can use to confirm the appointment. Also, if the client visits Petly.com within a specified number of days 
before the appointment, a reminder will appear, and this reminder also includes a Confirm Your 
Appointment button. 

When the client confirms the appointment, the confirmation is recorded on the Edit Appointment dialog 
box for that appointment. Next to the confirmation date, Cornerstone shows that the appointment was 
confirmed by Pet Health Network Pro (displayed as “PHN Pro”). 

Note: If you need to clear the Confirmed on text box, click Unconfirm, just as you would if you entered 
the confirmation date manually. 
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Share Documents with Clients 
With Pet Health Network Pro, you can share the following documents with clients electronically: 

• Medical Notes (enhanced format) 

• Medical Notes (text only) 

• Correspondence (enhanced format) 

• Correspondence (text only) 

You have the opportunity to add a personal message that will appear with the document the client’s 
page at Petly.com. Once a document is shared, you cannot remove it from the client’s page at 
Petly.com  

Note: You can also share laboratory results and client-friendly reports from IDEXX VetConnect* PLUS 
within Cornerstone. 

To share a document: 

1. In the Cornerstone Editor, while looking at a medical note or correspondence document that is in the 
Final state, click Share. The PetHealth Network Pro—Sharing dialog box appears. 
Note: Documents in a state of Tentative cannot be shared. 

2. Enter your staff ID and the message that you want to appear with the document. 

3. Click OK. The document will appear on the client’s Petly.com page within a few hours. 

Seeing What You’ve Shared 

When you share a document, Cornerstone displays when and by whom a document was shared in the 
following locations: 

• On the Medical Note window, in the Hx Description line  

• On the Patient Clipboard*, on the Summary and Medical Note tabs 

• On the Check-in Report (either by date or by type), in the history line 

Note: Laboratory results and client-friendly reports that you share from IDEXX VetConnect* PLUS within 
Cornerstone can be viewed from the VetConnect PLUS communications log but are not viewable 
elsewhere within Cornerstone. 
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Viewing Pet Health Network Pro Activities on Reports 
Information about activities related to Pet Health Network Pro is available in the following reports: 

 The Patient History Report and the Check-in Report show when a document was shared, and 
who shared it. 

Features to Record Client Email Addresses 
IDEXX Pet Health Network Pro uses the client email information stored in Cornerstone to send out 
reminders, confirmation requests, and invitations for clients to join Petly.com. To help ensure that email 
information is obtained, the following features are available: 

• If the Email address text box is empty, it is highlighted. 

• If the client does not want to give his or her email address, select the Email declined check box. 
This turns off the highlight on the Email address text box and turns off missing email address alerts 
for this client (if you have set up missing email alerts). Also, Cornerstone displays the date on which 
the client declined to provide their email address (the date you check the box). 

 

 

 

 

 

 

 

 

 

 

 

Additional IDEXX Pet Health Network Pro Features 
IDEXX Pet Health Network Pro is updated independently of Cornerstone. From time to time, new 
features may be available in IDEXX Pet Health Network Pro even though you have not upgraded your 
Cornerstone software. Check pethealthnetworkpro.com periodically to learn about these new features. 
After you have activated IDEXX Pet Health Network Pro, you can see additional information about new 
features on your practice’s IDEXX Pet Health Network Pro Home page (go to 
pethealthnetworkpro.com/login and sign in). 
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